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Introduction

Welcome to the new version of Visual Basic for 2005. As its name
implies, Visual Basic is a visual way to create new programs for the
Microsoft Windows family of operating systems.

And though it is basic in many ways, the Visual Basic language is also very
powerful. You can create new class libraries and XML Web services, as well
as programs that you can use on your PC or your Web browser, or even your
phone or PDA. Anything that can be done in Windows can be done in Visual
Basic.

Programming in Visual Basic is easier than you might think, thanks to the
visual tools supplied by Visual Studio. You don’t have to type line after line of
code to create a working program — Visual Studio automatically generates
some code for you when you drag and drop components with the visual
tools. Of course, being able to read and write code is important too, and this
book provides plenty of code samples so you can understand the inner work-
ings of your programs.

This book also shows you some best practices to keep in mind as you get fur-
ther along in your programming. Your first programs may be very simple, but
when you start getting into more complicated applications, you really need to
plan out your program before you start writing the code.

Previous versions of Visual Basic were complete development environments.
The latest version of Visual Basic is really only one part of a three-part pro-
gramming strategy:

1 A language: For this book, it is Visual Basic 2005. Other popular lan-
guages include C#, J#, Perl, and 24 others.

v An Integrated Development Environment (IDE): For this book, it is
Visual Studio 2005. Other IDEs include Borland, Macromedia, and several
other tools.

v A project: In this book, I cover four types of projects: Windows Forms,
Web Forms, class libraries, and XML Web services. You can also use VB
to build Web services, console applications, Smart Device applications,
Mobile Web Forms, and many other project types.
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About This Book

No matter who you are or what your background is, you are not a dummy if
you’re reading this book. You might, however, be a dummy about what Visual
Basic is, how to use it, or why it can help you do your job better.

This book is expressly designed to make you a good Visual Basic program-
mer. As such, I don’t spend every page talking about the features of the lan-
guage, or how to use Visual Studio, or how to connect to a database. I spend
a fair amount of time talking about how to make good decisions, build the
right software for the problem you need to solve, and not make common
mistakes.

Visual Basic — despite all appearances — is really very easy to use. Much of
the complexity of the language is hidden in tools provided to you by Microsoft.
Many of these tools are not expressly for Visual Basic, but they will become
very important to your success as a programmer. This book is also about
those tools, because they make writing good, working programs faster and
easier.

This book is also about you, the programmer. I'm a programmer like you.

[ have been writing in BASIC since 1981, and I've lived through all the ups and
downs. For about 15 years, Visual Basic was a program, not a language, and

[ lived through that. Now the tables have turned — Visual Basic is again a lan-
guage (Visual Studio is the program). In this book, I help you become a good
Visual Basic programmer.

Conventions Used in This Book

[ have written this book to be easy to read while you are programming. As
such, [ use certain conventions to make for easier reading:

v Words that [ want to emphasize or that I'm defining are placed in italics.
v Terms that are used in Visual Basic code are in monotype font.

v Menu selections look like this: FileoNew. This is shorthand for “From
the File menu, select New.”

I use numbered lists to guide you through a sequential process such as build-
ing a Windows Forms application. The bold part of the step is a technical
description of the action you are to perform, and the normal (not bold) text
that follows provides further explanation or describes how I implemented the
step in my examples.
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Bulleted lists are used to create memorable lists. One of the toughest things
about programming for me is remembering key points, like features or best
practices. [ use the bulleted lists to help with those kinds of things.

Code examples are broken out from the rest of the paragraph, as follows:

If DateNumber.Text.Length > 0 Then
DateInterval = CInt (DateNumber.Text)
End If
NextWeek.Text = DateChooser.Value.Add (TimeSpan.FromDays (7)) .ToString ()

The code blocks are usually written in such a way that you can copy them
right into your program. They will be in monotype font, and sometimes will
have linefeeds (the space and underscore character at the end of the line) in
inappropriate places because the printed page is only so wide. Remember
that when you’re writing out the code and you’re looking at it on-screen, you
won’t need to use so many linefeeds. If you have a question about where a
break should be, check out the sample code, which you can find on this
book’s companion Web site, www.vbfordummies.net.

What You're Not to Read

If you're not working with graphics right now, you can skip the chapter on
graphics. If you don’t use a database, you can skip the database chapter. See
where I am going? If you don’t use Web services, you don’t have to read
about it.

Effectively, this is a modular book. Aside from Part [, which everyone needs
to read, there are no requirements to read anything in any particular order.
Read what you need, and ignore the rest until someone comes into your
office and needs something done on that topic. Then you can pull the book
out again and read that chapter.

The Technical Stuff icon is for information that is more in-depth than the rest
of the book. If you are following along with Visual Studio and don’t want to be
distracted, skip over the Technical Stuff icons.

Foolish Assumptions

[ assume that, by buying this book and reading it, you are interested in find-
ing out how to program in Visual Basic. Beyond that, I also assume that you
have the following:
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v A PC running some flavor of Windows (Windows 2000 or XP, most likely)
v A copy of Visual Studio 2005 installed on your PC

v Access to the Internet, for downloading code samples and further
reading

How This Book Is Organized

This book is meant to be read as a series of articles, but it can easily be used
as a reference or read straight through. I recommend reading it at your com-
puter, with Visual Studio running.

Each part is designed to teach you something that you need to know. The
only part that I strongly suggest you read, however, is Part I, “Getting to
Know .NET Using VB.” After that, you can read whatever you need to get the
job done, or read the whole book all the way through — it is up to you.

Part I: Getting to Know .NET Using UB

After a quick jumpstart, I discuss the tools and concepts in this part. Chapter 1
is a Hello World introduction to the language, which experienced VB program-
mers will find useful and new programmers will find vital. Chapter 2 is a tour
of the development tool you will be using, Visual Studio 2005.

Chapter 3 is arguably the most important chapter in the book. It is about
designing good software with Visual Basic. You may want to read that one
twice. | wanted to print it twice, but the publisher wouldn’t let me.

Part II: Building Applications
with VB 2005

This part gets you started programming; you’ll find one chapter here for each
of the four most used project types (Windows and Web Forms, DLL files, and
XML Web services), and then a chapter discussing how to debug all of them.
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Part I1I: Making Your Programs Work

This part is actually about Visual Basic, the language. You see, the projects
discussed in Part Il are actually available to lots of languages. You can write a
Windows Forms project in Java (Microsoft calls it J#) if you want to. The
actual VB language doesn’t kick in until you write a program that needs more
than the visual design.

Part IU: Digging into the Framework

Finally, in Part IV, you look at the last part of the puzzle — what the .NET
Framework can do for you. Tons of tools that are built right in to the frame-
work are available to all languages, but have a special twist when used with
Visual Basic.

[ begin with the important stuff, specifically security. Then I cover data, files,
networks, and drawing. Throughout all these chapters, I provide code exam-
ples that will help you through the tougher problems that you may encounter
in your VB career.

Part U: The Part of Tens

Some things fit nowhere. That’s what the Part of Tens is for — in this part,

[ collected the most useful tips that didn'’t fit elsewhere and made them into
top ten lists. For more of these kinds of lists, check out this book’s compan-
ion Web site at www.vbfordummies.net.

Icons Used in This Book

One of the things I like best about the For Dummies series of books is the ease
of reading. Important facts are easily distinguishable from tips or technical
details by this cool series of icons in the margins. [ hope you find them as
useful as [ do.
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This is the icon I use most often. It highlights a best practice, a common
usage, or just something that I think you will find good to know about a fea-
ture or tool.

[ use this icon to point out something that you want to, well, remember. The
famous gotchas that all programmers are so familiar with get this icon. Some
usages aren’t always obvious. I hope to help you help yourself by pointing
them out.

This icon points out something you do not want to do unless you’re willing to
suffer the consequences. Read the paragraphs next to the Warning icon so
you’ll know how to avoid the pitfall, trap, or mistake.

These icons are pointers to places where the My object, new to Visual Basic
2005, can be useful.

Sometimes, I give you more information that you really need. When I do that,
[ try to use the Technical Stuff icon. You will find things you never wanted to
know about the inner workings of the .NET Framework, design ideas, and
other geeky stuff alongside this icon.

I use this icon to highlight a new feature in Visual Basic 2005.

Where to Go from Here

If you're completely new to Visual Basic and Visual Studio, start out by flip-
ping the page and reading Chapter 1. If you're interested in looking up a par-
ticular topic, skim through the Table of Contents or the Index and turn to the
indicated page.

When you’re feeling more familiar with the language, tool, and project type,
branch out by checking out the list of tips in the Part of Tens to take your
next programming step.

You can, of course, read the whole book all the way through. Another great
way to figure out how Visual Basic works is to follow a project path all the
way through — for example, start with a Windows Forms project with
System.Drawing elements, and go through the examples in the chapters
that discuss those topics (Chapters 4 and 18, in this case).
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Be sure to use the code samples provided at www.vbfordummies.net. They
will give you a broad starting point for a lot of other, larger programs that you
might want to write.

You also might be in the position where you have to quickly learn how to use
this language for your job, and there might be special libraries and standards
that you have to work with there. I recommend that you take the book home,
where you can work undistracted, and give yourself a good foundation in the
language. Then you can take the book back to work and use it as a reference
for your future programming efforts.

QgN\BER Things change in the software world, and Microsoft software is especially

> prone to change. Things have probably changed since [ wrote this book. If the
software changes, I can’t update the books that have already been printed.
However, I can (and do) list any errata and updates on this book’s companion
Web site, www . vbfordummies .net. Check it out often.
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In this part . . .

Everyone must start somewhere, and I start at the
beginning in this part. You write your first Visual
Basic program, and in doing so, you discover some of the
ideas behind the .NET Framework (the backbone of this
version of the language). You then get to do the only
required reading in this entire book. First, you go over the
use of the tool, Visual Studio. Second, you design the
example application that you write in the next part.




Chapter 1
Wading into Visual Basic

In This Chapter
Seeing where VB fits in with .NET
Writing your first Visual Basic 2005 program
Exploiting the newfound power of VB

T) get started with Visual Basic 2005, | recommend that you jump right in
and write software! And to help you with such an assertive approach, this
chapter gives you just what you need to test the waters of the Visual Basic pool
and get comfortable with its place in the larger Visual Studio environment.

Then, you can really get your feet wet as you build Hello World — your first
VB 2005 Windows Forms application — right here in the first few pages! You
find out how to launch Visual Studio 2005 (the development tool for your VB
applications), how to start a new project, and how to build a form visually
and make it work with code.

Also in this chapter, I give you a glimpse into the deeper power of Visual Basic.
Specifically, I introduce how VB 2005 integrates with the Microsoft .NET
Framework and offer insight into what that means to you as a programmetr.

Uisual Basic’s Role in the Framework

Microsoft created the .NET Framework to make development for the various
Windows operating systems easier. But because of the differences between
Visual Basic 6.0 and Visual Basic 7.0 (the first .NET version), most VB devel-
opers found development much harder. For example, VB 7.0 made all vari-
ables into objects, which removed the programmer’s ability to define a
variable type on the fly.
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|
Figure 1-1:
The .NET
Framework
hierarchy.
|

But developing applications in .NET doesn’t have to be harder than it was in
VB 6.0. The .NET Framework and Visual Basic 2005 can be powerful tools, and
the trick is discovering how they work together through the Visual Studio
Integrated Development Environment (IDE).

Part of the difficulty that many programmers face when moving to the .NET
Framework is the terminology, which can get confusing. I'd like to put the
problem with terminology to bed right now, so check out this list of the
potentially confusing terms used in .NET development:

v Visual Basic 2005: The programming language described throughout

this whole book. No longer can you run or load Visual Basic as a sepa-
rate entity. It is simply one programming language that speaks to the
Microsoft .NET Framework, which is the next term in the list.

v NET Framework: The layer that sits between the language (in this case,

Visual Basic) and the operating system, which can be Windows 98,
Windows ME, Windows 2000, Windows XP, Windows Server 2003, or any
of the sub-versions of those (such as the Tablet PC edition). The .NET
Framework layer serves to provide functionality based on the operation
of the Windows system on which it resides, as well as to provide
libraries for other functionality (such as math computations and data-
base access). Figure 1-1 is a visual representation of the relationship of
all the layers in the framework.

4 4 Y 4
| VB UC++U C# UJScriptu

Common Language Specification
ASP.NET Windows Forms

ADO.NET and XML

‘01pMiS [ensIA

Base Class Library

4
Windows |/| COM+ Services

v Visual Studio 2005: The tool that you use to create any kind of applica-

tion using any compatible programming language. Visual Studio replaces
the Visual Basic 6.0 program that was formerly part of the Visual Studio
suite (all individual suite components were labeled Version 6.0). When
you go to write a new program in the .NET environment, you run Visual
Studio 2005 and select the kind of program you want to write in the pro-
gramming language you want to use. For example, you may choose to
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create a Windows Forms program using the Visual Basic language, just
like the old days. Or you might want to write an application for a smart
device using C#.

v+ Windows Forms: The new term for an old-fashioned Visual Basic appli-
cation. This term refers to an application that is written using the .NET
Framework and has a Windows user interface.

v Web Forms: The term for an application with a Web page interface writ-
ten using the .NET Framework. Creating a Web Forms application is very
similar to writing a Windows Forms application.

v Web services: The class libraries that are written using a standard
defined by the same people who defined standards for the World Wide
Web. Web services are used for interaction between divergent systems.

The .NET Framework is what you may already know as the Win32 layer in the
old Windows DNA system. Like the new .NET Framework, the Win32 layer
gave you the ability to get to the functions of the operating system when
developing for a Windows platform. Also, the .NET Framework includes a lot
of adjunct functionality, such as math and data libraries, that makes program-
ming a more cohesive experience.

Basically, everything that Windows does is exposed by the .NET Framework.
Specifically, the .NET Framework gives a programmatic name to every object
and event that Windows can control. A programmer can use that name to refer
to anything having code in the operating system. Do you need to tell the
printer to make two copies of your document? Try referring to My . Computer.
Printers.DefaultPrinter.PrinterSettings.Copies = 2.Do you need
to paint some item on the screen blue? Try System.Drawing.Brushes.Blue.

How VB 2005 differs from VB 6

Visual Basic 6 was a standalone program, and
Visual Basic 2005 is one language in a larger
development system. To go back to VB's roots,
Basic was a programming language used 20
years ago as part of MS-DOS. In 1985, Basic
became Visual Basic and was made into a part
of the Windows application-building tool.
There’s a lot more to the Visual Basic 6 program
than just the language — its form-building soft-
ware, for example, is called Ruby.

In Visual Basic 2005, you have a new forms gen-
erator, and with it, a new way to interact with
the Windows operating system. The real reason
to understand the extent of this larger develop-
ment system — and the complexity of the .NET
Framework that surrounds VB 2005 — is so that
reading related books and documentation is
easier.

13
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In this .NET world, the programming language becomes just a way to interact
with the framework and, therefore, with the Windows operating system. All
programs need a set of established rules to handle the flow (decisions, loops,
and the like) within programs. Visual Basic provides one such set of rules,
and the framework provides the objects and events to interact with.

Saying Hello to VB 2005/

A\\J

In this section, I get you started with the classic Hello World program. Although
this isn’t the single most exciting application you can build, it helps to make
sure that your development environment is set up the best way possible.

Setting up Visual Studio

To follow this example, you need to start by running Visual Studio 2005,
which is the development environment used throughout this book to build
applications in Visual Basic. Before you can run Visual Studio, you need to
install it!

Visual Studio comes in a number of editions:

v Team System: Designed for full programming staffs in large corpora-
tions, this edition includes large-scale application system design tools
such as test-driven development and Team Foundation Server.

v Professional Edition: Designed for the developers working with users in
a standalone setting. The Professional Edition is more common for the
solo developer or for mid-sized application development. This is the edi-
tion I use in this book.

v~ Standard Edition: Designed for building smaller, standalone applica-
tions, this version is perfectly functional for 80 percent of applications
built. But if you plan to build large systems that need to be enterprise-
quality and may have many users, go for the Professional Edition.

v~ Express Edition: Designed for students and hobbyists. This version
lacks a lot of the project types that the other versions have.

If you don’t have access to the MSDN Library (Microsoft’s handy technical
archive), I highly recommend getting it. You can load up a machine with your
choice of sample code, documentation, and other reference material on
Visual Studio editions, operating systems, and server software. You can find
out about the library at http://msdn.microsoft.com, and you can buy sub-
scriptions from several resellers, including your favorite software dealer.
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Installing Visual Studio can be rough, so I recommend going with the defaults
for your first time. The installation process takes quite a while, too. Even if
you are using the DVD, expect to spend two hours installing. If you are work-
ing from the CDs, expect to spend four hours.

After installing Visual Studio, you can run it by choosing Start=>All Programs=>
Microsoft Visual Studio 2005=>Microsoft Visual Studio 2005. The environment
loads, and you can get started on a program by choosing File>New>Project
from the main menu. Next, you need to make choices about your project type
and language, as described in the next section.

Starting a Windows Forms project

After you choose FilewNew=>Project from the Visual Studio main menu, the
New Project dialog box appears, as shown in Figure 1-2. In the Project Types
pane, you find a folder structure that lists the languages loaded with your
installation and the project types available for those languages. I suggest
beginning with a plain old Windows Application — which is the Visual Basic
2005 answer to the traditional (and perhaps familiar) VB 6.0 application.

Projact types: Templates: BB I

Visual Studio installed templates

Windows Class Lbrary
Apphcation [

]
Vi

Empty Fraject

My Templates
A project for creating an application with & Windows user inberfacs

Hame: WirdowsApplcation 1

To get started building your Hello World application, following these steps:

1. Select the project type from the Templates pane in the New Project
dialog box.

For this example, select Windows Application. Also, make sure Visual
Basic is the language selected in the Project Types pane. If you loaded
other languages during installation, you may have other choices.

15
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|
Figure 1-3:
Choosing
the Button
control from
the Toolbox.
|

. Type the name you want to give your project to replace the default

name in the Name text box.

In this example, I type Hello World in the text box.

. Click OK.

Visual Basic loads the default form (called Form1) and presents it to you
in the Design View. The default form comes complete with a workspace,
the title bar, and familiar windows elements like the resize buttons and
the Close button. You do most of the work to customize your form using
this visual view.

. Click the word Toolbox on the left side of the screen.

The Toolbox appears, with Windows Forms controls loaded, as shown in
Figure 1-3.

. Double-click the Button control.

Visual Studio loads a button onto the default form in Design View.

6. On the default Form1, click the Button control and drag it to reposi-

tion it on the form.
Figure 1-4 shows the result of dragging the button to the middle of the
Forml window.
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This step list gives you the beginnings of the Windows Forms application,
which you see as a Form1 in the Design View. But to see where Visual Basic
comes in, you have to find the code behind the form. Visual Studio offers you
(surprise!) the Code View when you’re ready to use Visual Basic to add func-
tionality to your form.

Adding functionality to the
form with UB code

To add a little functionality to the Windows form you build in the preceding
section, follow these steps:

1. Double-click the Button control to enter Code View.

In the Code View window, you see basic button-click code that looks like
the following:

Public Class Forml
Private Sub Buttonl_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Buttonl.Click

End Sub
End Class

This code is a template that wraps the code that will be run when you
click the button. Visual Studio does the hard part for you, making sure
the formatting of the sub is correct!

2. In the Code View window, type a line of code to change the text that
appears on the Button control to Hello World.

17
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Specifically, type the following code on the line preceding the End sub
line:

Buttonl.Text = "Hello World"

Your button’s code now looks like the following:

Public Class Forml
Private Sub Buttonl_Click(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles Buttonl.Click

Buttonl.Text = "Hello World"

End Sub
End Class

Running and operating your Windows form

So, this experience is pretty cool, right? Programming with Visual Basic is so
easy that, here in Chapter 1, you can already write a Windows Forms applica-
tion. But what can you do with it? Check out the following:

+ Run your Windows Forms application within the Visual Studio envi-
ronment. Press the F5 key on your keyboard, and Visual Studio opens
your active project as a Windows program. It appears in your taskbar
and everything. Click the button on your form, and the button text
changes to “Hello World,” (or whatever text you specified in the code).
Pretty neat, huh? Your Windows form should look something like the
image in Figure 1-5.

_"'_' Form1 E]E

Hello 'wiord

|
Figure 1-5:
Your

Hello World
application.
I
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+ Run your application outside of the Visual Studio environment. If you
are still in Debug mode, you will need to stop your program first by
using the Stop button on the toolbar or by closing the form window.
Then you can save and move on.

The very simple way to run an application outside of Visual Studio is as
follows:

1. Choose File=>Save All from the Visual Studio main menu.

The Save Project dialog box appears, and Visual Studio prompts
you to pick a location to save your project (see Figure 1-6). In this
case, accept the default folder.

I | Save Project EJ
Figure 1-6: | name: Hello World
The Save Location: C:\Documents and Settings\sempfiMy Documents\Visual 5w
Project | mew solutiontame: | Hello World [¥] Create drectory for solution
dialog box.
I

2. Click the Save button.
3. Choose Build=>Build Program Name from the main menu.

In this example, choose Build=>Build HelloWorld, and Visual Studio
compiles your application into a usable Windows program (with
file extension .exe) and stores it in the default folder.

4. Navigate to the default folder containing your new Windows
application.

For my application, the path is C:\Documents and Settings\sempf\
My Documents\Visual Studio\Projects\Hello World\Hello World\
bin.

5. Double-click the filename for the compiled program to run it.

You may see a host of files in the default folder, but in the example,
Hello World.exe is the file you're looking for.

There is a more complex method for running your VB programs outside the
Visual Studio environment. You use a Setup Project, which is a very cool tool
but beyond the scope of this book. Research the term Setup Project in the
MSDN Library when you're ready to find out more about this device, which
helps you distribute your application to other users.

19
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Finding More Power in Uisual Studio

|
Figure 1-7:
The File
menu in
Visual
Studio.
|

Earlier in this chapter, [ show you the Windows Forms application develop-
ment environment and a little of the new Visual Basic 2005 code. If you are
familiar with VB 6.0, the form and the code look pretty familiar at this point.
In fact, the major Windows development tools for any programming language
work pretty much this way.

But when you look beyond the Windows form and the code structure, a few
more details become evident. For instance, Visual Studio takes your VB code
beyond the Windows form. The following sections give you an overview of
the development power that you find in Visual Studio.

Visual Studio doesn’t just do Windows!

The first evident change that sets Visual Studio apart as a development tool
is this: You can use Visual Studio to write programs that run on the World
Wide Web as well as on Windows computers. When you click the File menu
to add a new project, notice the second option in the menu. As shown in
Figure 1-7, the second project option is a new Web Site.

File

My P51 Project... Ctrl+shift+h
Open P welrSte..

Add » | ]| File... Cirl+N
Close Project From Existing Code...

: Close Project

| saveFormLvb Crl+s
Save Form1.vb As...

il Save Al Ctl+shift+s

Export Template...

Recent Files 13
Recent Projects »

Exit

Choose this option to create a Web application, which incorporates a whole
host of technologies — the .NET Framework, ASP.NET, Visual Basic, and
HTML — that each have essential roles for enabling an application to run
online.
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Visual Basic goes mobile

Mobile computing devices make their move into Visual Basic 2005. Two pro-
ject types that run on such devices are built right into Visual Studio.
Windows CE, Pocket PC 2003, and SmartPhone platforms are all represented.

[ don’t give examples of these specific project types in this book because you
can create a mobile device application in the same manner you create a
Windows Forms application (like the Hello World program discussed earlier
in the chapter). You should know that getting familiar with the Visual Basic
language as presented in this book puts you on the right track for creating
applications for a Pocket PC. Mobile computing applications require some
special programming practices, so make sure to grab some device-specific
information when you work on those project types.

Writing routines to use with other software is easier with Visual Basic 2005.
You can write add-ins for Microsoft Office apps, including Excel and Word
templates with VB code running behind them. These routines don’t use the
VBScript that you may have seen before; a completely new part of Office 2003
allows you to write templates with special, built-in functionality. For example,
I've built a Word template that automates a reporting process by asking the
user for a report number, checking that number against a database of all the
reports filed, and filling out part of the document-in-process with the relevant
information from the database.

VB as your one-stop development shop

Generally, Visual Studio and the .NET Framework are designed to be the one-
stop shop for any kind of development on Windows machines. But in this ver-
sion, Visual Basic 2005 can also do it all. The language can now touch all of
the parts of the .NET Framework that any of the other languages can get to,
without resorting to the cryptic function calls necessary in prior versions

of VB.

The new features covered in this book include

v Security: Encryption, validation, and permissions. Securing your code
using sophisticated encryption is now built in to the framework, among
other things.

v~ Data: Collections of information, accessing databases, and XML. There
are new Data controls for your forms pages, too!
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v~ 10: Integrate program activities with files, disks, and folders in a way
that requires writing much less code.

v System.Net: VB knows about the Internet. Web, FTP, and Mail are all in
one place.

v Drawing: Comprehensive screen graphics for Web and Windows —
even 3D.

v The my Object: Get to the hard-to-reach places more easily with this
simple-to-use set of shortcuts.

This list shows you that Visual Basic has grown up somewhat. If you don’t
know VB 6, then you have no worries! Getting chummy with this version
(Visual Basic 2005) is a much better place to be. If you do know VB 6, then
welcome home. This is where you always wanted to be.



Chapter 2
Using Visual Studio 2005

In This Chapter

Going over Visual Studio tools

Discovering how the code ties it all together
Customizing with options
Using third-party tools

Before you can effectively work with Visual Basic, you must know its
tools inside and out. For the purpose of this chapter and this book, I
will focus on just one — Visual Studio 2005. Visual Studio gives you access to
the drag-and-drop controls that were introduced in earlier versions of Visual
Basic.

Although I don’t cover the specifics of code in this chapter, I do cover all of
the code-generating tools that Visual Studio 2005 provides for Visual Basic.
For example, I discuss the new improved IntelliSense that can help you
remember the 288,000 methods, properties, and events in the .NET Framework,
but I don’t cover the framework itself.

Understanding Visual Studio Tools

Part of the joy of programming in Visual Basic 2005 is using the tools that are
provided by Visual Studio. Rapid Application Development (RAD) is a buzz-
word now, but when Visual Basic was first developed, it described (among
other things) the ability to code faster by reusing bits of code built in to the
development tools.
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This ability has never been more apparent than it is with Visual Basic 2005.
Even though Visual Basic is a language, and it depends on Visual Studio for
its environment, there are many tools that make RAD real. In the following
sections, I cover these tools. These tools are language-independent, project-
independent, and indispensable.

Keep in mind that Visual Studio isn’t necessary to make Visual Basic programs.
You can, in fact, make complete applications in the old-school style by using
a command line compiler.

Additionally, much of the documentation provided by the Microsoft Developer
Network (MSDN) Library assumes an understanding of the tools. The docu-
mentation refers to the tools by name and often doesn’t clearly describe
them. You must know where you are working before you can work, so the
following sections take you on a tour of the Visual Studio tools.

When you install Visual Studio, you were probably asked to install the MSDN
Library. You will find it an indispensable tool (it’s what you get when you go
to the Help menu, in fact). Additionally, you can find the library online at
http://msdn.microsoft.com/library.

Touring the Design Uiew

When you launch Visual Studio (usually by selecting its icon in your Start
menu) and begin any visual project, you see the Design View. The Design
View is where the Graphical User Interface (GUI) work takes place. Generally
speaking, anytime you are working with pictures of forms, not code, you are
working with the Design View. When [ use the term designer window, I am
referring to the actual place you do the work. The term Design View refers to
the state the application is in.

In the Design View, you can accomplish the following:

v Manufacture windows, Web, and smart device forms by dragging con-
trols directly to the form in a What-You-See-Is-What-You-Get (WYSIWYG)
type environment.

v Work with databases and XML files visually.
v Create software components by visually managing the parts.
In general, Design View is the core part of Visual Studio. Many of the other

tools in Visual Studio depend on the Design View, in fact, and are disabled
when you use another view, such as Code View, to work on your project.
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Using the Design View tabs

The designer tabs have the word [Design] in the tab name, as shown in
Figure 2-1, to indicate you are using the Design View. Tabs are used in the
Design and Code Views. The gray tab represents files that are open but not
active. An asterisk (*) next to the file name means that you’ve made changes,
but not yet saved the file.

The white tab is active and contains the editable form. When you have more
than one document open, you can edit only the active form. You can drag the
tabs to left and right to change their order. Right-clicking on a tab gives you a
menu from which you can choose several screen management options, as
shown in Figure 2-2.

Understanding tab groups

Tab groups make it easier to copy information out of one form into another.
For example, you can have one set of pages on the top half of the screen and
another on the bottom half, and copy from one and paste into the other with-
out changing screens. You can also save and close from this menu, or get
information, such as the current path or the containing folder.
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|
Figure 2-2:
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Accessing controls with the Toolbox

To add form components, such as buttons and text, to the form in the
Designer window, you simply drag them from the Toolbox. The Toolbox, usu-
ally seen on the left side of the Visual Studio environment and to the left of
the Designer window, is where the RAD components of various project types
are held for use until you need them. The Toolbox is shown in Figure 2-3.

The Toolbox is project sensitive, meaning that controls for Web pages and
smart devices don’t show up when you are writing a Windows Forms project.
Because those controls can’t be used in those project types, the Toolbox
doesn’t even let you see them.

You can access the controls in the following ways:

v Click a control and drag it to a form, dropping it exactly where you
want it.

v Double-click the control, and it appears in the upper-left corner of the
active form.



|
Figure 2-3:
The Toolbox.
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If you lose the Toolbox, or it isn’t showing on your screen, you can open it by
choosing Views>Toolbox or by pressing Ctrl+Alt+X. Right-clicking on the
Toolbox gives you layout options, including ordering and movement. One of
the options is Reset Toolbox, which puts it back the way Microsoft had it — a
great feature.

The gray dividers, labeled Data or Windows Forms among other things,
divide the tools in the Toolbox by category. To open a closed category, click
on the bar.

Visual Studio is extendable because of the Toolbox. You can use third-party
components with your programs. For example, a clock control that enables
the user to set the time would show up in the Toolbox. You can also use the
Toolbox to store often-used pieces of text, such as comment blocks.

Changing details with the
Properties window

After you drop the controls on the form designer, you will need to edit their
properties. Size, name, activity, color . . . these are the kinds of things you
find in the Properties window. The Properties window, shown in Figure 2-4, is
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|
Figure 2-4:
The
Properties
window.
|

usually on the right side of the screen. It contains all of the editable values
associated with a control.

If the Properties window isn’t on the right side of the screen, you can find it
by choosing Viewr>Properties, or you can press F4.

At the top of the Properties window, you see the form element whose proper-
ties are being viewed. You can select a different control by clicking on it in
the designer window or by selecting a new control from the drop-down list. In
Figure 2-4, the form itself is selected.

Beneath the selected control, there are a few buttons that resort the list or
filter by category. Of special interest is the lightning bolt button, which
allows you to define what the control does under certain circumstances — a
pattern called events. I cover events in depth throughout Part II.

The table that takes up the majority of the Properties window contains the
properties of the control. This is a simple hash table format — the properties
are on the left, and the possible values are on the right. To change a value,
you can usually type in the cell and press Enter. Some properties have an
ellipsis button (...) that opens a form to simplify adding complex details, and I
cover those as I discuss them in other chapters.
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The grouping buttons at the top of the Properties window are a useful fea-
ture. The Category button is great when you are just starting out, because
you can find the properties based on what you need. The A-Z list is better
later on, when you know exactly what property you are looking for.

The bottom of the Properties window has a brief description of the property
that is being edited. This information is right out of the documentation and is
a very handy feature.

Organizing your project with
the Solution Explorer

Solutions and projects hold forms and components like files in folders. In
fact, solutions and projects are represented by folders in the Visual Studio
Projects directory of your My Documents folder. The Solution Explorer is
Visual Studio’s tool that allows you to manage the files that make up your
project.

If you envision your projects like folders, you can imagine that you would
group like folders together in a folder one level up, right? That’s what solu-
tions do. They are both physically and logically exactly that — folders full of
projects.

In Figure 2-5, you see the important files in your project, and a whole bunch
of buttons above to help to manage them.

To open a file, double-click the file’s icon or name. To rename, copy, or delete
a file, right-click the file and choose your action from the context-sensitive
menu that appears. In the Solution Explorer, you can also make new folders
and move files into them, or right-click on the project to make a new form or
support file.

The buttons above the files themselves are the most significant part of the
Solution Explorer. They are, from left to right:

v Properties: Opens the Properties window.

v Show All Files: Shows hidden files, especially in Web Forms projects.

1 Refresh: Checks the solution folder for new files that may have been
added by another tool. This button is very handy when you’re using
third-party tools.

v View Code: Opens the selected file in Code View.
v View Designer: Opens the selected file in Design View.

1 View Diagram: Opens the selected file in Diagram View.
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Accessing outside resources
with the Server Explorer

Going outside of your project is one of the most common features that isn’t
supported by most development environments. That all changed with Visual
Studio 2005 and the addition of the Server Explorer, shown in Figure 2-6. You
can open Server Explorer by pressing CTRL+ALT+S, or selecting it on the
View menu. Now getting to the servers that provide your necessary services
is easier than ever.
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The Server Explorer is one of the more dynamic tools in the Visual Studio envi-
ronment. In Figure 2-6, I am using my local development machine, Banshee.
What you see in the Server Explorer depends on your local configuration.

The Servers node in this explorer shows up in some editions of Visual Studio.
At press time, the Professional edition was one of them. Also, the Team
System edition certainly has it, and you can get that edition from the
Microsoft Web site in a trial version.

Server Explorer gives you access to remote (or local) resources from a man-
agement and a code perspective. The tree view inside the Server Explorer
can show many servers, and beneath each server are the functional bits that
you have access to.

Most developers are looking for a one-stop shop for development, and most
often, that includes needing the ability to manage development server(s) and
look at databases. The Server Explorer handles both of these, but the new
Data Sources window is even better, and I cover it in the following section.

The services available to you in your Server Explorer depend on your envi-
ronment, but here is a brief description of some of the services that are
common:

v Crystal Reports Services: Crystal is a third-party reporting tool that is
included with Visual Studio. The services include Crystal Enterprise,
Report Application Server, and Web Services.

v Event Logs: This represents the normal old Windows NT-style event logs
that you can access from the Control Panel. Logs are available both pro-
grammatically in .NET and for management from the Server Explorer.

v Message Queues: Message Queues are a way to help manage the number
of requests to a very large application. The individual queues are made
available here.

v Performance Counters: This is access to PerfMon from the Windows
operating system. Each counter is available both for viewing and pro-
gramming.

v~ Services: The services from the Control Panel are available here. You
can stop and start the Web services, for example.

v Data Connections: Any SQL Servers or other databases that are running
on the server are available here. They can also be made available from
the Data Connection node or from the Data Sources window.

In Design View, you can actually drag an Event Log or Performance Counter
into the form write code to adjust its properties. Aside from these program-
matic capabilities, the Server Explorer does provide that one-stop manage-
ment shop.

31
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|
Figure 2-7:
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The Data Connections node allows you to connect your application to a data
source. Right-click the Data Connections node and choose Add Connection to
add a new connection. The Add Connection dialog box appears, shown in
Figure 2-7. If you want, you can select a different provider by clicking the
Change button next to Data Source. (I use SQL Server as an example.)

Add Connection

Enter information to connect to the selected data source or dick
“Change” to choase a different data source andjor provider,

Data source:

Microsoft SQL Server (SgiCient) Change...
Server name:

SCRIBE o Refresh

Log on to the server

(%) Use Windows Authentication
() Use SQL Server Authentication

Connect to a database

(@ Select or enter ﬁtabase name:
Morthwind|

() Attach a database file:

Advanced...
Test Connection OK Cancel

In Figure 2-7, I selected my local machine (Scribe) and the Northwind data-
base. Depending on your installation of Visual Studio, you should also be
running a local SQL Server and be able to select the same database. If not,
check your installation instructions for your edition of Visual Studio to see
whether you have a SQL Server 2005 Developer Edition available. Also, you
may need to download the Northwind database from the book’s Web site at
www . vbfordummies .net.

What this selection does is to connect your project with a database, which
then allows you to use the Data Sources window, manage the data objects
within the database, and edit data directly. When you have finished adding
the values to the Connection Properties dialog box, click the Test Connection
button to make sure that your project can get the database you selected.
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Dynamically editing data with
the Data Sources window

When you start a new project, the Data Sources window says “Your project
currently has no data sources associated with it.” In order to maintain data in
the .NET world, as with any other environment, you must connect your appli-
cation to a data source. The Data Sources window is the primary way to do
that.

To connect to a data source (like a database or XML file), follow these steps:

1. Click the Add a New Data Source button.
Doing so starts the Data Source Configuration Wizard.
2. Click the Next button.

The wizard shows the data source options. You can select the Database
option to use an SQL Server or Oracle database, the Local Database File
option to use a database on your computer stored as an Access or XML
file, the Web Service option, or the Object option.

3. Select the connection to Northwind that you made in the “Accessing
outside resources with the Server Explorer” section, and then click
the Next button (shown in Figure 2-8).

Data Source Configuration Wizard

Choose a Data Source type

Where will the application get data from?

& &

Database’  Web Service Chject

Lets you connect to a database and choose the database objects for your application. This option creates a
dataset.
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|
Figure 2-9:
The Data
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window.
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4. Accept the default connection name (probably NorthwindConnection)
and click the Next button.

5. Finally, you are given a choice of what objects to include in your
dataset.

I cover Datasets in Chapter 15. For now, select the first view as shown
back in Figure 2-8 and name the dataset Products.

6. Click the Finish button.

As shown in Figure 2-9, each of the columns in the view you selected appear
as the editable object types that can represent them. You can now drag them
to the Design View to create a data-bound control. The ability to drag
columns is one of the cool new features in Visual Basic 2005.
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Just for fun, drag the QuantityPerUnit field onto the blank form that was cre-
ated for you when you started the project. Visual Studio will create a bunch
of data piping for you, and then add the field and a label to the form. Using
the Data Sources window like this provides you with fantastic functionality
for quickly developing data applications.

In Figure 2-10, I have a picture of my screen as I dragged the field into the
form. You can see in the Design View bottom, where the background is gray,
that four components have been added to Form1. Components are functional
items from the Toolbox, not things that are visible on the screen. The Data
Sources window makes all of those components and adds the control to the
page, just based on the field you moved. That is the point of these RAD tools.
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Frankly, the Diagram View is a very sophisticated tool, which [ won’t cover in
this book. It allows enterprise architects to build component-based software
by taking whole blocks of code and moving them in a graphic environment.

Every now and again, when you have written something in Visual Basic, go
ahead and load up the Diagram View. You can enter Diagram View by right-
clicking a file in the Solution Explorer and selecting View in Designer from the
context-sensitive menu. It will create a new file called Classdiagraml.cdin
your Solution Explorer and show you the piping behind the software you
have built. It can be an educational experience — try it!

Moving a Tool Window

You can customize the Visual Studio environment to make it easier for you to
work in. All of the tools, windows, and views are part of an Integrated
Development Environment (IDE) that provides a home location. This makes
organization of your personal development space a lot easier.

Most often, you will want to move around a tool window to put it in a more
convenient spot. You can display a tool window in the following ways:
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|
Figure 2-11:
Moving
windows.
|
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v+ Floating: A floating window is very mobile — you can drag it around by
its handle to place it anywhere you want.

v Dockable: When you drag a dockable window, though, you are given the
option by Visual Studio to dock the window. This is demonstrated in
Figure 2-11, where I am dragging the Solution Explorer window around in
the Design View.

v Tabbed: You also have the choice to drag the window to the center and
have it become a tab at the top of the view window, like the Form1.vb
and Forml.vb [Design] files in Figure 2-11.
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There are five options to dock the window. If you drag the window over the
top, bottom, left, or right arrow, it will dock to that side. When a window is
docked, it has a thumbtack that you can pin or unpin. When pinned, it stays
on the side, moving the Design View over. When unpinned, it slides out of the
way toward the side it is pinned to. It is a brilliant feature.

If you drag the window to the center of the four-pointed star, it makes the
window a tab in the other central windows — much easier than the old triple-
click that was so hard to use. The triple-click still works, but you don’t need it
anymore!



Chapter 2: Using Visual Studio 2005 3 7

Working with Code

Most of what you want the user to see of the programs you create with Visual
Studio are the controls and the forms. But you will be spending most of your
time working with code. Fortunately, Visual Studio has a ton of tools to help
you write code.

Getting to Code View

Code View, like Design View or Diagram View, is just another way to look at a
file in the Solution Explorer. To get to Code View, you have several choices:

v You can right-click on a form in the Solution Explorer or in Design View
and select View Code from the context-sensitive menu.

v You can click the View Code button in the Solution Explorer.

v You can double-click an object in a form.

When you’re working in Code View, most of the tool windows will become
inactive. The Toolbox and Properties window, for instance, have little to noth-
ing available because their features are designed for use with the Design View
rather than in Code View. This is by design, to keep the code out of your way
when building business logic.

Using IntelliSense

The problem with using Code View is that you need to know what to type.
Welcome to programming! To help you get started, you can use some very
productive code-based tools, such as IntelliSense and Smart Tags.

The remainder of the book is about the language, but I want to give you
something to start with so that you can see how great these tools are. When
you are working with the code as the primary goal, the tools should be
second nature. Get started with these steps:

1. In the default project, double-click on the blank Form1 to move to
Code View.
2. Type My. in the Forml_Load method.

A special context-sensitive menu (the IntelliSense menu) appears, as
shown in Figure 2-12. This menu shows the code that is available to you.
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|
Figure 2-12:
Using
IntelliSense.
|
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3. You can continue to use IntelliSense menus as long as Visual Studio
thinks there are more types after the selected object. For instance,
double-click Application in the context-sensitive menu, and then
type . (a period).

You see another IntelliSense menu.

Using this method, you can access everything in the Visual Basic language.
Even when you write your own reusable code, IntelliSense will pick it up for
this special context-sensitive menu. It makes it much easier to work in the
.NET Framework with Visual Basic.

Reading the documentation

Rarely does an author have to write about how to read the documentation,
but in the case of Visual Studio, there is so much power in the documentation
model that it deserves a little space. The most straightforward use of the
documentation requires little more than clicking on or in the object that you
have a question about and pressing the F1 key to launch context-sensitive
Help.
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For instance, in any application, click somewhere on the form (make sure you
get the form and not an object on the form) and press F1. The Microsoft
Document Explorer launches with the Form object documentation loaded.

The Document Explorer has a sophisticated set of tools, mostly represented
in the Document Explorer toolbar, shown in Figure 2-13. The tools you find
there give you various ways to access the documentation, as follows:

v The toolbar’s first section has navigation buttons, a refresh button, and
font size maintenance.

v The How Do I button has preset questions that relate to the selected
topic, and may help with general queries about certain types of develop-
ment; if you are stuck, give it a try.

v Clicking the Search button allows for phrase searching. The Index button
and Contents button allow browsing through the index or TOC (table of
contents) of the documentation. You can save favorites in the Help
Favorites just like you can in Internet Explorer. The double arrow is
handy — it synchronizes the Contents panel with the page you are cur-
rently viewing.

v The Ask a Question button takes you directly to the NNTP Newsgroups
(using a Web-based viewer) hosted by Microsoft, where you can ask
questions and have them answered by Microsoft MVPs, authors, and
other experts. If you aren’t participating in the user community, please
do so — see Part V for more information.

You have all these options, and they’re only one part of the documentation in
Visual Studio. The IntelliSense shows information from the user documenta-
tion when you pause the mouse cursor over a piece of code. The Properties
window shows the documentation for a property when it is selected.
Everywhere you look, Help is there!

And don’t overlook the online tools provided by Microsoft. Choose Help=>
Technical Support to access a wealth of information available on the Web,
right from inside Visual Studio.

[ ) Back 2 & A | © HowDol ~ 4 Search | 3 Index &3 Contents [.i]Help Favorites __‘j | #J Ask a Question '!.:_] A i]
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Customizing with Options

|
Figure 2-14:
The
Customize
dialog box.

The options available in Visual Studio are amazing. For starters, as with many
other Windows applications, the toolbars and menus are completely editable.
Choose Tools=>Customize to access the Customize dialog box. Click the
Commands tab to get lists of all commands available in Visual Studio. To add

a button for a command to a toolbar, simply drag a command from the list to
the toolbar.

For instance, as shown in Figure 2-14, | dragged the Build icon to a toolbar so
that I can access it anytime. It is a fantastic feature for designing your own,
custom environment.
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The other significant customization available is available by choosing Toolsw>
Options. The Options dialog box has many options that are in a tree view on
the left-hand side of the dialog box. Well over 100 options screens are avail-
able for editing in such categories as Environment, Source Control, Database
Tools, and Windows Forms Designer.

The General Environment variables in the Options dialog box are shown in
Figure 2-15. I don’t discuss every option available in the Options dialog box
because there are bunches of them, but take ten minutes to look at these
options and see how they can help you develop programs. You might not see
what they all do now, but when you do need them, you will know that they
are there.
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|
Figure 2-15:
The Options
dialog box.
|
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The Reset Window Layout button changes the layout of the windows and
toolboxes and panels to the Microsoft default for your profile. It’s great to use
if you changed everything around as described in the earlier section, “Moving
a Tool Window” section.

Increasing Efficiency with
Third-Party Tools

Visual Studio offers a structure for third-party developers to write piggyback
programs called add-ins. Add-ins give you, the programmer, more flexibility
and functionality in Visual Studio. Most companies actually use Visual Studio
to develop these add-ins. I don’t cover third-party add-ins in this book, but it
makes a great topic for later research.

Microsoft has included a number of add-ins with the Visual Studio 2005 instal-
lation. While Microsoft provides a remarkable tool, it doesn’t provide every-
thing, and instead leans on partners to provide extra functionality in the way
of add-ins.

Take Dotfuscator, for instance. By definition, .NET applications are self-
documenting. Anyone can take an application written in .NET and look at
the basic structure of the code with little effort. With tools available on the
Internet, you can reverse-engineer this code back to Visual Basic. (Bet they
didn’t tell you that in the marketing.) I'm sure you can imagine that this fact
upsets a few people.
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Enter Dotfuscator. This add-in application, which is completely integrated
into Visual Studio, provides the ability to obfuscate compiled .NET applica-
tions, making it very difficult to reverse-engineer the code back to Visual
Basic — thus the product name. To run Dotfuscator, choose Tools=>
Dotfuscator Community Edition, and accept the terms. You then see the
default Dotfuscator window, as shown in Figure 2-16.
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Figure 2-16:
Dotfuscator
Community
Edition.
|

This application allows you to specify a finished project and perform some
magic. Dotfuscator speeds up execution, shrinks the package size, and pro-
tects your intellectual property. In my opinion, Dotfuscator was a good
choice for Microsoft to include with Visual Studio, and it shows the power of
third-party add-ins.
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In This Chapter
Getting deep in the .NET Framework
Planning your work
Working your plan
Describing software

Before you discover the diversity of all of the projects you can build, the
ease of Visual Basic, and the power of the .NET Framework, you must
know how to design software. By design, | mean planning your work. The clas-
sic comparison is that building software is like building a house. Would you
hire a contractor who was going to build your house without blueprints? Of
course not. Likewise, you shouldn’t expect to be able to write software with-
out designs.

In this one and only design chapter, | show how the .NET Framework makes it
easy for you to figure out how to build software right from the start. I also
show you the structure of the .NET Framework and how it works with Visual
Basic and Visual Studio.

Next, you discover the foundation upon which the .NET Framework is built.
[ explain the abstract concepts that make the .NET Framework so easy to use
and some concrete examples of how it is used.

Planning for building software is also covered in this chapter. Believe it or
not, there are accepted, structured ways to design software. Following this
structure is a great way to get your design plans on paper. In this chapter,
[ discuss how to design the software that you build in Part II.

Finally, I cover how to describe software from the perspectives of reading and
writing the designs. When you finish reading this chapter, you can plan an
actual software project.
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Making Software Simple Using
the .NET Framework

|
Figure 3-1:
The
structure

of an
application.
|

.NET as a concept is a library of connected software developed by Microsoft
that connects people and the systems and devices they use with the informa-
tion that they need. The .NET Framework is the development environment
that makes it all happen from the Visual Basic perspective.

Visual Basic is just a piece of the .NET Framework. As shown in Figure 3-1,
Visual Basic is only used to write the client, server, and connectivity software
that makes it all happen.
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Well-designed applications include the following layers:

v Clients in the .NET world include devices like cell phones and PDAs, PCs
running Windows, or a Web browser on any operating system.

v Servers in .NET usually running Windows Server and SQL Server. The
server platform is much less flexible than the client platform in the .NET
world. There are other options too, such as the Oracle database.
Sometimes, servers like BizTalk or SharePoint Services are used.
Generally, servers provide services. Makes sense!

v In the middle are XML Web services or other connectivity. XML Web ser-
vices represent a cross-platform strategy to get information from servers
to clients, clients to other clients, or even among the services themselves.

The developer tools represented in Figure 3-1 are Visual Basic and Visual
Studio. Visual Basic is the language, and Visual Studio is the tool. The third
piece of the puzzle is the plan — the project type. The plan is the focus of
this chapter.

At the top of Figure 3-2, you can see all of the structures that make up the
developer tools represented in Figure 3-1. The focus of this book, VB (Visual
Basic) is way up in the upper-left corner.

How VB interacts with the other parts of the diagram is very important,

too — that’s what your software does. Your program will use the services
provided by the .NET Framework via the tools in the language. This interac-
tion is the key to everything — it is where you need to focus your planning.
How do you take advantage of the interaction of the framework’s pieces?
That’s what you design for.

Before you get to the plan, you need to know what the .NET Framework can
do for you as a part of Visual Basic. One of the hardest parts of planning soft-
ware is knowing what your program needs to do, and what is done for you by
the services in the .NET Framework. In the next few sections, I explain what
the .NET Framework can do for you.

Getting to the operating system

The primary function of the core of the .NET Framework is the Base Class
Library (BCL), which provides access to the functions of the operating
system and services like graphics and databases. A lot of auxiliary pieces of
the framework cover other things, but getting to the operating system is the
big sell for Visual Basic. Why? Visual Basic programmers used to have to
jump through hoops to get to these services.

b5
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|
Figure 3-2:
The .NET
Framework.
|
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The path to the Windows operating system from Visual Basic is long and
winding. The My object is the shortcut to that path. It is also a fantastic exam-
ple of how the .NET Framework can help you, the VB programmer, get the job
done.

The My object gives you access to the computer through the eyes of the oper-
ating system. The My . Computer object allows your program to easily interact
with all the computer parts, such as

v Keyboard and mouse

v Printers

v Audio and video

v Clipboard

v Clock

v File system
Some of the common tasks that can be performed easily with the My object
include:

v Uploading and downloading a file

v Read from, write to, and clear the clipboard

v Control the computer’s connection to the Internet.

These tasks are fairly difficult in most business languages, but are made
easier in Visual Basic 2005 using the .NET Framework.
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Furthermore, you find two more primary objects in the My collection. The

My .Application object helps your programs learn about the environment in
which they are running. The My . User object helps you gather information
about the user who'’s logged in to the computer, such as his or her name and
e-mail address.

Look for the My Object icon throughout the book for tips on making your
development easier with the My Object.

Integrating servers and services

In Figure 3-2, four boxes are in the middle section — two are user-interface
oriented, and two are service oriented. ASP.NET and Windows Forms are user
interface oriented, and [ cover those next, in the “Interacting with the user”
section. ADO.NET and other components in the BCL are important, in part
because they help you to integrate servers like databases and services like
BizTalk.

ADO.NET covers the primary server that you will want to integrate — a data
server. Databases, like Microsoft SQL Server 2005, represent the most common
kind of interaction for Visual Basic programs. Business programs tend to need
to get information from user to user, and that information is often stored in
databases.

ADO.NET allows you to take data from the database, show it to users, accept
their manipulation of that data, and update the database without a lot of
wiring code. By that, | mean you can concern yourself with building the busi-
ness logic of your application, and not with how the database connection
itself works. I cover database connections and ADO.NET in Chapter 15.

There are more types of servers than database servers. Enabling you to con-
nect to those servers without writing piping code is part of the job of the
Base Class Libraries. Aside from the wiring that the BCL gives to your appli-
cations by helping with internal wiring of applications, within also reside a
host of services that are accessible easily thanks to the BCL's power:

v~ Enterprise Services: Tools needed by very large applications, like trans-
actions and activation, provided by the Component Service.

v Input Output (I0): Access to the file system, drives, and storage on
servers of various operating systems. I cover IO in Chapter 16.

b7
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v Messaging: Use of the Queuing service in Windows. (Not instant messag-
ing [ should add — that is different!) This kind of messaging is used
by applications to get messages back and forth about data and user
interaction.

1 Management: Access to the Windows Management Instrumentation ser-
vices, which give you an idea of the health of the server.

v Net: The network and Internet. All Web sites and e-mail servers are
accessible thanks to the Net collection in the BCL. I cover Net in
Chapter 17.

1 Drawing: Making decent art is tough, and the BCL gives you that power
by simplifying the set of Windows graphics tools known as GDI+. I cover
drawing in Chapter 18.

Interacting with the user

The other two boxes in the middle section in Figure 3-2 are ASP.NET and
Windows Forms. ASP.NET and Windows Forms help you the most of any of
these by enabling interaction with the user.

[ mention previously that there are three parts of development with Visual
Basic. The first is the language, Visual Basic itself. The second is the tool
Visual Studio 2005, which I discuss in Chapter 2.

The third and final piece to this puzzle is the project type or platform, and
that is controlled by the ASP.NET or Windows Forms. ASP.NET has all of the
bits for Web pages, mobile Web, and XML Web services. Windows Forms has
all of the bits for Windows applications, console applications, and smart
device applications.

For more information on interacting with the user, see Chapters 4 and 5.

Comparing Abstract Concepts
with the Real World

You spend a tremendous amount of your time reading about abstract and
concrete concepts when working in .NET. Though it isn’t as common in this
book, when you search for articles or documentation on the Web, you’ll read
a lot about classes and objects.
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Classes

Classes are a philosophical construct. They are vessels that can be filled with
things. They are frameworks, skeletons awaiting their flesh. They are a series
of pots with dirt, waiting for plants. They are conceptual, not concrete.

A class is a definition of a thing, with a list of what can be done to it, what is
known about it, and what it can do. Without being “instantiated” into an
“instance of the class,” a class is just a series of holding pens for animals that
aren’t there.

Objects

Objects are concrete items that exist in your application. They are what
classes become when they grow up. When you instantiate a class, the class
goes and gets dressed, and it becomes an object.

When you define something in an application, you are making a class. “A
House has a Color and a FrontDoor” would be an example of a class. It is
just the definition. An instance of the House class would occur when you
instantiate that class and it fills with data, and becomes your house, the
MyHouse object. You can build as many houses as you want from the blue-
print that is the class, because each one has its own space in memory where
it stores its own information, called its state.

I cover developing classes in Chapter 6, but classes and objects are dis-
cussed throughout the book and throughout the language. Everything in .NET
is an object, fleshed out by the existence of the application itself. When
Microsoft developed the objects, though, they were just classes!

Planning for a Project Using
the Project Lifecycle

Preparation to create a new project consists of two distinct stages, planning
and design. Planning consists of defining the project and gathering the
requirements. Design consists of writing down the screens and logic that will
fulfill the requirements, and figuring out how to test to see if they are right.
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|
Figure 3-3:
Project
lifecycle.
|
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Rather than just write about how to follow this prescription, I walk you
through the planning and design of a project that you build in Part II. The
sample project is a program that calculates dates. What the Date Calculator
program does and how it works are things that you figure out as part of the
project development lifecycle.

The project lifecycle is a process that is best shown on the Gantt Chart in
Figure 3-3.

=
Requirements ™
=
Code ~
=N

Deploy

Projects should be completed using this process. If you have been coding in
Visual Basic for a while, you might have noticed that a lot of programmers of
other languages are sometimes disdainful of Visual Basic. Part of the reason
is that it is so very easy to write programs without any planning with Visual
Basic. Doing so is not a good thing.

[ should tell you that this project lifecycle is just one of many design processes.
You may hear a lot of industry terms thrown around, and these terms repre-
sent various angles on the same basic paradigm. Just remember that no
matter what you call your development process, planning and design are
good things.

In order to write a decent application, you must first have a plan. Even though
steps may overlap, each step should be completed. Even in small projects, an
hour spent in design is worth the time. The bugs that you discover while
planning are about ten times cheaper in terms of time than the bugs you find
and squash in development and testing.
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As you're going through the steps in the project development lifecycle (refer
to Figure 3-3), you'll find that the first three steps raise questions that you
need to answer in order to figure out the requirements of your project. When
planning the application that you are creating in Part II, the questions might
look something like this:

v Scope: Does the date calculator need any other calculation capabilities?
What platform is it for? Does it need to be international?

1 Requirements: Exactly what is the program calculating? How will the
user enter dates? What results does the user expect?

v Design: How will the program calculate the dates? What user interface
elements will best show the data? What will trigger the application to
calculate? How will the screen look?

Scoping out the system

Scope is the most important part of the design process because it defines
exactly what the application will do. If someone asks you what your applica-
tion does, you should be able to tell him or her while standing on one foot.
Maybe more importantly, the scope defines what your application won’t do.
The term “out of scope” refers to this.

Try writing the definition of the application in 101 words or less. Doing so
enables you to keep the scope short because you are thinking about the
meaning of every word.

For the Date Calculator, a 101 word scope might be a little much, because the
system is fairly simple. Bullet lists are convenient ways to write scopes:

v The Date Calculator is an application that finds differences between two
U.S. dates.

v It runs on a Web page or Windows computer, or as a function in any kind
of application.

This scope defines the application. When a user says that he or she expects
that the Date Calculator would add two numbers because it is a calculator,
you can reply that the feature was out of scope. If this is an expected require-
ment, then the scope must be altered, which takes you back to the drawing
board in the planning stages.
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Gathering requirements

Requirements are the specific rules that govern the application. Think of
requirements as the problems that must be solved in the design step of the
project lifecycle. For the Date Calculator, these problems are fairly straight-
forward:

v The Date Calculator accepts a U.S. date startDate and an integer span,
and returns the date endDate that is span number of days from
startDate.

v The Date Calculator also may accept two U.S. dates startDate and
endDate and returns the number of days between the two dates as an
integer span.

v The Date Calculator must be able to be implemented as
¢ A Windows application, as an executable file
¢ A Web application, run in a client/server environment
¢ A reusable component in Windows
e An XML Web service

v If possible, the previous five calculations will be stored by the applica-
tion and saved from use to use.

“If possible” requirements are surprisingly common. Basically, they consist of
features that may or may not fit into the budget. Leave those for last.

[ have collected all of the information that [ need to describe the functionality
of the application. This information should be placed in a document, appro-
priately enough called a requirements document. This document can be a
Word file, a text file, a piece of notebook paper, or a cocktail napkin. Creating
and using a requirements document helps ensure that the finished applica-
tion does what it is supposed to do.

Each of the points of the requirements document must be covered by a point
in the next stage, the design document. You may want to number the points
in your requirements document and in your design document to ensure that
each requirement has a related design.

When the requirements are settled, it is time to describe the software from a
technical perspective; the end of the design phase. In the following section,
I cover the steps: drawing screens and defining logic.
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Designing the Date Calculator

The steps at the bottom of the project development lifecycle chart are more
technical topics. The design, code, test, and deploy steps are usually handled
by the developers, rather than the business analysts in a large development
shop. If you are working alone, you get to do it all!

You should describe software carefully and thoroughly, so that you could
hand the document to an intern to code. For the Date Calculator, you need to
look at three primary points. Dividing the effort into these logical sections
makes your life easiest when building most software:

v Design your data.

v Draw your user interface.

v Diagram the connections between the business layer and the data layer.

Storing data

The Date Calculator stores the information that it collects and calculates. If
you carefully read the requirements given in the “Gathering requirements”
section, you will note that there are only three values:

v The first date, startDate

v The second date, endDate

v The number of days between the startDate and endDate, span
You may also want to consider storing the following data:

v The date that the calculation was last run
v The user who last ran the Date Calculator program

1 Some way to refer to the search

You can store these in one data entity, which you can call calculations.
Usually, these are described using a grid that looks like Figure 3-4. This dia-
gram is an Entity Relationship (ER) diagram because, if there were more than
one entity, the relationships would appear as lines between the grids.
Databases are commonly shown in this way.

53



Part I: Getting to Know .NET Using VB

Understanding n-tier design

An n-tier system is one that has the presenta-
tion layer, business logic, and data access phys-
ically running on different platforms, with at
least one single layer divided amongst those
platforms. Web applications are perfect for n-
tier architecture, because the presentation
layer is divided between the Web browser and
Web server, and the business and data compo-
nents can be divided — much like a client/
server application — among an Object Request
Broker and a Database Management System.

When designing a large system, | like to define
the database first, known as the Data Layer.
Then | usually build the User Interface, or

the Presentation Layer. Finally, | tie the two
together, using the Business Logic Layer.

The benefit to an n-tier system is twofold. The
modularity of a good n-tier design allows for the
removal or replacement of a particular compo-
nent without affecting the functionality of the
rest of the application. Also, separation of the
business logic from the database allows for
load balancing, security, and general stability in
highly available systems. The bottom line is that
n-tier transactional systems are replacing the
reams of COBOL code that run the world econ-
omy. If you want to have an impact, you need to
understand n-tier systems.

Calculations
— .
Figure 3-4: PK | Calculationld
The Entity StartDate
Relationship Span
diagram for EndDate
calculations. DateRan
User
|

By using the ER diagram, you can see the type of information that your appli-
cation will be handling — a very useful endeavor. Three of these pieces of
information, or fields, represent user information, and three of them repre-
sent system information. In the following section, I show you how to design a
screen mockup that uses these fields appropriately.

Designing screens

Referring back to the “Gathering requirements” section, you can see that this
application must be a multiplatform application. Of the four platforms that
you need to develop, only two of them (Windows and Web Forms) have user
interfaces, and they are pretty similar. You should be able to use the same
user interface design for the both of them.
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Figure 3-5:
The Date
Calculator
initial user
interface
design.
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Based on the requirements and the data design, you need to create three
user-identifiable field controls and some way to submit the information to the
system. Then you need to create some type of control to handle the “last
five” feature.

My recommendation is to start with the field input and output. You will need
three implementations of the fields. The simplest way to gather the user’s
input is to just use three text entry boxes for this, and label each text box
appropriately.

This is where the user interaction parts of the Base Class Library come in. If
you do a little digging in the documentation, you’ll discover that both the
ASP.NET and Windows Forms boxes hold a control that allows the user to
pick a date from a calendar. This is where knowledge of what the system can
do for you comes in handy. Many developers might build their own date
chooser, not knowing that there was already one available.

So knowing that, you need to use two date choosers, one text input box, and
a button the user can click to have the program perform the calculation to
determine the number of days between the two dates. The mockup of these
components looks something like the window shown in Figure 3-5.

Span
Start Date End Date

Go get that date!l! |

At this point, you might not know yet exactly how the calendars will work, so
you can’t create an accurate picture. But that’s okay. You know what the cal-
endars are going to do — let the user pick a date.

User interface design is sometimes a matter of experience. I can see that this
design will work in both the Web and Windows worlds. That is not obvious to
everyone. If you are not familiar with Web design and have an ASP.NET require-
ment, get a Web developer to help. Nothing is harder than trying to write a
Windows application using the Web as a platform.
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|
Figure 3-6:
The finished
Date
Calculator
mock up.

The second major requirement is the ability to save the last five searches.

For example, you might chose to show this requirement in the design as an
expandable grid that appears to show the user what searches had been saved.
This breaks into both ADO.NET and the user interface controls. In ADO.NET,
you can collect the last five searches for this user by asking the database for
them, and both Windows and Web Forms have a Data Grid viewer.

Therefore, you need a grid that will show the user the starting date, ending
date, span, and date searched, and that will allow the user to click on a saved
search and view it. This grid can just be added to the bottom of the screen,
as shown in Figure 3-6.

- Span
Start Date End Date

Ga get that datell! |

Save this search |

StartDate [ Span | EndDale [ When searched |
AIBET 1 AIBET 7472004

You use software, and you know what interfaces you like and don’t like. Strive
to design interfaces that you would like to use. Take popular software, such
as Windows, Office, Quicken, and the like, and design your own apps that
way. Remember, as proven several years ago, you can’t patent look and feel!

Defining logic

So now you know what the software is storing and how it will look to the user.
The last step is to connect the user interface and the data together. This is
usually called the Business Logic Layer, and sometimes is separated from the
rest of the application and put on a totally different machine.

You will find that in the world of Windows development, it is best to just
figure out everything that a user can do on the application, and then write
pseudocode that describes that functionality.
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Pseudocode is language-neutral instructions that describe functionality. Think
of it as writing your program’s code in English. The goal is to create a line-by-
line description of what a given user interaction is supposed to do, so that if
someone else happens to code it, or figure it out after you are gone, that
person can see what you wanted to accomplish. Most methodologies call
these use cases, user stories, or scenarios.

There are a limited number of user actions in this application, and a limited
number of things the application can do. Here is a breakdown, and what your
design would look like:

v~ Application load:

¢ Set the startDate and endDate equal to the current date and
leave span empty.

e The assumption is that the user wants to search for the numbers
of days between two given dates.

¢ Load up the Saved Search grid from the data source, listing them in
inverse order of date and time saved.

v When the user clicks the Go Get That Date button:

¢ If there is a value in the startDate and span fields, add the span
number of days to the startDate and display the calculated date
in the endDate field.

e If there is a value in startDate and endDate, put the difference in
days between the two dates in the span field.

¢ If there is a value in all three, assume that the user wants to calcu-
late the span.

\NG/
Vg‘\\

Assumptions kill software projects. Never make an assumption in the
design, like I just did. Always ask the user what he or she wants. I just
made this assumption for the sake of simplifying the example.

v Save this search:

e Add the startDate, endDate, span, current date and time, and the
current user to the data storage fields.

¢ Refresh the grid with the new search, keeping the newest search
on the top.

1 When the user clicks a search in the grid:
¢ Load up the startDate, endDate, and span values into the fields.

¢ Replace the current values in the startDate, endDate, and span
fields with the values from the search.

e Everything else remains the same!
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That should about cover the functionality that the user expects from the
application, and it meets all of the requirements. The system is designed!

Writing a test plan

Before you start coding, write a test plan. It is simple and will make sure you
have hit all of the important parts of your design. The steps are simple:

1. Review the requirement that a particular design point supports.

For instance, the Date Calculator application has the requirement that
the user can enter a starting date, ending date, and a span.

2. List the design point in question.

The Date Calculator interface must have controls that accept data entry
from the user.

3. Describe what will be needed to make sure the design point works.

You make sure that the user enters dates by focusing the entry using a
Calendar control. And what about the span? It needs to be an integer!

4. Describe what could happen to make the design point break or cause
an error.

One question you need to ask in the test plan is “What happens if the
user puts a non-integer in the span field?” Of course, under normal cir-
cumstances, such an entry will cause an error of some kind.

You might need to alter your design to make sure that the user can enter only
a number. [s there a text box that allows that? If you do a quick Google
search, you find that such a text box exists for Windows, but not for the Web.
For more in-depth information about how Visual Basic can help you validate
user input, see Chapters 4 and 5.

Just make sure to have a written test plan that you can give to a third party
to make sure that your application does what you expect. It is best for you
not to test your own application. You should either have another person
work through the plan, or use an automated test system like NUnit or
Microsoft Team System.

Sticking to the plan

Now that you've created the plan, the trick is to follow it. The following point-
ers may help you stick to the plan:
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v Don’t reinvent the wheel. Look for solutions in similar applications or
sample applications before you rewrite something.

v Research and read the documentation. Don’t be a power user, an “I'll
figure it out myself” kind of person. The .NET Framework is just too big.
Learn how to use the docs — I discuss them in Chapter 2.

v Code the way you want to see the application look. Don’t give up. If
you think you should be able to do something, keep digging until you
see how it is done. If it isn’t worth it, then you can redesign it.

v Write less code. Use the user interface tools that Visual Studio gives

you. Don’t give in to the code snobs who think you should hand-code
everything.

v~ Be consistent. Use the same names as you did in your design. Decide
what to call concepts. Don’t use x to refer to a number.
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In this part . . .

USual Basic is about writing software, and in Part II,
you write programs for Windows and the Web. You
start by creating a traditional Windows application, and
you also build class libraries to go with it. Then you build
a Web application and XML Web services.




Chapter 4
Building Windows Applications

In This Chapter

Experiencing the power of Visual Studio to build Windows applications

Creating your first Windows application
Empowering your application with code
Looking at Windows Forms in more depth

Building a Windows Forms project with Visual Basic2005 is a great way to
start working with the language. You are familiar with Windows applica-
tions, such as Microsoft Word, which I'm using to write this book. When you
are done reading this chapter, you might check your e-mail with Outlook
Express or Groupwise. Every program that is used on a Microsoft Windows
computer is a Windows application by definition, but they are not all devel-
oped by Microsoft. Some are developed by programmers using a tool such as
Visual Studio 2005, using a language like Visual Basic 2005.

In this chapter, [ take a look back at how the language has changed since
Visual Basic 6.0. Then I cover the building blocks of Windows Forms — the
collection of Windows Controls provided with the language. You also find
out how to build your first application — the Date Calculator you design in
Chapter 3. Finally, I go over adding the features your users will expect to find
to your Windows Forms applications — features such as text entry, menus,
status bars, and ToolTips.

A OQuick Look Back at Visual Basic

When you think about Visual Basic, you probably also think about Microsoft
Windows applications. For 15 years, developers have used the Visual Basic
program’s Ruby Forms engine (shown in Figure 4-1) to write common busi-
ness applications. When a program was defined as a VB program, it was, by
default, a Windows application.
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Figure 4-1:
The Ruby
Forms
Engine

in Visual
Basic 6.0.
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But the scope and versatility of Visual Basic grew with the introduction of
Visual Basic.NET. (Refer to Chapter 1 for in-depth information about this
transformation.) Visual Basic.NET is a language, just like Java, COBOL, or
C++, that you can use to write any kind of application that is supported by an
API (Application Programming Interface). Now when a program is defined as
a Visual Basic program, you must ask, “What kind of program? Is it a Windows
application? A Web site? A Windows service or XML Web Service?”

The Windows application — now called a Windows Forms application — is
far from dead. Although Web applications are clearly growing in popularity,
the rich environment of a Windows application is not only familiar but also
hard to beat for many uses. In this chapter, you discover how to use the still-
powerful tool, Visual Studio, to build a Windows Forms application. Specifically,
I show you the kinds of elements that Microsoft provides, how to structure a
Windows Forms application in VB 2005, and details beneath the surface of
Windows Forms.

Windows Forms has many more features than I can cover here in this one
chapter. Over 60 Windows Forms controls are built into Visual Studio 2005,
and you can also very simply create your own. Visual Basic is a powerful lan-
guage in its own right, and combining it with the controls you find in Windows
Forms brings almost complete control over the user experience.
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Discovering Windows Controls

|
Figure 4-2:
The Date
Calculator
asa
Windows
application.

Over the years, a standard way to build Windows applications has developed
because users expect applications to work in a certain way. Menus, toolbars,
status bars, and cursors have all become standard equipment. As shown in
Figure 4-2, the calculator has a title bar, text boxes, and a button, as well as
text on the screen. All of these standard Windows interfaces are developed
using controls provided to you by the Toolbox in Visual Studio 2005.

a! Date Calculator = IE

]

B 9/20/2005 45417 P4

WWednesday, September 14, 2005 | v

To make using standard Windows features easier, Visual Studio includes all of
them as standard equipment for the developer, too. These pieces of standard
equipment are called controls. Controls are preprogrammed pieces of user
interface code that handle a lot of the plumbing for you, the Visual Basic pro-
grammer. You can use them in your Windows Forms application to provide
the features your users want.

The word control is generic and often overused — even by Microsoft.
Generally, though, I use this term to refer to the code that makes a feature
you recognize (such as a text box or a button) work the way you expect.

Using controls is easy. In the following sections, you find out how to do the
following:

v~ Position a control by dragging it from the Toolbox onto the form.

v Write code for a control by double-clicking it in the form, which takes
you into Code View.

v~ Change the properties of a control by clicking it and changing values in
the Properties window. For more details on changing properties of a con-
trol, see the section “Adding Features to Windows Forms.”
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The power of using Visual Basic.NET to build Windows Forms is in the con-
trols. Table 4-1 shows you some common form controls and their uses.

Table 4-1 Some Form Controls

The Controls Toolbox Icon  Uses

Label Displays text on the screen thatisn’t

A editable by the user.

TextBox Accepts basic text input from the user.

abl

RichTextBox E= Offers word processing types of function-

7 | ality such as bold and italics.

Button Causes the application to perform a pre-

defined task.

DataGridview ] Displays an editable table on a form.

DateTimePicker = Allows the user to select a date from a
calendar.

TabControl Provides user interface navigation, along
with other tools such as buttons and tree
views.

MenuStrip = Displays a menu bar, as you would find in

= Word or Outlook.

ToolStrip — Offers Office-type toolbar functionality,

sl including open/save and cut/copy/paste.

PrintDialog _é Gives users easy access to printing.

ErrorProvider : I Communicates input problems to users.

WebBrowser = Includes a browser right in your

2l application.
DomainUpDown . Allows users to select from a list.
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Making a Windows Application

|
Figure 4-3:
The New
Project
dialog box.
|

A good place to start building an application is with a user input form
(because that’s what a VB programmer does most often), and the following
steps lead you through that process. The example I use is a Date Calculator
that accepts input (a date) from the user and then returns a calculated value
(a future date) based on that input. Follow these steps to make a new
Windows application:

1. Open Visual Studio 2005 and click the New Project button to access
the New Project dialog box.

No matter what kind of VB application you want to make, you begin at
the New Project dialog box, shown in Figure 4-3.
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2. Select Windows as the Visual Basic project type and select the

Windows Application template.

. Enter an appropriate project name in the Name text box and click OK.

[ named my application DateCalcChapter4, because I built a similar
application for Chapters 5, 6, and 7.

Visual Studio generates a new project for you, including a new form
(Forml.vb) and the MyProject folder.

At this point, Visual Studio does a bunch of work for you. Initially, it
seems as though a form (Form1 .vb) and a Project file (MyProject) are
created, but actually much more is accomplished. Visual Studio creates

¢ A References folder to hold parts of the framework that you will
be using for this project.

¢ A bin folder to hold the finished program and any components.
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|
Figure 4-4:
The
MyProject
configu-
ration form.

¢ An obj folder to hold any resources specific to the application.

¢ The MyProject folder to hold configuration files. You can edit this
folder by double-clicking on the folder in the Solution Explorer.
Visual Studio provides you with a tabbed form to use to edit the
various configuration details, as shown in Figure 4-4.
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4. Rename the default form (Form1.vb) by right-clicking on it in the
Solution Explorer and choosing Rename from the context menu.

I named the form DatecCalc in the sample application. In your programs,

name the forms appropriately so that your projects are somewhat self-
documenting.

. Resize the default form by clicking on the handle in the lower-right

corner of the form in the designer and dragging it to a new position.

In this step, design starts to become important. If you don’t know how
many controls are going in the form, you don’t know what size to make
it. Although you can always resize it later, it is much easier to just know

what you plan to put in there! (I cover the design on the Date Calculator
in Chapter 3.)
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6. Drag controls from the Windows Forms toolbar onto the renamed
default form.

You can add controls such as the TextBox or a MenuBar to your forms
by simply dragging them from the Windows Forms Toolbox to the form.
The type, number, and location of the controls you add to your form
define its look and eventual function. When you drag controls to your
form, the controls assume the default properties that Visual Studio sup-
plies. Specifically, the name of the instance of your control is set to the
name given to that type of the control followed by a number. For exam-
ple, Labell for a Label control, or DateTimePickerl for a DateTime
Picker control.

[ used a DateTimePicker control as one of the primary controls on the
form. Adding this control enables users to pick the starting date.

Also, you need to add a Label control to show the results of the opera-
tion. A Label control can be preset now, at design time, and left static.
Or it can be modified by your code, at run time, to the show the results
of an operation.

There are controls, and there are instances of controls. The term control
applies to a DateTimePicker. After you drag a control onto your form,
it becomes an instance of the control, referred to by a reference name.
Default reference names are the type name followed by a number in
sequence.

7. After all the appropriate controls have been added, right-click on
each and press F4 to get the Properties window where you can
change each default name to something memorable.

I name my DateTimePicker control DateChooser and my Label con-
trol Nextieek because that’s what it will show when the user selects a
date.

Leaving your controls’ properties set to the default values (for Name and
Content Text) is a bad idea. If you don’t reset the values to something
more logical, you probably won’t remember what controls you're work-
ing with when you see the default values in Code View.

You can also change the Text value of the form to show something nice
in the title bar of the application. I used Date Calculator.

8. Save the project by clicking the Save button.

At this point, you should have a form that looks about how you want it to look
when it runs. My form in my sample application looks like Figure 4-5. Your
form might look a little different from mine, and that’s OK. Next, you need to
add some business logic to the form, so that it actually does something.
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|
Figure 4-5:
The Date
Calculator
with
controls
added.
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Adding Functionality to a Windows Form
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As with most other Integrated Development Environments (IDEs), Visual
Studio 2005 separates the look of the forms you are creating from the func-
tionality behind them. When you assign the controls a meaningful name, you
give yourself a way to refer to those controls from code. Each control has
predefined functionality that you can access from the code.

You can add VB 2005 code to controls in Code View. You can get to the Code
View window in several ways, but the easiest is to double-click on a control.
Doing so generates an event handler for that control’s default event and
switches the interface to Code View. For example, double-clicking on a com-
mand button takes you to the button’s click event in Code View.

Event handlers are special methods that are run when a particular event
occurs, like a button being clicked or a timer reaching its assigned time.

To get started entering the business logic for the controls on your form,
follow these steps:

1. Double-click a control to create its event handler and go to Code View.

Controls in a Windows application have to do more than look good; they
must also do something in response to user interaction, or an event.
Visual Studio helps you easily add functionality to your controls. When
you double-click a control, Visual Studio does two things: It creates the
definition for the code that runs when the default event occurs — such
as a value changing or a button being clicked — and it adds some linking
code (which you can view in the Windows Form Designer Generated
Code section) that links the event itself with the code that needs to run.
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[ started with the DateTimePicker that | named DateChooser. Double-
clicking this control creates a valueChanged event handler. That is, the
code in the event handler is run when the value in the control is changed
for whatever reason (usually by the user). The subroutine template for
the event handler looks like this:

Public Class DateCalc

Private Sub DateChooser_ValueChanged(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles DateChooser.ValueChanged

End Sub

End Class

2. Add code to the event handler to perform appropriate functions.

All of the magic is based in those few simple words. Aside from the func-
tionality built into the controls themselves, all of the functionality of
every application that you write will be in one event handler or another.

For the Date Calculator, you need a piece of code that will fulfill the
requirement from Chapter 3 — that is, accept the date, add a value, and
then display the result. With the .NET Framework, you can do all of that
with one line of code. Between the line beginning with private and the
line beginning with End, enter the following:

NextWeek.Text = DateChooser.Value.Add(TimeSpan.FromDays (7)) .ToString()
Here’s a breakdown of that line of code:

v On the left of the equal sign is the Text property of the Nextweek
object, which is a Label control. This means that you are setting the
text of a label equal to something.

v On the right side of the equal sign is the DateChooser object. You are
adding something to its value — which would be the date that the user
has set. In this case, you are adding a TimeSpan of seven days and then
converting it to a string.

So the finished code looks something like that in Figure 4-6. Visual Studio
inserts a lot of code for you, and you add the important functional code that
makes everything perform to the functional requirements. Click the Start
button, shown in Figure 4-6, or press the F5 key to run your new application.

/1
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Figure 4-6:
The Code
View, ready
to run the
Date
Calculator.
|
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Pick a date, and the label will change from a blank value to display a date that
is one week from the date you selected. Neat toy, but it doesn’t do too much
for the user. Next, [ show you how to add a few features to the program.

Adding Features to Windows Forms

In order to meet the functional requirements of your applications, you need
features. The more complex the feature request, the more complex the code
has to be. Take the current application, the Date Calculator, for example. All
inputs have to be variable for the calculations to be truly useful. Currently,
only the starting date is variable. You need to change this situation if you
want to add functionality and features.

Managing text input with the TextBox

Clearly, the number of days (now set at seven) that the Date Calculator uses
to calculate the new date should be variable. Follow these steps to accept
input from the user, specifically the period in number of days:

1. Add a TextBox control to the form.

Change the name of the TextBox control to DateNumber using the
Properties window. This text box is the control where the user enters
the number of days to add to the selected date.

2. Align the text box with other objects on the form.

Drag the text box around until the left-hand side aligns with the left side
of the date picker — use the guidelines to help make that alignment, as
shown in Figure 4-7.
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You can also use the Align feature in the Format menu. This feature makes
laying out your forms the way you want them a lot easier by giving you
options such as Align All Controls Center and Even Spacing Between
Controls.

At this point, you should have two tabs at the top of the designer, Date
Calculator.vb [Design] and DateCalculator.vb. The Design tab repre-
sents the form designer, which should be selected now. The other tab repre-
sents the Code View, which you opened before by double-clicking on a control.

You need a default value for the number of days. If the user doesn’t add any-
thing into the text box, you have to be able to have the application set the
interval value to something. For now, define a new variable in the Code View.
Under the Inherits class definition, add a dimension statement like the
following:

Dim DateInterval As Integer = 7

Then replace the body of the bateChooser_valueChanged event handler
with the following:

Private Sub DateChooser_ValueChanged (ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles DateChooser.ValueChanged
If DateNumber.Text.Length > 0 Then
DatelInterval = CInt (DateNumber.Text)
End If
NextWeek.Text =
DateChooser.Value.Add (TimeSpan.FromDays (DateInterval)) .ToString ()

End Sub

/3
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|
Figure 4-8:
The Date
Calculator
so far.

What have you done here? You added a text box that allows a user to over-
ride the default number of days you are calculating from the date in the date
chooser. Click the Start button to enter debug mode again and give it a try.
You see something like the calculator shown in Figure 4-8.
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You now have an application that

v Accepts a starting date from the user or uses a default date.

v Accepts a span (number) of days from the user or uses a default number
of days.

v~ Calculates and displays the date that falls the entered span of days from
the input date.

Next, you just need to add a few of the features that users will expect of a
Windows application, and you’ll just about be done.

Communicating with the user
using the status bar

Now that you have the base functionality of the Date Calculator, you need to
add those features that users expect of a Windows application. Menus, status
bars, and mouseover ToolTips are part of the Windows experience. Visual
Studio 2005 supports all of these and more.

As [ write this chapter using Microsoft Word 2003, there is a fairly complex
status bar at the bottom of the window, shown in Figure 4-9. It shows the cur-
rent page, the section, the line and column, and what features I have active,
such as recording of macros or tracking changes.
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This status bar is another control provided by the team that developed
Visual Studio. Find the statusStrip control in the Toolbox and drag it onto
the Date Calculator form, as shown in Figure 4-10. Rename it to something
like mainStatusStrip and delete the default text.
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The statusStrip is just a container for stuff. You can add stuff to the bar as
needed in StatusBarPanels, which are added from the Properties window,
in the property collection called Panels. There is a shortcut for adding these
properties, in the form of a Smart Tag (refer to Figure 4-10).

Also, note the Edit Items link in the Properties window. Clicking this brings up
the Items Collection Editor dialog box, as shown in Figure 4-11.

75



76

Part II: Building Applications with VB 2005
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The Items Collection Editor dialog box is a tool that becomes very familiar —
it is common throughout Visual Studio as a tool to edit items in collections.
To add an item, click the Add button: The instance will appear to the left,
under the Members drop-down list, and the properties will appear to the
right, in the Properties window.

Go ahead and add two StatusLabels, name them datePanel and userPanel,
and set the text to blank. Click OK to close the Items Collection Editor dialog
box. In order to do something with these new members of your statusBar,
you need to set that text value and other properties programmatically, when
the form loads. You can do that in another event handler, called Form_Load.
To edit the Form_Load event handler, double-click the form.

The Form_Load event handler is one of the first things to run when a new
form is brought onto the screen.

In this type of single-form application, the Form_Load event handler will be
close enough to the first code that runs that all of your setup code should go
here. Because you want to set up the statusBar instance when the form
loads, you add the following code to that event handler:

Private Sub DateCalc_Load(ByVal sender As System.Object,
ByVal e As System.EventArgs)
Handles MyBase.Load
datePanel .Text = System.DateTime.Now.ToShortDateString ()
datePanel .Width = mainStatusBar.wWidth / 2
userPanel .Text = DatelInterval.ToString /()
userPanel .Width = mainStatusStrip.Width / 2
End Sub
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Of controls and values...

Look atthe DateCalc_Load subroutine in this
chapter’s application for a bit, and see if you can
find some higher truths. When you create a
control, it is an instance of an object. The con-
trol knows it can have a text value, and the
control knows where to show the value, but it
doesn't know what that value is until you set it.
You can set the value at design time, (when the
code is written), or you can set it at run time
(meaning when the code is executed). Run-time
versus design-time variables are an important
development consideration, as in the following
examples:

v~ Setting text at design time is handled like |
handled setting the text date interval. You
can set the text in the designer, and then
largely leave it alone. This is great for titles
of forms, labels on radio buttons, and stuff
like that.

v~ Setting run-time text is dependant on more
than your whim as a developer — it is

based on the environment at the time the
program is executed on the user’s machine.
In the example for the status bar, the date
and the current value of the period are set
as the two panels. The date is obviously a
run-time decision because that value
changes day by day. In order to handle run-
time changes, you set the value as | did in
the DateCalc_Load event handler.

But why set form width at run time?
Because the actual size of the form is
another variable that you have little control
over. Various preferences that the user can
set in Windows can control the size of new
forms, such as requiring that they open
maximized. The statusBar itself changes
with the form. The panels, because of their
static nature, do not. Thus, you will need to
calculate the width of the panels when an
application loads, not when you build the
form.

Giving hints with the ToolTip control

The ToolTip control gives you the ability to add a different ToolTip to every
control on a certain page, and control them as a collection. You can assign a
ToolTip object to any set of objects, but each individual object can only be
associated with one Too1Tip object. Note that you can change the individual
ToolTip.

Because you have a ToolTip referenced on the form, you have access to a
ToolTip property in each control on that form. Go ahead and drag a
ToolTip object onto the Date Calculator form, and note that a component
appears in the Component Tray. Click on the component and change the
Name property to primaryToolTips.

Now if you look at the Properties window for, say, the DateNumber text

box, you find a new property, ToolTip on primaryToolTips, as shown in
Figure 4-12. Select the property value and type Enter the number of days
here and then run the program. When you put the mouse pointer over the
text box, the famed ToolTip appears next to the pointer, just like Figure 4-13.

/7



/8

Part II: Building Applications with VB 2005

|
Figure 4-12:
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ToolTips are only one of many ways an application communicates with the
user in real time.

Navigating with the MenuStrip control

Throughout the history of Windows application development software,
nobody has come up with a decent way to deal with the development of
menus. Visual Studio 2005 uses a draggable control as the core visual repre-
sentation of the menu.
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Some controls come with extras

ToolTips and context menus can be dragged
into the designer from the Toolbox, and the
properties can be set in the Properties window
by selecting the objects in the Component Tray.

Take a look at the Tool1Tip object, for exam-
ple. The ToolTip object, as do many unob-
servable objects in the Windows Forms world,
provides additional functionality not usually
available to a given set of controls. Unlike the
Menu object, which specializes in user interac-

tion, or the statusBar object, which special-
izes in user information, the Too1Tip control
gives Windows Form controls extra properties.

Extra properties added to an object? How is that
possible? Polymorphism. Visual Basic.NET is an
object-oriented language, and thus it has to
adhere to four rules — objects must be inheri-
table, extensible, relatable, and polymorphic.
Therefore, you can define an object that rede-
fines the properties of another, if you wish.

Main Menu

Go ahead and drag a MenuStrip control anywhere on the form in Design

View, as shown in Figure 4-14 and rename it to MenuStrip. The form designer

provides you with a Type Here prompt, which brings you to the key part
of developing Windows Forms applications and software with accepted

standards.

Have you noticed that almost every application you run in Windows has a
menu bar that says “File, Edit, View, Insert, Window, Help” or something of

the sort, as shown in Figure 4-15? Nothing forces developers to make such a

menu bar, but they do it because this menu configuration is an accepted

standard.
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Figure 4-15:
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To beef up your main menu according to the accepted standard, follow these
steps:

1. To add a File menu, type File (after adding the Menustrip control), as
shown in Figure 4-14.

A prompt appears to the right of and below the new menu item just
added.

2. To add an Edit menu, click and type to the right of the last menu item
added.

For this example though, just add an Exit option under the File menu.

Notice that the Menustrip object adds a component to the Component
Tray at the bottom of the Design window, as shown in Figure 4-16. To
access properties of the menu instance, you can click on the control
instance, rather than the menus at the top of the form.
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Figure 4-17:
A context
menu.
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3. To add functional code to the menu, just click away from the menu,
then go back and click on the File menu to bring up the Exit item.

A lot of menu items have form-wide functionality, so you will make a lot
of use of the Me object. Me is a useful Visual Basic alias that refers to the
object that is currently the focus of the application. Double-click on that
item, and the already well-named item will create its own event handler.

4. Double-click on the Exit item and add the Me.Close () statement to
the event handler for this item.

This is the code’s way of saying, “Run the close function of the container
object,” in this case, the form, so that it closes the window when the
menu item is selected.

In order to tell the application that the menu you have defined is the menu
you want to use, you need to add another line of text to the page ILoad event
handler. The Menustrip property of the Form object is immediately available
in the code page, so you can make the assignment fairly simple:

Me.MenuStrip = mainMenu

Activating the right-click with the
ContextMenuStrip

Another type of menu is the context menu, which is accessed by right-click-
ing on a control in a running application.

You probably use context menus constantly, without even thinking about it.
Right-clicking on an image in a Web browser allows for printing and saving.
Right-clicking on a scroll bar provides a Page Down and Page Up option. You
can provide this functionality, like I did in the form shown in Figure 4-17, with
the ContextMenuStrip object.

]
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Like ToolTips, context menus are objects in the Component Tray, and they
can be assigned certain properties. Like the MainMenuStrip object, you can
assign a context menu to the ContextMenuStrip property of a form after
using the neat little Menu Builder in the Design View.

Drag a ContextMenuStrip object from the Toolbox into the Component Tray
and change the default name to primaryContextMenu. The ContextMenu
Strip builder will appear in the form designer, and you can build it just as
with the MainMenuStrip. Then, in the code, you can assign the property, just
as with the MainMenuStrip. When you run the form, the MainMenuStrip
appears in the upper-left corner, and the ContextMenuStrip appears when
you right-click on the form or other control. To determine what control gets
what context menu, add a little code to the Load event of the form:

DateNumber .ContextMenuStrip = primaryContextMenu

You can use code like this to predefine a few context menus and assign them to
certain user interface controls based on what options the user needs to see.



Chapter 5
Building Web Applications

In This Chapter
Understanding the inner workings of ASP.NET

Knowing the processes that make Web applications different
Finding out about the tools for Web development
Creating your first Web application

Communicating with the user

Web application programming has changed drastically since its origin in
the '90s. But no matter how much programming characteristics may

have changed, the applications still spring from a single concept: Based on a
request from the Web application, a server passes data to a pre-existing
client (the Web browser), which then renders that data into an interface that
the Web application user sees.

The addition of form elements and Common Gateway Interface (CGI) to the
Web scene in 1993 boosted the Web servers’ capacity to accept input from a
user and return a processed response. Over the next 10 years, everything
changed and remained the same. Currently, Web developers can use hun-
dreds of preprocessing languages on dozens of platforms, but all these tools
essentially use the CGI protocol to get information from the browser to the
server and back again. ASP.NET — part of the .NET Framework — is the
newest rendition of the original CGI protocol.

In this chapter about ASP.NET, I cover the difference between Windows and
Web applications, and I tell you how the .NET Framework provides you with
tools to simplify the difference for you as a developer. I explain how ASP.NET
works and tell you about the problems that being disconnected (that is, not
having a constant connection between the Web browser and the Web server)
causes, specifically with the application issues of State and the reality of the
PostBack.
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You can build your first Web application — a Date Calculator, as designed in
Chapter 3 — using Web tools and view it in a Web browser. And you find out a
little about the immense power of ASP.NET through the details about hyper-
links, images, and the Ht tpRequest object.

Seeing How ASP.NET Works
with Your Web App

ASP.NET is a preprocessor that works with Internet Information Server (IIS)
5.1 or higher to serve HTML to Web browsers. What you must remember —
throughout this description of how ASP.NET works — is that it is essentially
CGI for managing a request from browser to server, and a response from
server to browser. ASP.NET is built into the .NET Framework and is used to
build Web Forms in Visual Studio 2005. For use on the Web, ASP.NET has sev-
eral benefits over Windows Forms:

v~ Clients using the Web Forms application don’t need to have the .NET
Framework installed because information is returned to the browser
making the request as only HTML — and not as some proprietary ASP
format.

v Clients don’t even have to be using Microsoft Windows or Internet
Explorer. You can tell ASP.NET to render HTML that will work in any
contemporary browser.

1 Complex processing or data access happens on the server, which
allows the browser to reside on a simpler workstation.

v Code for an ASP.NET application is stored on the server. Any change
to an application has to be made in only one place.

Of course, ASP.NET has constraints as well:

v The client computer must be able to access the server via a network
connection. This connection can come from a local network behind or
through a firewall.

v The server has little control over the software that the client uses to
view the information. Web Forms designs must remain simpler than
those in Windows Forms so that the majority of users can get a satisfac-
tory viewing experience.

+~ Everything that the client needs to do what it does is sent in clear text
in the form of HTML. The programmer must be very careful how forms
are coded for stability and security reasons.
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Two processes heavily differentiate the handling of Web Forms and Windows
Forms. The first process is PostBack, which is how ASP.NET handles the CGI
transmissions for transfer of information. The second process involves how
ASP.NET manages the State of the application (that is, the way the server
remembers what the client is doing inside your program).

PostBack: Not a returned package

The PostBack — a quasi-automated request from the browser to the server —
is the magic behind the ASP.NET model. The PostBack communication
process is how ASP.NET identifies a request for the same page in order to
handle an in-page request by the user. Every user-initiated event — from
typing in the initial URL, to clicking a button, to even changing a radio button
selection — can cause a PostBack.

Visual Studio 2005 treats PostBacks as Events, just like an Event in a Windows
Forms application. In Chapter 4, you find out about double-clicking a button
to generate event handler code for that button. The process is much the
same for Web Forms. If you are designing a Web Forms application and add a
button, double-clicking that button in the Design View gets you event handler
code, too. Although the coding process is very similar, the code that Visual
Studio writes for you is different, and the amount of control you have is
different.

The programmer really has no control over the way the browser makes
requests to the server. If you have coded Web applications before — using
ASP Classic or another preprocessor — the PostBack code that’s automati-
cally generated will feel very different. If you're coding your first Web applica-
tion, using ASP.NET’s automatic method will seem very easy. Either way, let
Visual Studio do its thing and don’t try to force the program to work the way
you’re used to. Like playing piano with a metronome, the framework that ini-
tially seems like a constraint will actually give you a lot of freedom.

A matter of State

Web applications differ from Windows applications in regard to managing the
State of the application. The State of an application is characterized by what
the application knows about itself at any given moment. For example, if you
set a variable to a value in a Windows Forms application, the variable keeps
that value until the application changes it or is closed (provided that the vari-
able is declared in the program’s Declarations section).
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In a Web Forms application, however, the moment the server finishes render-
ing a page and sends it to the browser, the server promptly forgets any asso-
ciated variable value until a request comes back from the client and the
server looks up the State for that user. The Web Forms application itself has
no State whatsoever unless the programmer specifically stores that variable
somewhere.

Part of the power of ASP.NET is its capacity to save the application State in
the server’s memory until the browser makes another request. At that time, the
server will remember the user session that the browser is referring to in the
request, and it will call up the saved variable values.

ASP.NET saves different elements of your Web application in different ways,
as follows:

v The values in Web Forms controls — such as text boxes and data
grids — are saved automatically unless you specifically ask the values
not to be saved.

v The values of your variables aren’t saved at all unless you explicitly
write code to save them and include it in your Web application.

v Details about the browser making the request are saved every time,
but you have to know where to look for them. (These details are
called server variables, and you can find out more about them in the
documentation — you won’t need them for this chapter.)

PostBack and State management may seem confusing in theory, but they
become much clearer after you see them in action. I show you how these
processes relate to the controls and structures that you use for the develop-
ment of Web Forms applications.

Discovering the Web Controls

ASP.NET is more than just the sum of its form controls, but the controls do
make up a significant part of the total. For example, take a look at Figure 5-1,
where you can see the Date Calculator (the same one you find in Chapter 3)
formatted as a Web application. The controls, like the calendar and the text
box, look much the same as those found in the Windows Forms application
that appears in Chapter 4.



|
Figure 5-1:
The Date
Calculator
asa

Web Forms
application.
|

Chapter 5: Building Web Applications 8 7

#]Untitled Page - Microsoft Internet Explorer E]IE
File Edb  Wiew Favortes  Took  Help o
i Y A ) i
@Eack le] = |, Search
Address | 2] http:flocalhost: 1072/ Chapter %205(Defa Go | Links *

Date Calculator

9/14/2005 12:00:00 AN

July August 2005 September
Sun Mon Tue wed Thu Fri Sat
1 2 2 4 E =3 [}
Z B 2 10 11 12 13
14 15 16 17 18 13 20
21 22 23 24 23 26 27
28 29 20 31 :
l' Buttan
&l & Local intranet

Table 5-1 shows often used Web server controls and their main uses. In addi-
tion to these and other core controls (such as a data grid and a button),
Visual Basic offers a number of other controls that have less obvious visual
impact on a page, but are just as significant in application development.
Table 5-2 contains a list of categories for these less obvious controls.

The goal of the ASP.NET developers was to reduce the amount of code that a
Web developer (like you) must write by a total of 70 percent. And giving you
all these server controls to choose from goes a long way toward reaching

that goal.
Table 5-1 Often Used Web Server Controls
The Controls Toolbox Icon Their Uses
Button Submits a request (thereby causing a
PostBack)
Calendar ] Allows the user to select a date from a
o calendar

(continued)
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Table 5-1 (continued)

The Controls Toolbox Icon  Their Uses

RadioButtonList Offers easy access to a selection list like
':i;::' aDDL

ImageMap = Creates a dynamic version of the HTML
._I.'.d classic

FileUpload it Handles the complexity of the multipart

=] form

Panel Acts as a collation mechanism for other

|:| controls on a page

Table 5-2 Other Server Control Categories

The Control Categories  That Offer

Web Forms Page-level controls, such as the Crystal Report viewer,
or PDF controls

Data Data access providers, such as data sources and grids

Personalization Web Parts, such as Business Intelligence tools, as
developed for SharePoint

Security Login functionality that integrates with other Windows
security controls, for example, NTFS Security

Validation Input validation controls that produce their own client-
side script code

Navigation Prebuilt systems for getting from page to page

HTML Simply prewritten HTML for easy access

Outside the scope of server controls is the Web Forms namespace that is
part of ASP.NET. Because Web application design is so outside the normal
scope of a regular development effort, ASPNET provides a significant number
of classes to assist with the management of the application. For instance, the
concept of PostBack and State described in the previous section provide
some challenges that ASP.NET is well suited to meet because of this added
functionality. Table 5-3 lists some of these namespace classes.
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Table 5-3 Some Classes in the System.Web Namespace

The Classes Their Uses

HttpApplication Defines properties of the entire application

HttpSession Identifies properties of one session within an
application

HttpContext Offers access to the HTTP-specific properties

of a specific request

HttpBrowserCapabilities  Gives accesstothe Server_variables
collection provided by CGI

HttpCookie Reads and saves cookies to a client PC
HttpRequest Grants access to the values sent by a request
HttpResponse Provides access to the values sent to the

clientin a response

HttpUtility Defines generic utilities to encode and
decode HTTP messages

HttpWriter Allows passing values to a Ht tpResponse

Building Your First Web Application

This section takes a look at building the Date Calculator (like the application
appearing in Chapter 3) as a Web application. Essentially, the Web version of
the Date Calculator works much the same way as the Windows Forms version
discussed in Chapter 4. The difference in the Web Forms version is the extra
code required to ensure that the application can forget and re-remember
everything between refreshes of the form. That is, the application must save
State every time the browser calls back to the server on a PostBack request.

Viewing the extras in Web Forms

As with Windows Forms (Chapter 4), you have a selection of views in the
designer window, as shown in Figure 5-2. But unlike the views in Windows
Forms, the Web Forms views have the names Design, Source, and Server.

These views show you the following:
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v Design View: As you may expect from Windows Forms, Design View
shows you Web Forms in What-You-See-Is-What-You-Get (WYSIWYQG)
format.

v Source View: Shows you the display code, which is essentially the HTML
that the browser downloads. The exception to that is the ASP.NET
server controls, which are rendered by IIS before they get to the
browser. For those controls, you see special ASP.NET markup.

v Server View: Shows the Visual Basic 2005 code that is compiled and
saved into a class library for use by the server in processing the incom-
ing browser requests.
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ASP.NET pages that accompany a Web application are actually represented
by two editable files. The .aspx file contains the presentation code, that is,
the HTML, which formats the material that shows up in the user’s Web
browser. The .aspx.vb file, what is called the CodeBehind file, contains the
functional stuff (the Visual Basic code) that the user never sees. You can look
at both files from the designer window, as you do with the Windows Forms.
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Figure 5-3:
The New
Web Site
dialog box.
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Constructing the Web Forms application

Follow these steps to start your Web Forms application and populate it with
the controls you need:

1. Choose FileoNew Web Site from the Visual Studio main menu.

Web Forms are set up a little differently than Windows Forms projects:
They appear as Web sites rather than projects. Visual Studio gives you
a few template options in the New Web Site dialog box, as shown in

Figure 5-3.
Harw Wob Site B>
Ternplated: 3|
Visual Studin installed templates
[MASPNET Web Ste 4 ASPRET Wi Servics Aparsonal Wed She Sarter Kit
% Empty Wsh Ske AMASPRET Crpstal Reperts Web Sie

My Templates

“Hsewch onlne Tamplies..

0 Blark A58 0ET Webh sie

Locatian: Fils System | Efiwebatesinatecalrhapters| | [ Eronse..
Language: Utsual Basic e [.';:

2. Select ASP.NET Web Site from the Visual Studio Installed Templates
list and type a name for the site in the appropriate text box.

In Figure 5-3, notice the Location drop-down list to the left of the file
selection drop-down list. This Location list gives you the choice to pub-
lish to an IIS site or an FTP site. If you use the local File System — which
[ recommend during development — others won’t be able to access the
site until after you publish it using the Copy Web or another deployment
tool. Search MSDN for the term ASP.NET deployment to find out more
about publishing your ASP.NET applications.

I named my Web site DateCalcChapter5, and | recommend saving the
site in the default location. Visual Studio creates a new Web site from the
template with the name you specify. The site includes a default page,
which I left with the name default.aspx. When you run the site from
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Visual Studio for testing, it will run with a special custom Web server. If
you want other users to be able to see the site, you need to copy it to a
regular Web server.

3. Click the Design tab to go to Design View and drag the controls you
need from the Toolbox and onto the form.

Layout in the Web designer is different than in the Windows designer.
Generally speaking, Web pages are laid out relative to the upper-left
corner of the screen. Because you as the developer don’t control the
size of the users’ screen (or the font size, or just about anything), the
design for a Web application has to be a lot more flexible than a
Windows application.

In this example, I start with a Label control. The Label control provides
server-controlled text on a Web page. Unlike with Windows Forms, Web
Forms allow you to type static text directly on a Web page, so you actu-
ally have two different ways to present text to the user.

When you place your first control, two characteristics become obvious
right away:

¢ The object in question aligns itself with the upper-left corner of the
form, no matter where you dragged it.

¢ The properties available when you work with a Web Forms control
are very different from those of a Windows Forms control having
the same name.

4. To add all controls for the Date Calculator application, drag a Label,
Calendar, and Button to your form.

Figure 5-1 shows the placement of these controls in my sample date cal-
culator form.

5. Format the Calendar control by selecting one of the formats and click-
ing OK.

When you drag the Calendar control onto the page, you see another fea-
ture of the SmartTags (which you may have discovered in the Windows
Forms application built in Chapter 4) — the Auto Format dialog box, as
shown in Figure 5-4. The Auto Format dialog box gives you the opportu-
nity to quickly implement one of the predesigned looks for a given con-
trol. For my example, I choose the Professional 1 format from the Select
a Scheme list. Make your choice, and the new design shows up in the
designer.

6. Click to place the cursor in front of the Label control you added at the
upper left, and press Enter twice to add space.

7. Click to place the cursor back at the top of the page and type your
application name.
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In this example, | type Date Calculator to name my Web application.
Highlight the text and use the first drop-down list in the Text Formatting
toolbar to change the Block Formatting to Heading 1.
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8. Press F4 to open the Properties window; then click each control (the
Label, the Button, and the Calendar) and change the ID property to
usable names.

[ used Nextweek for the Label, SubmitButton for the Button, and
DateChooser for the Calendar.

When you add the Web Forms controls, you have made a good start on your
first Web application.

In Visual Studio, developing Web applications with Web Forms is very differ-
ent from developing Windows applications with Windows Forms. Web devel-
opment adds another layer — ASP.NET — which is a central topic for the first
several pages in this chapter. (But this is a book about Visual Basic, and don’t
worry, this chapter does relate ASP.NET to VB 2005.) If you are completely
new to Web development, and you need to become very good very quickly, I
recommend reading ASPNET 2 For Dummies by Bill Hatfield (Wiley Publishing)
in addition to finishing this chapter.

Viewing the results in Source Uiew

To view your work in Source View and also add some functionality to your
form, try these steps:
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1. Click the Source tab to change to Source View.

You suddenly can see the specific layout of the form in HTML format.
The HTML code for my date calculator application appears in Listing 5-1.

Qg(,N\l?'EI? You can work with (add, delete, change, and so on) your controls in this
> view, or in Design View — although you must know that a mistake in code
in the Source View will cause a problem in Design View. Figure 5-5 shows
the message resulting from an error made in the Source View.

Listing 5-1:  The HTML Code for Default.aspx

<%@ Page Language="VB" AutoEventWireup="false" CodeFile="Default.aspx.vb"
Inherits="_Default" %>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.0org/TR/xhtmll/DTD/xhtmll-transitional.dtd">

<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Untitled Page</title>
</head>
<body>
<form id="forml" runat="server">
<div>
<asp:Label ID="Labell" runat="server" Text="Label"></asp:Label>
<asp:Calendar ID="Calendarl" runat="server" BackColor="White"
BorderColor="White"
BorderWidth="1px" Font-Names="Verdana" Font-Size="9pt"
ForeColor="Black" Height="190px"
NextPrevFormat="FullMonth" Width="350px">
<SelectedDayStyle BackColor="#333399" ForeColor="White" />
<TodayDayStyle BackColor="#CCCCCC" />
<OtherMonthDayStyle ForeColor="#999999" />
<NextPrevStyle Font-Bold="True" Font-Size="8pt" ForeColor="#333333"
VerticalAlign="Bottom" />
<DayHeaderStyle Font-Bold="True" Font-Size="8pt" />
<TitleStyle BackColor="White" BorderColor="Black" BorderWidth="4px"
Font-Bold="True"
Font-Size="12pt" ForeColor="#333399" />
</asp:Calendar>

</div>
<asp:Button ID="Buttonl" runat="server" Text="Button" />
</form>
</body>
</html>
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Generally, I would advise that you focus on being either an HTML editor
or a design editor. If your background is in Web design, use and stick
with the HTML Source View. If most of your experience is in form design-
ers like Visual Basic or Delphi, focus on using the Design View. Switching
between the two is confusing and can cause logistical problems.

2. Click the Design tab to go back to Design View.
3. Double-click the Button control to add a Click event handler.

Visual Studio changes to Server View, where you have the opportunity
to add code to the instance of that click event. The methods, properties,
and events for the Button control here are slightly different from those
of the Windows application Button control because they need to sup-
port the PostBack model of the ASP.NET engine.

For this example, I add code that increments the chosen date by seven
days, as follows:
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|
Figure 5-6:
Setting up
debugging.

Partial Class _Default
Inherits System.Web.UI.Page
Protected Sub SubmitButon Click(ByVal sender As Object, ByVal e As
System.EventArgs) Handles SubmitButton.Click
NextWeek.Text =
DateChooser.SelectedDate.Add (TimeSpan.FromDays (7)) .ToString ()
End Sub
End Class

After you complete these steps, you have the basics of a date calculator
application. When you run the application, you can click a date on the calen-
dar, click the button, cause a PostBack event, and get a refreshed Web page
that displays the date a week hence as your result.

Running your Web application

Generally, Internet Information Server is required for running an ASP.NET
Web application. When you develop the application with Visual Studio, how-
ever, that isn’t the case. The Visual Web Developer (VWD) Web Server is an
integral part of Visual Studio 2005 and makes development on a non-server
platform painless. You can take advantage of the close integration of these
products and test out the Web applications you’re developing on your local
machine. With your application open in Visual Studio, follow these steps to
run it in debug mode:

1. Press F5 or click the Play button on the toolbar to launch the Web
application in debug mode.

Debug mode is not automatically set up on a Web project, so you are ini-
tially prompted to set it up via the Debugging Not Enabled dialog shown
in Figure 5-6.

Debugeing Mot Enabled

The page cannot be run in debug mode because debugging & nok enabled in the Web. corfig fle,
what waould you bke to do?

(3 Madify the \Web.config file bo enable debuoging.

1y Debugang should be difabled in the Web.config Fie befare deploying the
‘Wb site to & productiotgnviranment,

() Run without debugging. (Equivalent bo Chr+FS)

2. Accept the default option — Modify the Web.config File to Enable
Debugging — and click OK.
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VWD Web Server appears in your System Tray as hosting the site on the
local machine with a random port number. See Figure 5-7.

|
Figure 5-7:
pn . i) ASP.NET Development Server
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oh Sorver o o]
Web Server. 18 17
|
And your application runs with your Web page active and visible in the
default Web browser you set up in the Visual Studio options. (See the
Cheat Sheet at the front of this book for information on setting these
options.) Figure 5-8 shows my Date Calculator application open in
Internet Explorer.
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3. Activate your Web application (by clicking a button, typing into a text
box, or otherwise interacting with your program) and watch the
results.

In my application, I click a date (August 31, to be exact), click the
button, and the calendar changes to highlight the date one week out
(September 7), as shown in see Figure 5-9.
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4. Close the Web browser that is running your application.

Visual Studio comes out of debug mode, and the VWD Web server also
closes.

Looking Below the Surface of Web Forms

ASP.NET is a framework within a framework — a comprehensive Web server
management system provided for free as part of the .NET Framework from
Microsoft. ASP.NET is insanely sophisticated and powerful, and it does much
more than I can cover here. But I can help you with an important basic under-
standing of how ASP.NET encapsulates the CGI (Common Gateway Interface)
functionality that has been around for ten years.

Validating user input

User input controls on Web Forms look just like user input controls on
Windows Forms. Text boxes, drop-down lists, check boxes, and the like all
accept user input, and buttons submit that information to the application.
The difference between Web and Windows Forms comes from how the forms
handle user information under the covers.
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From the development perspective, text boxes and other controls work simi-
larly to accept user input. For example, you can get to the value submitted by
the user using the Text property of a text box, or the Selectedvalue prop-
erty of a drop-down list. One development issue that differs significantly
between Web and Windows applications is validation of the user input.
Because (for Web apps) the client is separated from the server, making sure
that the client requests are formatted correctly is something that developers
want to do on the client rather than the server. ASP.NET makes verifying
format simple with the Validation controls available in Visual Studio 2005.

You can find the Visual Studio Validation controls, as shown in Figure 5-10, in
the Toolbox under the (go figure) Validation section. Web application users
may forget to provide all the data your application needs to work correctly;
they also may mistype an entry or enter the wrong type of data (for example,
entering text in a field where you expect numbers). Common reasons that
you want to validate input include the following:

v Confirming that required information meets the rules of the applica-
tion: For instance, checking to make sure a date entered falls after the
current date, if that is what your application requires.

v Verifying the type of data entered: Making sure that a date is formatted
properly, or that a number is entered in a numeric field.

To use Validation controls in your application, simply select the on-screen ele-
ment that requires validating, and drag the control (or controls) onto the page
you're designing. [ include a RequiredFieldvalidator and Vvalidation
Summary on my Date Calculator page. The RequiredFieldvalidator
accepts a control to “watch” as a parameter, and reacts if the requirements
set for that control are not met. The validationSummary sits at the top of
the page and provides one of those nice bulleted lists of problems, without
any code at all!
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Figure 5-11:
My appli-
cation’s
Design View
after putting
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box and
Validation
controls.
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Go ahead and drag a text box onto the page, double-click it, and change the
1D property name to DateSpan. You can use this text box to do the same
thing as the text box in the Windows Forms project (see Chapter 4). In this
text box, the user specifies the number of days out to calculate from the
selected date in the calendar. Figure 5-11 shows how my Web application’s
Design View looks after | added the RequiredFieldvalidator and
ValidationSummary controls (for which I set the ID to DateSpanValidator
and DateSummary). I can set up this validation to look for users to enter a
number and send them warning messages if they don’t.
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You need to do three important things to set up a RequiredFieldvalidator
control. You can do all of these things in the Property panel with the valida-
tor selected in Design View:

1. Type in the Error Message.

This message is what appears in the validationSummary when the
user misses filling in the field. | set my error message to “Date Span is
Required.”

2. Set the Text parameter.

This is what the validator itself shows when it is triggered. I usually use
an asterisk (*).
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3. Set the Control to Validate parameter.

This setting shows the control that the validator is watching. In this
case, the control is the DateSpan text box.

When I run my Date Calculator program and try to change the date without
typing a number into the DateSpan text box, the user input validation that
these steps put in place displays the error message shown in Figure 5-12.

Dealing with State

As I mention in the introduction of this chapter, the State of an application is
described by the current value of controls, variables, and object properties at
any given time. When the server stops processing a page and sends it to the
browser, the server gives up (forgets) almost all the elements that comprise
the State. ASP.NET provides you with a few mechanisms to preserve State in a
Web Forms application. The most useful of these are the viewState and the
Session objects, which I describe in the following sections.

Prompting for required input.
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ViewState

ViewState is a new concept for ASP.NET. In a nutshell, the server packages
up the values of the form controls that were passed to it, compresses them,
and saves them in a hidden form field that is rendered into the info that’s
sent back to the browser. The user doesn’t know (or care) that the variable is
there, but the server sure knows (and cares). This hidden form variable is
passed back to the server when the user causes another PostBack (by asking
for the same page again), and the server can decompress the variable to find
out what values to set when it returns the page to the client.

Knowing the working details is less important than knowing how to use the
ViewState object. In addition to the values of form controls, you can save
non-control variable values to the viewState as well. If your program needs
to remember a variable from PostBack to PostBack, you can do so by saving
and then retrieving the variable to the viewState, as shown by the following
two lines of code:

Me.ViewState ("_NextWeek") = NextWeek.Text

NextWeek.Text = CStr (Me.ViewState ("_NextWeek"))

In these lines, the Me object is just a shortcut that refers to the current
object, which in this case, is the Web page in general. You see this structure
used a lot more in Parts IV and V of this book. The cstr string conversion
appears in this code because when a value comes back from the viewState;
it is just an object type, and your code needs to tell Visual Basic that the type
value is a String. For more on types, see Chapter 9.

Session object

The viewState object is great for saving a variable within a page, but what
happens if you need to save a value across several pages? When a user
changes pages, the viewState object is lost. This situation makes sense if
you think about it since your code refers to the viewState object with Me,
and that Me is the page. If the user moves to a different page, your program
has a different instance of viewState.

So to take care of this problem, enter the Session object. The Session
object represents a particular user using a particular application. While the
Session object has several methods (which you can see if you check out the
IntelliSense), the important method to know helps you save values — just
like you do with viewState object. But with the Session object, these
values stay around until the user stops using the application, even if that use
involves multiple pages.



Chapter 5: Building Web Applications ’ 03

The following two lines of code show that setting and getting variables values
with the Session object is just as easy as using the viewState object:

Session ("_NextWeek") = NextWeek.Text

NextWeek.Text = CStr(Session (" _NextWeek"))

Checking Out Some Cool Web Tricks

|
Figure 5-13:
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caused
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|

The Web has a ton of toys. Because the Web is a disconnected technology,
and many of the toys are cross-platform, they are kind of cool. Some of them
are even expected — more or less — by users, and a few of them are worth

knowing about.

Getting from one page to another

One of the most important capabilities of a Web application is allowing users
to move from one Web page to another. If you are just creating straight navi-
gation, you can use a simple Anchor tag and never even get involved with
Visual Basic. The following line of code shows how an Anchor tag looks in the
Source View, and Figure 5-13 shows how the coded link appears in the
browser.

<A HREF="NextPage.aspx">This goes to the next page</A> and
this does not.

‘A Untitled Page - Microsoft Internet ... !Eu

File Edt Yiow Favortes Too * Links | gF
® * Google- 2

address [&] nttp:fiocalhost: 24555 iDatecao v | [ Go

This goes to the next page and this does not.
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ASP.NET gets involved when you need to set the value of the HREF property
of the Anchor tag in your .vb file (the file that contains your application’s

Visual Basic code). Suppose that you need to pick which page you want the
user to reach during a PostBack. In Visual Basic, you could use a Hyperlink
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Web user control and set the value of the NavigationUrl property in the
CodeBehind as needed. Following is an example of what that code would look
like if you want to set the HREF based on input gathered from the user. In

the case of the Date Calculator application (which you see in the section,
“Building Your First Web Application,” earlier in this chapter), the DateSpan
control (text box) retrieves the number of days to span from the user.

If DateSpan.Text > "7" Then

HyperLinkl.NavigateUrl = "thispage.aspx"
Else

HyperLinkl .NavigateUrl = "thatpage.aspx"
End If

This example shows an If-Then-Else statement used to handle the navigation
decision. (I cover using the If-Then-Else decision statement in Chapter 10.)
You can use this coding technique for site navigation (as depicted) or even
for security. For example, you could look up an ID entered by a user in a data-
base that matches the user ID with a list of Web pages (URLs) that the user is
allowed to access.

Adding pretties

Web sites just aren’t Web sites without images. Like anchors, images can be
handled just with normal HTML, with an image tag that looks like this:

<img src="image.gif" height=100 width=100>

This tag refers to a Web-ready image (usually a GIF, JPEG, or PNG file) that is
in the same directory as the HTML code file referring to it. The path can, of
course, be changed in the src attribute to point to another directory in the
project.

Keep in mind that all paths are relative to the root of the project. If you
always reference the location of images with a complete path from the root of
the project — for example, with src="/images/navigation/image.gif" —
then no matter where your code is used, the browser will be able to find your
image.

Just as the NavigateUrl property of the Hyperlink control changes the HREF
attribute of an Anchor tag that it renders, the TmageUr1 property of the
image object changes the src attribute of the img tag it renders. So, if you
drag an image object to a Web page you're designing and want it to render
the tag as shown in the preceding line of code, you would write the following
to add to the VB CodeBehind file:
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Sub Page_Load(ByVal sender As Object, ByVal e As System.EventArgs) Handles
Me.Load
Imagel.ImageUrl = "imagel.gif"
Imagel.Height = 100
Imagel.Width = 100
End Sub

Getting information about the user

In the earlier section, “Discovering the Web Controls,” | discuss some con-
trols that give server-based Web applications access to the browser environ-
ment. Sometimes browser information is very useful.

Take the security controls, for example. As part of its request to the server,
the browser sends information about the user in the form of an object called
aWindowsIdentity. Remember, because ASP.NET is disconnected, the
server doesn’t know which user is making a request at any given time unless
it checks every request. You can use the Ht tprRequest object passed to your
application from the server to get a windowsIdentity object and then check
the object for user information, including the user name.

The following code is the Source View for a Web Forms page containing a
little text and a label:

<%@ Page Language="VB" AutoEventWireup="false" CompileWith="ThisPage.aspx.vb"
ClassName="ThisPage_aspx" %>
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN"
"http://www.w3.0rg/TR/xhtm111/DTD/xhtml111.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Untitled Page</title>
</head>
<body>
<form id="forml" runat="server">
<div>
The current user is <asp:Label ID=ThisUserNameLabel Runat=server></asp:Label>
</div>
</form>
</body>
</html>

When you double-click on the form in the Design View, you get the
Page.Load event handler (see the following code) where you can add the VB
code that lets your application access Web environment objects. This code
gets a copy of the windowsIdentity object from the Request object and
then gets the Name property from the windowsIdentity.
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Sub Page_Load (ByVal sender As Object, ByVal e As System.EventArgs)
Handles Me.Load

Dim thisUser As System.Security.Principal.WindowsIdentity =
Request .LogonUserIdentity ()

Dim thisUserName As String = thisUser.Name.ToString()

ThisUserNameLabel.Text = thisUserName

End Sub

This method follows the general pattern for getting information out of the
http objects. Generally, such objects return some kind of subobject that you
need to declare in your application. For more information about getting infor-
mation out of objects, check out Chapter 13.

You can use the Request terminology to refer to the current Ht tpRequest
object because it is an artifact from earlier versions of ASP.

Suppose that your application has now received a request from the user,
gotten the Request object fired up, and extracted a copy of its LogonUser
Identity, which is an instance of a WindowsIdentity object. The Logon
UserIdentity object has a Name property, which you have set equal to the
text of a Label Web control (ThisUserNameLabel .Text = thisUserName).
When you create and run this Web Forms application, you see a screen that
(hopefully) has your machine and user name, rather than mine, as shown in
Figure 5-14!
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The HttpRequest object offers a lot more than simply security; it passes infor-
mation about cookies, the Header collection, the client’s PC, and so on. For
more details on what this object provides, you can heed my continued encour-
agement to read ASPNET 2 For Dummies by Bill Hatfield (Wiley Publishing)
and the MSDN documentation.
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Other good Web development things to know

There are more details that you need to know to
effectively write ASP.NET applications. Infor-
mation on HTML, client-side scripting, and
image development come to mind. ASPNET —
a server preprocessing platform — is just one
piece of the whole, and a lot more technologies
and practices go into making a good Web appli-
cation. This chapter gets you started with
ASPNET, and this book deals with the
CodeBehind VB language details you need to
know. But you still have an opportunity to glean
much more information about the workings of
Web applications before you become an expert
Internet application designer. Take a look at the
following:

v Elements of HTML, such as Tables and Lists,
that help you lay out pages.

v~ The impact of image processing — includ-
ing converting files to GIF, PNG or JPEG —
on the usability of the Web page.

v Scripting languages such as JavaScript, to
provide interactive functionality on the
client that isn't otherwise provided by
ASP.NET.

v Configuration and management of a Web
server, specifically Internet Information
Server, to help maintain the environment for
your applications.
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Chapter 6
Building Class Libraries

In This Chapter
Understanding the history of DLLs
Building a class library

Using a class library to isolate the program’s logic

Getting information into and out of objects

WMBER
@%
&

T) say that understanding class libraries is important would be a gross
understatement. (A class library is a collection of reusable code organized
into groups.) The entirety of the .NET Framework is a class library. All of the
groups of controls discussed in Chapters 4 and 5 are class libraries. In fact,
all of Windows is a set of class libraries, even before .NET.

[ cover a lot of details on a very complicated topic in this chapter. [ describe
how to use a class library to encapsulate logic, save on memory usage, and
share code between applications. You should understand the parts of the
class library and the parts of the class itself after reading this chapter.

In this chapter, you build a simple class that handles the logic of the Date
Calculator designed in Chapter 3. The class you build here could be part of a
larger class library (libraries usually have multiple classes) if you made more
classes to group together. I discuss the difference between a class and an
object. Also, I talk about some of the in-depth features of class libraries in
this chapter.

I hope that classes and class libraries will become a significant part of your
development pattern. You can, or course, write perfectly functional software
without creating class libraries, but you really shouldn’t. You should design
your application first so you can decide if your software has no reusable code
or anything that can be componentized, before you dispense with the class
libraries. Even if you just build them into the project and do not create sepa-
rate DLLs, as described in this chapter, you should use class libraries for
code encapsulation. Code encapsulation and reuse (covered in detail in
Chapter 12) makes your code much more maintainable and easy to build
other software with — you can even reuse the same code in Windows and
Web applications this way.
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Past to Present: DLLs Defined

Flash backward to November 1985. Microsoft has just released Windows 1.0,
based on work at Xerox and Apple. At the time, Windows was really just a
monolithic application for MS-DOS 2.0, meaning all of the code for the appli-
cation was compiled into one executable file. When you wanted to use
Windows, you ran the program. When you closed it, you went back to DOS,
and the computer forgot all about it.

|
Figure 6-1:
How
Windows
uses DLLs.
|

Windows 1.0 applications, in sum total, required more memory than the hard-
ware was able to give them. In order to get all of the features in place, stay
within the memory constraints, and give the users a seamless experience,
Microsoft built its software in component pieces. When Windows needed a
particular feature, it loaded only the piece that was needed, as shown in
Figure 6-1. These pieces are called Dynamic Link Libraries, or DLLs.

BuinessDII | PersonQbject |Apg|ication0b'ect |Agp|ication0b'ect ApplicationListObject

T T T T T

1 1 1 1 1 1
] [T ] [T [T [T
1 1 1 1 1 1
: findApplicant() : : : : :
1 1 1 1 1 1
1 1 1 1 1 1

- = = = = = = = — .
: findPerson() : : : :
1
1 [ 1 1 1 1
N - o oo o - ] o __ 1 1 1 1
! 1| Applicant() ! ! ! !
1 1 1 1 1 1
1 1 1 1 1 1
(1 I [ P 1 1 1
! MakeApplication() 1 1 | \
1 Il Il 1 I I
1 1 1 1 1 1
€ - - == - - - - - - - = — = = - Y [ 1 1 1
1 1 1 1| Application() 1 1
1 1 1 1 1 1
1 1 1 1 1 1
1 1 1 If<— - - - - -+ 1 o 1
| | | | 1| addApplication() |,
1 1 1 1 1 1
1 1 1 1 1 1
l€ - - = — — = 4

: addPersoB() : : : :
1 T 1 1 1 1
1 1 1 1 1 1
I €-—-~-~-=-=--- Tf-——~~-~--1 1 1 1 1
1 1 1 1 1 1
1 1 1 1 1 1
1 1 1 1 1 1
1 1 1 1 1 1
1 1 1 1 1 1
1 1 1 1 1 1
| 1 1 1 Lt 1
T 1 1 1 [ 1
I L n L I L
[ [ 1 [

| | ' '



Chapter 6: Building Class Libraries , ’ 1

As it turned out, DLLs are good for more than memory management. They
are good for encapsulation of functionality. Encapsulation is the localization
of knowledge within a module, and it is one of the core tenants of object-
oriented programming, as well as a handy feature to have when writing an
operating system. When you need to upgrade a function, you need to replace
only the DLL, not the whole program. If a particular function needs to be
secure, isolating the DLL helps to secure the function. If you have several pro-
grams that use the same function, they can share a DLL.

A DLL is just a particular kind of class library that’s specific to the Windows
operating system. You can build class libraries for other platforms. When you
build a class library for the Windows platform, the end result is a DLL.

As it turns out, the DLL thing stuck. All of Office, contemporary Windows, the
.NET Framework — more or less everything in the Windows world — is built
using DLLs. DLLs are just the best way to make software for the Windows
platform.

Designing a Library

A class library on a Windows computer is a component of a program and is
implemented as a DLL file, as described in the preceding section. This section
covers how and why to build a class library.

In the .NET world, class libraries are used to encapsulate functionality. For
instance, take the Date Calculator that I discuss in Chapter 3. This application
has some functionality involving adding a number of days to a date. (This
functionality has nothing to do with the user interface, which is covered in
Chapters 4 and 5. No matter what the user interface looks like, the program
changes the date in the same way.)

Ideally, you write the code that makes the program work, or business logic, in
a separate DLL file and include that file by reference in the calculator project.
This separates the logic and the user interface and brings all of the benefits I
talk about in the section, “Past to Present: DLLs Defined.”

That is an example of functionality that can be encapsulated. Though it is
obviously a simple example, a well-structured Windows program — either a
Windows Forms or Web Forms application — should encapsulate this func-
tionality in a class library. An application that uses a class library references
that library as part of the code. It then uses the functions and subroutines of
that class library just as if they are part of the original program.



] 12 Partii: Building Applications with VB 2005

Objects and classes

So you have a class library, and there are classes in it, as one would expect of
a class library. You expect, that because it is a library, that you can check out
the classes within like you check out books from a regular library, and you
can do exactly that. The difference is that when you check out a class from a
class library, you get a copy of the class, so the original class remains in the
library. This copy is called an object, and it is an instance of that class.

Classes are more or less like molds. They have holes to put information.
When you get information together, you can get an instance of the class — an
object — to hold the information. Take the Date Calculator example. You can
define a class, called DateCalcClass, that has two properties and a subrou-
tine. At design time, those properties are empty, and the subroutine is just a
tool. When you instantiate the class in another program, however, it becomes
an active vessel.

The program can put things in the object, because it is a three-dimensional
vessel, whereas the class was only a two-dimensional mold. When the user
sets the initial date — the first property — the subroutine calculate is
called. That sets the second property to the answer, which you can then use
elsewhere in the application. The benefit is that after you are done, you can
remove this logic from the computer memory, and of course if you need the
logic elsewhere in the application, you don’t have to rewrite it, you just add a
call for the class library.

The patrts of a class library

From the development perspective, the class library starts with a file, just
like all of the other projects. In the case of VB 2005, it is a . vB file that con-
tains the following:

1 Classes: The formal description of an object

v Namespaces: An abstract container of classes, as opposed to a class
library, which is a concrete collection of classes

v Functions: A sequence of code that performs a specific task and returns
a specific value

v Subroutines: A sequence of code that performs a specific task
v Properties: The qualities of an object
The structure of a . VB file is shown in Figure 6-2. Contained within the .vB

file are namespaces. Within the namespaces are classes. Finally, within the
classes are functions, subroutines, and properties, among other things.
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Namespace

Property

|
Figure 6-2:
The class
library file
structure.
|

This structure makes a lot of sense when you go to use a class file. For
instance, take the method System.String.ToString (). The namespace is
System, the class is String, and the function is ToString (). The following
code demonstrates this structure:

Namespace System
Class String
Public Function ToString (ByRef inputObject as Object) as String
'Functional code would be in here
'In the end, you would Return a String
End Function
End Class
End Namespace

Inside the class are the code-building parts of the VB 2005 language. Instead
of using them now, however, you are building them:

v Functions return a value. Generally, functions accept input and return
output. The Date Calculator would use a function that accepts a date as
input and returns a date one week into the future as output. Functions
are denoted by the Function keyword.
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v Subroutines don’t return a value. Generally, subroutines modify some-
thing else about the system, such as properties within the class. If you
wrote code to set the value of a label, it would be a subroutine because
it wouldn’t return a value when you called it. Instead, it acts on some-
thing else in the system. Subroutines are denoted by the sub keyword.

1 Properties maintain a value. An instance of a class maintains its own
data in properties. For instance, when you set the value of a label in a
Windows Forms or Web Forms application (as discussed in Chapters 4
and 5), you modify its text property. Properties are denoted by the
Property keyword.

Don’t let me fool you, there is a lot more to a class in any language than func-
tions, subroutines, and properties, but those are enough to get you started.

Coding a class library

The following list describes some of the important things you need to know
about a class library:

v~ Class files are, by nature, code-heavy devices.

v~ Class libraries are designed and built with a language, and they are
meant to be used in a language.

v Class libraries are not generally built using a designer, as are Windows
and Web Forms.

v Class libraries make use of the same .NET Framework tools that
Windows or Web Forms use in the Code View. In fact, the code behind
for Windows or Web Forms is actually a class library.

A class library has three parts that are important to understand right now:
v The class definition: This is where you define one of what might be

many classes in your library.

+ The operation declaration: Here you define something about that class
for later use. These are the functions, subroutines, and properties that |
define in the previous section.

v The functional code: This is the innermost piece of the puzzle, and it
goes inside an operation declaration. Here, you write the code that does
the work.

Listing 6-1 shows the parts of the class.
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Listing 6-1: The Parts of the Class

Class Sample

Public Function SampleFunction(ByVal input as String) as String
'Functional code goes here
'The function returns a string

End Function

Public Sub SampleSub(ByVal input as String)
'Functional code would be in here
'No return value because it is a subroutine
End Sub

Public Property SampleProperty() as String
Get
'Code to get the value goes here
'Returns a string based on property return type
End Get
Set (ByVal value As DateTime)
'Code to set the value goes here
'Uses the value parameter to set the base property
End Set
End Property

End Class

The difficulty in coding class libraries becomes apparent when I say, “That is
all you need to know.” The fact is, nearly anything can go in the functional
code, as long as it doesn’t depend on other code elsewhere in the program.
The procedures can be defined however you wish. The classes can be struc-
tured in practically any way. There is lots of room for doing things poorly,
and the only way to find out how to code class libraries efficiently is to prac-
tice and review code from other programs.

Creating a Class Library

A good place to start when you’re creating a new class library (perhaps your
first) is to write a piece of code that manages the functionality of the Date
Calculator. (See Chapter 3 for more about the Date Calculator.)

Getting started

To get started building a class library, follow these steps.
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1. Open Visual Studio and choose File>New Project.
2. Select VB.NET Class Library from the project templates.

3. Rename the default class file, class1.vb, to something more appro-
priate to your project.

For example, | named the library DateCalcClassChapter6.vb
4. Add appropriate code inside the Class block.

In this case, I added code described in the following section, “Building
the Date Calculator.”

5. Choose Build=>Build Solution to create the DLL file.

The DLL file is the file that you use with the user interface to implement
the code that you write.

The process of building a class library is very simple. Because the majority of
the code is designed to make your program run, you won’t always get a lot of
guidance from Visual Studio. This makes figuring out what goes into the class
library all the more difficult, and puts the burden on you. The only guidance
you have in creating a class library comes from the design of your applica-
tion (see Chapter 3), which points to one reason why design is so important.

Building the Date Calculator

When you have a design, you know what procedures you need to define and
what functions the code needs. If you followed the steps in the preceding sec-
tion, you're looking at a blank class like the following code, one of the scari-
est things in all of Visual Basic programming — or one of the most liberating.

Public Class Classl
End Class

Renaming and adding properties

The first thing you want to do is change the name of the class to
CalcClass2005. You will refer to the class in other programs by this name.

Public Class CalcClass2005

End Class

Then, you need three properties: the start date, the end date, and the span
you want between them. In order to create properties, you need local storage
for the values of the properties, in the form of private variables.
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A private variable is a variable that is defined outside of an operation and that
is available to all of the procedures; they are sometimes called fields. By con-
vention, private variables that provide local storage to properties use the
same name as the property, but started with an underscore character, as
follows:

Private _startDate As DateTime
Private _endDate As DateTime
Private _span As Integer

Next, you need the properties themselves. Start by typing Public Property
StartDate as Datet between the lines of the class declaration, and the
IntelliSense feature pops up with DateTime selected. Press the Tab key to
complete the statement.

Then press Enter to finish the line, and enjoy one of the nicest, simplest fea-
tures of class library development with Visual Studio. The code template for
the property is completed for you by Visual Studio, as follows:

Public Property StartDate() As DateTime
Get

End Get
Set (ByVal value As DateTime)

End Set
End Property

This feels a little more like Visual Basic. All you have to do is finish up the
code. Visual Studio built two little mini-procedures for you, which are prede-
fined parts of a property — Get and set. They work exactly as expected: Get
has the code that gets the value of the property, and set has the code that
sets the value of the property. The finished property declaration looks like
the following:

Public Property StartDate() As DateTime
Get
StartDate = _startDate
End Get
Set (ByVal value As DateTime)
_startDate = value
End Set
End Property

Go ahead and make two more properties by following the same procedure,
but substitute Endbate and Span for your names. Remember that the value
for span should be Integer.
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Doing math with a subroutine

Next, you need to teach the library to do the math necessary to use the prop-
erties. As described in Chapter 4 and 5, this code is fairly simple, and nothing
has changed. Instead of using the values of DateTimePickers and Labels,
you use the properties, and instead of an event, you will use a subroutine.

A subroutine is an operation that doesn’t return a value — it only affects inter-
nal values. In this case, the internal values are the private variables in the
class. An example of how the subroutine works follows:

Public Sub IncreaseDate ()
Dim dblSpan As Double = CDbl (Span)
EndDate = StartDate.AddDays (dblSpan)
End Sub

The logic to this is a little convoluted. It assumes that the user of the system
sets the properties, so by the logic in the set statement, the private variables
are set as well in the instance of the class the user is working with.

You use the private variables to do the math, and set the private _endbpate
variable. When the user goes to get the finished value — the Endbate
property — the logic for the Get statement is called, and the user gets the
current value in the private property.

These properties are a simple example of a very complex, powerful idea. This
may seem like a lot of extra code to do something so simple, but when you're
developing applications, you rarely create a program as simple as the Date
Calculator. And as a developer, you'll often find — in a real project — that a
little extra code makes the project much easier to write.

When you build the project, you have a class library that calculates a given
number of days from a given date. What’s more, the class library is compiled
into a DLL file usable by any .NET application. In the next section, I show you
how to use your DLL file.

Running a DLL file

As I mention at the beginning of this chapter, a DLL needs to be used by an
application with a user interface, such as a Windows Forms application.

To run your new DLL file, you need to add a project with a user interface to
the same solution that holds your DLL project. The following steps help you
get this working:
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1. Choose File=>Add~>New Project.

2. Select a new Windows application and give it an appropriate name.

I named mine DateCalcShell, representing that it is a shell around the
DLL it will reference.

3. Rename the default form to something appropriate.

Naming strategies never cease. | named my form Calculator.

4. Right-click the new project and select Add Reference.

The Add Reference dialog box appears.

5. Click the Projects tab, select the project that appears there, and

click OK.

In this example, DateCalcClassChapter6 appears in the list under
Project Name, as shown in Figure 6-3.

Add Reference

MET | com | Projects | Browse | Recent

Project Name Project Directary
DateCalcClasschapters  CiiDocuments and Settngsiadministratorify .. |

|

6. Double-click the My Project file in Solution Explorer, and when it

opens in the Design View, click the References tab.

DateCalcClassChapter6 appears in the References grid, as shown in
Figure 6-4.

7. Go back to the form file and move appropriate controls to the form.

Add a Label and a DateTimePicker control. (See Chapter 4 for more
about these controls.)

8. Change the names of the controls to something appropriate.

[ used startDatePicker for the DateTimePicker control and EndDate
for the Label control.
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|
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9. Instantiate your class from your class library as a new object in Code
View.

Getting a new DateCalc object is the same as getting a new instance of
the string object. Remember, everything is an object in .NET. A simple
dimension does the trick: Dim myCalc as DateCalc.

10. Double-click controls to add code.

In this case, double-click the SstartDatePicker control to add a
ValueChanged event handler. Then you use the new component that
you defined in Step 9. You can set the StartDate property from the
value of the DateTimePicker control, set the Span property to 7 to rep-
resent a seven-day span, and then call the calculate method so that
the object sets the Endpate for you. Finally, set the EndDate label text
to the endbDate property of the myCalc object. This code is as follows:

Private Sub StartDatePicker_ValueChanged (ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles StartDatePicker.ValueChanged
Dim myCalc As New CalcClass2005.DateCalc ()
myCalc.StartDate = StartDatePicker.Value
myCalc.Span = 7
myCalc.IncreaseDate()
EndDate.Text = myCalc.EndDate.ToString()
End Sub
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11. Click the Start button to test the application.

Set the DateTimePicker control to some value and watch the label
change. For a cheap thrill, use the debugger, which I cover in Chapter 8.
Set a breakpoint in the DLL file and use the debugger to watch the code
walk through two projects. It’s neat. You might need to right-click on the
Project file for the Windows Application and set it as the Startup
Application.

Delving Deeper into DLLs

There is more to discover about DLLs than [ can put in this chapter. However,
you should understand a few more points about DLLs before you start using
them.

Telling between friends and foes

Throughout this chapter, you use the public keyword to describe class pro-
cedures. This is not the only way to describe procedures, however, and the
differences among the procedures are notable, especially when it comes to
the touchy subject of security. I discuss security in depth in Chapter 14, but I
discuss accessibility keywords here briefly.

Five accessibility keywords can be used to describe procedures. They
describe a gradually more restrictive security outlook. Generally, you want to
pick the most restrictive accessibility possible for your expected use of the
procedure in question:

v Public: These methods essentially give no restrictions. Any application
with physical access to the DLL can use Public methods.

v Protected: These methods are only available from other methods within
their own class, or a class that is derived from their class.

v Friend: These methods work anywhere in the application where they are
declared.

v Protected Friend: These methods are a combination of the Protected
and Friend keywords, so they are available only in an application where
the class and calling program are in the same class and assembly.

v~ Private: These methods are accessible only from within their own scope.
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|
Figure 6-5:
Declaring a
function.
|

Be nice and share

Shared functions are handy because the programmer doesn’t have to instanti-
ate the class into an object with a dimension statement to use it. You can just
directly call the functions — but you don’t have the benefit of a stateful
object with properties and the like. Using the shared keyword is another tool
in your programmer’s toolbox.

To build a shared function, you need to accept and return values. For this
example, I built a shared function that accepts the startDate and Span
values and returns a value for DateTime, which should be the end date.

This shared function is completely different from the subroutine because you
don’t use the properties at all. It is a separate function altogether. I am show-
ing you for the sake of example: This shared function and the subroutine/
property solution are two ways to do the same thing.

So as you do with the properties in the earlier section, “Building the Date
Calculator,” type the beginning of the function declaration, and IntelliSense
picks up that you are declaring variables, as shown in Figure 6-5.
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The functional code then takes the StartbDate and Span values that are
passed in, does the date math, and sets the value of the function equal to the
result. The code looks like the following:
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Public Function IncreaseDate(ByVal startDate As DateTime,
ByVal span As Integer) As DateTime
span = CDbl (span)
IncreaseDate = startDate.AddDays (span)
End Function

Getting more out of less

Without saying anything, [ used one of the more useful features of VB 2005
class design in the playbook — functional overloading. Notice something
interesting about the finished class, especially the IncreaseDate function. ..
oh, wait, was it a subroutine? No, it was both! How is this possible?

It is possible through overloading. To simplify class design, two methods can
have the same name if they have a different method signature, meaning para-
meter types and number. In this case, you have a function that doesn’t use
the properties, so it accepts the start date and span as parameters, and then
returns the end date. A subroutine has the same name, but it has zero para-
meters and returns nothing.

Because of the different signatures, you can have two methods that do approxi-
mately the same thing, but in a different way. The IDE is even prepared to
handle this with a special feature of IntelliSense, as shown in Figure 6-6.
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When you call the method in the code, after you type the first parenthesis,
you can see that the method is described with two lines. Use the arrow keys
to move between them. You don’t have to choose a specific one explicitly, the
IntelliSense is just there for reference.



Chapter 7
Building Web Services

In This Chapter

Understanding Web services

Using IIS to provide business logic
Designing applications with Web services

Building your first Web service

Fis chapter covers the fourth of what I consider the four most significant
project types: the XML Web service. In the grand scheme of things, an
XML Web service is an open-source version of the class library (described in
Chapter 6). It can be used in a Windows or Web application (see Chapters 4
and 5, respectively) as needed.

The two main parts of developing a Web service are producing and consum-
ing. Producing a Web service is what you do as a programmer: develop a ser-
vice for users’ consumption (as with the class libraries built in Chapter 6).
Consuming a Web service is what the end-user does: make use of the service
in your application.

This chapter also examines how you bridge the gap between producing and
consuming Web services — for example, documenting your service so the
default page that IIS creates for it will actually make sense to the reader. The
players in XML Web services show up in the final act of the chapter, including
a parade of the great acronyms — XML, SOAP, WSDL, and UDDI — and what
they mean.

Getting to Know XML Web Services

If creating a Web service seems a little familiar, it’s no accident; if not, no
problem. An XML Web service is to a DLL what Web Forms are to Windows
Forms — and (like a DLL) it’s a class library — only more so. A Web service is
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more versatile than a DLL or Windows Forms — after all, those are compiled
only for use on Microsoft Windows computers. XML Web services and Web
Forms can be used on any platform because they follow open standards.
Figure 7-1 sums up the similarities and differences of these project types.

Windows Only Open Platform
2
= .
£ Windows Web Forms
8 Forms Project Project
s
— ]
Figure 7-1:
Four project - : :
types and < Class Library Web Services
their = Project Project
platforms.
|

The figure shows the extension of familiar Windows concepts into open-
source versions that XML makes usable on the Web:

v Windows Forms have their equivalent in Web Forms (detailed in Chap-
ter 5), which create a user interface that can be viewed on any platform.

v Windows DLLs are compiled from class libraries (see Chapter 6) to help
build applications on Windows platforms; a Web service is an open-
source equivalent of a DLL.

v XML Web services represent a novel combination of the best features of
class libraries and Windows Forms. What’s new here is XML; it gives Web
services a standard format that is available to a variety of platforms —
including (but not limited to) Windows.

Of course, this basic relationship between XML Web services and their ances-
tors is just scratching the surface. Properly used, they could be the Next Big
Thing in application development. To produce a solid Web service and have
it used (consumed) correctly, however, you have to get a handle on a lot of
practical details — such as security policies, the management of transac-
tions, and the availability of system resources. The next sections give you a
closer look at what makes a Web service tick.
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Web services: Characteristics

DLLs have broad functionality within Windows; it makes sense that as their
talented offspring, XML Web services are broadly usable. If you're designing a
broad enterprise system, this flexibility means you can (and probably should)
develop a complete suite of tools for a wide range of users. Remember, how-
ever, the four vital characteristics of XML Web services. They are

v Architecture-neutral: Web services don’t depend on any proprietary
wiring configuration, cable type, file format, schema description, operat-
ing system, or discovery standard.

Discovery is how other consumers can find out what your Web service
does.

v Ubiquitous: Web services are “all for one and one for all,” everywhere.
Any Web service that supports the standards can support the service
you’re creating.

v~ Simple: Creating Web Services is easy, quick, and even (sometimes) free.
That’s partly because the description of the data is human-readable,
making for a better development experience. Any programming language
can participate.

~ Interoperable: Because the Web services all follow the same standards,
they can all speak to one another.

Web services: Quirks

Designing Web services feels like designing class libraries because (basically)
that’s what they are. These particular class libraries are Web-driven, though,
so here are some design differences to watch for:

v All communication between an application and the service happens
over the Internet. That means you incur at least some overhead to send
each individual message; the wise developer reduces the overall number
of messages.

v Chunky beats chatty. Sending fewer messages means making fewer —
and larger — function calls. Rather than make several calls to get pieces
of a document, for instance, you make one call and get the whole docu-
ment. This practice is called making chunky rather than chatty calls.

v~ These class libraries aren’t stateful. There are no properties (or any-
thing like them) in a Web-service-based class library; in effect, all opera-
tions are shared.

127
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v Because functions are shared, subroutines are not very effective. After
all, there are no properties or local variables for the subroutines to alter
when called. As with Web applications, the problem is a lack of stateful-
ness. Your service, then, ends up as a set of tools, implemented as func-
tions with return values.

Designing for Web Services

The overall goal of building Web services is to get your business logic exposed
to the masses. (Business logic is the code that sits between your user interface
form and your data source or file and that tells the program what to do; you
can read more about it in Chapters 3 and 6.) Because there is a standard for
consuming Web services, as well as one for creating them, you can focus your
development on providing tools for a very broad range of applications.

Planning the design strateqy

The root of Web-service design is a basic contrast: DLLs are stateful — and
Web services are not. When you instantiate a DLL with a Dim statement in
your application code, you are creating an in-memory representation of the
class. Not so with Web services; they are using IIS to support themselves, so
you can’t instantiate them in the same way. Treat them as though you were
developing a bunch of static functions, rather than a group of stateful objects.

This strategy actually has a name — Service-Oriented Architecture, or SOA.
When you’re designing for SOA, the approach is different from what you may
be used to: In effect, you treat it more like a toolbox and less like a living
piece of software.

No surprise that designing for SOA requires a sort of thousand-yard view.
Fortunately, Visual Studio provides this big picture — one that system archi-
tects can use to tie Windows and Web Forms applications into the same
bundle with class libraries built from both Web services and DLLs. From this
bird’s-eye view, the map looks like Figure 7-2.

Okay, Figure 7-2 lays out the basic frame of reference for your design strategy;
what turns your project into an actual Web service is another consideration
that’s just as important to software development: how you use your program-
ming language. Stay tuned.
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Getting a grip on the tactics

Developing a Web service requires two very different sets of tactics: one set
for producing the Web service, one set for controlling how the service is con-
sumed. Some specific — but probably familiar — tactics come into play when
you use Visual Basic 2005 to create tools that work within SOA:

v The tactics you use to produce Web services will be just like those used
to create class libraries and compile them into DLLs.

v The tactics that control how a Web service is consumed are similar to
referencing a DLL and using its methods and properties in a Windows
Forms project (as described in Chapter 6).

Building a Web Service

The whole process of creating a Web service and setting it up for use involves
three stages: Producing the service, viewing the service to make sure it’ll do
what you want, and making the service available to the users who consume it.
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Producing a Web service begins with (surprise, surprise) a project template.
Use these steps to get one started:
1. Open Visual Studio and choose File->Newr>Web site.

The output of a Web service project is a Web site, as the output of a
class library project is a DLL file.

2. Under Visual Basic, select ASP.NET Web Service as the Visual Studio
installed template.

3. Under Location, change the name to something appropriate for the
project.

Here, I changed my sample project’s name to Chapter7DateCalc.
4. Visual Studio creates a project template for you.

The new template includes a default service file called service.vb, a
Data folder, and an ASMX file called Service.asmx. The Service.vb file
contains your class library code. The Service.asmx file contains dis-
play code that the Web server will use to make an automatic page of
documentation for your Web service.

5. Rename the files and class to something appropriate for the project.

Here, [ used DateCalc, so my class is DateCalc, my ASMX file is
DateCalc.asmx, and my class file is DateCalc.vb.

6. Write code in the class as Public Functions, overwriting the sample
method.

Notice the default code in Listing 7-1.

Listing 7-1: The Default Web Service

Imports System.Web

Imports System.Web.Services

Imports System.Web.Services.Protocols

<WebServiceBinding (ConformanceClaims:=WsiClaims.BP10,
EmitConformanceClaims:=True)> _

O R

(€]

Public Class Service
Inherits System.Web.Services.WebService
<WebMethod ()> _
Public Function HelloWorld() As String
Return "Hello World"
End Function
: End Class

© W © J o
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Is that all there is to a Web service? Well, yes, but there’s more going on here
than meets the eye. Here’s a closer look:

v After the Imports statements and before the Class statement, a
WebServiceBinding statement (on line 4) serves as a compiler direc-
tive. It tells the .NET Framework that this particular class will be used as
a Web service.

v The standard-looking Class statement on line 5 is followed by an inheri-
tance statement that gives you as the programmer of the class access to
the methods, properties, and events of the Web service classes. (For
more about inheritance, see Chapter 12.)

v Another compiler directive appears on line 6 — the webMethod direc-
tive, which gives you a few documentation choices later on — and also
shows the compiler that this specific method will be exposed to the ser-
vice when you've got it up and running.

v Lines 7, 8, and 9 are pretty standard in Visual Basic 2005: just a function
that accepts nothing and returns a string: "Hello World".

v The End Class statement completes the class. It is just a test line of
code, to make sure the wiring works.

You can replace lines 7 through 9 with most any VB function. In the Microsoft
world, such a function can return any object in the .NET universe. But let’s
not get too far a field here. In reality, you must consider that a UNIX or main-
frame computer might call this service. If cross-platform (or backward) com-
patibility is an issue, it might be necessary to limit the return value to a
primitive type. (I cover primitive types in Chapter 9.)

s

When you have your completed project template in hand, you're ready to
build the Web service.

Building the DateCalc Web service

This section of the chapter builds the DateCalc Web service as a detailed
example. [ have replaced the sample code in lines 7 through 9 with a function
for the class library in your DLL file (see Chapter 6 for details of this func-
tion). Listing 7-2 shows the sample code for the finished service.
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Listing 7-2: The DateCalc Service

Imports System.Web

Imports System.Web.Services

Imports System.Web.Services.Protocols

<WebService (Namespace:="http://services.vbfordummies.com/")>

Public Class DateCalc

Inherits System.Web.Services.WebService

6: <WebMethod (Description:="A Web Service implementation of the Date
Calculator")> _

7: Public Function IncreaseDate(ByVal startDate As DateTime, ByVal span As
Integer) As DateTime

8: IncreaseDate = startDate.AddDays (CDbl (span))

9: End Function

10: End Class

Ul W N

Okay, [ admit it, I changed a few things here (that was the point):

v Line 4 has changed from a webServiceBinding directive to a Web
Service directive. I did that so I could easily describe a default name-
space. Default namespaces are important for the consumer; they validate
the expected location of the service with its actual location. (The web
ServiceBinding directive is more often used for enterprise-level ser-
vices, which aren’t of interest here.)

v Line 6 now includes a Description property so that the service is more
self-documenting.

v Line 7, the function declaration, now accepts a startDate and span as
input.

v Line 8 contains the code that has a starring role in all four chapters in
Part I — the date math that increases the start date.

When the appropriate Web-service features are in place, give the new service
a test drive before you send it out there to meet the users.

Viewing the DateCalc service in action

Click the Play button to start the service. (Now, there’s something you can’t
do with a DLL.) Web services come with a default display page; in this case, |
have named it DateCalc.asmx. IIS will create a nice page for you (as shown
in Figure 7-3), with some documentation as described in the webMethod
directive.



Figure 7-3:
The opening
page of the
DateCalc.
asmx file.
|

|
Figure 7-4:
The test
page for
Increase-
Date.
|

|
Figure 7-5:
The
DateCalc
response.
|

Fl=  Edk Wew  Favodes  Tock Hep

DateCalc

The follewing operstions sre suoported. For a formal definition, please review the Service Description.

.
& Wied Seruice implernenation of the Date Caloulamr

Chapter 7: Building Web Services ’33

| of?

& Local inkranst

When you click the IncreaseDate link, you see the test page for the function I

created, as shown in Figure 7-4.
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At this point, enter a starting date and a time span in the StartDate and Span
text boxes, respectively. (I entered 7/25/75 in the StartDate text box and 13 in
the Span text box.) Click the Invoke button, and your browser opens a new
window with the answer in its full date format glory, as shown in Figure 7-5.
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Pretty cool — but this exercise is not really the point of the XML Web service
[ created. It’s just a simple way to test a Web service — even a sophisticated
set of services — regardless of whether you've written them yourself or have
tried someone else’s handiwork.

“@N\BEI; The goal of any Web service (as [ mention in the “Designing for Web Services”
& section), is to provide other applications with access to your business logic.
Notice that all these sample pages are shown in a Web browser — and that
the namespace of the service is at a Web address. Neither of those choices is
an accident. If this function is published, [ want it to be available at a URL on
the World Wide Web — like this one:

http://yourMachine/Chapter7DateCalc/DateCalc.asmx

With the Web service built and tested, the next step is to consume the ser-
vice in an application. The next section shows you how.

Consuming a Web Service

At first, building an application that consumes a Web service seems similar to
building a test application for a class library. You start by building a Windows
Forms application similar to the one described in Chapter 4 — but then you
reference the Web service in much the same way as you reference a DLL (see
Chapter 6).

In fact, Visual Studio treats a Web service much the same as it treats a class
library in development. When you reference a Web service and then compile
a project, Visual Studio actually builds a small DLL file that remembers the
details of the Web service. (Fortunately, this happens automatically, as you
can see in the upcoming steps.)

To build an application that consumes a Web service, follow these steps:

1. Create a new project of any type.

Here I use a Windows Forms application called DateCalcConsumer, but
any .NET project can consume a Web service.

2. Right-click the project file and select Add Web Reference.

The Add Web Reference dialog box shown in Figure 7-6 appears, offering
to help you reference the service.
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3. Type the URL of the service you are trying to reference into the URL
text box.

This bit could be tricky if you're trying to reference the service built in
the “Viewing the DateCalc service in action” section, earlier in this chap-
ter, but you aren’t running IIS on your local development computer. If you
are in that position, the simplest solution is to run the service from Visual
Studio and then copy the URL from the Address text box of the Web
browser. On my PC, that URL is http://localhost:65039/Chapter?
DateCalc/DateCalc.asmx, but on yours the port number (the number
after the colon) will be different.

If you don’t want to run the service from your local machine — and you
want to try running the service from the Internet — try the service I
have running on www.vbfordummies.com. The URL for that service is

http://www.vbfordummies.com/Chapter7/Services/DateCalc.asmx

After the browser locates the service, the screen changes to the refer-
ence format, as shown in Figure 7-7.

4. On the right, where the Web reference name is set to localhost by
default, change the name to suit your project.

To keep things simple, use the name of the object referenced in your
project — just as if it were a DLL. (I changed my Web reference name to
DateCalcService.) Visual Studio creates a proxy class and gives you a
reference to it in the Web References folder. An example appears in
Figure 7-8.

Chapter 7: Building Web Services ’35
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5. Add code to your project that references the Web Reference you just
added.
In my case, | have a Windows Forms application, so [ add a bDateTime
Picker and a Label, and then double-click the DateTimePicker to get
the valueChanged event handler.
6. Reference the Web service by instantiating a new copy of the proxy
class.
In my sample project, here’s what this looks like:
Dim myDateCalc As New DateCalcService.DateCalc
*Qa.\ECT
S

You can also get to the service using the My object. Try My . Services.
DateCalcService.

7. Call the methods of the Web service, just as you would for any other
function in VB.

The finished code for the date calculator that uses the Web service
looks like Listing 7-3.
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Listing 7-3: The Date Calculator Using the Web Service

Public Class DateCalc
Private Sub StartDatePicker_ValueChanged(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles StartDatePicker.ValueChanged
Dim myDateCalc As New DateCalcService.DateCalc
Labell.Text = myDateCalc.IncreaseDate(StartDatePicker.Value, 13
End Sub
End Class

QgN\BER The proxy class has a state, but that doesn’t mean the service itself has any
& sense of state. If you want to get fancy, you can use this fact in ways that
make the Web service emulate a class — but you are still dealing with a dis-
connected Web service; it doesn’t keep track of its own state.

Web Services in More Depth

Ah, Web services — now, there’s a topic that could fill several books (in fact,
I've written a few that you can still find floating around). Though you don’t
have to understand how all the players (systems, policies, applications, and
users) use Web services, it helps if you are working on a team of developers
to make sure you are all speaking the same language.

From the serene bird’s-eye perspective of Web services (refer to Figure 7-2),

there are a few parts of the big picture that generally you won’t have to deal
with as a developer — for example, actually presenting your completed Web
service to the users. Internet Information Services (IIS) is the Microsoft Web
server application that makes these services public. Four protocols — XML,
SOAP, WSDL, and UDDI — are what make that minor miracle possible:

v~ 1IIS: Internet Information Services plays the same role with XML Web ser-
vices as it does with Web Forms. The page that you see when you run a
service from Visual Studio, or type the URL into a browser, is automati-
cally generated by ASP.NET, and passed to the browser by IIS. You can
see this flow in Figure 7-9.

|
Figure 7-9:
[IS handling
| e f :Eﬂ: '
service. ' i
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IIS treats a Web services application just like a Web Forms application.
Bottom line: It needs the same tender loving care from your administra-
tor. Remember, you're exposing your business logic to the world.
Security is important, and is covered in Chapter 14.

v XML: Of the four protocols that make Web services work, eXtensible

Markup Language (XML) is the one you’re likeliest to run into. Generally
considered a data-storage protocol, XML is the backbone that supports
all the messages passed as part of Web services.

* SOAP: Simple Object Access Protocol describes the messages that are

passed. It’s a meta-language of XML. The .NET Framework spares you
(almost completely) from having to deal with SOAP.

v WSDL: Web Services Description Language is the XML meta-language

that describes the service’s input and output parameters for public con-
sumption. Again, the .NET Framework shields you almost completely
from having to hassle with WSDL. Almost.

Occasionally, however, a Web services directory will need a link to your
WSDL for listing purposes. To get the WSDL from any ASMX-based ser-
vice, add ?wsDL to the end of the URL. For instance, the WSDL for the
URL I list here would be at

http://www.vbfordummies.com/Chapter7/Services/DateCalc.asmx?WSDL

v~ UDDI: Universal Discovery and Description Language is another XML

meta-language that assists consumers with the discovery of your Web
services. More information about UDDI can be found at http://uddi.
microsoft.com.

UDDI could easily take up an entire new book, and in fact it has. I at least get
you started by telling you how to enable UDDI. The industry standard is a
DISCO file — an XML file with a set of standard tags that tells a UDDI server
(such as uddi .microsoft.com) what services are in your project.

The process in which a UDDI or other server gets Web services (in this case,
from a DISCO file) is called discovery.

To create a DISCO file, follow these steps:

1. Create a new XML file in your Web service project by right-clicking

the project and selecting XML File.

. Add the standard discovery tags to the document.

For this purpose, this process can be as simple as the one shown in the
following code, though it will be tougher as the services get more com-
plex. (All that would need to be changed for another project would be
the two tags ending in Ref, which I set in boldface in the following code.)
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<?xml version="1.0"?>

<discovery xmlns="http://schemas.xmlsoap.org/disco/">

<discoveryRef ref="/Folder/Default.disco"/>

<contractRef ref="http://TheServerUrl/DateCalc.asmx?WSDL"
xmlns="http://schemas.xmlsoap.org/disco/scl/"/>

</discovery>

3. Rename the file.
In this case, base it on the DISCO file by using default.disco.

Now, when you register this service with UDDI (at uddi .microsoft.com),
the site there will know where to browse. Then your service will appear in
the listing for everyone to use.

UDDI is unusually handy for large-scale deployments of company-wide ser-
vices, or public services of any size. Remember, if you are in a multi-server
environment, you can create UDDI servers that go find functions they need
by using DISCO files. Potentially, that’s a very powerful system.
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Chapter 8
Debugging in VB 2005

In This Chapter

Using visual tools to squash bugs

Implementing debugging with tools from the .NET Framework
Finding bugs in different types of projects

In the examples in Part II, you play your code to see it run in a Web
browser or as a Windows application. As you may have guessed, there is
more to this functionality than meets the eye.

Debugging is the process of finding and fixing problems in an application of
any type. Often, debugging code takes as long as writing it did in the first
place, according to most software development lifecycle systems, such as
CMM (Capabilities Maturity Model). One of the most significant reasons for
using an integrated development environment to build applications is to take
advantage of the included debugging tools.

Visual Studio 2005 is replete with debugging tools that work in some or all of
the project types. Throughout this chapter, I give you a blow by blow of what
debugging tools are available — both visual tools and tools in the .NET
Framework. | then show you how to debug each project type.

Cool Visual Tools for Debugging

Debugging is so important that it has its own menu in the Visual Studio envi-
ronment. The ability to watch your code run, review values in variables, and
check the contents of objects is the primary reason why experienced devel-
opers use an IDE such as Visual Studio instead of just writing their code in a
text editor.
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Before you can use the visual tools, you must meet the following requirements:

+ You must have a runnable project open to debug. Class library projects
such as the ones I discuss in Chapter 6, for instance, will not run without
some kind of visual shell. See the later section, “Class libraries,” for
instructions.

v Visual Studio must be in Debug mode (also called Paused or Break
mode). When you press F5 or click the Play button to run your project
from Visual Studio, you are putting the project in Debug mode.

+ The project must be paused in order to see runtime variables. You
pause the project with a breakpoint, which I talk about in the next sec-
tion. Also, you can enter a project in Break mode, which I cover in the
later section, “Debugging the Projects.”

Visual Studio provides a number of debugging tools of varying complexity.
[ cover the three most often-used tools:

v Breakpoint: A marker that you place on a line of code to pause the
execution of a program.

1 Watch window: A window that shows the runtime values of variables
and objects.

v Immediate Window: A command window that lets you type in runtime
VB 2005 commands and see potential results.

Breakpoints

The breakpoint is your friend.

Allow me to suggest a scenario. You have a complicated algorithm that gener-
ates a final price for a user. Two object properties and three variables are
used to create the final price. When you test your application, the price is
wrong.

How do you figure out what the problem is? You know what line it is in, but
you don’t know the values of the variables. You could laboriously put five
labels on your form and set the values of the labels equal to the two proper-
ties and three variables. Then, when you find the problem, you need to delete
all of the labels. A better way to find the problem is to set a breakpoint at that
line and check the variables while the application is paused.

P In order to view the values of variables, your application must be in a paused
state, such as provided by a breakpoint. If you try and look at variable values
while the application is running, you won’t get what you expect. This is why
developers use breakpoints.
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Setting up breakpoints

When you play your applications from Visual Studio, you are actually enter-
ing Debug mode. From this mode, you can ask Visual Studio to pause the exe-
cution of the application at a specific line of code with a breakpoint.

You create a breakpoint by clicking on the gray bar to the left of the line of
code at which you would like the program to stop. This action leaves a little
red dot on the gray bar, as shown in Figure 8-1.

Program will stop here.

DateCakc.vb ' Formlvb® | Formlub [Design]®

When you play the project, the execution stops at that location. Go ahead
and press F5 after putting in a breakpoint, and you see execution stop at that

line of code, as shown in Figure 8-2. Pressing F5 again continues execution of
the program from that point.

Das=Cac.vb, ' Formlvb  Formlvh Design]
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|
Figure 8-3:
The
Breakpoints
window.

<MBER
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Managing breakpoints

Fast forward to the middle of the development project, and you may find
that you have way too many breakpoints to be useful. Visual Studio provides
a tool for you to manage them all — the Breakpoints window, shown in
Figure 8-3, which you invoke by pressing Ctrl+Alt+B.

Breakpoints
New~ | X | 0 |5 -gtqlCDLurm*
Name Condition Hit Count

J Form1.vb, Ine 6 character 5§ {no conditi... break abvays (currently 0)
[#]@ Formi.vb, line 5 character9 (no conditi... break abvays (currenty 1)

@ Breakpoints | ] Immediate Window

The default Breakpoints window is useful when in a paused state, or just in
normal development mode. The default columns include the Hit Count
column, which describes when the breakpoint is hit during the execution of
the code, and the Condition column, which describes an expression that
must evaluate as true in order for the execution of the application to stop.

Other considerations for deciding how to work with breakpoints include the
following:

v You can add other Breakpoint window columns by selecting them from
the Columns drop-down list, including columns that show what function
the breakpoint is in, the Language, and When Hit. The When Hit column
allows you to define a message to print or a macro to run when the
breakpoint is reached.

v You can edit debugging functions — such as Hit Count, Condition, and
When Hit — by right-clicking the breakpoint marker to the left of the
code, or by right-clicking the breakpoint in the Breakpoints window. The
context menu that appears contains selections for each of these options
that enable you to manage breakpoint functions.

v Breakpoint properties simply make breakpoints quicker to use. While
debugging, you can easily just set a breakpoint and go look at values to
see what the problems are. Using the options, though, reduces the
number of steps you need to go through to get the answer you need.

A breakpoint strategy becomes like a standard set of chess openings over
time. Experience dictates how you use the debugging tools, based on your
personal programming style.
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The Watch window

Watches are little programmatic spies that you can place on objects to keep
an eye on their values while stepping through code. Visual Studio provides
four Watch windows, and on a project-by-project basis, they remember what
you have chosen to watch.

To show the Watch window, choose Debug=>Windows=>Watch, and then
select one of the four Watch windows. The Watch window itself is essentially
a table that shows the name of the object being watched, its type, and its
value, as shown in Figure 8-4.

atch ||
'thanel \'alu% Type |
v NextWeek.Text = 4 = String
|
Figure 8-4:
The Watch
window.
I
To add a watch to the watch list, follow these steps:
1. Pause the project, either by reaching a breakpoint or by clicking the
Pause button on the toolbar.
2. In Code View, right-click the object that you want to watch and select
Add Watch from the context menu.
P In order to see the value of a variable, it must be in scope. A variable is in

scope when it exists within the block of code currently running. For instance,
if you declare a variable within an event handler for a button, only when you
click that button do the values of that variable become available to watch.

When in Debug mode, a variable is either with or without a value, just as it is
when a program runs. The Watch window shows this very well, as shown in
Figure 8-5. When the variable is without value, it appears with the error icon,
and the text

Variable.Name is not declared or the module containing it is not loaded in
the debugging session.

When the variable has a value, it is described with all properties.
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|
Figure 8-5:
Variables

in and out

of scope.

|
Figure 8-6:
The
Immediate
Window

in use.
|

Watch 1

Name Value Type
@ NextWeek. Text " 4 = String
1 ] Thls\'\ﬁfk.Text 'ThisWeek.Text' is not declared or the module containing it

The Watch window is a great way to watch whole objects, rather than just
values in variables. Collections, such as arrays and datasets, often have a
wide variety of properties and values that you need to check on every break.
The Watch window provides a simple method for a structured check on
values.

The Immediate Window

Sometimes a watch isn’t enough, and you need to run a command while the
application is paused. The Immediate Window, shown in context in Figure 8-6,
is designed for just such a situation.

Immediate Window
TNextiesk. Text
“5/E5/2005 2:58:13 M

The basic syntax for the Inmediate Window is that of writing the values of
expressions to the window using the Debug . Print method, which I cover in
the next section. The shortcut for this method is the question mark.

To use the Immediate Window, as with most other debug tools, your project
must be paused. To write the value of a variable to the screen, then, you
simply type ?VariableName into the window. In the example in Figure 8-6,

I typed ?NextWeek.Text to get the value of that property. If the value is out of
scope, [ would receive the same out of scope error as displayed in the Watch
window.
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Using the Immediate Window is more of a spot check than using many of the
other debugging tools. If you are using conditional breakpoints that only
break when variables contain certain values, you will find yourself using the
Immediate Window to see what brought about the stoppage.

Using the Debugging Tools
in the .NET Framework

Visual Studio provides great tools for debugging, but the .NET Framework
itself also has some fantastic features that make debugging easier. These
tools are more code-based and less visual. I go over a few of them here, and
then cover a few more when I discuss debugging specific project types later
in this chapter.

The Debug class

What would debugging be without a Debug class, right? Just like the windows
that [ show you earlier in this chapter are sort of the Windows Forms imple-
mentation of debugging, the Debug class is the DLL implementation of
debugging.

The Debug class has a whole host of methods, properties, and events that
assist you in seeing what your application does while it runs. The simplest
example of a method in the Debug class is the wWrite method. The following
steps get you started:

1. In Visual Studio 2005, choose File=>Project/Solution to open a
Windows Application project.

For example, | opened the DateCalcChapter4 from the Sample
applications.

2. Double-click an empty place on the form to create a Form_Load event
handler.

This example creates a DateCalc_Load function that handles the form
load event.

3. Insert a Debug.Write statement in the DateCalc_Load function, as
follows:

Private Sub DateCalc_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
Debug.WriteLine ("Loading Form")
End Sub
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4. Click the Play button in Visual Studio to enter Debug mode.
5. The Output Window displays your message.

There is more to the Debug class than the write statement, but the most
common use of the class is to track program execution, and the best way to
track program execution is to drop breadcrumbs as parts of the program
execute.

Error handling

Error handling and debugging go hand in hand. Debugging is the act of track-
ing down errors, and error handlers are designed to, well, handle errors!

Error handling is a big part of debugging, because the errors that are created
by bugs in software should be caught and handled. An interesting phrase
describes error handling in Visual Basic — Try-Catch. You ¢ry a piece of code.
If a problem occurs, Visual basic throws an error, and you can catch that
error.

The Try-Catch block looks like the following code. Visual Studio writes most
of it for you. Just type Try in a function and press Enter, and Visual Studio
automatically inserts the rest of the block.

Try
Catch ex As Exception

End Try

You can see that the catch statement is catching something in particular that
deserves a closer look — the Exception object.

The Exception object is what you get back from Visual Basic in runtime
when an error occurs. It is what Visual Basic throws to you so that you can
catch it with your error handling.

For instance, follow the steps in the earlier section, “The Debug class,” to get
a Form_Load event handler method, except insert the code in Listing 8-1.
Inside the Try block (Line 2 of Listing 8-1), an Integer is set equal to a
String, which you cannot do. (For more information, see Chapter 9.)

This test causes an error to occur, and an Exception object is the result. In
the catch part of the block (Line 4 of Listing 8-1), you can get to the
Exception object with its declaration ex.
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Listing 8-1:  Causing an Error in the Form_Load Event Handler

Try

Dim bugInCode As Integer = String.Empty
Catch ex As Exception

Debug.Write (ex.Message)
End Try

In Debug mode, you can look at the contents of the Exception object by
typing ?ex in the Inmediate Window. Set a breakpoint on the Debug.

Write (ex.Message) line and run the project. For the code in Listing 8-1,
the Exception object returns all of this useful information in the Immediate
Window:

Data: {System.Collections.ListDictionaryInternal}
HelpLink: Nothing

HResult: -2147467262

InnerException: {System.FormatException}
IsTransient: False

Message: "Conversion from string "" to type 'Integer' is not valid."
Source: "Microsoft.VisualBasic"
StackTrace: " at Microsoft.VisualBasic.CompilerServices.

Conversions.ToInteger (String Value)

at DateCalcChapter4.DateCalc.DateCalc_Load (

Object sender, EventArgs e) in C:\Documents and Settings\sempf\
My Documents\Visual Studio\Projects\OSIA\DateCalcChapter4\
DateCalcChapter4\DateCalc.vb:1line 9"

The Exception object returns a wealth of information about what went
wrong. Some details may be hidden in objects that you need to look at sepa-
rately, but two main pieces of information are front and center: The Message
property (of the Exception object, which you name ex) has the error that
occurred, and the stackTrace property has the line number. With those two
pieces of information and the date you originally sent to the method, you
have what you need to know 80 percent of the time.

All of this information can be used in application-level error handling. You
can e-mail this information to yourself, return it to the user, or write it to a log
file. More information on the various ways to get this done can be found on
the Web — [ would recommend the Microsoft Exception Management Blocks
component, available from the Microsoft Patterns and Practices Web site at
http://msdn.microsoft.com/patterns.
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Debugging the Projects

Each of the projects I cover earlier in Part I — Windows Forms, Web Forms,
class libraries, and XML Web services — have a similar set of debugging
tools. The details I talk about earlier in this chapter work for all projects, but
each of the project types has its own specific tweaks. | cover these in the fol-
lowing sections.

Windows Forms

Windows Forms applications are the most straightforward to debug, because
they are standalone applications over which you have complete control.
There are few tricks to debugging Windows Forms, but I take this opportunity
to cover the debugging feature you use most often — stepping through code.
You can apply this feature to all project types, but it is best shown as part of
a Windows Forms application.

The “Breakpoints” section, earlier in this chapter, describes how to use break-
points and demonstrates how powerful they are. You can use this power to
execute your code one line at a time and keep an eye on the specifics of object
properties and variable values. The following steps get you started stepping
through code:

1. Load a Windows Application project by choosing File=>Project/Solution
and selecting a project file.
For example, | use the DateCalcChapter4 project.

2. Press F10 to start debugging the project.

This starts running the project in Debug mode and stops the project on
the first breakpoint found. For the DateCalcChapter4 example, you can
set one at the Form_Load handler.

3. To continue stepping through the code, press F10.

This walks through the code one line at a time in Break mode. You can
use the Immediate Window, or you can mouse over variable names to
see their values.

4. To step over a method call, press F10.

This passes over the internal code of a method, so that you stay in the
flow of the original program.

5. To step into a method, press F11.

This enters the functional code of a method call, and may change the file
you are looking at.
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6. To continue running the program in Run mode (that is, to exit Break
mode), press F5.

This continues to run the program outside of Debug mode.

Using a combination of the breakpoints and stepping through code, you can
solve most of the logic and execution problems that your program may have.

Web Forms

Web Forms are different, as | mention in Chapter 5, because they are running
on an Internet Information Server (IIS) rather than directly on your worksta-
tion. While it is true that you can be running a Web Forms application on
your workstation using either IIS or Visual Web Developer Web Server, it is
still considered remote debugging, because the application is being handled
by a separate system.

This brings whole new problems to debugging. First, you may need to debug
a Web Forms application that is not running on your workstation. Second,
environment variables (such as Session variables, which I discuss in
Chapter 5) can make a large impact on your application. Knowing the values
of these variables is important — in Break mode or Run mode.

Remote debugging

Remote debugging is necessary because if you are running a Web Forms
application on a server that doesn’t have Visual Studio installed, it won’t
have the necessary program to allow debugging. To install that program,
follow these steps:

1. Insert the Visual Studio 2005 Remote Debugger CD on the remote
machine.

2. The Remote Debugger Setup program should run automatically.

If not, open the CD drive from Windows and launch the Remote
Debugger Setup program.

Often, to debug on a remote machine, you need to have an Administrator
account on that machine. When you open a Web project with a remote
address, you can debug the project as if it was running locally on Visual Web
Developer Web Server.

151
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Trace

Some information about Web applications is not best gathered through
debugging in Break mode. Sometimes if a page can be viewed in Run mode,
but with comprehensive information about the execution of the page avail-
able, your problems can be solved.

Trace enables just that. Trace is enabled by changing the epage directive at
the top of an ASPX file. To do this, follow these steps:

1. Open a Web project by choosing File~>Project/Solution and selecting

an ASP.NET project file.

For this example, | use DateCalcChapters.

. Open a page by double-clicking it in the Solution Explorer.

[ use the default.aspx page that I created with the Date Calculator in it.

Note the @page directive at the top of the page, like the following code.
This appears on every ASP.NET page, and it is what the Web server uses
to link the page to the code-behind file and set the language, among
other things.

<%@ Page Language="VB" AutoEventWireup="false"
CompileWith="Default.aspx.vb" ClassName="Default_aspx" %>

. Add a Trace attribute to the @rage directive, setting Trace="true",

as follows:

<%@ Page Language="VB" AutoEventWireup="false"
CompileWith="Default.aspx.vb" ClassName="Default_aspx"
Trace="true" %>

. Save your changes, and then compile the application by choosing

Build=>Build Web Site.

. Right-click the file you changed and select View in Browser.

The information provided by Trace appears at the bottom of the page.

Trace works great for XML Web services too!

Like the Exception object that I discuss earlier in this chapter, Trace has a
whole host of information, well organized by ASP.NET. Sections include:

1 Request Details: Gives the basic information about the request made to

the server.

v Trace Information: Details the timing from step to step in the request,

which is very important for discovering performance problems.
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v Control Tree: Shows every Server and User control being used by the
application.

v~ Session State and Application State: Displays the contents of the
Session and Application variables at response time.

1 Request Cookies Collection and Response Cookies Collection: Details
the collections of cookies at response time.

v Headers Collection and Response Headers Collection: Shows the stan-
dard HTTP headers, usually used for debugging Web server problems.
The Headers Collection is what came into the server, and the Response
Headers Collection is what went to the client.

v Form Collection: Give the values of all of the form fields sent to the
server.

v QueryString Collection: Displays the values of variables sent to the
server in the URL.

1 Server Variables: Shows a standard set of variables passed between all
clients and servers, independent of platform or middleware.

You can see that this information is completely invaluable when debugging
problems with Web applications. There is even more too, because with the
Trace class in the .NET Framework, you can insert notifications into your
code that only appear in the Trace mode. Because changing a page to Trace
mode just requires a change to the ASPX file, you can even do it in a produc-
tion system. It is a very powerful tool; more can be discovered by searching
for ASPNET Trace in the MSDN Library at http://msdn.microsoft.com/
library.

Class libraries

Class libraries are an interesting debugging problem just because they are
not runnable by themselves. As [ mention in Chapter 6, class libraries are
used by other applications to componentize functionality. For this reason,
they are only usable as part of other applications.

Chapter 6 describes how to use two projects in one solution. That is what
you need to do to debug a class library. If you run a Windows Forms applica-
tion that references a class library, and you have the project for the refer-
enced class library in the same solution, when you step through the code in
the Windows Forms application, the app steps right into the class library
when you call a method or property of that class library.
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To make this happen, follow these steps:

1.

Open a class library solution in Visual Studio.

For this example, I use the class library that I developed for Chapter 6,
DateCalcClassChapters6.

2. Add a project to the solution by choosing File->Add=>New Project.

. Select a Visual Basic Windows Application project from the Add New

Project dialog box, name it something appropriate, and click OK.

I call mine DateCalcShell.

. Right-click the new project and select Add Reference from the context

menu.

. Click the Project tab, select the class library file project, and then

click OK.

6. Double-click the Form1 form to get a Page Load handler.

7. Add the code that calls a function of the class library project.

In my example, I just added a quickie variable called myDate that [ set to
a week from now using the IncreaseDate function, as follows:

Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
Dim dateCalculator As New CalcClass2005.DateCalc ()
Dim myDate As DateTime
myDate = dateCalculator.IncreaseDate(System.DateTime.Now, 7)
End Sub

. Press F10 to step into the application. Continue pressing F10 to move

line by line through the code.

As you step into Line 4 of the preceding code, the debugger opens the
class library project and steps you through the code of the Increase
Date function, and then returns you to the Form_Load event handler.

If you used Visual Basic 6 or 7, you may recognize this feature — it has been
around for a while. The new object-oriented flavor of Visual Basic makes it
look a little different, but it is really very much the same thing.

Web services

Web services are by far the most challenging to debug. Like with class
libraries, you have to use some tricks to debug Web services. After you get
past those tricks, it is very much like debugging any other type of project.
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The key thing to remember about debugging Web services is that you can’t
debug unless you have access to the source code of the service itself. If you
are using someone else’s service, for instance, and a bug is in the code, your
debugging doesn’t show you all of the advanced debugging information. If
you have the code for both the Web service and the client application, you
can debug both.

If you are debugging a Web service that you have developed locally — as
described in Chapter 7 — you can just press F10 and enter Break mode to
step through the code, just as in the preceding examples in this chapter. If
the service is already running on a Web server, you may need to attach to the
process that is running on that server.

To attach to a process in order to debug a Web service, do the following:

1. Open a Web service project.

For this example, | use the project I developed for Chapter 7 called
DateCalcChapter?.

2. Choose Tools=>Attach to Process.

The Attach to Process dialog box appears, as shown in Figure 8-7.

Attach to Process &
Tanspert:  [nafat |
uakfer: SCRIEE v

Transport Information
The cefault transport lats th ora ter running the Marcsaft Wisual Studio Remats
Debuggng Monitor (MSVSMON.EXE).
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T e — ey
LiConfig.ese i []
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S EmimEg.exe bl o
Aprtt. e e o
Apcintexe 3 B o
CrossMeruexe 3820 e [
ctfmon.exe 3488 £ o
3568 Managed, x5 0
3660 SearchResits 35 [
403z x5 o =
] [ 2l sassians Refresh |
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3. Select the server running the Web service from the Qualifier drop-
down list.

4. In the Available Processes box, choose either aspnet_wp.exe or
w3wp.exe.

aspnet_wp.exe is used on Windows XP and 2000 servers. w3wp . exe is
for Windows 2003 servers.
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5. Click the Attach button.
6. Click OK.

When you press F8 to step into the project, Visual Studio can watch code run-
ning on the remote server that you have selected in the Attach to Process
dialog box.

This method is also useful for other debugging actions. For more information,
search for Debugging Deployed ASP.NET Applications in the MSDN Library at

http://msdn.microsoft.com/library.
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In this part . . .

M uch of programming is about the details of business
logic — the rules of the program you are writing.

This part covers how to make decisions, do things more
than once, and use and reuse code that is already out
there, ripe for the picking, to make your job easier.
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Interpreting Strings and Things

In This Chapter

Finding out how Visual Basic stores the most basic of information

Manipulating information

Validating user input

Working with numbers and dates

Changing input from one type to another
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Fe core of an object-oriented programming language such as Visual Basic
is the movement of information. Some other programming languages spe-
cialize in maintaining a link with hardware, some specialize in the manage-
ment of machinery, but Visual Basic specializes in information.

How Visual Basic stores information internally is of great importance to you,
the developer. Words, numbers, digital pictures, and locations inside the
computer each have their own special types. These types all have their own
methods, properties, and events because they are treated as objects in Visual
Basic 2005.

In this chapter, I describe this feature of the language by showing how words,
numbers, and dates (all types) are treated when referred to in programs. I
discuss the functionality that an integer automatically acquires as part of a
program, and the cool things that you can do with text the user enters.

[ go over how to use types to your best advantage, too. For instance, valida-
tion of type is essential for making sure that the user enters the correct infor-
mation (numbers, text, and so on) into your application. You can also manip-
ulate information in interesting ways by using fantastic tools called regular
expressions.
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I briefly cover dates and date math in this chapter. There is a lot to under-
stand about dates. In order to get there, though, you need to start at the
beginning — by discovering the differences among types.

Changing one type into another is also covered in this chapter. For example,

you can handle changing a number to a word in several different ways. Some
of these methods are best used in specific situations, which I describe in this
chapter.

Types of Information in Visual Basic

Computer programs, at their most basic, have two kinds of storage: volatile
and non-volatile. Volatile storage is the storage that the program uses while it
is running; when the program stops, the stored information is gone. It is
physically stored in the Random Access Memory (RAM) of your PC.

Non-volatile storage is permanent storage, such as databases and text files —
I cover non-volatile storage in Part IV. Non-volatile information is usually
stored on the hard drive.

Volatile information is stored in “buckets” labeled by the kind of information
that can go in them. Words, numbers, and dates, for instance, are different
kinds of information. They are stored in volatile memory in buckets called
variables, which are sorted by type.

Some of the types of information you frequently need to store in variables
include the following:

v Text: Words are usually stored in the string type.
v Dates: Time and dates are stored in the DateTime type.

v Numbers: Numbers can be stored in several different ways — if you are
a math specialist, you’ll appreciate the Integer and Double types.
Integers are whole numbers, and doubles are fractions stored as decimal
numbers.

When working in Visual Basic, most of your programming time is spent writ-
ing the code to accept input from users, figure out what type to put the input
into, and putting it there.
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Understanding types in Uisual Basic

To create a new variable of a certain type in Visual Basic, you use the Dim
statement. Dim stands for dimension, and it refers to the old days when you
needed to set aside a parcel of memory to store the contents of the variable.
That is actually what is still happening, so programmers still use the term.
For instance, to declare a new string, you would code:

Dim MyNewString as String = "This is the content of my string variable!"

String values are surrounded by quotation marks. If you need to have a quo-
tation mark in a string, use two quotation marks; for example "I use the
word ""bucket"" too much in this chapter". Using two quotation
marks is called escaping the mark. Other type values, such as numbers and
dates, are referenced without quotation marks.

A string is an object, like all types, and sometimes the value of another object
is of a string type. This can get confusing when there are enough objects on
the page. Essentially, you only need to dimension a new string object when
you need to handle it individually.

The types, such as string and integer, available for use are many and varied.
Table 9-1 covers the most often used types. You should know that there are
more types, and that you can create your own.

Table 9-1 Intrinsic Types in Visual Basic
Type Description

Byte A single-digit number, such as 8.

Char Asingle character, such as r.

DateTime A date and time together, such as 3/4/2004 12:45:54 PM.

Double A decimal number, such as 4.534.

Integer A whole number, such as 56386.

Object Anything. An object type can hold anything in the .NET Framework.
String Words, such as This is a string.

When you get data from a user or another source, such as a database, it will
already have a type, usually string or Object. To use the data to do math,
for instance, you need to change that string or object into the Integer or
Double type. That is done with cType.
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Figure 9-1:
The
StringsAnd-
Things
example
application.
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Changing types with CType

CType is Visual Basic’s way of letting you change the type of a variable.
Seeing how this works is best done by using a real-world example. Follow
these steps to change the type of a variable:

1. Open Visual Studio 2005 and choose Filec>Newr>Project.

2. Select a Windows Application project, name it in the Name text box,
and click OK.

[ named mine StringsAndThings. You could also use a Web Forms pro-
ject for these steps.

3. Put two text boxes, a label, and a button on the default form, as
shown in Figure 9-1.

For this and all of the chapters in Part IlI, I leave the default names for
simplicity. Never, ever do this in a production application. It makes the
application hard for you to debug and impossible for someone else to

maintain.
a3 Form1 E]@
Label1
l

&

4. Double-click Button1 to create an onclick event handler.
5. Put the following code in the event handler for Button1i:
Labell.Text = TextBoxl.Text + TextBox2.Text

6. Press F5 to run the program.
7. Enter 4 in the first text box and 56 in the second text box.
8. Click Buttonl.

Whoops. Must be new math. 4 + 56 = 456? What happened?
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What happened was that the program concatenated two strings (put them
one after another) instead of added two numbers. Visual Basic assumes
that — because you didn’t tell it differently — the two pieces of information
entered into the text boxes were strings. This is usually a good assumption,
but in this case it was incorrect.

So what do you do? You need to tell Visual Basic that those values are inte-
gers. To do that, you use the aforementioned cType function. Try putting the
following code in the event handler for Buttoni:

Labell.Text = CType (TextBoxl.Text, Integer) + CType (TextBox2.Text, Integer)

The cType statement tells Visual Basic that it can expect integers from the
Text property of TextBox1 and TextBox2. When you run the application
again and enter the same values in the text boxes, you get the correct value
in the label when you click the button.

Some shortcuts to the CType statement are throwbacks to earlier versions of
BASIC:

v Cstr casts from an object to a string. (To cast is to describe the action of
using a CType.)

V¥ CInt casts from a string to an integer. You could use CcInt in the preced-
ing code line if you wanted to, as follows:

Labell.Text = CInt (TextBoxl.Text) + CInt (TextBox2.Text)
V¥ CDate casts strings to dates.
v CBool casts a string or integer to a Boolean — a true or false value.

v CObl casts anything to an object — useful if you are interacting with an
older language.

v CDbl casts types to a double, which is a decimal number.

Using a convert statement has certain implications, though. What happens if
the user enters a few letters or words in those text boxes instead of num-
bers? In that case, Visual Basic gives the error message shown in Figure 9-2.

Visual Basic throws an InvalidCastException error because you can’t
change a letter to an integer easily — or at all. As they say, you just can’t do
that.

So what do you do? You have to force the user to only enter integers in this
case. That is handled on the user interface side of things.
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Controlling types with validation

To restrain the user to entering only a specified type of information (integers,
in this case), follow these steps:
1. In the Design View, click on TextBox1.

2. In the Properties window, click the Events View button (it’s the one
with the lightning bolf), find the Validating event, and double-click it.

Visual Studio switches to Code View.

3. In the TextBox1l_ Validating event handler, enter the code that
makes sure the input is valid.

In this case, you want to make sure that the data entered is a whole
number, and a whole number only, by entering the following code:

If (TextBoxl.Text < "0" Or TextBoxl.Text > "1000") Then
MessageBox.Show("You must enter a number between 0 and 1000.")
End If

4. Go back to Design View and click on TextBox2.

5. Find the TextBox2_Validating event in the Properties window and
double-click it.
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6. Put the code from Step 3 in the TextBox2_validating event handler.
Change the references from TextBox1.Text t0o TextBox2.Text.

7. Press F5 to run the application.

8. After the application has started, type a few letters in the first text box
and press Tab to move to the next text box.

You get the error message you defined in Step 3. Note that this happens
no matter what causes the cursor to move away from the textbox, even
closing the application.

Of course, this is a very simple validation mechanism — there are several
more complex ways to handle validation (for instance, with global validators
or business logic), but this gets the job done in a lot of situations.

Making Words Work with the String Type

When you do want words, not numbers, you are dealing with the String
type. Traditionally, the BASIC languages — Visual Basic included — were
weak in string handling. Because of the .NET Framework backing up Visual
Basic 2005, many of those problems have disappeared.

The fantastic tools built into strings

When you declare a string and fill it, the string becomes an object with its
own methods, properties, and events. To get started using strings, open a
new Windows Forms application and add a button, two text boxes, and a
label as described in the earlier section, “Changing types with CType.” Then
add a title string to your program by following these steps:

1. In Design View, drag a second label to the form.

2. Double-click a blank part of the form to switch to Code View with a
Forml_Load event handler.

3. Enter the following code in the Forml_Load event handler:

Dim TitleString As String = "This is my sample program."
Label2.Text = TitleString

When you run the application, it should have a title on the form where you
dropped the second label. Now that you have a string object in your pro-
gram, you have the opportunity to look at some of the cool things that you
can do with a String object.
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For instance, look at the ToUpper method. Instead of Label2.Text = Title
String, enter

Label2.Text = TitleString.ToUpper.

The form shows the uppercase version of the string without changing the
original string! To replace a specified character with another character, use
the Replace method, as follows:

Label2.Text = TitleString.Replace("i", "!")

The string object has 46 methods, properties, and events built in, and all of
them are available to any declared string. Find out more by searching for
“String class, methods” in the Help files.

I would be remiss if I didn’t mention String.Format. It is a tool that is built
into the string type itself — not any particular string. It uses the string for-
matting basics that I discuss in Chapter 4, where you can refer to an argu-
ment with an ordinal. For instance:

MessageBox.Show (String.Format ("The text in Label2 is {0}",Label2.Text)

The ordinal in the curly braces refers to the first argument. If another argu-
ment followed the Label2.Text statement, it would be referred to as {1}.

Essentially, this is a yet another way to build text strings, just like concatena-
tion and the stringBuilder class. (For more about StringBuilder, see the
“Constructing strings with the StringBuilder class” section, later in this chap-
ter.) String.Format is great for building URLs in ASP.NET pages.

Emptiness — handling nulls

Because strings are objects, they can be set to various values that one would
not think of as strings. Primarily, these values are different ways to say the
string is empty.

For instance, one preset value is called string.Empty. What is it equal to,
you ask?

(]

Yup. Nothing. A whole property to refer to nada. Why? In case the value of
nothing changes. It is a little more elegant than coding MyString = "".
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The worst of these empty values are nulls, variables full of nothing, not even
zero or an empty string. Nulls come in two flavors — those assigned by the
.NET Framework, and those given to you by databases. The database nulls,
additionally, come in one flavor for each kind of database. (No, I am not kid-
ding.) I cover databases in Chapter 15.

The nulls used by the framework are pretty simple. Setting a string to the
value of null is just like saying that it equals nothing. Not String.Empty, not
" not 0, but actually nothing.

To check and see if a string contains a null value, you can use the IsDbNull
method built into Visual Basic. [ cover If-Then statements in Chapter 10, but
here is a preview:

If IsDbNull (MyString) Then
MessageBox.Show ("That string is null")
End If

Null values should frankly be avoided because of the need to check for them
at every turn. You don’t need to use null values to code good programs. In
the flow of your application, as I discuss in Chapter 3, make sure that all vari-
ables have a type and a value.

Finding Tools for Managing User Input

Continuing on the thread of discussing getting values from users, you may
need to manage the input you get from the users after the input becomes
values inside your system. Strings, especially, are subject to manipulation,
either by building new strings for output or by changing existing strings for
storage.

The stringBuilder class is a fantastic tool that was new for the .NET
Framework 1.0, and it has been updated for the 2.0 version of the .NET
Framework. It allows you to systematically make decisions about how to
make big strings out of many little strings.

Several high-end programming books are devoted entirely to regular expres-
sions, which is a special language devoted to handling string patterns. [ don’t
cover even 10 percent of what there is to know about regular expressions
here, but I give you enough information so that you can read a book about
regular expressions without being lost.



1 68 Part lll: Making Your Programs Work

Constructing strings with the
StringBuilder class

StringBuilder is a class that is designed to help you manipulate strings. Often,
is it used for creating output strings from various sources of input, such as a
database, an input file, or user input.

The stringBuilder class is part of a part of the .NET Framework that isn’t
included in the default project. In order to use it, you need to add a new line
of code to the very top of the Code View. The new line 1 will be:

Imports System.Text

You need to add this line because the stringBuilder class is really the
System.Text.StringBuilder class. In order to reference it, you need to use
the Imports statement. You can reference an object with the entire path, but
it’s simpler to just add the System.Text reference.

After you have that, you can create a new StringBuilder object in the code
for the Forml_onLoad event handler. Then you can build new strings!

The great little functions available in the sStringBuilder class include:

v Append: Adds the provided text to the end of the original string.

v~ Insert: Sticks the provided text into the original string at the specified
location.

v Remove: Takes a range of characters from the string.

v Replace: Similar to the Replace method I show in “The fantastic tools
built into strings” section, earlier in this chapter, this method replaces
specified instances of strings with the string you supply.

The stringBuilder class performs string manipulations that you can do
other ways. Howevey, it is a very elegant solution to a problem that you will
face all the time: Visual Basic programmers must constantly stitch strings
together, and then go back and make changes based on changed require-
ments. The stringBuilder class makes implementing changes to strings
easier if you use it to start with.

For instance, take a look at the code that you could use to construct a new
title string, as described in the earlier section, “The fantastic tools built into
strings.” Replace the lines of code that assigns the title
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Dim TitleString As String = "This is my sample program."
Label2.Text = TitleString

with the following lines:

Dim sb As StringBuilder = New StringBuilder
sb.Append ("This ")

sb.Append("is ")

sb.Append("a ")

sb.Append ("title.")

sb.Insert (10, "new ")

Label2.Text = sb.ToString/()

This code writes a title in Label2 that reads “This is a new title.” The Insert
statement puts the word “new” in the middle of the string — something that
is notoriously difficult to do in the course of programming logic. The String
Builder class does this for you — and does it faster and better than any
other method.

Manipulating strings with
regular expressions

After a string is built, you often find the need to search or modify the string.
Regular expressions, a traditional part of the Perl language, are a complex way
to manage strings using fantastic, intricate, innovative coded strings to
describe that you need to change.

Regular expressions are based on patterns. Patterns are just what they sound
like — combinations of characters that are recognizable by a definition, such
as [a-z] for all lowercase letters. The complexity comes in when you try and
make the definition.

Regular expressions are used for a number of wonderful things:

v Searching a string for values, right within your code.
v Editing strings using a pattern.
v Validating user input against values too complicated to be shown as a

string.

Two major components make up a pattern:
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v~ Literals: Exact representations of a string that you are looking for — like
the example in the “Controlling types with validation” section, earlier in
this chapter. “0” is a literal, as is “1000.”

v Metacharacters: Descriptions of categories of characters.
Metacharacters are normally defined by using square brackets and
dashes. For instance, the range of numbers from 0 to 1000 would be
described as “[0-1000]".

The original validation code for the text boxes given earlier in this chapter in
the “Controlling types with validation” section is as follows:

If (TextBoxl.Text < "0" Or TextBoxl.Text > "1000") Then
MessageBox.Show ("You must enter a number between 0 and 1000.")
End If

To use regular expressions for this example (make sure that you have
Imports System.Text as the first line of your code), the code becomes:

Dim myPattern As New RegularExpressions.Regex("[0-1000]")
Dim theMatch As RegularExpressions.Match = myPattern.Match (TextBoxl.Text)
If not theMatch.Success Then
MessageBox.Show ("You must enter a number between 0 and 1000.")
End If

This example is five lines of code, while the previous example is only three
lines, but these five lines of code are more elegant. For one thing, the value in
the Regex method is just a string, so you can more easily define the pattern
that you want to match on the fly, with code or even user input from another
screen. That gives you much more flexible validation.

Regular expressions aren’t just for validation, either. For instance, you can
split a string using a pattern, breaking another string into parts using the
characters and metacharacters specified in the pattern.

You can also replace characters using a pattern. The Replace method of the
Regex object tells the string, “Hey, replace anything that matches this pattern
with this new text.” This is astonishingly powerful, as [ am sure you can imag-
ine. When working with data manipulation, you are constantly asked to
change large strings. “Replace all integers with an X” is a common one. The
following code actually works:

myPattern.Replace (newString, "[0-9]", "X")

[ spent one section on a topic that could — and does — fill an entire book. If
you are into string manipulation, regular expressions will be a powerful tool
for you. For more information, look for a book about Perl or search for “regu-
lar expressions” online.
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Things That Aren’t Strings —
Numbers and Dates

Though you spend most of your time in Visual Basic with words and strings,
sometimes you need to work with other types. Numbers and dates have a big
place, and they are fairly tough to work with.

Integers and reals and imaginavies,
oh my!

Numbers are covered by a whole host of types. For the purpose of this dis-
cussion, I cover only two — whole numbers and decimals. Whole numbers
use the Integer type. Decimals use the Double type.

Numbers are really fairly simple — the main thing to remember is that unlike
strings, you do not refer to them using quotation marks. When setting a vari-
able equal to an integer or a double, you just directly refer to the number, as
follows:

Dim myInteger as Integer = 65
Dim myDouble as Double = 6.555

Any number type can be manipulated with operator symbols, as shown in

Table 9-2.
Table 9-2 Operators
Operator Description
+ Addition
- Subtraction
* Multiplication
/ Division

% Modulo (The remainder of a division)
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To add two numbers using an operator, you build code that looks just like
the code used to concatenate the input from two text boxes, as described

in the earlier section, “Changing types with CType.” It is just myAnswer =
myNumber + myDouble. Numbers of any sort can usually be added together,
as long as the variable for the answer is of a type that can handle it. In this
case, myAnswer has to be a Double type, or the numbers after the decimal
point in myDouble will get lost.

Just like all of the great tools that are built into strings, numbers have a few
built-in methods that assist with making sure they are as expected. For
instance, the Integer type has a Maxvalue and Minvalue method, so you
can make sure that an operation won’t overload the variable.

Variables are just memory locations and have a specific amount of space allo-
cated. Integers can only be between -2,147,483,647 and 2,147,483,647. This
sounds like a big range for numbers, but you will be surprised how easily you
can overwhelm that range.

Doubles have a few other methods that represent wild math values. You can
test for values that represent PositiveInfinity, NegativeInfinity, and
Epsilon — that wonderful number approaching zero but not reaching zero
that your freshman year calculus teacher kept talking about. Because all of
these imaginary numbers are possible outcomes to mathematical equations,
it is great to be able to test for them.

Working with dates and date math

Dates are a whole different story. Not only do a whole separate category of
applications use dates — as compared with heavy numerical applications —
but it takes a different mindset to use the bateTime types in Visual Basic.

Let me start with one straightforward fact — whether you need a date or a
time or both, Visual Basic essentially stores the whole bunch in a single type.
The type that you use most often is DateTime; as you may expect, it holds
both a date and a time.

In Part II, [ show you date math by building the Date Calculator program that
finds the difference between two dates using a method built into the DateTime
type, just as you use the Toupper and ToLower method to manipulate the
content of the string variable.

The DateTime type has a blue million built-in methods. The following list
describes just a few of the most powerful:
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v add: You can add any type of span to a date in a DateTime type. For
instance, Hours, Minutes, and Days are some of the spans available in
the Add method.

V¥ Component: The Component properties allow you to just get a part of a
DateTime. For instance, the Month property gets just the month out of a
date.

v Conversion: The Conversion methods help you to get a date to
another common format. For instance, the ToUniversalTime method
converts the date in the DateTime object to UTC universal time —
handy for international applications.

In addition, a few methods and properties don’t fall into any category; instead,
they do something specific. For example, the IsDaylightSavingsTime deter-
mines if the date is dependant on Daylight Savings Time in the United States.

To get a better idea of how the DateTime type works, take a look at the chap-
ters in Part II.  used it extensively while designing and building the Date
Calculator application.

You can find a lot more to dates than this, though. For instance, to get the
current date in a DateTime variable, you can use the Now function, as in the
following code line. It gives you the current date down to the nanosecond.

Dim myDate as DateTime = Now

It is also possible to get the string representations of dates and times. For
instance, say you need the name of a month that you uncovered using one of
the Component categories of DateTime type methods. The MonthName func-
tion gives you a string back that contains the actual name of the month:

Dim MyMonth As Integer = 4
Dim Name As String

Name = MonthName (MyMonth)
MessageBox . Show (Name)

You get a message box that says “April” — a very handy tool for user inter-
face creation, because users don’t want to see a number, they want to see a
word!

One last thing on dates — format providers give you the ability to show dates
in any wonderful way you want. The DateTimeFormatProvider is a global
tool that allows you to format dates in a flexible, universal way. The most
common way to use the format provider is with the ToString method. The
following code returns “Saturday, August 7, 1971 12:00:00 AM”:
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Dim myDate As DateTime = "8/7/1971"
MessageBox.Show (myDate.ToString ("F"))

Some of the other format providers for dates include those in Table 9-3.
Notice that the case of the value used in the ToString method is important.
More can be discovered by searching for “DateTime.Parse method” at the
MSDN Library Web site.

Table 9-3 DateTime Format Providers
Format Provider Example Output

d 8/1191

D Saturday, August 7, 1971

g 8/7/1971 12:00 AM

G 8/7/1971 12:00:00 AM

s 1971-08-07T00:00:00

Y August 1971

Changing Types with Parse and TryParse

Farse is a term used by system architects when they need to get something
from one format to another, but they don’t really know how. In Visual Basic,
the Parse and TryParse methods give you a way to get a value into a new
format while controlling exactly how it is done.

To use the parse method, you need to understand something complex about
Visual Basic — types are objects, too. Just as a variable can be declared as a
DateTime type, the DateTime type itself is an object of Type type. That
means types have their own methods, properties, and events.

Note that every object has a Tostring () method. The ToString () method
isn’t always what it seems. Ostensibly, it is designed so that you can see the
object as a string, but it isn’t always obvious what should be shown when
you ask for a string version of an object (such as the Tostring () method
of a Graphics object, for example). Don’t depend on the ToString ()
method — use Parse, ConvertTo, or CStr instead, and allow the system to
throw an error if it gets confused. Better that than bad data.
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One of the most common problems is taking a string from the Text property
of a TextBox and making it into a usable type such as a date. When someone
enters “8/7/1971” into a text box, it is just a string, not a DateTime type.
Strings are useful, but you can’t add a number of days to a date entered as a
string because according to Visual Basic, it isn’t a date!

To make, for instance, a string into a date, you use the pParse method of the
DateTime type. Logically, you follow a number of steps:

1. Get a date as a string, myString, from a database or user input.
2. Declare a new DateTime called myDate to handle the new date.

3. Use the DateTime.Parse method to make a new DateTime variable
from the string, as follows:

Dim myString as String = "8/7/1971"
Dim myDate as new DateTime
myDate = DateTime.Parse (myString)

The TryParse method is very much the same, but it is more useful if you
aren’t sure that the value in myString is a date. Because TryParse doesn’t
return a value, but instead accepts a value such as a subroutine, it will not
throw an error if the value in myString is not able to be parsed. Instead, it
will return a null. The following code shows what the preceding code would
look like using TryParse:

Dim myString as String = "8/7/1971"
Dim myDate as new DateTime
DateTime.TryParse (myString, myDate)
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Chapter 10
Making Decisions in Code

In This Chapter
Diagramming program flow
Directing flow with If-Then statements
Choosing with Select-Case statements

Handling exceptions with Try-Catch statements

Fey don’t call the code in business applications logic for nothing. Many
applications that you write in Visual Basic involve logic, and much of
logic involves making decisions. In fact, making decisions represents the
single most important process in business. You can’t proceed with producing
business applications without understanding the complexities of replicating
the human decision-making process using Visual Basic 2005 code.

In this chapter, I give you a design procedure to follow when describing a
business process for your applications. This process, which is a derivative of
basic flowcharting, assists you in all decision-making designs — not just pro-
gramming code.

Then I show you how to work with the three decision-making tools in Visual
Basic — single process, multiple choice, and exceptions — which are utilized
in the Visual Basic code by the 1f-Then-Else, Select-Case, and Try-Catch
constructs, respectively. You see how these three constructs can be used to
assure that your business applications most closely replicate the human
decision-making processes you are trying to replace.

Designing Business Logic

I have a client who describes all business process logic as those if-then-goto
diagrams. Given the number of degrees this client has under his belt, I always
assumed that he really knew what he was talking about. And [ was right!
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When I showed this gentleman a four-page, sophisticated process flow (the
diagrams I present in this chapter), he picked out the only flaw in my logic in
about 15 minutes. (Wouldn'’t I love for all my clients to think like that.)

[ use this example to illustrate that outlining the business logic is the single
toughest situation that a programmer deals with on a daily basis. The busi-
ness logic serves as the basis for the mechanical code between the user
interface and the data in an application. This code determines how the user
views the information he or she is after, and how that information gets manip-
ulated when saved.

Before I delve into each example of code in the following sections, I discuss a
process for designing business logic using a flowchart. I go over the basics of
application design in Chapter 3, but the problem of logic design is a specific
situation that not all business applications encounter.

The reason for using a flowchart to describe business logic is straightfor-
ward. Modeling the processwdecision=>direction system using a flowchart is
exactly what you will need to do when modeling program logic. Even with a
large system, it benefits you as the programmer to model complex loops and
decisions using flowcharts.

Depicting Logic with Flowchart
Components

A flowchart is a “pictorial representation of an orderly step-by-step solution
to a problem,” according to Indiana State University. | couldn’t agree more. A
flowchart is simply lines that connect three structures representing commu-
nication, processes, and decisions. Flowchart magic — that is, the business
or application logic — is depicted by how you combine these components
(also known as nodes).

For example, a comprehensive flowchart that describes a morning routine
might look something like Figure 10-1. This particular flowchart uses the
process and decision components, depicted by rectangles (like Wake Up) and
diamonds (like Shower last night?), respectively. Obviously, this morning rou-
tine is something that you would not replicate in code, but because you have
hopefully performed a similar process in the last 24 hours, it makes a great
example!
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Wake Up

Shower last

night? Shower
If anything goes
wrong, go back to
Brush teeth bed.

Hot chocolate
maybe?

Drink cola

|
Figure 10-1:
The wake-
up routine
asa . . Drink hot
flowchart. Drink coffee Drink tea chocolate

Communicating with the user

Of the three components of an application flowchart, communicating with
the user becomes the part of the program visible to the outside world. To the
user, this communication may come across as a message written to the
screen, or a printout. Program flow for user communication is represented by
a box with rounded corners, as in the In/Out diagram shown in Figure 10-2.

Your program successfully communicates with the user when the following
happens:

v The output is tangible.

v The program produces a printout, even if it’s just printed to the screen.

v The user would expect feedback from the program at this point.
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Are there two
numbers?

Multiply
them
|
Figure 10-2:
Communi-
cation with Show them to
the user. the user
|
Defining the process
A process component of a program flowchart depicts a block of code that
handles a single interaction with an entity. For example, acquiring input from
the user or updating the database are processes that may be depicted in a
flowchart. Process components (like the drinking processes from the morn-
ing routine depicted in Figure 10-1) are represented by rectangles, as shown
in Figure 10-3.
|
Figure 10-3:
Morning Drink Drink Drink hot
routine coffee tea chocolate
processes.
|

The following three characteristics identify a process component:

v The node has no output.
v~ It represents a business rule.

v It describes a function that would usually be performed manually.



|
Figure 10-4:
Morning
routine
decisions.
|
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Making a decision

The core of the flowchart is the decision component, which has associated
branches that allow the chart’s flow to change direction. Branching (that is,
following a branch in the flowchart) is that magic that adds flexibility and
substance to the program logic. Without decisions to make, the flowchart is
just a list of things to do (processes) and stuff to show to (or ask of) people
(communication).

The decision node is physically very simple; it’s a diamond in the diagram
that requests a yes or no answer. Figure 10-4 shows the decision diamond
and its branches. One branch comes in with the input, and two branches go
out — one for yes and one for no.

Hot chocolate
made?

A decision component

v Has one input and two outputs
v Is phrased as a question (like a contestant’s “answers” in Jeopardy!)

1 Requires a feat of logic to pass the node

You can think of the decision component as management input to the normal
processes of business. Suppose you have a bunch of staffers who perform a
set of processes day in and day out. If this group suddenly needs to deal with
a single unusual decision, a multiple-choice question, or an exception, it may
call in the managers to make a decision. Such a situation would constitute a
decision node in a human process flowchart.

A computer process has similar decision-making situations, which you can
divide into three categories:

1 Single process: A simple “If this, then that; else go on as usual” sort of
decision. An example of a single-process decision would be driving on
the highway: “If the car in front of me stops, then I should hit my breaks;
else I keep going.”
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v Multiple choice: A process that has a lot of options. “If she wants it blue,
then buy blue paint; if she wants it green, then buy green paint; if she
wants it red, then buy red paint; else drink beer.”

v Exception: A special kind of single process. This is a decision when you
didn’t want to make a decision. “Go on as usual. If it breaks, call the
manager.”

Implementing These Processes
in Uisual Basic

|
Figure 10-5:
The single
processina
flowchart.
|

To describe the processes in code, you need to know what the processes
looks like in a diagram. Properly designed, the diagram tells you what you are
describing in code.

Single process

The single process is fairly simple — a single decision, isolated within a flow,
is usually a single process. There are some cases where you are actually
looking at an exception. Largely though, if you are looking at an image like
Figure 10-5, it is a single process.

Shower last

night? Shower

Brush
teeth

Single-decision processes execute a block of code if a statement is true. In
Visual Basic, you need to provide the program’s decision point with a
Boolean statement — that is, something that can be evaluated either true or
false — in order to decide whether the code is to be executed. For example,
check out these steps for a quick single-decision project:
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1. Open Visual Studio and create a new Visual Basic 2005 Windows
Application project.

2. Drag a Textbox control and a Button control from the Toolbox to the
form.

3. Double-click the Button control to have Visual Studio generate its
onClick event handler.

4. In Code View for the onclick event handler, add the code that gives
your program a single decision to make.

In my example, | add the following code to display a message box if the
right word is typed into the text box.

If TextBoxl.Text = "Showered" Then
MessageBox.Show ( "Brush Teeth!")
End If

Notice that this code shows an If statement followed by an End If state-
ment. An If statement requires an End If statement only when you have
multiple statements to execute. A single statement can be put on one line,
like so:

If TextBoxl.Text = "Showered" Then MessageBox.Show("Brush teeth!")

But in general, the control-flow statements in Visual Basic have a start and an
end line. Also, the start line (the 1 £ condition is this example) can become
more complex. If either of two possible answers can cause the message box
to show, you can generate a Boolean statement by hooking together exactly
two statements with a conditional operator.

For example, if you want to support showers or baths, then the code can be
written as follows to mimic the English in this requirement:

If TextBoxl.Text = "Showered" OR TextBoxl.Text = "Took Bath" Then
MessageBox.Show ("Brush Teeth!")
End If

It is possible to link two conditional If statements together. Use two linked
If statements when two possible results to the decision can cause two differ-
ent lines of code to be executed in an exclusive way. You can link two condi-
tional If statements together with an E1se statement, which works just like
the English “If this, then that; else the other.”

The Else statement is for the “No” branch on the decision box in your flow-
chart. An Else statement shows up in the following code:
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|
Figure 10-6:
The
multiple-
choice
process.
|

If TextBoxl.Text = "Showered" Then
MessageBox.Show ("Brush Teeth!")
Else
MessageBox.Show ( "Shower. ")
End If

You can also link together several If-Then-Else statements to handle a multiple-
choice process. The E1seIf statement can help with that, as follows:

If TextBoxl.Text = "Showered last night" Then
MessageBox.Show ("Brush teeth!")

ElseIf TextBoxl.Text = "Showered two nights ago" Then
MessageBox.Show ("Shower again!")

Else
MessageBox.Show ("Shower!")

End If

This example is startlingly like the next in a series of conditional statements
that are available in Visual Basic — proving once and for all that you can
accomplish the same task in more than one way in Visual Basic. For many
multiple-choice environments, the best choice in code is the Select-Case
statement.

Multiple choice

Multiple-choice processes are equally obvious to code if you are very honest
in your diagram. The fact is that few designers are honest enough to write a
diagram like that shown in Figure 10-6. This tiered structure, though, is the
unquestionable signature of a multiple-choice process.

Drink
cola

Hot chocolate
made?

Drink Drink Drink hot
coffee tea chocolate




\\3

Chapter 10: Making Decisions in Code ’85

Effectively, this diagram shows several single-process diagrams in a row.
Visual Basic 2005 provides you with a structure that handles this kind of situ-
ation. A good software design takes advantage of as much of the language in
question as possible.

Whereas an If-Then-Elself statement evaluates a number of different answers,
the Select-Case statement evaluates the same variable against a number of
possible answers.

For example, the If-Then-Elself statement shown in the previous section com-
pares the same text box to two different values. It could have just as easily
compared two different text boxes to two different values.

The Select-Case statement is designed to compare the same variable to sev-
eral possible values. The following code shows how to write a Select-Case
statement that accomplishes the same thing as an If-Then-Elself statement.

Select TextBoxl.Text
Case "Coffee Made":
MessageBox.Show ("Drink Coffee!")
Case "TeaMade":
MessageBox.Show ("Drink Tea!")
Case "How Chocolate Made":
MessageBox.Show ("Drink How Chocolate!")
Case Else:
MessageBox.Show ("Drink Cola!™")
End Select

The code in a Select-Case statement can do exactly the same thing as the
code in an If-Then-Elself statement (as in the preceding code and the code
shown in the previous section), but the Select-Case statement is much easier
to read, and it actually runs a little faster.

You can also put a comma-delimited list of values in each case to give almost
a two-dimensional grid feel to the process. Using a comma-delimited list that

way is pretty slick, and an elegant way to code the multiple-choice process as
designed in the preceding code.

The Select-Case statement isn’t the only process that is similar to the If-Then-
Elself statement. Another process is the exception process, where you find
yourself writing a flow that says, “Try to go on unless something goes wrong,
then do this.” In VB 2005, this is called a Try-Catch statement.
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|
Figure 10-7:
How |
handled an
exception.
|
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Exception

The exception is a special case of the single-process model. When you’re writ-
ing a flow, and you suddenly need to put in a process that says “If this isn’t as
expected, do that,” you’re dealing with an exception. Figure 10-7 shows what
an exception looks like in a flowchart.

If anything goes

wrong, go back to
bed.

An exception is different from an error. An error is a flaw in one of the layers
of an application — for example, a bad database row or a failed network con-
nection, or in the worst case, an error is a bad piece of code. An exception is
an expected error. It is something that you figure might happen, though you
don’t want it to, and you have a piece of logic to deal with it. For more about
exceptions, see Chapter 12.

The Try-Catch statement is different from the other two decision structures.
It assumes the following:

v You have a list of processes that you want to perform.
v You want to redirect the process flow if there is an error.
v There are processes to follow if an error is encountered.

The Try-Catch statement is best for that process that is hard to diagram —
“Do this unless something goes wrong, then do that.”

The list of things to do goes under the Try statement, and each expected
error goes with a Catch statement. Each Ccatch statement includes the
process that is to be run if that catch statement is reached. If there are no
errors, the code in the catch statements is ignored.

The following code shows an example of a Try-Catch statement based on
Figure 10-1, just to keep things consistent. The MorningRoutine function
would consist of all of the decision code in the chapter so far.
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Try

MorningRoutine ()
Catch somethingWentWrong as Exception

MessageBox.Show ("Something went wrong - go back to bed")
End Try

The following code is a much more common use of a Try-Catch statement.
Notice how I use the Message property of the exception that is caught to tell
the user what went wrong:

Dim smallNumber as Integer
Dim largeNumber as Integer
Try
smallNumber = 4534
largeNumber = 7654
largeNumber = smallNumber * LargeNumber
Catch badNumber as InvalidCastException

MessageBox.Show ("The number was bad - " & badNumber.Message)
Catch somethingElse as Exception

MessageBox.Show ("Something else went wrong - " & somethingElse.Message)
End Try

The exceptions that make up the catch statements are an exciting part of the
.NET Framework, and a little beyond the scope of this chapter, or even this
book. When something unexpected happens, such as an error, the framework
throws an exception, and that exception is what you are catching with the
preceding code.

I should mention Finally. After a Try-Catch statement, sometimes you need
to do things no matter whether there was an error or not. If that is the case,
put the code in a Finally statement. For instance, if you are dealing with a
database, you should close the connection to the database on success or fail-
ure. That instruction would appear in a Finally block, after your last catch
block.

There are hundreds of exception types, and you can write your own. For
more on exception management, see Chapters 8 and 12; for further research,
search for “Exception Management” in the MSDN library.
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Chapter 11
Getting Loopy

In This Chapter
Confirming the concepts of counting in code

Digging into your looping options

' here are two kinds of control structures in Visual Basic — decisions and
loops. In Chapter 10, I cover decisions, which are all about branching the
flow based on some input to the program.

Looping, the second type of control structure, is about repeating the same
command (or series of commands) until a certain condition is met. Business
applications, especially, have to repeat program logic for a certain amount of
time or a certain number of iterations — resulting in the programming equiva-
lent of “lather, rinse, repeat.” Of course, you wouldn’t want to wash and rinse
your hair all day, so this phrase really should read “lather, rinse, and repeat
once.” A sequence of events like this is analogous to a looping structure —
known as the For-Next loop — in a Visual Basic program.

Programmers often use looping and decisions together. Visual Basic provides
a construct for that, too. The Do-While loop is an example of this — the pro-
gram loops through a command or series of commands (the Do part) as long
as a certain condition (the While part) is true. As soon as the condition
becomes false, the looping stops.

In this chapter, I go over the design and code for the four kinds of loops in
Visual Basic 2005:

v For-Next

v For-Each

v Do-Until

v While-End
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All of these looping control structures have some common characteristics.
They repeat a block of code, and they make a decision about when to stop.
The differences among them are completely based on counting logic.

Dealing with Zero

Making decisions about which loop to use is tough. Using the wrong loop can
significantly change the processing of the program, and it can really mess up
the user experience. So this section helps you determine which looping struc-
ture to use and where to start counting your loops.

Starting at zero

Everything important about loops can be broken down by looking at count-
ing. Ever tried to count the number of hours between the end of lunch and
the end of the workday? You count, “one o’clock, two, three, four, five! Five
hours!”

But your workday afternoon isn’t five hours long, it’s four hours long. In
order to count the right number of hours, you need to skip the first time
increment. What you need to count are the spaces between hours, as follows:
“One to two, two to three, three to four, four to five. Four hours.”

Looping through code in a program is similar: If you're counting the spaces
between the numbers, you skip the first number. That is, you always run the
loop the first time, and then check the condition at the end.

Figure 11-1 shows two diagrams. The one on the right is the wrong way to
count the hours after lunch. This diagram starts counting at 1:00 PM. The dia-
gram on the left starts counting at 2:00 PM, which is the same as counting the
spaces between the numbers.

Compatring specific loops and

indefinite loops

Another difference among the different types of loops is whether the loop
repeats for a specific number of times or repeats for an indefinite number of

times. A specific loop is looped a definite number of times; an indefinite loop
makes a decision, either at the beginning or the end of the loop, to stop.



Chapter 11: Getting Loopy ’9 1

Start at 1PM Start at 1PM
Increment hour Yes
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Y
Increment hour
|

Figure 11-1:
Two looping
|

A'loop that runs a specific number of times is like “ten lashes with a wet
noodle.” This concept is implemented with a For-Next or For-Each loop.
Effectively, you are translating the example to, “For each in a collection of
ten, lash with a wet noodle.” This example is shown in Figure 11-2. That
seems a bit overboard, but it makes a lot of sense in context.

l No
I
Figure 11-2:
The iterative | Do the process process run 10 Yes>
loop. i ?
I

A'loop that has an indefinite quantity is like “lather, rinse, repeat.” How many
times to repeat? Well, that’s the joke in the example — you don’t know. You
assume that it means repeat until clean, but you don’t really know.

Assuming that the goal is to repeat until clean, you're back to the counting
problem. Do you assume that it is dirty, and then start with the lather? Or do
you check first before you lather the first time? Figure 11-3 shows you how
Figure 11-1 could be changed to show those two options for the shampoo
example.
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|
Figure 11-3:
Lather,

rinse,
repeat.
|
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Writing Loops with For-Next

\\J

The For-Next loop is an iterative loop. At the beginning of the loop, you
define a quantity, and the loop repeats that many times. When the loop is
done repeating, the code after the loop runs. The following is an example of a
simple For-Next loop that shows the number in a message box:

Dim Counter as Integer
For Counter = 1 to 5

MessageBox.Show ("The number is " & counter)
Next Counter

You can do a lot with a For-Next loop. Whenever you are manipulating some-
thing a set number of times, you need to make sure something happens a set
number of times, or you must retrieve a set number of items from a group,
this is your loop.

For-Next loops can do a few neat tricks, too. For instance, imagine that you
need to do something to every other line of a collection. You could test in the
middle of the loop to see if your counter is even, or you could use the Step
statement like I do in the following code:

Dim Counter as Integer

For Counter = 2 to 10 Step 2
MessageBox.Show ("The number is " & counter)

Next Counter
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This codes block shows you 2, 4, 6, 8§, and 10 in the message box. Pretty slick.
You could use this to access every other item in a collection by using
Counter in the collection index.

Also, the step statement can be used to count backwards, like I show in the
following code. When you do this, make sure the first number is bigger than
the second, or the loop won’t run at all!

Dim counter as Integer

For Counter = 5 to 1 Step -1
MessageBox.Show ("The number is " & counter)

Next Counter

As I'm sure you guessed, this code gives you 5, 4, 3, 2, and 1. | suppose this
adds another use — counting down for a rocket launch or something.

One last thing about For-Next loops: Sometimes you need to get out of a loop
before the loop is done. This situation usually happens when the start and
end values are variables, and you don’t know going in exactly what they are.

For example, say you don’t want to go below 0 in the following example. You
can use an If-Then statement and an Exit-For statement to stop the loop.

Dim Counter as Integer
Dim startValue as Integer = 5
Dim endValue as Integer = -1
For Counter = startValue to endValue Step -1
If counter < 1 Then Exit For
MessageBox.Show ("The number is " & Counter)
Next Counter

This code will stop when the counter gets to zero and moves to the line after
the Next Counter statement.

Using the For-Each Listing
with Collections

A collection is a special construct of the .NET Framework that contains a
number of objects and is accessed with an index that refers to the item in the
collection. Although a collection isn’t found only in the Windows world, the
specifics are rather unique to the .NET Framework.
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|
Figure 11-4:
The
For-Each
example
form.
|

[ don’t have enough space in this chapter to go into the specifics of collec-
tions. You see them in examples in the book, usually as a plural property of
an object. For instance, all of the controls in a form (such as buttons and text
boxes) are held in a collection called ControlCollection.

The collection is implemented using an interface called IEnumerable. This
library of code specifies that the code using TEnumerable must be able to be
iterated using the For-Each listing. If you need to know whether you can use
For-Each to iterate through a collection, look at the documentation of the
object to find out if it implements IEnumerable. For instance, the control
collection — which is iterative — looks like this in the documentation:

Public Class Control.ControlCollection _
Inherits ArrangedElementCollection _
Implements IList, ICollection, IEnumerable, ICloneable

To loop through the control collection using the For-Each listing, you need
to set up a little sample application by following these steps:
1. Open Visual Studio and start a new Windows Application project.
2. Drag four text boxes to the form.
3. Drag a button to the form.
The application should look like Figure 11-4.

a5l Form1 E]@

4. Double-click the button to fire up the onclick event handler.
5. Add the following code to the method created:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
For Each myControl As System.Windows.Forms.Control In Me.Controls
If myControl.GetType Is TextBoxl.GetType Then
myControl.Text = myControl.Location.ToString
End If
Next
End Sub



Chapter 11: Getting Loopy ’ 95

6. Click the button to start the code in the method.
7. Note that the text is changed in each of the text boxes.

Although you didn’t tell the loop how many times to run, it was still a con-
strained number of times, because the collection contains a discrete number
of form controls. Also notice how I further isolated the number of controls
acted upon by checking the type in the loop with an If-Then statement.

Why did I have to do that, you ask? Because there is no collection of text
boxes, just a collection of form controls. If you only want the TextBox con-
trols, you need to filter using an If-Then statement like I did.

Writing Indefinite Loops with Do-Loop

Indefinite loops are loops that aren’t counted, but that continue infinitely until
something happens. Indefinite loops are a little tougher to write, because two
things can happen to lock up your application — forgetting to move to the
next item in a group, or setting the criteria for when to stop the loop to a con-
dition that will never be true.

You can use the Do-Loop in four ways:

v Loop while something is true, checked before you start.

v Loop while something is true, checked after the first iteration.

v Loop until something becomes true, checked before you start.

v Loop until something becomes true, checked after the first iteration.
The Do-Loop is by far the most flexible looping construct because it handles

almost everything. In fact, with a counter that you manually increment, a
Do-Loop can replace a For-Next loop.

Generally, though, programmers use the Do-Loop as a last resort because it is
so prone to error. A Do-Loop is so very broad that it is very easy to create a
situation where the loop would end prematurely, never run, or go on end-
lessly.

The Do-Loop is a very useful construct, however, and worth learning to use
well. I discuss each of the four options, first in a flowchart, and then in code.
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Figure 11-5:
Running

a daily
process for
the month of
December.
|

Do-While loop, checked at start

The following example of using the Do-While loop describes running a routine
for every day in a month when you aren’t sure if you are in the month you
want. For instance, say you had a process that you wanted to run once for
every day of the month, but only in the month of December. Charted out, this
would look like Figure 11-5.

Is it December?

o)

Run the process

Running this would look like the following code:

Dim myDate as DateTime = Date.Now ()

Do While myDate.Month = 12
RunTheProcess ()
myDate.AddDays (1)

Loop

Do-While loop, checked at end

To take the opposing perspective of this daily-process example entails a
process that you know you always want to run once, no matter what the
month. For instance, say the process runs at least once for every month, in
every month, and you just want the loop to stop when the day counter doesn’t
fall in December, as shown in Figure 11-6.
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Building Figure 11-6 in code would look like the following:

Dim myDate as DateTime = Date.Now ()
Do
RunTheProcess ()
myDate.AddDays (1)
Loop While myDate.Month = 12

Do-Until loop, checked at start

Following along with the date theme, say you have a process you want to run
every day of the week until Saturday. If it starts on a Saturday though, it
shouldn’t run at all, right? So the logic reads like this: “Run the routine once
for every day until Saturday.”

Running this would look like the following code:

Dim myDate as DateTime = Date.Now ()

Do Until myDate.DateOfWeek = DayOfWeek.Saturday
RunTheProcess ()
myDate.AddDays (1)

Loop

197
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Do-Until loop, checked at end

You can run the routine at least once every time, and run it until the day
shows as Saturday. This means if it starts on a Saturday, it would run until the
next Saturday, meaning eight days total. Maybe that is what you want — but
make sure first!

Running this would look like the following code:

Dim myDate as DateTime = Date.Now/()
Do
RunTheProcess ()
myDate.AddDays (1)
Loop Until myDate.DateOfWeek = DayOfWeek.Saturday

Chectking at the Beginning with While

In the code in the “Do-While loop, check at start” and “Do-While loop, check
at end” sections, you can see the while statement in the Do-Loop. Why, then,
is there a While-End loop?

The difference is the Exit wWhile statement. It isn’t possible to exit a Do-Loop.
The While-End loop can be exited like a For-Next loop can by using the Exit
While statement. Other than that, as you can see in the following code, the
differences between a Do-While loop and a While-End loop are minimal.

Dim myDate as DateTime = Date.Now ()

While myDate.Month = 12
RunTheProcess ()
If MyDate.DayOfWeek = DayOfWeek.Saturday Exit While
myDate.AddDays (1)

End While



Chapter 12
Reusing Code

In This Chapter
Writing functions and subroutines for reuse
Reusing code versus keeping it simple
Taking advantage of existing programs
Talking to DOS

A lot of functionality is floating around out there. Old VB 6 programs, DOS
apps, other people’s DLL files, and even module files that the last pro-
grammer left are all potential sources of code to reuse for your new VB 2005
application.

In Chapter 6, I show you how to write library programs, called Dynamic Link
Libraries, or DLLs. And although I recommend a DLL as the project type to
turn to when you need to write reusable code, it is far from the only way to
reuse your code’s functionality. You can also create reusability by writing
functional code within your programs themselves. That is, you can easily add
helper subroutines and functions to your programs without having to use a
DLL project.

A program that is losing prominence but is still out there is the old Disk
Operating System, or DOS. Many people who started with early personal
computers still swear by the command line interface. Admittedly, some
things are much easier using the command line, and .NET allows for touching
the old DOS commands right from your VB 2005 code.

In this chapter, I cover how to get values into and out of functions and sub-
routines. You also find out where to find the hooks for outside programs and
when to use DOS.
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Reusing Code to Build Software

Every piece of code in any program in Visual Basic must be inside a proce-
dure like a function or a subroutine. The event handlers that show up
throughout the programs in this book (see Chapters 4 and 5 for examples)
are all functions. However, controlling program operation by using event han-
dlers is not the only way to build software. Moving repeated code — that is,
the same lines of code that show up in more than one event handler — into
auxiliary procedures is the accepted way to build applications. The reason
for this is simple: Debugging and maintaining an application that was built
this way is quicker and less prone to introduced errors. Specifically, making
changes to code lines that appear in one place (the reusable procedure) is
much more efficient than making changes to the same code lines that appear
in several places (the individual event handlers).

Creating reusable functions or subroutines is not more difficult that coding
specific event handlers, but it does require a little different approach. You
construct reusable code by building a standalone function or subroutine in a
class file and then calling it from the event that requires it. Keep the following
items in mind when you set out to make truly reusable code:

+* Know the difference between encapsulating code and creating
reusable code. Encapsulated code is common code that you put in a
file or location away from your main program — within a class file, for
example — for convenience and logical separation. Encapsulated code
keeps a specific piece of logic together for the use of a specific set of
functional code. Reusable code is code that you encapsulate and use
again without changes. A company-wide data library is an example of
reusable code that can be used in several programs.

v Understand that good reusable code contains an element of abstrac-
tion. That is, the reusable code must not depend on the specific names
of controls that call it, or in fact, on controls at all. Being abstract means
that the reusable code operates on passed parameters and returned
values. It needs to accept base types (like integers and strings) or known
constructs (like datasets and collections) and return the same.

1 Make the reusable function part of a separate file, rather than placing
it within the project that calls it. This is the encapsulation part. You
want to encapsulate your code so that you can easily move it from one
project to another.
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Building functions with reuse in mind

To show you how reusable code looks in a real application, I start with code
from the Date Calculator built in Chapter 4 and alter it to meet the require-
ments of reusability. The Date Calculator contains event-handler code —
LateDate_ValueChanged and EarlyDate_ValueChanged — which is the
actual code that does the date math and sets the returned value. The follow-
ing code shows both event handlers:

Private Sub EarlyDate_ValueChanged(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles EarlyDate.ValueChanged
NumberOfDays.Text = CStr(System.Math.Abs(CInt((EarlyDate.Value -
LateDate.Value) .Days)))

End Sub

Private Sub LateDate_ValueChanged(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles LateDate.ValueChanged
NumberOfDays.Text = CStr(System.Math.Abs(CInt((EarlyDate.Value -
LateDate.Value) .Days)))

End Sub

Notice that the same code line appears as the middle line in both private
subs (it is the bold line of code in both functions). Repeating this code line is
no good, because it violates the concept of reusing functionality. If you need
to change the functionality of this code line later on, you have to change the
same line in both places. Instead, you can put the repeated functional code in
one place in your program, give it a public name, and call it from the event
handler. To do this, you can build a procedure — just as in the class library in
Chapter 6 — and place it right in the code of the form.

Now when you want to do the date math, you can just call this function, and
it does the work. The following code shows the FindDateDiff function.

Public Sub FindDateDiff ()

NumberOfDays.Text = CStr(System.Math.Abs(CInt ((EarlyDate.Value -
LateDate.Value) .Days)))

End Sub

And the following code shows what the event handlers look like now that
they call the FindDbateDi f £ function instead of repeating the code line.

Private Sub EarlyDate_ValueChanged(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles EarlyDate.ValueChanged
FindDateDiff ()

End Sub

Private Sub LateDate_ValueChanged(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles LateDate.ValueChanged
FindDateDiff ()

End Sub
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When you place this new public subroutine within your Date Calculator form,
it is an example of encapsulated code (common code that appears in one
subroutine within a form for convenience). If you move the routine outside
the form, you can use it in another form only if you name the other form’s
controls exactly the same as you named them in this application. That situa-
tion might not be possible, so making the function itself as abstract (that is,
independent of the controls) as possible is best.

Even with its limitations, I show you an example of code encapsulation
because sometimes encapsulating is more important than reusing. Not every
function needs to be abstracted to the nth degree. In fact, most of your code
won'’t be in the form of abstract functions. Understanding when you need to
reuse code and when it doesn’t matter depends on your business model —
that is, your program’s overall purpose. For example, if a particular function
is just maintenance code within the application itself — conversion from one
local data format to another, for instance — it probably won’t need to be
reused outside the program.

To make a function appropriate for reuse by making it independent of specific
names from the calling routine, you need to pass parameters to your function
and accept returned values from it. In the Date Calculator application exam-
ple, you accomplish this abstraction by

v Passing the start date

v Passing the end date

v Accepting the returned interval (in days) as an integer
Effectively, you set the value of the NumberOfDays . Text text box equal to

the return value of the FindDateDi £ £ function by passing it the values of the
two date pickers. I show this truly reusable function in Listing 12-1.

Listing 12-1:  Abstracting Using a Function, Rather than a Subroutine

Private Sub EarlyDate_ValueChanged(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles EarlyDate.ValueChanged

NumberOfDays.Text = CStr (FindDateDiff (EarlyDate.Value, LateDate.Value))

End Sub

Private Sub LateDate_ValueChanged (ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles LateDate.ValueChanged

NumberOfDays.Text = CStr (FindDateDiff (EarlyDate.Value, LateDate.Value))

End Sub

Public Function FindDateDiff (ByVal startdate As Date, ByVal enddate As Date) As

Integer
Dim difference As Integer
difference = (startdate - enddate).Days #1

Return difference
End Function
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Figure 12-1:
Adding a
class file to
your project.
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Notice the interesting element in the line numbered as 1. This line takes
advantage of the property of the date calculation. That is, because
(startdate - enddate) is a subtraction of two dates, it returns an object
of the DatesSpan data type. An object of that type includes a Days property,
which line #1 hooks on to. To find out more about types and how they work,
look at Chapter 9.

Extending reusability with class files

For real reusability, you need to make the function part of a separate file
called a class file. These class files are sort of in-project libraries and are
handy when the code may be reused within a project, but the code is not
likely to be used outside a project. A class file in a project is exactly the same
kind of creature as a class file inside a DLL.

Follow these steps to set up and use a class file:
1. With your program open in Visual Studio, make a new folder in your

project.

[ recommend that you store classes in a separate folder — with the
clever name of Classes — inside your project. That way, your class files
are easy to find.

2. Right-click on the Solution Explorer and choose Add->Class to make a
new class file. (See Figure 12-1.)

24| Buid
Rebuild
Clean
Publish. ..
[=3| Mew Item... Add 3
25| Existing Ttem.. 7 AddReference...
(4] Mew Folder Add Web Reference...
5] windows Form... &5| View Class Diagram
]| User Contral... Debug b
]| Component... _‘3’ Add Preject to Source Contral...
#] Module... # cut
|¢; Class. .. f\_l
- Rename
iz=]| Properties

3. Type a name for your class file when prompted; make the name some-
thing appropriate for the kind of code it will be holding.

[ named my new file DateDi ff.vb.
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4. Copy and paste the reusable code (your function) from your applica-
tion’s form code into the class file.

My finished class file code looks like Listing 12-2.

Listing 12-2:  The Function Code in a Class File

Public Class DateMath
Public Function FindDateDiff (ByVal startdate As Date, ByVal enddate As Date) As

Integer
Dim difference As Integer
difference = (startdate - enddate).Days

Return difference
End Function
End Class

When you create reusable functions and put them in class files, you naturally
move the related code into a separate physical file in your project. In the
Date Calculator example, taking the date-calculating function out of the
DateCalc form code means that Visual Studio can no longer find the
FindDateDi ff method. You can tell as much because a blue squiggly line
appears under the method name. The ability to call the date-calculating code
is effectively lost because the method is no longer located in the same class
that calls it.

Visual Basic gives you two ways to fix the problem. You get no real benefit by
choosing one way of referencing over the other; it is just personal preference
for how you want your code to look.

+ You can add a reference in your form to the new class you created to
hold your reusable functions. This process is similar to adding a refer-
ence to a new class library, as described in Chapter 6. Add the neces-
sary code above the class name using the Imports statement, as [ show
in the following code.

Option Strict On

Option Explicit On

Imports DateCalc2005.DateMath
Public Class CalculatorMain

+ You can directly reference the function by using the class name in
front of the function name when calling the function, as demonstrated
by DateCalc2005.DateMath.FindDateDiff in the following code:

Private Sub EarlyDate_ValueChanged(ByVal sender As System.Object,
ByVal e As System.EventArgs) Handles EarlyDate.ValueChanged
NumberOfDays.Text = CStr(DateCalc2005.DateMath.FindDateDiff( _
EarlyDate.Value, LateDate.Value))

End Sub



Public and Private stuff

The Public or Private keywords for class
files and functions become especially important
when you're creating reusable code. You have
been using them all along as part of forms, but
they take on a new significance when it comes
to calling a function outside of the class in
which it was declared.

A Public function can be seen and called by any

use all of the Public statements within it.
A Private class can only be seen and used
by other functions within the same class. In
the example in the “Extending reusability with
class files” section, if FindDateDiff were
Private, it would be invisible even if an
Imports statement was used. Friend and
Protected are other options, but they control
access within assemblies (compiled blocks of
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program that references the class in which it
resides. The Imports statement in the exam-
ple in the “Extending reusability with class files”
section references the class, and then you can

code). Public and Private are the options
you will see most often.

<MBER To directly reference a method in a class, the method must be shared, or you
must Dim a new instance of the class and reference the method by the new
variable name. In the case where you are writing a class file that is mostly ori-
ented toward sharing, marking the methods as Shared allows you to use
them without instantiating an instance of the class. If the object represented
by the class needs to be created first, though, then you have to Dim a new
instance of the class before calling the method. In that case, you use the vari-
able name to refer to the method in question. To see a great example of
Shared classes, check out File and FileInfo in the System. IO namespace,
covered in Chapter 16.

Avoiding the Code-Complexity Trap

Complexity, that is, writing more code than is necessary to solve a program-
ming quandary, is a problem for all applications, no matter what platform or
language they are built with. Complexity causes problems, such as programs
you can’t maintain, and it also makes existing problems harder to find
because it is difficult to follow the logic represented by the code.

As a developer, you need to balance complexity with common sense. Making
code so sophisticated that you can’t ever find errors is a particularly danger-
ous situation. Imagine a function that calls a function that calls a function
that calls a function . . . you get the idea. You can lose yourself in the flow of
the code very fast.
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However, you can’t put all of the procedural code into one large file either. If
your buttonl.click method has all of the logic in it to handle an order, from
billing to shipping, you will have a 1,000-line event handler. This isn’t the way
to go either.

You can employ two good programming practices that help you avoid com-
plexity problems in your procedures:

v Prevent logic problems by protecting the parameters you pass to the
functions in the procedures.

v Incorporate error handling to help you with procedural programming.

Protecting the values of parameters

When using a procedure, you have two ways to pass the parameters. You can
pass a copy of the information held by the variable you use as the parameter,
or you can pass the actual variable.

Determining how to pass your parameters harkens back to the programming
languages that use pointers. For example, the C language made use of point-
ers to reference information expected to be in certain memory locations. You
could pass a copy of information, or a pointer to the actual information.

Ask yourself this question to decide how to handle passing parameters: Do you
need your original data protected from the procedure you're calling, or are you
expecting the called procedure to change your data? Answer this question and
then choose the Visual Basic structure that gets you the result you want. Visual
Basic handles passing parameters with the following keywords:

v ByVal refers to By Value, and using this keyword assures that a copy of
the parameter’s data (its value) is made before it’s passed to the func-
tion. If the function changes the value of the parameter, then that
changed value is discarded at the end of the functional life of the para-
meter (which is at the end of the subroutine or function). In general,
functions don’t change the values that are passed to them, but if you
want to be absolutely sure, then you should protect those values by
choosing to pass parameters Byval. This is the default option.

v ByRef stands for By Reference, and this keyword sees to it that a refer-
ence to the original variable passes to the function as the parameter. The
reference points to the actual location of the variable value, so if the func-
tion changes the parameter, the variable in the host program changes as
well. You may actually want the function to change the original values —
for instance, a billing operation might always want to zero out a cumula-
tive fees variable passed into a function. In this case, using ByRef allows
the function to directly access the original variable and saves you a lot of
code.
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You may notice that — if you don’t type in the keyword yourself — Visual
Basic sets the default parameter passing to Byval for all functions and sub-
routines. Having Byval as the default state is safer (because the variable’s
original value is preserved) and avoids the logic errors (such as accidentally
overwriting a value that the calling code expects to be the same) that can
result from using ByRef and are difficult to find later.

Handling errors effectively in an
abstract environment

Another consideration for limiting complexity in procedural programming
relates to handling errors. I cover error handling using the Try...Catch block
in Chapter 10. In this section, I talk about the details of determining how to
deal with errors thrown in procedural programming.

The problem with errors in procedural code is one of abstraction (the same
functional separation you are aiming for when you create a reusable class). If
you create reusable code using class files and procedures, you can lose the
ability to communicate with the user interface and thereby inform users
when an error occurs. Figure 12-2 illustrates this concept.

The class file has
no access to the
error handling

o oo e . . devices of
| Windows, like
-The X MessageBoxes
W.mdows ! -
Environment ! interface
1
1

interface

Your Application \/@— theClassFile

So what happens when an error occurs in the procedure that is abstracted
from the application? You handle this situation by allowing exceptions to
bubble up from the procedure to the user interface, rather than trying to
handle them in the class file itself. For example, rather than handling a data-
base conversion error in a reusable function with a Try...Catch statement,
you should just allow the error to be thrown up to the source application.
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Abstraction, therefore, has an impact beyond facilitating code sharing. When
you move a procedure containing reusable code into an isolated environment
(like a class file), you cannot assume that the program using the class file can
pop up a message box if (and when) an exception occurs! You must make
good decisions about when and how to deal with exceptions. Here are a few
pointers:

v~ Allow the majority of errors to bubble up to the code calling the pro-
cedure. Don’t try to handle errors that you can let the system handle for
you. When an error occurs that is covered by a system exception (such
as the database being out of whack), the error will cause the procedure
to stop executing and then pass execution back to the calling program.
This automatic process is good enough to deal with most errors.

1 Organize your business logic to avoid exceptions in the class files.
Procedures that you design to be shareable need to be better than they
have to be. In other words, your reusable functions and subroutines
must be as infallible as possible. Do the little things that reflect careful
programming practices — like making sure your loops won’t overstretch
their bounds or your data won’t be subject to type confusion. Check
that the values your procedure accepts as parameters are what the code
really needs so that you don’t have to worry about conversion errors.
Taking care of details like this makes reusable code much more useful.

+ When a business logic error occurs, inform the calling program by
creating an error of your own. This programming practice is called
throwing an error, and it is unsurprisingly handled by the keyword
Throw. For instance, suppose your procedure wants to make sure that
the passed parameter called startdate is always earlier than the
passed parameter called enddate. The following code shows how to
throw an error after checking the two values:

Public Shared Function FindDateDiff (ByVal startdate As Date, _

ByVal enddate As Date) As Integer

Dim difference As Integer

If enddate > startdate Then

Throw New ArgumentException("End Date cannot " + _
"be before Start Date")

End If

difference = (startdate - enddate) .Days

Return difference

End Function

If the startdate is not earlier than the enddate, this code causes the execu-
tion of the procedure to stop, and control is returned to the calling program
with the ArgumentException in tow. If your program wraps the call to the
procedure in the Try...Catch block (which I discuss in Chapter 10), then the
program handles the exception. If not, Windows will handle it for you!
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Finding Other Ways to Reuse Code

Other ways to write reusable code are built into the Visual Studio environ-
ment. The server controls (components such as text boxes and buttons)
that you can use in Windows and Web Forms are built into the environment,
and you can create your own reusable components. You also find a simpler
control concept, a user control, in ASP.NET pages. And you can build easy-to-
reuse page templates, such as master pages in ASP.NET, as well.

Creating custom controls

Server controls — such as the TextBox and Button control that [ show in
many examples — are easily built using a special project type in Visual
Studio. Although creating custom controls is a little beyond the scope of this
book, follow these steps to create a simple custom control and make it avail-
able to your Windows Forms projects:

1. Open Visual Studio and select a new Windows Control Library project.

The editor opens with a workspace that looks much like the regular
Windows Forms designer, but with just a gray area to work in. I name my
example Sample Windows Control.

2. Drag one or more controls from the Toolbox to the gray area and
resize the area to fit around them.

I drag three text boxes to the gray area in my project and arrange them
as shown in Figure 12-3.

3. Right-click the default .vb file in the Solution Explorer and give your
control a name you can remember.

I call my file PhoneNumber . vb.

4. Choose Build~>Build Solution from the main menu to compile the
project.

5. Choose Filec>Add=~>New Project and select a new Windows Application
project to add another project to the solution.

I call my new project Sample Control Test.
6. Right-click the new project and choose Set As Start Up Project.
7. Right-click the new project again and choose Add Reference.
The dialog box shown in Figure 12-4 appears.

8. Click the Projects tab, select the Sample Windows Control project, and
click OK.
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9. Expand the Toolbox and note the addition of your new control.
In my example, | see the PhoneNumber control.
10. Drag your new control onto the default form.

The new control appears on your form just as if it were any of the built-
in controls.
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How making custom controls helps you share code is obvious. If you define a
common set of controls that have common logic, you can create custom con-
trols and write the code for these controls just once. Your logic is protected
by the compilation, and you can redistribute the customized controls within
your organization. In short, making custom controls is a tremendous tool in
terms of sharing code.

Adding user controls

Another great tool in the code-sharing arena is the ASP.NET user control.
A user control is a simpler version of the custom control and is represented
by a special file — an ASCX file — in the ASP.NET Web project.

Otherwise, a user control works and acts the same as a custom control.
A user control
v Encapsulates other controls and the logic around them.
v Shows up as a separate object within the project.
v s built in a separate design space.
If you open a Web project and right-click the project file in the Solution
Explorer, you can see that one of the options is the Web User Control, as high-

lighted in Figure 12-5. Click the Web User Control icon to add a user control
to your project.
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The process for developing a user control is just like the process for develop-
ing a Web Forms page. Drag controls to the screen and double-click to add
code to the control. To add your new control to a Web page, just drag the
ASCX file to the ASPX page in Design View.

“@N\BEI; You should keep in mind, though, that ASP.NET user controls are not as ver-
Ny satile as custom controls. User controls are not compiled into class files, but
are built into the Web site itself. To reuse the user control code in another
project, you need to copy the code from one project to the other. And when
you add user controls to a page, they don’t appear exactly as you designed
them, but are represented by a placeholder.

Regardless of their shortcomings, user controls can be important parts of a

Web project. Lots of Web page elements are repeated — for example, naviga-
tion controls, footers and headers, and the like. All such elements make fan-
tastic user controls.

Making master pages

Another ASP.NET feature, along the lines of a user control, is a master page.
A master page is effectively a page template for Web sites, so it isn’t shared
code as much as it’s a common framework for a project.

You add master pages to projects just as you add user controls. You can
right-click on the project file and select the Master Page icon to add one to a
project. From that point, you edit a document that is just like a Microsoft
Word template for Web pages.

The master page uses a construct called a content placeholder to determine
the layout and placement for content of the ASPX pages. The
ContentPlaceHolder construct allows you to structure where on the page
the content from a content page is placed. The content control in the ASPX
pages defines what content goes with each control. For instance, the follow-
ing code shows a master page with two ContentPlaceHolder controls right
next to one another in a table:

<%@ Master Language="VB" CompileWith="MasterPage.master.vb"
AutoEventWireup="false" ClassName="MasterPage_master" %>

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN"
"http://www.w3.0rg/TR/xhtml11/DTD/xhtml1l.dtd">

<html xmlns="http://www.w3.0rg/1999/xhtml" >
<head runat="server">
<title>Untitled Page</title>
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</head>

<body>

<form id="forml" runat="server">

<table>

<tr>

<td>

<asp:ContentPlaceHolder id="ContentPlaceHolderl" runat="server">
</asp:ContentPlaceHolder>

</td>

<td>

<asp:ContentPlaceHolderid="ContentPlaceHolder2" runat="server">
</asp:ContentPlaceHolder>

</td>

</tr>

</table>

</form>

</body>

</html>

In order to run this master page with content, the content page must have:

v A Master attribute in the Page directive.

v Two content controls in the page that have the content to be placed in
the ContentPlaceHolderl and ContentPlaceHolder2 controls in the
master page.

Using a master page to control the layout prevents you from having to recode
the HTML tags over and over from page to page. You can also accomplish
this reusable structure with user controls, but the master pages are much
more efficient.

Reusing Programs Outside
of the Framework

I know of two reasons to think about reusing program functionality outside of
the .NET Framework:

v You may have older programs — legacy code written before the .NET
Framework existed — that have business logic you still want to use.

v You may need to work with parts of the Windows operating system that
are not available in the .NET Framework.
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At least 90 percent of programmers have legacy code to work with. While you
can rewrite most of your legacy code into VB 2005, you won’t always have the
time or energy. The ability to directly implement the world of COM (the
Component Object Model architecture used prior to .NET) in Visual Basic and
the .NET Framework will significantly simplify your work environment.

Fortunately for VB 2005 programmers, working with COM objects is now
easier than ever. Additionally, the Visual Basic developers had a very realistic
view of the Windows platform. While Microsoft’s developers are very focused
on the .NET Framework, not every product by their third-party providers is
.NET ready. Also, certain Windows elements (such as NT file properties) still
don’t have .NET objects associated with them.

I start my discussion about connecting to old code with implementing COM
because that topic covers a lot of the legacy code reuse problems you will
have to solve. Then I talk about getting down to the operating system’s
legacy operations. You may not connect to the old OS operations a lot, but
some situations — like dealing with older hardware — still require that you
know how.

Referencing the old Component
Object Model

The Component Object Model (COM) is the library of code that allowed for
development of DLL files before .NET existed. Nothing is wrong with COM per
se, but the fact is that .NET is much more appropriate for development in
today’s environment.

Nonetheless, you will find times when you need to write code that uses logic
in old COM objects. Visual Basic 2005 provides a function, called
CreateObject, that is built into the language. This function allows you to
dimension an object, then assign it to an existing COM class if you know the
reference to that class.

For example, to make a new Microsoft Word file, you could use the following
code. The code simply defines a new object placeholder and assigns it to the
Word.Application class, which is the old COM class for Microsoft Word
functionality. The class exposes several methods, properties, and events, but
this code uses the save method and supplies the newly created object with a
filename.
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Public Sub MakeWordFile()

Dim myWord as Object

myWord = CType (CreateObject ("Microsoft.0Office.Interop.Word.Application"),
WordApplication)

myWord. Save ("c:\NewFile.doc")

End Sub

Before you have access to any of this functionality, you need to reference
the DLL file in your project. In this case, you click the COM tab in the Add
Reference dialog box (refer to Figure 12-4). From this dialog box, you need to
add a reference to the local version of Word. On my PC, it is Version 11, and
the DLL is called Microsoft Word 11.0 Object Library.

When you use Visual Basic’s CreateObject function and link to old COM
classes, you may get some pushback from Visual Studio. In the Code View,
Visual Studio may warn you that the Late Bound Resolution could cause
errors. Such a warning appears because you didn’t use Visual Studio to
create the new object, and that means Visual Studio can’t confirm that the
Save method actually exists.

Calling methods in COM objects

If you don’t need an actual instance of the object defined by a COM class, you
can use the callByName function to just run a method as defined by a class.
For example, the following code shows how you could call the save method
in the preceding example without using an object.

CallByName (myWord, "Save", CallType.Method, "c:\NewFile.doc")

Using other programs with the
Process class

By far, the best way to get information to another program from a VB 2005
program is the Process class. The Process class makes use the of the file
extension mappings in Windows to determine what application to launch. A
great example of this use involves the Google Search Tool. The Google Search
Tool is a very simple Windows application that presents users with a text box
and a button. It returns a URL based on the search term entered in the text
box and lets Windows decide what application to launch to view the URL.
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To build your own Google Search Tool, follow these steps:

1. Open Visual Studio and start a new Windows Application project.
Surprisingly enough, [ name my application Google Search Tool.
2. Right-click on the project and choose Add a Reference.
The Add Reference dialog box appears.
3. On the .Net tab, add a reference to the system.Web component.
4. Drag a text box and button from the Toolbox to the form.

My form looks like the one in Figure 12-6.
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5. Double-click on the button to get to the onclick event handler and
add the code to incorporate the outside program.

The code looks like the following:

Dim myProcess As New Process()
Dim searchString As String =
System.Web.HttpUtility.UrlEncode (TextBoxl.Text)
Dim urlString As String = "http://www.google.com/search?g=" + searchString
myProcess.StartInfo.FileName = urlString
myProcess.Start ()

6. Click the Play button to run the application. Type a search term in the
text box and click the button to cause your default browser to load.

Figure 12-7 shows my results. For this example, I use Mozilla Firefox
rather than Internet Explorer, and the process class still works great!

The code to include this outside application is surprisingly simple. The lines
work as follows:

v Get the search term from the text box, and combine it with the search
URL that Google provides to create a new variable called url1String:

Dim searchString As String =
System.Web.HttpUtility.UrlEncode (TextBoxl.Text)

Dim urlString As String =
"http://www.google.com/search?g=" + searchString
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v~ Set the new variable equal to the StartInfo.FileName property of the
new Process object [ created. If | had wanted a Word document instead
of a URL, I could have provided a Word filename:

myProcess.StartInfo.FileName = urlString

v Call the Start method, and VB 2005 looks in the registry to see what
application is set to handle a URL:

myProcess.Start ()

Visual Basic then runs the app for me, sets the URL in the address bar, and
away it goes!

Though I did not use it, the Windows Forms program created to incorporate
the Google Search Tool now has control of the browser process it has

spawned. | can review its progress, pause its execution, or end it completely
from the program if I so desire. For a complete list of the functionality of the
Process class, you can search for Process Class in the MSDN documentation.
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Accessing DOS: But Only
as a Last Resort

DOS is dead. The operating system that many experienced programmers cut
their teeth on in the PC world is simply emulated in newer operating systems
such as Windows 2003 servers, and the even newer Windows Vista systems
that are in development as I write this book.

Nonetheless, there are bits of DOS and older Windows that you may want to
use in your programs, and VB 2005 supports that too. For a number of rea-
sons (such as the possibility of Microsoft removing the function in a later ver-
sion of Windows), digging in to the older operating systems is not something
you want to do — unless you have no other choice. But it’s nice to know that
if you have to go that low, you can.

Running command line programs
with Shell

If you have done any systems administration work, you know that a lot of
powerful and necessary applications are available only from the command
line. Also, you can write a command line application in Visual Studio by using
the Console project type. To run such programs from your VB 2005 programs,
you can use the shell command.

The following code shows a very simple example that launches the Windows
Calculator using its command name, calc.exe. I implemented this code by
putting it in the onc1ick handler of a button on a blank form.

Private Sub Buttonl_Click(ByVal sender As System.Object,_
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim CalcId As Integer
CalcId = Shell ("C:\Windows\system32\calc.exe", _
AppWinStyle.NormalFocus)
End Sub

The process ID returns to your program in the form of an integer (in this
case, CalcId), and the program can refer to the application or process as
long as that process remains running. Like with the process class, the
process ID gives you the ability to hold up your application while the refer-
enced process runs, check its progress, or kill it as you wish.
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The shell command takes a few parameters. The first is (obviously) the
name of the process to be run, complete with the parameters the process
might accept. The second parameter is the Appwinstyle, which is a collec-
tion that defines how the process will appear to the user. It includes

v Hide: Doesn’t show in the taskbar.
» NormalFocus: Shows normally, based on the system default.

» MinimizedFocus: Is minimized in the taskbar and has focus as though
the user had clicked on it.

1 MaxamizedFocus: Fills the screen and has focus.
V¥ NormalNofocus: Shows normally with no focus.

V¥ MinimizedNoFocus: Is minimized without having focus.

The third parameter of shel1l, which I didn’t use in my example, is a Boolean
parameter that tells the program if the calling program should wait for the
process called to finish. The fourth, and final, parameter is a timeout value
that tells the calling program when to let go of the reference.

Getting focus with AppActivate

No matter what tool you use to run a program from a VB 2005 application —
whether it’s a Process class, the Shell command, or the Interop function —
you can give the program focus with appaActivate. The AppActivate func-
tion accepts a window name of a running program or a process ID, and gives
focus to that application.

For example, running Calculator as shown in the following code initially
sets the application to have no focus. The appactivate line then gives the
application focus using the process ID that was returned from the shell
command.

Private Sub Buttonl_Click(ByVal sender As System.Object,_
ByVal e As System.EventArgs) Handles Buttonl.Click
Dim CalcId As Integer
CalcId = Shell("C:\Windows\system32\calc.exe",
AppWinStyle.MinimizedNoFocus)
AppActivate (CalcId)
End Sub



220 Part lll: Making Your Programs Work

In the Process example from a prior section, “Using other programs with the
Process class,” you can give the browser focus if you know exactly what the
window name will be. The following code demonstrates:

Dim myProcess As New Process ()

Dim searchString As String = System.Web.HttpUtility.UrlEncode (TextBoxl.Text)
Dim urlString As String = "http://www.google.com/search?g=" + searchString
myProcess.StartInfo.FileName = urlString

myProcess.Start ()

AppActivate ("Google Search: Bill Sempf - Mozilla FireFox")

Using AppActivate would not be the best solution in many circumstances. In
this example, if you aren’t using Mozilla FireFox, this code will not work for
you! You want to avoid using the Windows name string when the name varies
based on the user. As it turns out, the Process object has a ProcessId para-
meter that gives you a much more flexible result.
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Making Arguments,
Earning Returns

In This Chapter

Discovering tricks for using classes
Building event handlers
Leveling out performance with threading

Finding flexibility in generics

usual Basic 2005 is still, at it’s heart, a very functional language. Much of
the benefit from using VB revolves around calling functions and getting
values back. Even with the movement toward more object- and service-
oriented use of the language, you will always need to know how to call a func-
tion and get a return value — no matter what the higher cause happens to be.

The Visual Basic language is heavily based on designing, defining, and calling
procedures, passing arguments, and getting return values that are useful to
your program. Understanding how to make highly intricate functions and
subroutines makes your programs run better and your code more readable.

In this chapter, | discuss advanced procedure design — sophisticated func-
tions and subroutines. In Chapter 6, you design class files, and in Chapter 12,
you make reusable code realistic. The information in this chapter gives you
the last bit of detail that you need to make the best possible functional code
you can.
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This chapter covers the last few details of function design and creation that
haven’t been discussed in previous chapters. You find

v An in-depth description of the parameters and return values of functions
v Procedures that accept different sets of values using overloading

v Tricks for calling and using classes

v An introduction to making flexible objects with generics

v A description of event handling

v A fun example of object timing using threading

Using Classes Effectively

Although I discuss class library design, programming, and testing in Chapters
6 and 8, in this chapter, I discuss the most effective ways to use classes. The
logic contained in classes is important because you use it over and over. You
can significantly improve overall reliability of your programming efforts if
you follow a few of the suggestions I go over in this section.

For example, how you instantiate and destroy objects can have a distinct
impact on your application’s memory management. Understanding if an
expensive resource is being utilized is important. Finally, you should know
about a few tricks of the trade that can make your code cleaner.

Making and destroying objects

Behind the scenes, when you make an object, you are taking information from
the program file and storing it in the RAM of the machine. You have a lot
more room on the hard drive than in RAM, so you should be cautious using
your RAM.

Every Dim statement takes up more memory on the machine. Some things,
such as graphics and network connections, take up more memory than
others. Because of this fact, you must be cautious what you make and when
you destroy it.

For the small programs I go over in this book, you don’t need to worry about
making and destroying objects in a timely fashion. Because the programs are
so small, the memory management is negligible.
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However, it’s easy to create a program that would need to use tons of memory
and where memory management would become important. For instance,
imagine a program that looped through a large number of records in a file
and started a mechanism to confirm them. At the end of the loop, that
process will have one copy of the mechanism for every line of the file alive in
memory!

.NET has something called garbage collection that gets rid of unused objects.
It usually takes objects that were used in a method and destroys them after
that method has run. If the method is particularly long, however, you might
want to get rid of an object early. [ show an example of this garbage collec-
tion in the following code. To get rid of an object early, you use a method that
all objects inherit from the .NET Framework: Finalize.

'Get a new instance of the Date Calculator
Dim currentCalculator as new Calculator
'Get rid of it for good!
currentCalculator.Finalize()

Resource utilization

Another consideration when deciding when to destroy an object are the
resources handled by the class you instantiated. [ cover resources (such as
network and database connections) in greater detail in Chapters 15 and 17.
The resource may be locked by the object, and if you’re depending on having
that resource later, this lock could be a bad thing.

The following constraints should govern how you make and destroy objects.
If you are in a tight resource situation, then consider the following best
practices:

v Use a Dim or Private statement to dimension the object right before
you are ready to use it, rather than at the beginning of your code.

1 When you are through with the object, call its Finalize method.

Keep in mind that using Finalize is for specific situations. I try to imple-
ment Resource Utilization Management when I am having a problem with a
resource, or [ am working with objects like networks, files, or databases.
Generally speaking:
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v The garbage collector will run after every method signature.

v Most classes in .NET are very lightweight, and the garbage collector will
handle them just fine.

With and Using

When working with objects, don’t type them so often. Really — take a look at
the following code! The with keyword tells VB that the next few lines of code
are to be used “With” a given object — it’s pretty cool.

With myArray
LAdd (1)
.Add (3)
.Sort ()
End With

Like with, Using defines a new resource that should be used as part of the
code inside the block, and then discarded. The MSDN documentation has a
great example using a Font in the Drawing classes, which I show here:

Public Sub makeBig (ByVal myControl As Control)

Using myFont As New System.Drawing.Font ("Garamond", 18.0F, FontStyle.Normal)
myControl.Font = nf
myControl.Text = "Big Garamond Title!!"

End Using

End Sub

Using Event Handlers

Event handlers are methods that automatically run when an event occurs

that the .NET Framework knows about. The most obvious example is a button
click — when the user clicks a button, the framework knows it as an onClick
event. It looks in the code for that screen for a method designed for that
button’s onC1lick event. That method is an event handler. An example follows:

Private Sub Buttonl_MouseEnter (ByVal sender As Object, ByVal
e As System.EventArgs) Handles Buttonl.MouseEnter
End Sub
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Two qualities designate an event handler:

v The Handles statement: The Handles statement tells the framework
that this method in particular is designed to deal with a specific event
for a specific object.

v~ Special parameter types that event handlers require: These are the
Sender and the Event arguments. The Sender represents a reference to
the object that sent the event, and the Event arguments are a custom
collection of properties that relate to the request — like the position of
the mouse on a click, or the exact time of a network event.

To support an event handler, the event must be exposed by an object. Using
Visual Studio, you can see what events are exposed by an object in Design
View by using the Properties window and by using IntelliSense. The following
sections look at both of them.

Event handling using the
Properties window

By far the easiest way to work with event handlers is by using the Design
View. The Properties window, which I go over in Chapter 2, has a special
panel designed for working with events.

To get started, try this little sample:

1. Open Visual Studio 2005 and create a new Visual Basic Windows
Application project by choosing File=>New Project.

2. In the Form1 designer, add a button and a timer.
The Timer control is under the Components tab in the Toolbox.

3. Select the button, and then open the Properties window.

4. Click the Events button, like the one shown in the margin.

5. Note the events available for use.

Figure 13-1 shows what can happen to a button in the user environment.
Do you want code to run when the user hovers the mouse cursor over
your button, rather than when it is clicked? If so, use the MouseEnter
event. Do you want code to run when the user drags something over
the button? Use the bragDrop event.
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|
Figure 13-1:
The Events
panel.
|

|
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6. To see how this can be used, go ahead and double-click in the prop-
erty area to the right of the MouseEnter event.

Visual Studio will automatically generate an event handler for you and
send you to Code View. The event will probably be called Buttonl_
MouseEnter. Notice the Handles statement? It tells the .NET Framework
that you want this method to handle any instance of that event.

Private Sub Buttonl_ MouseEnter (ByVal sender As Object,
ByVal e As System.EventArgs) Handles
Buttonl.MouseEnter

End Sub

Event Handlers using IntelliSense

The second way to create methods for event handlers is using IntelliSense
and the Code View. While in the Code View, you can use the selectors at the
top of the screen to pick event handlers! For instance, pick the timer in the
drop-down list at the top of the code window, on the left side, as shown in
Figure 13-2. The right-hand drop-down list changes to show all of the events
of the timer that are available.

“% Form1 w

|- (General)
“i; Form1
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|
Figure 13-3:
Picking an
event.
|

Now that right-hand drop-down list has all of the events that would show in
the Events panel. Just pick one (as shown in Figure 13-3) to generate an event
handler for it.

] (Dedarations) w
|- (Declarations)

If you aren’t sure what the event exactly is all about, just go ahead and gener-
ate the handler, then click on the name of the event in the Handles statement
and press F1 for help. You can always delete the method without penalty.

Making Sensible Procedures
with Overloading

Overloading is an organizational feature that allows a variety of parameter
counts and types to be used in one logical procedure. For instance, you could
have a method that adds two numbers or three numbers. When you are using
the procedure, it seems like one function that takes two or three numbers.
When you are writing the procedure, though, it is actually two functions.

Although overloading doesn’t do anything you can’t do by coding multiple
procedures, you can use it to make your code make more sense.

Reusing your procedure names

Let me show you an example by reusing a procedure that you have already
written with Overloading. Take the previously mentioned specification — an
add function that can add two or three numbers. You can imagine the func-
tion in VB; it would look like the following:

Public Function add(ByVal numberOne As Integer, ByVal
numberTwo As Integer) As Integer
Return numberOne + numberTwo
End Function
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|
Figure 13-4:
Overload-
ing and
IntelliSense.
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With the requirement in the introduction, you will need to create an add pro-

cedure that accepts three integers. You could make a whole new function, but
wouldn’t you rather just use the add name again, with the new method signa-
ture? As you can see in the following code, with overloading you can!

Public Function add(ByVal numberOne As Integer, ByVal
numberTwo As Integer, ByVal numberThree As
Integer) As Integer
Return numberOne + numberTwo + numberThree
End Function

If you are experienced in VB.NET 1.0 or 1.1, you will notice that I didn’t use
the overloads keyword. It is no longer required unless you are overloading a
built-in function.

What does this do for you in the development environment? Primarily, it
makes the IntelliSense make a lot more . . . sense. I show this in Figure 13-4.

4l
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# (Form1 Events) || # Load

E Pulklic Class Forml

IncreaseDate | I
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If you use IntelliSense, you can see the two add methods shown as one method.
This has no real impact on functionality — it is just a convenience — but boy
does it make your code make a lot more sense!

Changing built-in functions
with operator overloading

Overloading isn’t limited to methods you have written yourself. You can over-
load built-in methods and operators, too! As I discuss in Chapter 9, operators
are mostly math symbols, with a few Boolean logic bits thrown in. Operators
are shortcuts for longer math expressions.

For instance, instead of the add method shown in the preceding section,
“Reusing your procedure names,” you can just write answer = numberOne +
numberTwo + numberThree. Much easier to create something like that.
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If you want the add function to do something different, such as warn people if
they are adding a negative number to a positive number, you could write a
function to do this, or you could overload the + operator. The following code
shows an example of this:

Public Shared Operator + (ByVal numberOne as Integer, ByVal
numberTwo as Integer) as Integer
If (numberOne < 0) Or (numberTwo < 0) Then
MessageBox.Show ("You are adding a negative number!")
End If
End Operator

When you do this, the add operator works as originally designed, but it has
this added functionality that you have placed on it — and only when you add
two integers.

This is new functionality in VB 2005, though it has been available in other
Microsoft languages for a while. It might seem to be a theoretical program-
ming concept, but really, overloading in general has a big place in writing
clear, concise code. See what [ mean in the next section.

Designing for overloading

Even though overloading doesn’t have a direct impact on functionality, it can
have a big impact on how you think about software. When you are writing
Windows or Web Forms, overloading doesn’t have a big impact, but when you
are writing libraries of classes or a DLL file, it is very significant.

For the ultimate example, look at the .NET Framework itself. Remember
arrays, those lists of things one can keep in memory? You sort a few in Part II.
Anyway, that sort subroutine has 18 different versions, each one accepting a
slightly different set of parameters based on the needs of the programmer.

Each of those versions of the sort subroutine are coded separately and look
like different subroutines in the source code of the .NET Framework, but to
you, the user of the framework, there is just one method, Sort, and it just
happens to take exactly the parameters you need!

Without overloading, the Array class would have 18 sort subroutines, rather
than just one. And when you were coding for an array, you would need to
remember just the particular Sort subroutine you wanted or dig through all
18 in the IntelliSense or the documentation.
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There are already 24 methods that are part of the Array class. With all of
the overloads, my rough count shows that there would be 107 methods —
functions and subroutines — in the Array class. That’s over four times as
many. Now, there are 220,000 methods, properties, and events in the .NET
Framework, so without overloading, there would be almost a million if the
ratio held. That’s significant!

P It should be said that you can overload too much. If you find yourself over-
loading a method 250 times to deal with a lot of parameters, you might want to
check into a parameter array, which allows you to pass in a variable quantity
of parameters.

So overloads are really a design issue. When you are building a class library,
think about how the methods are named and if your patterns make sense.
Have another programmer look over them. Compare it to what has already
been done in the .NET Framework. Then see if overloading can help you
design better classes.

Optional parameters

Using optional parameters is another way to structure procedure naming, but
rarely does it have benefits over overloading. Since early versions of Visual
Basic, optional parameters have been available for use when writing subrou-
tines or functions. In fact, Visual Basic is the only contemporary language
that allows optional parameters.

Optional parameters are used by including parameters at the end of the
method signature that are not required for the method to run. For instance,
[ could implement optional parameters in my add method as shown in the
following code:

Public Function add(ByVal numberOne As Integer, ByVal
numberTwo As Integer, Optional ByVal numberThree =
0) As Integer
Dim result as Integer
If numberThree > 0 then
result = numberOne + numberTwo + numberThree
Else
result = numberOne + numberTwo
End If
Return result
End Function
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The differences between optional parameters and overloaded procedures are
pretty clear:

v There is a third parameter called numberThree, which has an Optional
keyword.

v The optional parameter has a default value.

v | had to include login in the code to handle the possibility that the
optional parameter was left as the default value.

While it is true that because of the rules of addition, I could have just used
the optional parameter no matter what — it would have either been a
number or 0, right? Adding anything to 0 returns the original value. But that
is specific to this example. If this were a divide method, that wouldn’t be the
case.

Generally, use overloading rather than optional parameters. Overloading
makes a lot more sense to the end programmer using the method.

Flexible Objects with Generics

Generics are exactly what they sound like — objects that accept their own
type as a parameter.  mention in Chapters 6, 9, and 12 that properties of
objects are of certain types, such as strings or integers. With generics, you
can make an object that holds items of a generic type so that you can define
it when you use it, rather than when you code it.

Confused? Don’t be. The keyword you want to remember is Of. Of is your
best friend. When you build a new generic class, it should be declared as of a
certain type. Then a list within that object can be a list of anything you need
the object to be at code time. At run time, then, the object can be declared to
be Of a type, like Integers or Apples, to make sure it gets the right types of
values.

Building generics

I have a very simple example in the following code. The staff object is a list
of people. You may want to hold the names in the list, or their IDs, or even
Person objects if you were to create one. You might not know when you build
the staff object, so you make it generic.
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|
Figure 13-5:
Using
generics.
|

'First, declare the object with the generic type.
'The name can be anything, I just invented the staffType
Public Class Staff (0f staffType)
'You need a private array to hold your list of ten People
Private peopleArray(10) as staffType
'The Add method will add one of whatever you have
'instantiated the object as to the collection.
Public Sub Add(ByVal person as staffType)
peopleArray.SetValue (person, peopleArray.Length + 1)
End Sub
End Class

So now when you go to use the staff object, you have to declare what kind
of things you will be keeping in it. This is shown in the following code:

'This could hold a list of names
Dim myStaffofStrings as New Staff (0Of String)

'This could hold a list of IDs
Dim myStaffOfIntegers as New Staff (of Integer)

'Or even a list of People for a previously coded Person
object
Dim myStaffOfPeople as New Staff (Of Person)

What you have done here is created a generic staff list capable of holding
whatever you want to be in it when you use it. When you declare what you
are going to put in it, it holds you to it. You can see in Figure 13-5 that when I
declared the staff object as holding Integers, it even showed up in the
IntelliSense.

2 Sub Timerl Dispesed(ByVal sender Rs Object, ByVal e As)
1 myStaff A= Hes taff (of Integer)
taff.mdd( |

the =taffType

14 our list of ten People
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Designing for generics

Perhaps you’re wondering what the point is, and I can understand the ques-
tion. Basically, you are preventing having to write classes twice. If staff can
be a collection of names or ID numbers, you would have to write it twice
(without Generics) and name it two different things. With Generics, that is no
longer necessary.

From a design perspective, this is just like overloading. Overloading prevents
you from having to write two methods to handle two different parameter
types. Generics prevent you from having to write two different classes to
hold collections of two different kinds of types.

If you think of classes as molds and objects as the items that come out of
those molds, then think of generics as a way to modify the mold on the fly. It
is another tool in your toolkit, and isn’t a requirement for class design. When
you have a problem that can only be solved by using generics, though, you
will know about it.

Controlling Objects with Threading

[ show you a lot about building and using objects, but not much about their
feeding and care. Generally, the .NET Framework takes care of the objects for
you, but there are times when you need to take control. That’s when you
need to know about threading.

Designing for threading

From a design perspective, threading is very simple. If you have a very time-
consuming operation, you may need to put it on the back burner and return
control to the user. Have you ever done something in Word and had the hour-
glass show up? That’s an example of a blocking operation. The whole applica-
tion had to wait for that operation to complete before returning the control
to the user.

If the operation is such that the application doesn’t have to wait, then you as
the programmer can run that operation on a separate thread, running parallel
to the application as a whole, and leave the user’s control of the application
on the original thread. (I demonstrate this concept in Figure 13-6.) The user
might not even know that another process is running!
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|
Figure 13-6:
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threading.
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Lots of applications that you use every day use separate threading. Word
uses it when you spell check or print. Outlook uses it when it sends or
receives e-mail. Excel uses it while calculating values in cells. All of these
things go on while you are still typing away, for the most part. The number of
simultaneous threads is only limited by the memory of the machine.

The Office examples are good ones because they show the most often used
reason for implementing threading — access to a resource. Network connec-
tions, dictionaries, and databases might only accept one connection at a
time. If you want to let the user continue using the program while the applica-
tion is processing, you need to use threading.

Implementing threading

To get an idea of how a blocking operation works in and out of a thread, try
this simple example using a timer to emulate a troublesome operation:

1. Start Visual Studio and create a new Windows Application project in
Visual Basic.

I called mine ThreadingExample. You can find it on this book’s compan-
ion Web site at www.vbfordummies.net.

. Add two buttons, called startThread and TestLocking to the form.
. Add a Timer object called NetworkEmulator to the form.

. Change the text of startThread to “Start the Timer.”

V1 W N

. Change the text of TestLocking to “Test The Lock.”

Figure 13-7 shows an example of how the form should look.
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6. Double-click the Start the Timer button to launch the Code View and
get the onclick event handler.

7. Add an imports statement to the top of the code behind — Imports
System.Threading.

This will make available the new Timer methods that you need to have
the timer run in a separate thread.

8. Add the following code to the startThread_click event handler:

Dim NetworkEmulator As New Timer (New
TimerCallback (AddressOf FakeNetworkCall),
Nothing, 0, 4000)

9. Add the following code to the class to generate the FakeNetworkCall
that you are emulating with the timer.

Public Sub FakeNetworkCall (ByVal state As Object)
MessageBox.Show ("This is a network call!!")
End Sub

This will pop up a message box every four seconds. Not usually
recommended.

10. Go back to Design View, double-click on the Test the Lock button, and
add the following code to the event handler generated:

Dim TestNumber As Integer = 0
Private Sub TestLocking Click(ByVal sender As
System.Object, ByVal e As System.EventArgs)
Handles TestLocking.Click
TestNumber = TestNumber + 1
Me.Text = Me.Text + TestNumber.ToString
End Sub
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|
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When you run this code, you will find that nothing happens until you click
the Start the Timer button. Then every four seconds, you will get a dialog box
with the test message inside. Try and keep up with them. Every now and
again, click the Test the Lock button. The counter should increment in the
name of the form. You can see my crazy test in Figure 13-8.

Start the Timer | Test the Lock

This is a network calll!

What does this program prove? It shows that an application can run two
things at the same time — for real. At the same time, the program was count-
ing to 4,000 over and over, and it was still allowing you to work with the form.

This was all due to the TimerCallBack object, which is a thread encapsula-
tion. You told the .NET Framework, “Hey, launch a thread that does a timer
every four seconds and calls this method.” It works pretty well. There are
other things that threading will do for you, too, including:

v Many network calls have an asynchronous set of methods, which enable
threading.

v Priority is built in, so when you have several threads, you can say which
thread is the most important.

v File reading and writing can be automatically threaded.

v You can define a block of code as threaded.
All of this is in the MSDN documentation, of course. Just search for “thread-
ing,” and start with About Threading. If you are writing large-scale Windows

applications that do more than read from and write to a database, you will be
interested, [ promise!



Part IV
Digging into the
Framework

The Sth Wave By Rich Tennant

TFREE LANCER. NED WiLLS CONSULTS
WITH A MEMBER OF WIS TeCHNICAL STAFF

& {

L " s 3
“..and that’s pretty much all there is to
creating a dgnamic array.”




In this part . . .

Fle .NET Framework is the backbone of Visual Basic
2005. It provides access to databases, graphics, secu-
rity, files, and just about everything that your program
might want to use. In this part, you use the tools that do
that work for you, and trust me, you’ll be amazed at how
that framework makes some very difficult features seem
very, very easy.




Chapter 14
Writing Secure Code

In This Chapter

Designing for security

Building secure Windows and Web applications
Digging into System. Security

Security is a big topic. Ignoring for a moment all of the buzzwords sur-
rounding security, I'm sure you realize that you need to protect your
application from being used by people who shouldn’t be using it. You also
know that you need to prevent your application from being used for things it
shouldn’t be used for.

At the beginning of the electronic age, security was usually performed by
obfuscation. If you had an application that you didn’t want people peeking at,
you just hid it, and no one would know where to find it. Thus, it would be
secure. (Remember the movie War Games? The military just assumed that no
one would find the phone number to connect to their mainframes — but
Matthew Broderick’s character did.)

That obviously doesn’t cut it anymore, and now you need to consider secu-
rity as an integral requirement of every single system that you write. Your
application might not have sensitive data in it, but can it be used to get to
other information on the machine? Can it be used to gain access to a network
that it shouldn’t? The answers to these questions matter.

The two main parts to security are authentication and authorization.
Authentication is the process of making sure a user is authentic — that is, that
the user is who he or she claims to be. The most common method of authen-
tication is to require the use of a username and password, though other ways
exist, such as thumbprint scans. Authorization is the act of making sure that a
user has the authority to do what he or she asks to do. File permissions are a
good example of this — users can’t delete system-only files, for instance.
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The silent partner of security is making sure that your system can’t be fooled
into believing a user is authentic and/or authorized. Because of this require-
ment, there is more to security than just inserting username and password
text boxes in your program. In this chapter, I tell you what tools are available
in the .NET Framework to help you make sure that your applications are
secure.

Designing Secure Software

Security is a fair amount of work to accurately design. If you break the
process into pieces, you find that it is a lot more reasonable to accomplish.
The Patterns and Practices team (a group of software architects at Microsoft
who devise programming best practices) have created a systematic approach
to designing secure programs that I think you will find very straightforward,
so I describe it in the following sections.

Determining what to protect

Different applications have different artifacts that need protection, but all
applications have something that needs protection. If you have a database in
your application, then that is the most important item to protect. If your
application is a server-based application, then the server should rate pretty
high when you’re determining what to protect.

Even if your program is just a little single-user application, the software
should do no wrong — an outsider shouldn’t be able to use the application to
break into the user’s computer.

Documenting the components
of the program

If you think this section’s title sounds similar to part of the design process
described in Chapter 3, you're right. A lot of threat modeling is just under-
standing how the application works and describing it well.

First, describe what the application does. This description becomes a func-
tional overview. If you follow the steps laid out in Chapter 3, then the use
cases, requirements, or user stories document (depending on your personal
methodology) should give you a good starting point.
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Next, describe how the application gets all of that stuff done at the highest
level. A Software Architecture Overview (SAO) diagram is a great way to do
this. This diagram shows which machines and services do what in your
software.

If you happen to be using Visual Studio Team System, building a diagram in
the Enterprise Architect version is the ultimate SAO diagram and is a good
model.

Sometimes the SAO is a very simple diagram — if you have a standalone
Windows Forms program like a game, that’s all there is! A standalone pro-
gram has no network connection, and no communication between software
parts. Therefore, the software architecture is just the one machine.

Decomposing the components
into functions

After you have a document that says what the software is doing and how, you
need to break out the individual functional pieces of the software. If you have
set up your software in a component fashion, then the classes and methods
show the functional decomposition. It’s really simpler than it sounds.

The end result of breaking the software into individual pieces is having a
pretty decent matrix of what components need to be protected, what parts of
the software interact with each component, what parts of the network and
hardware system interact with each component, and what functions of the
software do what with each component.

Identifying potential threats
in those functions

After you have the list of components that you need to protect, you get to do
the tough part: Put two and two together. Identifying threats is the process
that gets the security consultants the big bucks, and it is almost totally a
factor of experience.

For instance, if your application connects to a database, you would have to
imagine that the connection could potentially be intercepted by a third party.
If you use a file to store sensitive information, it is theoretically possible that
the file could be compromised.
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To create a threat model, you need to categorize the potential threats to your
software. An easy way to remember the different categories of threats is as
the acronym STRIDE:

v~ Spoofing identity: Users pretending that they are someone who they
are not.

v Tampering with data or files: Users editing something that shouldn’t be
edited.

” Repudiation of action: Users having the opportunity to say they didn’t
do something that they actually did do.

v Information disclosure: Users seeing something that shouldn’t be seen.

v Denial of service: Users preventing legitimate users from accessing the
system when they need to.

v~ Elevation of privilege: Users getting access to something that they
shouldn’t have access to.

All these threats must be documented in an outline under the functions that
expose the threat. This strategy not only gives you a good, discrete list of
threats, but also focuses your security hardening on those parts of the appli-
cation that pose the greatest security risk.

Rating the risk

The final step in the process is to rate the risks. Microsoft uses the DREAD
model to assess risk to its applications. DREAD is an acronym that defines
five key attributes used to measure each vulnerability:

v Damage potential: The dollar cost to the company for a breach.

* Reproducibility: Are there special conditions to the breach that could
make it harder or easier to find?

v Exploitability: How far into a corporate system could a hacker get?
v~ Affected users: Who is affected? How many users?
v Discoverability: How easy is it to find the potential breach?
You can research the DREAD model at http://msdn.microsoft.com/
security, or just position your threat model to consider those attributes.

The key is to determine what threats are most likely to cause problems and
to mitigate them as best you can.
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Building Secure Windows
Forms Applications
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The framework lives in a tightly controlled sandbox when running on a client
computer. Because of the realities of this sandbox, the configuration of secu-
rity policy for your application becomes very important.

The first place you need to look for security in writing Windows Forms is in
the world of authentication and authorization. Authentication is confirming
the identity of a user, and authorization is determining what he or she can
and can’t do within an application.

When you are threat modeling, you can easily consider all of the possible
authentication and authorization threats using the STRIDE acronym. (See the
earlier section, “Identifying potential threats in those functions,” for more
about STRIDE.)

Authentication using Windows login

To be straightforward, I have to say that the best way for an application to
authorize a user is to make use of the Windows login. There are a whole host
of arguments for this and other strategies, but it all comes down to simplic-
ity: Simple things are more secure.

For much of the software developed with Visual Studio, the application will
be used in an office by users who have different roles in the company; for
example, some of those users might be in the Sales or Accounting depart-
ments. In many environments, the most privileged users are managers or
administrators — yet another set of roles. In most offices, each employee has
his or her own user account, and each user is assigned to the Windows NT
groups that are appropriate for the roles he or she plays in the company.

Using Windows security only works if the Windows environment is set up
correctly. You can’t effectively build a secure application in a workspace with
a bunch of Windows XP machines where everyone logs on as the
Administrator, because you can’t tell who is in what role.

Building a Windows Forms application to take advantage of Windows security
is pretty straightforward. The goal is to check to see who is logged in
(authentication) and then check that user’s role (authorization).
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The following steps show you how to create an application that protects the
menu system for each user by showing and hiding buttons:

1. Start a new Windows Application project by choosing File=>New
Project, and give your new project a descriptive name.
For example, | named my project Windows Security.

2. Add three buttons to your form — one for Sales Menu, one for
Accounting Menu, and one for Management Menu.

My example is shown in Figure 14-1.

I | o2 Our Company Application :- [D]
Figure 14-1: | Our Company Application
The
example d
Windows
ety v
application.
| o ]

3. Set all of the buttons’ visible properties to False so that they are not
seen on the form by default.

4. Double-click on the form to get to the Form1_ILoad event handler.

5. Above the Class statement, import the System.Security.Principal
namespace, as follows:

Imports System.Security.Principal

6. In the class statement, dimension a new Identity object that repre-
sents the current user with the GetCurrent method of the
WindowsIdentity object by adding the following code:

Dim myIdentity As WindowsIdentity =
WindowsIdentity.GetCurrent

7. Get a reference to this identity with the windowsPrincipal class, as
follows:

Dim myPrincipal As WindowsPrincipal = New
WindowsPrincipal (myIdentity)

8. Finally, in the Forml_Load subroutine, run a little If/Then statement
to determine which button to show. All of the code is shown in
Listing 14-1.
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Listing 14-1: The Windows Security Application’s Code

Public Class Forml
Dim myIdentity As System.Security.Principal.WindowsIdentity =
System.Security.Principal.WindowsIdentity.GetCurrent
Dim myPrincipal As WindowsPrincipal = New
System.Security.Principal.WindowsPrincipal (myIdentity)
Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
If myPrincipal.IsInRole("Accounting") Then
AccountingButton.Visible = True
ElseIf myPrincipal.IsInRole("Sales") Then
SalesButton.Visible = True
ElseIf myPrincipal.IsInRole("Management") Then
ManagementButton.Visible = True
End If
End Sub
End Class

In order to successfully run this code, you must have an environment that
has Accounting, Sales, and Management NT user groups.

There are cases when you don’t need this kind of diversification of roles.
Sometimes you just need to know if the user is in a standard role. System.
Security provides for that, too. Using the WindowsBuiltInRole enumera-
tor, you can describe actions what should take place when, for example, the
Administrator is logged in.

If myPrincipal.IsInRole (WindowsBuiltInRole.Administrator) Then
'Do something
End if

Encrypting information

Encryption is — at the core — an insanely sophisticated process. Five name-
spaces are devoted just to different algorithms. Because encryption is so
complex, I'm not going to get into the details in this book.

Nonetheless, it is important that you understand one cryptographic element
for a key element of security — encrypting files. When you work with a file in
a Windows Forms application, you run the risk of someone just loading it up
in a text editor and looking at it, unless you have encrypted the program.

DES (Data Encryption Standard) is a common encryption scheme that is
implemented simply in .NET. It is not the strongest encryption in these days
of 64-bit desktop machines, but it is strong enough to encrypt the data files
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for a Windows application. You can find the methods to encrypt for DES in
the DESCryptoServiceProvider in the System. Security.Cryptography
namespace.

Deployment security

If you are deploying your application using C1ickOnce, then you need to
define the access to the PC that the application will request. C1ickOnce is a
Web server-based deployment strategy that allows users to run Windows
Forms applications from a Web browser. This is accomplished with the
Security tab in the My Project configuration file, as shown in Figure 14-2.

Getting to the My Project configuration file is fairly straightforward:

1. From an open project, go the Solution Explorer by pressing
CTRL+ALT+L.
2. Double-click the My Project file.

3. Click the Security tab.

3 Windows Security - Microsolt Visual Studio d@]%
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Here, you can define the features that your application uses, so that the user
installing it will receive a warning at installation rather than a security error
when running the application.

Building Secure Web Forms Applications

CMBER

Web Forms applications are disconnected, loosely coupled programs that
expose a server to potential attacks through the exposed ports used by the
applications. By loosely coupled, | mean they have a transact-and-wait rela-
tionship with the server.

Because of this coupling, building for security becomes more important than
ever with a Web Forms application. A side effect of this is that your applica-
tion can become less functional due to security considerations.

When building Web-based applications, you spend less of your time worrying
about authentication (especially if your application is made publicly avail-
able) and more time worrying about crackers. Because you are making a
server — usually something you would keep private — available to the
public, your programs are subject to a whole new set of rules for security.

The key to protecting a public server is honesty. You have to be honest with
yourself about the weaknesses of the system. Don’t think, “Well, a cracker
could figure out the password by doing XYZ, but no one would ever do that.”
Trust me, someone will figure it out.

The two main types of attacks you should be concerned about for a Web
Forms application are SQL Injection attacks and script exploits.

SOL Injection attacks

A SQL Injection attack is when a hacker enters a line of SQL code into a

input field used to query a database in a form on a Web page (such as the
Username and Password text boxes in a login form). This malicious SQL code
is written in such a way as to cause the database to act in an unexpected way
or to allow the hacker to gain access to, alter, or damage the database.

Understanding SOL Injection

The best way to understand how a hacker uses a SQL Injection is to see an
example. For instance, a Web page has code in place that accepts a Product
ID from the user in a text box and returns product details based on the
Product ID the user entered. The code on the server might look like this:
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'Get productId from user

Dim productId As String = TextBoxl.Text

'Get information from the database.

Dim selectString As String = "SELECT * FROM Items WHERE
ProductId = '" & productId & "';"

Dim cmd As SglCommand = New SglCommand (selectString, conn)

conn.Open ()

Dim myReader As SqglDataReader = cmd.ExecuteReader ()

' Process results.

myReader.Close ()

conn.Close()

Normally, a user would enter the appropriate information into the text box.
But a cracker attempting a SQL Injection attack would enter the following
string into textBox1:

"FOOBAR' ; DELETE FROM Items;--"

The SQL code that would be run by your code would look like this:

SELECT * FROM Items WHERE ProductID = 'FOOBAR';DELETE FROM
Items; --"'

The SQL Server executes some code you didn’t expect; in this case, the code
deleted everything in the Items table.

Preventing SOL Injection

The easiest way to prevent SQL Injection is to not ever use string concatena-
tion to generate SQL. Use a stored procedure and SQL parameters. You can
read more about that in Chapter 15.

Script exploits

A script exploit is a security flaw that takes advantage of the JavaScript engine
in a user’s Web browser. Script exploits take advantage of one of the more
common features of public Web Forms applications — enabling interaction
among users. For instance, a Web Forms application may enable a user to
post a comment that other users of the site can view, or it may allow a user to
fill out an online profile.

Understanding script exploits

If a malicious user were to put some script code in his or her profile or com-
ment, that hacker could take over the browser of the next user who came to
the site. Several outcomes are possible, and none of them are good.
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For instance, the cookies collection is available to JavaScript when a user
comes to your site. A malicious user would put some script code in his or her
profile that could copy the cookie for your site to a remote server. This could
give the malicious user access to the current user’s session because the ses-
sion identifier is stored as a cookie. The malicious user would then be able to
spoof the current user’s identity:.

Preventing script exploits

Fortunately, ASP.NET prevents users from typing most script code into a form
field and posting it to the server. Try it with a basic Web Forms project by fol-
lowing these steps (you will get the error shown in Figure 14-3):

. Create a new Web Forms project.

. Add a text box and a button to the default page.

1

2

3. Run the project.

4. Type <script>msgbox()</script> into the text box.
5

. Click the button.
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) Additionally, you can use the Server .HTMLEncode method to encode any-

thing that the Web Forms application sends to the screen — this will make
script code appear in real text rather than in actual HTML.

Best practices for securing your
Web Forms applications

Aside from making sure that your Web Forms application will prevent SQL
Injection attacks and script exploits, you should keep in mind some good
practices for securing your Web applications.

The following list runs down some of the most important practices for secur-
ing your Web applications:

v Keep your IIS box up to date.

v Back up everything.

v Avoid using a Querystring variable.

v Don’t leave HTML comments in place. Any user can view the HTML code
and see your comments by choosing Viewr>Source in a browser.

v Don’t depend on client-side validation for security — it can be faked.
v Use strong passwords.

v Don’t assume what the user sent you came from your form and is safe. It
is easy to fake a form post.

v Make sure that error messages don’t give the user any information about
your application. E-mail yourself the error messages instead of display-
ing them to the user.

v Use Secure Sockets Layer.

v Don’t store anything useful in a cookie.

v Close all unused ports on your Web server.
v Turn off SMTP on IIS unless you need it.

v Run a virus checker if you allow uploads.

+ Do not run your application as Administrator.

v Use temporary cookies, if possible, by setting the expiration date to a
past date. The cookie will stay alive only for the length of the session.
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v Put a size limit on file uploads. You can do this in the web. Config file, as

follows:

<configuration>
<system.web>

<httpRuntime maxRequestLength="4096"

</system.web>
</configuration>

/>

1 Remember that the viewState of Web Forms are easily viewable.

Using System.Security

While much of the security tools are built into the classes that use them,
some classes defy description or classification. For that reason,
System.Security is the holding pot for stuff that doesn’t fit anywhere else.

The more common namespaces for System. Security are described in
Table 14-1. I show how to use the Security.Principal namespace in the
earlier section, “Authentication using Windows login.”

Table 14-1 Common Namespaces in System.Security
Namespace Description Common Classes
Security Base classes for security CodeAccessPermission,
SecureString
AccessControl Sophisticated control for AccessRule, AuditRule
authorization
Authorization Enumerations that describe CipherAlgorithmType
the security of an application
Cryptography  Contains several namespaces CryptoConfig,
that help with encryption DESCryptoService
Provider
Permissions Controls access to resources PrincipalPermission,
SecurityPermission
Policy Defends repudiation with Evidence, Site, Url
classes for evidence
Principal Defines the object that repre- WindowsIdentity,

sents the current user context

WindowsPrincipal
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Chapter 15
Accessing Data

In This Chapter

Understanding the System.Data namespace
Connecting to a data source
Working with data from databases

Making quick data management screens

Not to predispose you to the contents of this chapter, but you will proba-
bly find that data access is the most important part of your use of the
.NET Framework. You're likely to use the various features of the System.Data
namespace more than any other namespace.

Unquestionably, one of the most common uses of Visual Basic is the creation
of business applications. Business applications are about data. This is the
black and white of development with Visual Basic 2005. While understanding a
little of everything is important, complete understanding of the System.Data
namespace is very important when you’re building business applications.

You can look at the data tools in VB 2005 in three ways:

+~ Database connectivity: Getting information out of and into a database is
a primary part of the System.Data namespace.

1 Holding data in containers within your programs: The Dataset,
DataView, and DataTable containers are useful mechanisms for accom-
plishing the holding of data. If you are a Visual Basic 6 or ASP program-
mer, you remember Recordsets, which have been replaced by the new
constructs.

+~ Integration with data controls: The System.Web and System.Windows
namespaces function to integrate with the data controls. Data control
integration uses database connectivity and data containers extensively.
This makes data controls a great target for your reading in this chapter.
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Getting to Know System.Data

Data in .NET is different from data in any other Microsoft platform you have
used before. Microsoft has and continues to change the way data is manipu-
lated in the .NET Framework. ADO.NET, whose implementation is contained
in the new data library System.Data, provides yet another new way to think
about data from a development perspective:

v Disconnected: After you get data from a data source, your program is no
longer connected to that data source. You have a copy of the data. This
cures one problem and causes another:

¢ You no longer have a row-locking problem. Because you have a
copy of the data, you don’t have to constrain the database from
making changes.

¢ You have the last in wins problem. If two instances of a program get
the same data, and they both update it, the last one back to the
database overwrites the changes made by the first program.

v XML driven: The data copy that is collected from the data source is
actually XML under the hood. It might be moved around in a custom
format when Microsoft deems it necessary for performance, but it is just
XML either way, making movement between platforms or applications or
databases much easier.

v~ Database-generic containers: The containers don’t depend on the type
of the database at all — they can be used to store data from anywhere.

v Database-specific adapters: Connections to the database are specific to
the database platform, so if you want to connect to a specific database,
you need the components that work with that database.

The process for getting data has changed a little too. You used to have a con-
nection and a command, which returned a Recordset. Now, you have an
adapter, which uses a connection and a command to fill a DataSet container.
What has changed is the way the user interface helps you get the job done.

System.Data has the classes to help you connect to a lot of different data-
bases and other types of data. These classes are broken up into the name-
spaces in Table 15-1.
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Table 15-1

The System.Data Namespaces

Namespace

Purpose

Most Used Classes

System.Data

Classes common to all of
ADO.NET

The containers DataSet,
DataView, DataTable,

DataRow.
System.Data. Utility classes used by data- DbCommand,
Common base-specific classes DbConnection
System.Data. Classes for connections to OdbcCommand,
ODBC 0DBC databases such OdbcAdapter
as dBASE
System.Data. Classes for connections to OleDbCommand,
OleDb OleDb databases such as OleDbAdapter
Access
System.Data. Classes for connections to OracleCommand,
OracleClient Oracle OracleAdapter
System.Data. Classes for connections to SglCommand,
SglClient Microsoft SQL Server SglDataAdapter
System.Data. For referencing the native SglDateTime

SglTypes

types common to SQL Server

Though there is a lot to the System.Data namespace and related tools, I
focus on the way Visual Studio implements these tools. In previous versions
of the development software of all makes and models, the visual tools just
made things harder because of the black box problem.

The black box problem is that of having a development environment do things
for you over which you have no control. Sometimes, it’s nice to have things
done for you, but when the development environment doesn’t build things
exactly how you need them, it ends up generating code that isn’t very useful.

Fortunately, that isn’t the case anymore. Visual Studio now generates com-
pletely open and sensible VB code when you use the visual data tools. I think
you will be pleased with the results.
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How the Data Classes Fit
into the Framework

The data classes are all about information storage. In Chapter 13, I talk about
collections, which are for storage of information while an application is run-
ning. Hashtables are another example of storing information. Collections hold
lists of objects, and hashtables hold name and value pairs.

The data containers hold data in larger amounts and help you manipulate
that data. The data containers include the following:

v Dataset: Kind of the granddaddy of them all, the DataSet container is
an in-memory representation of an entire database.

” DataTable: A single table of data stored in memory, the DataTable
container is the closest thing you can find to a Recordset, if you are a
VB 6 programmer and are looking. DataSet containers are made up of
DataTable containers.

v DataRow: Unsurprisingly, a row in a DataTable container.

v DataView: A copy of a DataTable that can be used to sort and filter
data for viewing purposes.

»” DataReader: A read-only, forward-only stream of data that is used for
one-time processes such as filling up list boxes. Usually called a fire
hose.

Getting to Vour Data

Everything in the System.Data namespace revolves around getting data
from a database such as Microsoft SQL Server and filling these data contain-
ers. You can get to this data manually. Generally speaking, the process goes
something like this:

1. You create an adapter.

2. You tell the adapter how to get information from the database
(the connection).

3. The adapter connects to the database.
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4. You tell the adapter what information to get from the database
(the command).

5. The adapter fills the Dataset container with data.
6. The connection between the adapter and the database is closed.

7. You now have a disconnected copy of the data in your program.

Not to put too fine a point on it, but you shouldn’t have to go through that
process at all. Visual Studio does a lot of the data management for you if you
let it, and [ recommend that you do.

Using the System.Data Namespace

The system.Data namespace is another namespace that gets mixed up
between the code world and the visual tools world. Though it is more of a
relationship between the form controls and the Data namespace, it often
seems like the data lives right inside the controls, especially when you're
dealing with Visual Basic.

In the following sections, you deal primarily with the visual tools, which are
as much a part of the Visual Basic experience as the code. First, I go over
connecting to data sources, and then I show you how to write a quick appli-
cation using one of those connections. Finally, [ go over a little of the code
side.

Connecting to a data source

There is more to connecting to a database than a establishing a simple con-
nection to Microsoft Access these days. Visual Basic developers have to con-
nect to mainframes, text files, unusual databases, Web services, and other
programs. All of these disparate systems get integrated into windows and
Web screens, with update, add, and delete functionality to boot.

Getting to these data sources is mostly dependent on the Adapter classes of
the individualized database namespaces. Oracle has its own, as does SQL
Server. Databases that are ODBC (Open Database Connectivity) compliant
(such as Microsoft Access) have their own Adapter classes, and the newer
OLEDB (Object Linking and Embedding Database) protocol has one, too.



258 Part IV: Digging into the Framework

|
Figure 15-1:
The Data
Sources
panel.
|

Fortunately, a wizard handles most of this. The Data Source Configuration
Wizard is accessible from the Data Sources panel, where you spend much of
your time when working with data. To get started with the Data Source
Configuration Wizard, follow these steps:

1. Start a new Windows Application project by choosing Filec=>New

Project. Select a Visual Basic Windows Application and give it an
appropriate name.

For this example, | named the Windows Application project Accessing
Data.

. To open the Data Sources panel, choose Data=>Show Data Sources, or

press Shift+Alt+D.

It should tell you that you have no data sources, as shown in Figure 15-1.

Data Sources =

3. Click the Add New Data Source link in the Data Sources panel.

This brings up the Data Source Configuration Wizard. The wizard has a
variety of data source types that you can choose from. The most inter-
esting of these is the Object source, which gives you access to an object
in an assembly to bind your controls to.

Click the Object source type to see the options there, as shown in
Figure 15-2, and click the Previous button to go back to the previous
screen.



|
Figure 15-2:
Using an
object for a
data source.
|

|
Figure 15-3:
Using a
Web service
for a data
source.
|
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Data Source Configuration Wizard

Select the Object you wish to bind to

In what assembly is the object located?

= ] Accessing Databases | | AddReference...

=-{} Accessing_Databases
€5 2

Hide assemblies that begin with Microsoft or System

<previos |[_mext> ][ Finsh | [ cancel

You can pick a Web service to connect to a function on another com-
puter. I cover Web service creation and consumption in Chapter 7, but
this functionality sets you up to have a data source along with the Web
service reference. It’s pretty cool. I selected the TemperatureService
from XMethods as an example in Figure 15-3.

When you are done looking around, click the Previous button to come
back.

Add Web Reference =]

Mavigabe bo & web service URL and dick Ade Reference to add 3l the avalabie services
 sack @
URL: | bt fjwmons samthiods. retfocd/ 2001 TempersbreSenioesd v | Y5,
"'I'emperatureService" Deseription We ga.vices fourd at this URL:
1 Service Found:
Documentation - Temperatresenvice

Returns current temperaturs in s guen LS. zpcode

Methods
= getTempl Ls
Add Reference
| Cercel

4. Click the Database data source type to be taken to the Choose Your
Data Connection screen, as shown in Figure 15-4.

The most common point of access is a database.
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|
Figure 15-4:
Choosing
your data
connection.

|
Figure 15-5:
The Add
Connection
dialog box.
|

- . . T
Data Source Configuration Wizard - _
kg
Choose your data connection
Which data should your use to connect to the database?
» Mew Connection...
3|

5. If you have an existing data connection, it appears in the drop-down
list. Otherwise, you need to click the New Connection button to bring
up the Add Connection dialog box, as shown in Figure 15-5.

For this example, I click the New Connection button and select

Northwind, the Microsoft sample database.

Add Connection
Enter information to connect to the selected data source or dick
“Change” to choase a different data source andjor provider,

Data source:
Microsoft SQL Server (SgiCient) Change...
Server name:
| b Refresh
Log on to the server
(%) Use Windows Authentication
() Use SQL Server Authentication
Connect to a database
Advanced...
Test Connection Cancel
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The Add Connection dialog box assumes that you are going to connect
to a SQL server. If that isn’t the case, click the Change button to select
a different database from the Change Data Source dialog box, as shown
in Figure 15-6. For this example, [ chose Microsoft SQL Server and

clicked OK.
=1
| Change Data Source L
Dafa source: ) 5
Microsoft Access Database Fle bescpton
Microsoft ODBC Data Source Use this selection to connect to
Microsoft SQL Server Microsoft SQL Server 7.0, 2000 or
[ Microsoft SQL Server Database File 2005 using the .NET Framewark Data
Microsoft SOL Server Mobile Edition Provider for SQL Server.
- Orade Database
Figure 15-6: | -ove-
The Change :
Data provider: %
Data Source | /e rranenorkData providerfor | ~
d|a|0g box. [[] Always use this selection K ! [ Cancel
I

6. Select a server from the Server Name drop-down list.

7. Select the Northwind database from the Select or Enter a Database
Name drop-down list.

8. Click OK.
You go back to the Choose Your Data Connection screen.

9. Click the Next button to save the connection string to the application
configuration file.

10. Accept the defaults by clicking Next.

You go the Chose Your Database Objects screen. Here you can choose
the tables, views, or stored procedures that you want to use.

11. Under Tables, select Orders and OrderDetails (as shown in Figure 15-7),
and click Next.

You're done! If you go look at the Data Sources panel, you find that the new
data connection was added, as shown in Figure 15-8.

Note that the Data Sources panel has the Orders tables, and the Data
Connections panel has all the tables. This is because the DataSet container
that you built in the wizard just has the Orders table and related tables in it.
The Data Connections panel shows everything in the database.
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|
Figure 15-7:
Selecting
your data
objects.
|

|
Figure 15-8:
New data
connections
appearin
the Data
Sources
panel.
|

Data Source Configuration Wizard

Choose your database objects

‘Which database objects do you want in your dataset?
= EET
=[] categories
= []E] CustomerCustomerDems
% [ |E CustomerDemographics
= |_| Cushomrers
#-CIE Emplayees
EmployeeTerritories
[ Crder Dekais
+ [P Orders
= []E Products
# [_|E@ region
# 15 shiopers
=[] suppliers
DakaSet name:

x

Data Sources

e L

= L MorthwindDataset

] Order Detals
+-13 Orders

o Selutien E... | 3] Daka Sources

» You create a connection to the database, shown in the Database
Explorer. You find that it sticks around — it is specific to this installation

of Visual Studio.

v You also create a project data source, which is specific to this project,

By following the preceding steps, you create two significant entities in Visual
Studio:

and won’t be there if you start another project.
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|
Figure 15-9:
Table
Options
drop-down
list.

Both of them are important, and they provide different functionality. In this
chapter, I focus on the project-specific data source displayed in the Data
Sources panel.

Working with the visual tools

The RAD data tools for Visual Basic are a massive improvement over what
has previously been provided by Microsoft. The RAD data tools in Visual
Basic 2005 are usable, do what you need, and actually write decent code
for you.

You need to know that I would never, ever show this kind of black magic if it
was not a best practice. In the past, tools that did something that you couldn’t
see often did their job poorly. Using the tools, in the long run, actually made
your program worse. The new tools, though, are a pretty good way to build
software. People may tell you that [ am wrong, but it really isn’t bad. Try it!

If you click a table in the Data Sources panel, a drop-down arrow appears.
Select it and you see something very interesting, as shown in Figure 15-9.

A drop-down list appears, which enables you to choose how that table is

integrated into Windows Forms.

Data Sources =
3 37 G |
=/ [ NerthwindDataset

| prdrDate] v

13 pataGridvien
= DeEIBs
3 [Narke]

Customize, .,

_‘Q Solubion E... j Daka Sources

Change the Orders table to a Details view. It is used to create a detail type
form — one that easily allows the user to view and change data. Then drag
the table to the form, and the Details view is created for you, as shown in
Figure 15-10.
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Creating an
Orders
Detail data
form.
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A whole lot of things happened when you dropped the table on your form.
First, the fields and the field names were added. The fields are in the most
appropriate format — note that the Order Date is a date chooser. The field
name is a label — and Visual Studio automatically adds a space where the
case changes.
¥ Note that each field gets a Smart Tag that allows you to specify a query for
the values in the text box. You can also preset the control that is used by
changing the values in the Data Sources panel, as shown in Figure 15-10.

Also, a VCR Bar (called the BindingNavigator) is added to the top of the
page. When you run the application, you can use the VCR Bar to cycle among
the records in the table.

Finally, four completely code-based objects are added in the Component
Tray at the bottom of the page: the Dataset, the BindingSource, the
DataAdapter, and the BindingNavigator objects.
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Click the Play button and you can easily see the VCR Bar work. You can walk
through the items in the database with no problems, as shown in Figure 15-11.
It’s just like working in Access or FoxPro, but with enterprise quality!

—

=X

L= -

04, 1996
01,1996

16,1936

a2 Form1 k
I [ Jorsam] b bi %
Cirder ID: 10249
Customer IC: VINET
Employee ID: 5
Diredes Date: Thurzday . Jul
Fequited D ate: Thureday . August
Shipped Date: Tuesday . July
Ship Via: 3
Freight 32,3800
Ship Mame: Wing &l alcoals Chevalist
Ship Address: 59 1 de labbaye
Ship City: Reims
Ship Region:
Ship Postal Code: | 51100
— Ship Couniry; France
Figure 15-11:
Running the
example.
I

w

w

v

It gets better. Follow these steps to create a child table interface:

1. Open the Order table in the Data Sources panel by clicking on the
plus sign next to the table.

2. Scroll down until you see the Order Details table nested in the Orders

table.

3. Drag the that instance of the table over to the form and place it under
the Orders fields that you placed on the form earlier in this section
(refer to Figure 15-10).

4. Click the Play button to run the example, as shown in Figure 15-12.

You have a running, easy-to-use parent/child form, with orders and order
details. Creating this form would have required you to write 100 lines of code
even in previous versions of VB. With the ability to choose an assembly for a
data source that Visual Basic 2005 grants you, the form is even enterprise
ready. It’s pretty slick stuff.
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|
Figure 15-12:
A complete
edit form.
|

P =

! Form1 Q@
LI 4 [+ |nraan,m 3l " |
u
Order ID: =2l
Customer 1D: WICTE

Employes |D: 3

Ordler Date: Mondsy . July 02199 ||
Requred Date: Mondsy . August 06,1996 ||
Shipped Date: Mondsy . July 151996 ||
Ship Via 1

Freight: 41,3400

Ship Nare: Wiclualles en stock.

Ship Address: 2. e du Commerce

Ship Ciy: Lycen

Ship Region:

Ship Postal Code: 65004

Ship Counbiy: France

OrderlD FroductiD UritPiice
» 10251 22 16,5000
10251 57 15,6000

10261 113 16.8000

Writing data code

In most enterprise development environments, you won’t be using the visual
tools to build data access software. Generally, an infrastructure is already in
place.

The reason for this is that often, enterprise software has very specific
requirements, and the easiest way to manage those specifications is with
unique and customized code. In short, some organizations don’t want things
done the way Microsoft does them.

Output of the visual tools

The reason that the visual tools are often not used in enterprise environ-
ments is that the code the tools put out is rather sophisticated. If you switch
to Code View and right-click on an instance of an object (such as the
CustomersTableAdapter object) and select Go To Definition, you go to the
code behind the designer.
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I count 212 lines of code in that file — much of it going to defining the data
objects being used — as shown in the following code:

'NorthwindDataSet

Me.NorthwindDataSet.DataSetName = "NorthwindDataSet"

'CustomersBindingSource

Me.CustomersBindingSource.DataMember = "Customers"

Me.CustomersBindingSource.DataSource = Me.NorthwindDataSet

'CustomersTableAdapter

Me.CustomersTableAdapter.ClearBeforeFill = True

'CustomersBindingNavigator

Me.CustomersBindingNavigator.AddNewItem = Me.bindingNavigatorAddNewItem

Me.CustomersBindingNavigator.BindingSource = Me.CustomersBindingSource

Me.CustomersBindingNavigator.CountItem = Me.bindingNavigatorCountItem

Me.CustomersBindingNavigator.CountItemFormat = "of {0}"

Me.CustomersBindingNavigator.DeleteItem = Me.bindingNavigatorDeleteItem

Me.CustomersBindingNavigator.Items.AddRange (New
System.Windows.Forms.ToolStripItem()
{Me.bindingNavigatorMoveFirstItem,
Me.bindingNavigatorMovePreviousItem, Me.bindingNavigatorSeparator,
Me.bindingNavigatorPositionItem, Me.bindingNavigatorCountItem,
Me.bindingNavigatorSeparatorl, Me.bindingNavigatorMoveNextItem,
Me.bindingNavigatorMoveLastItem, Me.bindingNavigatorSeparator2,
Me.bindingNavigatorAddNewItem, Me.bindingNavigatorDeleteItem,
Me.bindingNavigatorSaveItem})

Me.CustomersBindingNavigator.Location = New System.Drawing.Point (0, 0)

Me.CustomersBindingNavigator.MoveFirstItem = Me.bindingNavigatorMoveFirstItem

Me.CustomersBindingNavigator.MoveLastItem = Me.bindingNavigatorMoveLastItem

Me.CustomersBindingNavigator.MoveNextItem = Me.bindingNavigatorMoveNextItem

Me.CustomersBindingNavigator.MovePreviousItem =
Me.bindingNavigatorMovePreviousItem

Me.CustomersBindingNavigator.Name = "CustomersBindingNavigator"

Me.CustomersBindingNavigator.PositionItem = Me.bindingNavigatorPositionItem

Me.CustomersBindingNavigator.Size = New System.Drawing.Size (292, 25)

Me.CustomersBindingNavigator.TabIndex = 0

Me.CustomersBindingNavigator.Text = "BindingNavigatorl"

'bindingNavigatorMoveFirstItem

Me.bindingNavigatorMoveFirstItem.DisplayStyle =
System.Windows.Forms.ToolStripItemDisplayStyle.Image

Me.bindingNavigatorMoveFirstItem.Image =
CType (resources.GetObject ("bindingNavigatorMoveFirstItem. Image"),
System.Drawing.Image)

Me.bindingNavigatorMoveFirstItem.Name = "bindingNavigatorMoveFirstItem"

Me.bindingNavigatorMoveFirstItem.Text = "Move first"

Nothing is wrong with this code, but it is purposely very generic to support
anything that anyone might want to do with it. Enterprise customers often
want to make sure that everything is done the same way. For this reason,
they often define a specific data code format and expect their software devel-
opers to use that, rather than the visual tools.
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Basic data code
The code of the sample project is pretty simple:

Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load

'"TODO: This line of code loads data into the 'NorthwindDataSet.Customers' table.
You can move, or remove it, as needed.

Me.CustomersTableAdapter.Fill (Me.NorthwindDataSet .Customers)

End Sub

Private Sub bindingNavigatorSaveItem Click(ByVal sender As System.Object, ByVal
e As System.EventArgs) Handles bindingNavigatorSaveItem.Click
If Me.Validate Then
Me.CustomersBindingSource.EndEdit ()
Me.CustomersTableAdapter.Update (Me.NorthwindDataSet.Customers)
Else
System.Windows.Forms.MessageBox.Show(Me, "Validation errors occurred.",
"Save", System.Windows.Forms.MessageBoxButtons.OK,
System.Windows .Forms.MessageBoxIcon.Warning)
End If
End Sub

While this is fairly straightforward, it obviously isn’t everything that you
need. The rest of the code is in the file that generates the visual form itself,
supporting the visual components.

There may come a time when you want to connect to a database without
using the visual tools. I discuss the steps in the earlier section, “How the Data
Classes Fit into the Framework,” and here I show the code to go with it.

This becomes useful especially when you want to build a Web service or a
class library — though it should be noted that you can still use the visual
tools in those project types.

Dim myConnection As New SglConnection
myConnection.ConnectionString =
"server=(local) ;database=Northwind; Trusted_Connection=True"
Dim myAdapter As SglDataAdapter
myAdapter = New SglDataAdapter ("SELECT * FROM Customers", myConnection)
Dim myDataSet As New DataSet
myConnection.Open ()
myAdapter.Fill (myDataSet)
myConnection.Close ()

After running this code, you would have the Customer’s table in a DataSet
container, just as you did in the visual tools in the earlier section, “How the
Data Classes Fit into the Framework.” To access the information, you would
set the value of a text box to the value of a cell in the DataSet container, like
this:
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TextBoxl.Text = myDataSet.Tables(0) .Rows (0) ("CustomerName")

To change to the next record, you would need to write code that changes the
Rows (0) to Rows (1) in the next example. As you can see, it would be a fair
amount of code.

That’s why few people use the basic data code to get the databases. Either
you use the visual tools, or you use a data broker of some sort.

Using data brokers

A data broker is a block of code that makes data access simpler. Basically, it
takes all of the complicated piping of the database connection and puts it in a
class file, so that you can call the code that is common to all of your database
access from one place.

The Patterns and Practices team at Microsoft
(http://msdn.microsoft.com/practices) created a broker that does
exactly this, called the Enterprise Library Data Access Application Block. It is
designed for use by the large enterprises [ mention throughout this chapter,
but the broker is excellent for use in standalone applications as well, espe-
cially if you find that the visual tools don’t do the trick for some reason.

With the Enterprise Library Data Access Application Block data broker, you
only need to be concerned about the most customized parts of the data
access process, specifically:

1. Create the database object.
2. Supply the parameters for the command, if they are needed.
3. Call the appropriate method.

These steps can be executed in one line of code that looks something like
this:

myDataSet = DatabaseFactory.CreateDatabase ("Northwind") .ExecuteDataSet ("SELECT *
FROM Customers");

These steps assume that you have the Enterprise library already installed,
referenced, and configured. You can find the Enterprise library at http: //
msdn.microsoft.com/practices/default.aspx?pull=/library/en-us/
dnpag2/html/entlib.asp, or you can get it from this book’s companion
Web site at www.vbfordummies.net.
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Chapter 16
Working with the File System

In This Chapter

Understanding the classes and controls in System. I0
Using the System. I0 file management controls

Opening, saving, listing, and viewing files in your applications

Soring information in files is one of the most common tasks of a com-
puter program, and Visual Basic makes it simpler to perform those tasks
in the 2005 version. Visual Basic is not known as a strong file handling lan-
guage. With the addition of the .NET Framework, though, a surprising number
of file handling tools are available for your use.

In this chapter, [ show you how to work with the directories and files on
your computer. The System.I0 namespace and its classes, along with the
My .Computer.FileInfo class, contain the tools you need to read directo-
ries, parse files, save information to files, get file information, and more.

[ also describe the controls that Visual Studio provides for manipulating files
in Windows Forms applications. The OpenFileDialog, SaveFileDialog,
and FolderBrowserDialog speed development of programs that manage
files. The FileSystemWatcher component makes it easier to maintain com-
munication between an application and its files.

The key to working with files in .NET is to not avoid them. While it requires
some effort to design in a file format or to figure out an existing format, I rec-
ommend that you use them when you need them. The controls in Visual
Basic 2005 make using files much more straightforward than ever before.
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Getting to Know System.]0

System. IO has two categories of classes and a set of components that you
want to become familiar with: The stream classes, the file and directory
classes, and the bDialog controls.

Stream classes allow you to handle the contents of files as a sequence of
characters. Table 16-1 describes some of the common stream classes avail-
able in Visual Basic.

Table 16-1 Stream Classes in System.10

Classes Description

Binaryreader, BinaryWriter Used to read and write non-text files, such
as images, in a stream.

FileStream Can be used to make any file into a stream.
TextReader, TextWriter Specifically used for reading and writing text
to streams.

Streams are tricky tools, and I don’t cover them much here. They are mostly
used for movement of information in various states of connection, and while
this is important, it is beyond the scope of this book. I instead focus on the
file and directory tools in System. 10, which you are much more likely to
need on a daily basis.

The file and directory maintenance classes are partially shared, meaning that
you don’t need to get a copy to use them because they are always available.
You can also use the instance implementations, which accepts the path to
the file or directory in question as a parameter. The file management classes
are shown in Table 16-2.

Table 16-2 File Management Classes in System.l0

Classes Description

Directory, DirectoryInfo  Shared and instance tools for maintaining
directories.

DriveInfo Helps with maintaining a drive (such as a hard

drive or a virtual drive).
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Classes Description
File,FileInfo Shared and instance tools for maintaining files.
FileSystemWatcher A really cool class that keeps an eye on the

file system and raises events when specific
things happen.

Path Helps to maintain UNC paths to files and such.

The File Management classes in System. I0 replace the old FileSystem
Object in VB 6 and VBScript.

The classes that end in Info are instance classes, meaning you need to dimen-
sion them before you use them and give them a path to start out with. This is
handy when you are doing a lot of operations on a single file or directory. The
classes without Info at the end are shared, meaning you can use them when-
ever, like a digital toolbox. The shared classes are great for a quick change to
a file or directory.

You get the most use out of the File and Directory classes. For instance,
both classes support an Exists method, which accepts a path and returns a
Boolean value that shows if that file or directory exists — very simple, useful,
and something you just can’t live without.

The third important category of tools that the System. 10 classes provide
aren’t classes at all — they are controls. What used to be called the
CommonDialog control is now a set of controls, among those generically cate-
gorized as Dialogs.

These controls make a lot of use of the File and Directory classes, and
they make it a lot easier for you to give the users control over the files that
relate to the application. You have seen these Dialog controls in other pro-
grams (such as Microsoft Office programs). Table 16-3 describes the Dialog
controls available in Visual Basic.

Table 16-3 The Dialog Controls

Classes Description

FolderBrowserDialog Shows a dialog box that enables the user to browse
for and choose a directory.

OpenFileDialog Shows an Open dialog box that allows the user to
select a file from the local file system.

SaveFileDialog Shows a Save dialog box that enables the user to
save a file to the local file system.
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Saving files to a Web server

The classes described in Table 16-3 are
Windows Forms controls — Web applications
that need to work with files are subject to the
whims of the browser and are stuck using HTTP
Upload.

HTTP Upload gives you access to a few con-
trols, namely the FileUpload control. The
FileUpload control allows the user to select
a file on his or her local file system to upload to
the server. Remember, the Web is discon-
nected, so the files that the user sees in the
browser are on his or her machine.

After the file is uploaded on the server, the
File and Directory classes are used to

save the file on the server. For instance, the fol-
lowing code might be used to handle a file
uploaded with the FileUpload control:

myPath = "C:\files\"

Dim fileName As String =
FileUploadl.FileName

myPath += fileName

FileUploadl.SaveAs (myPath)
Behind the scenes, this code uses a
StreamWriter to save the file, which is part
ofthe System. 10 class. You see this a lot, and

are shielded from it a lot, throughout the .NET
Framework.

Using the System.10 Namespace

Some of the applications you write will require a lot of file access. Some appli-

cations need practically no file access at all. No matter what, being able to

quickly set up an application to get to a file, move it, copy it, read it, or delete

it is an important part of day-to-day programming.

The following sections provide a series of the most common tasks your pro-
grams need to perform with files and describe how System. 10 and the
related tools in the VB language make handling files easy.

All of the following examples — where appropriate — use a text file in
the c:\ directory called inputFile. txt and write to a text file called

outputFile. txt.

Opening a file

You can open a file a few ways in Visual Basic, but there is only one good way
to have the user select a file to open — the OpenFileDialog. The OpenFile
Dialog control is a Component Tray control — it doesn’t go right on a form,
but you call it from another firm object, such as a button.
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Start a new Windows Application project by choosing Filew>New Project.
Name your new Windows application something appropriate; I used the name
File Management for this example. When you have a new Windows Application
project ready, follow these steps to use the OpenFileDialog to enable the
user to open a file:

o

. Drag an openFileDialog control from the Toolbox into the form.

The OpenFileDialog component is in the Dialogs portion of the
Toolbox. It appears in the Component Tray.

2. Drag a Label control from the Toolbox onto the form. Change the
Text value to be blank, and name it FileName. Set the Autosize to
False.

3. Drag a TextBox control onto the form. Change the Multiline prop-
erty to True. Change the name to FileContents.

4. Drag a new button to the form, and set the Text value to Open a
File. Name the button openFile.

Your environment should look something like Figure 16-1.
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5. Double-click the button to enter the code editor. Visual Studio then
makes the openFile_Click event handler.

6. Add the following code into openFile_cClick to get the contents of
the file into a string variable:

Imports System.IO
Public Class Forml
'This is for the contents of the file.
Dim myFileContents As String
Private Sub OpenFile_Click(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles OpenFile.Click
'Open the dialog and make sure it was successful
If OpenFileDialogl.ShowDialog() = DialogResult.OK Then
'Open a streamreader with the file name from the dialog
Dim myStreamReader As New
StreamReader (OpenFileDialogl.FileName)
'Read the file with the streamreader
Dim myFileContents As String = myStreamReader.ReadToEnd ()
'Close the streamreader - it uses resources
myStreamReader.Close ()
'Set the output fields
FileName.Text = OpenFileDialogl.FileName.ToString
FileContents.Text = myFileContents
End If
End Sub
End Class

7. Run the application, and click the button.

If all is well, when you click the button, you will be able to select a file
and see its contents. If you put the inputFile. txt file in the Cc:\
directory, you can see the results in Figure 16-2.

o' File Management 'Z@
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You can choose from a lot of options for the 0OpenFileDialog. You can set
the default file type that is to be opened, the title of the dialog box, and the
starting directory, just for starters. Check out the Properties window for the
control to see what I mean.

Changing the contents of a file

If you followed the steps in the previous section, you have a string with a
file’s contents, and you need to get something else into the file. You use the
StreamReader to get the information out of a file, and not surprisingly, you
use the Streamiiriter to get the information back into the file.

Though the examples in this chapter use text files, you should be aware of
two caveats. First, any file that is formatted as text can be managed this way.
(Open the file in Notepad first to make sure that you do indeed have a text
file.) Second, binary files such as images can be handled with streams too,
but the output will be something other than a string (a bitmap, for instance).

For this example, the contents of the file are in a string called myFile
Contents. To get the filename, you use the saveFileDialog, which is dis-
cussed in the next section. To use the same filename, you can follow these
steps:

1. Add a button to the form and name it saveFile.

2. In the code, make a new StreamWriter and give it the filename and
contents:

Private Sub SaveFile_Click(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles SaveFile.Click
'You can get the filename from the label
Dim myStreamWriter As StreamWriter = New StreamWriter (FileName.Text)
'Then use the TextBox to get the contents.
myStreamWriter.Write(FileContents.Text)
End Sub

3. Run the application. Change the content in the text box, and click the
Save File button to save the contents.

Saving a file

If you want the user to be able to save the file with a different filename, you
can use the saveFileDialog. This is just like the OpenFileDialog, except it
allows the user to make a new filename and to save the renamed file in a dif-
ferent directory.
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To use it, just drag a SaveFileDialog to the form, and then change the code
in the saveFile_Click subroutine to the following:

Private Sub SaveFile_Click(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles SaveFile.Click
If SaveFileDialogl.ShowDialog() = DialogResult.OK Then
Dim myStreamWriter As New StreamWriter (SaveFileDialogl.FileName)
If Not (myStreamWriter Is Nothing) Then
'Then use the TextBox to get the contents.
myStreamiWriter.Write (FileContents.Text)
'Close the StreamWriter - it uses resources
myStreamWriter.Close ()
End If
End If
End Sub

When you run the application, you have a chance to give the file a new name.
Note that the saveFileDialog, like the OpenFileDialog, has a lot of
yummy options to define what the user can and can’t do. You can see some of
them in Figure 16-3.
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Listing directories and files

Directories and files are in collections as part of the System.10.File and
System.IO.Directory objects. When you call one of those methods, you get
an array of strings that are the subdirectories in the directory you specify.

So for instance, if you write a little code like this:

Dim subDirectory As String

For Each subDirectory In Directory.GetDirectories("C:\")
Console.Write("subDirectory")

Next

You get something like this:

C:\Documents and Settings
C:\Program Files
C: \WINDOWS

The same thing works for files. Notice, though, that I didn’t have to dimen-
sion a copy of the Directory class — I just got to use it. That’s because the
Directory class is shared, which allows you to use it without instantiating it.
This cuts down on clutter in your code, and on memory use as well.

On the other hand, the shared classes in System. 10 check their security
access every time they are called, while the instantiated classes check only
once, when they are instantiated. If you are going to use the classes over and
over, you should use the DirectoryInfo and FileInfo classes, described in
the next section.

Viewing file information

If, for instance, you need more information about a directory than the other
directories in it, you might want to use the DirectoryInfo (or FileInfo, for
files) class. This class is similar to the related class without the Info tag, but
it requires a New statement.

Dim subDirectory As String

For Each subDirectory In Directory.GetDirectories("C:\")
Console.Write("subDirectory")
Dim myDirectory As DirectoryInfo = New

DirectoryInfo (subDirectory)

Console.Write (myDirectory.CreationTime)
Console.Write (myDirectory.LastAccessTime)
Console.Write (myDirectory.Parent)
myDirectory = Nothing

Next
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Figure 16-4:
Adding
theFile-
System-
Watcher
to the File
Manage-
ment
application.
|

The purpose of using DirectoryInfo in line 4 is to clarify the use of the file
system and set up an object, however briefly, that has a base directory. If you
are going to use the Directory object (here, myDirectory) more than once,
it is worth using the DirectoryInfo and FileInfo classes.

Keeping an eye on files

FileSystemWatcher is a great little tool that keeps an eye on files for you. If
something happens, such as a rename or file content change, it lets you know
by throwing an event that you can catch with code.

To see how FileSystemiWatcher can be used, you can add a little feature to
the file editor you build in the preceding sections. The addition of a
FileSystemWatcher informs you when something about the files change.
1. Add a FileSystemWatcher to the File Management application.
2. Add a Label to the right of the controls you added previously.
You may need to widen the form.

3. Change the TextBox to have a Fixed3D BordersStyle, and set the
AutoSize value to False.

4. Stretch the text box out to an appropriate size. Set the Textalign
value to MiddleCenter.

Your application should look something like Figure 16-4.
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5. Add the following two lines of code to the openFile_Click event
handler:

FileSystemWatcherl.Path = "C:\"
FileSystemWatcherl.EnableRaisingEvents = True

6. Click the Object drop-down list in the Code View and select the
FileSystemWatcher, and then in the Event drop-down list, select the
Changed event.

Visual Studio creates an event handler subroutine.

7. Add the bold line of code below that writes the details of the file
change to the Label object into the FileSystemWatcherl Changed
handler that was generated for you:

Private Sub FileSystemWatcherl_ Changed (ByVal sender As
Object, ByVal e As System.IO.FileSystemEventArgs)
Handles FileSystemWatcherl.Changed
Labell.Text = String.Format("{0} was written to at
{1}", e.Name, DateTime.Now.ToString)
End Sub

The event arguments provide the filename and other details. Other events,
such as Renamed, even provide the 01dName. This would be exceptionally
useful for logging file access or changes to files in your system. It’s a powerful
object for system management.
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Chapter 17
Accessing the Internet

In This Chapter

Taking a tour of the System.Net namespace
Using built-in tools to access the network

Making the network tools work for you

n my honest opinion, the reason that Microsoft had to create the .NET

Framework in the first place was the lack of Internet interoperability
within the existing infrastructure. Visual Basic 6 just couldn’t handle the
Internet. The Internet works differently than most platforms, such as PCs.
The Internet is based on protocols — carefully defined and agreed upon ways
to get things like mail and file transfers working. Microsoft’s environment
before 2002 distinctly didn’t handle those as well.

As you can see throughout this book, the .NET Framework is designed from
the ground up to take the Internet and networking in general into considera-
tion. Not surprisingly, that is nowhere more clear than it is in the System.Net
namespace. The Internet takes first chair here, with Web tools taking up nine
of the classes in the namespace.

In this second version of the framework, even more Internet functionality is
baked in. While in version one, the focus was on tools used to build other
tools (low-level functions), now it contains features that are useful to you,
such as Web, mail, and FTP. Secure Sockets Layer — the Internet’s transport
security — is much easier to use in this version, as is FTP and mail, which
previously required other harder-to-use classes.

System.Net is a big, meaty namespace, and finding your way around it can
be difficult. My goal for this chapter is to take things that you do often and
show the basics, and then give you the tools to research the more complex
features of the classes.
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Networking is a big part of the .NET Framework, and all of the functionality is
in this namespace — a whole book can be (and has been) written on the sub-
ject. For the purposes of this introduction to networking with VB, I show you
these features:

v Getting a file from the network

v Sending e-mail

v Logging the transfers

v Checking into the status of the network around your running application
Keep in mind that [ am not saying that sockets and IPv6 and other advanced
Internet protocols are not important. I am just suggesting those parts of the

namespace that you will be using every day. As always, there is more to learn
about System.Net.

Getting to Know System.Net

The system.Net namespace is full of classes that are very confusing if
viewed in the documentation, but make a lot of sense when used in an appli-
cation. The namespace removes all of the complexity of dealing with the vari-
ous protocols used on the Internet.

There are over 2,000 RFCs for Internet protocols (an RFC is a Request For
Comments, a document that is sent to a standards body to get reviewed by
peers before it becomes a standard), and if you have to learn all of them sep-
arately, you will never get your project done. The System.Net namespace is
about making that less painful.

System.Net is not just for Web projects. Like everything else in the base
class library, you can use System.Net with all kinds of projects. You can do
the following:

v Get information out of Web pages on the Internet and use them on your
programs.

v Move files via the internet using the FTP protocols.

v Send e-mail easily.

v Use more advanced network structures.

v Secure communications over the Internet using the SSL protocol.
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If you need to check on the connectivity of a computer from a Windows appli-
cation, you can use System.Net. If you need to build a class that will down-
load a file from a Web site, System.Net is the namespace you need. Just
because most of the classes relate to the Internet doesn’t mean that only Web
applications can use it. That’s the magic of System.Net. Any application can
be a connected application. While some parts of the namespace function to
make the development of Web applications easier, the namespace in general
is designed to make any application work with the Web.

How the Net Classes Fit
into the Framework

The system.Net namespace contains 62 classes and six smaller namespaces.
Even as I write this, | am overwhelmed. However, if you look closely, you can

\BE see patterns.
«MBER

If you need help using classes, you can find more information in Chapters 1
and 3.

The classes are very well named, and you will note that a few protocols get a
number of classes each. After you translate, you can narrow down what you
need based on the way the protocol is named:

v Authentication and Authorization: These classes provide security.

»” cookie: This class manages cookies from Web browsers, and usually is
used in ASP.NET pages.

v~ DNS (Domain Name Services): These classes help to resolve domain
names into IP addresses.

v Download: This class is used to get files from servers.
v EndPoint: This class helps to define a network node.

v Fileweb: This brilliant set of classes describes network file servers as
local classes.

v FtpWeb: This class is a simple File transfer Protocol implementation.
v Http (HyperText Transfer Protocol): This class is the Web protocol.

v~ 1P (Internet Protocol): This class helps to define network endpoints
that are specifically Internet related.
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v IrDA: This class is an infrared endpoint. Infrared ports are networks too!
” NetworkCredential: This class is another security implementation.
v service: This class helps manage network connections.

1 socket: This class deals with the most primitive of network
connections.

v Upload: This set of classes helps you to upload information to the
Internet.

v Web: These classes help with the World Wide Web — largely implementa-
tions of the http classes that are more task oriented.

This list is so extensive because the classes build on each other. The End
Point classes are used by the socket classes to define certain network
specifics, and the 1P classes make them specific to the Internet. The web
classes are specific to the World Wide Web. You will rarely use highest-level
classes, but it is often tough to see what is needed when.

Most of the functions that you use every day, though, are encapsulated
within six mostly new namespaces under the System.Net namespace:

v cache: This function has a lot of enumerators that manage the browser
and network caching functions built into the namespace.

v configuration: This function grants access to the properties that you
need to set to make many of the other System.Net classes work.

v Mail: This function takes over for System.Web.Mail to facilitate the
sending of Internet e-mail.

v Mime: This function bundles file attachments with the Mail namespace.

v NetworkInformation: This function gets details about the network
around your application.

v Security: This function implements the network security managed by
many classes of System.Net.

1 sockets: This function utilizes the most basic of network connections
available to Windows.

Using the System.Net Namespace

The System.Net namespace is very code-oriented, which means that few
implementations are specifically for user interfaces. Most everything that you
do with these classes is behind the scenes. You have few drag-and-drop user
controls — the System.Net namespace is used in the Code View.
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To demonstrate this, in the rest of this chapter, I go over building a Windows
Forms application that has the following requirements:

v Check the network status.
v Get a specific file from the Internet.
v E-mail it to a specific e-mail address.

v Log the whole transaction.

This is not an insignificant set of requirements. In fact, even in the 1.0 and
1.1 versions of VB.NET, this would be very difficult. One of the main goals of
the system.Net namespace in this version is to make these kind of tasks —
very common tasks — much easier. You can get started by loading the
sample code or by starting a new project and following the steps in the fol-
lowing sections.

Checking the network status

First, you need to inform the user about network connectivity by following
these steps:

1. Create a new Windows Application project in Visual Studio.
I called mine NetworkTools.

2. Reference the system.Net namespace by adding the line Imports
System.NET to the top of the code.

3. Add a statusstrip control to the form by dragging it from the
Toolbox.

4. Select the SmartTag that appears and add a statusLabel.

5. Back in Design View, double-click the form to get the Form_Load event
handler and move to Code View.

6. Add the code in bold from the listing below to test to see if the net-
work is available and display it in the status bar:

Imports System.Net
Public Class Forml
Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
If NetworkInformation.NetworkInterface.GetIsNetworkAvailable Then
ToolStripStatusLabell.Text = "Connected"
Else
ToolStripStatusLabell.Text = "Disconnected"
End If
End Sub
End Class
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That’s all there is to it. The NetworkInformation class contains a bunch of
information about the status of the network, current IP addresses, the gate-
way being used by the current machine, and more.

Keep in mind that the NetworkInformation class will only work on a local
machine. If you use this class in an ASP.NET Web Forms application, you will
be getting information about the server.

Downloading a file from the Internet

So next, you need to get a file from the Internet. This can be accomplished a
number of ways, but one of the most common is by using FTP (File Transfer
Protocol). FTP is a lightweight protocol that is favored because it is secure
and supported on many systems.

To build an application that uses FTP, follow these steps:

1. Drag a button onto the form from the Toolbox.
2. Double-click the button to get the click event handler.

3. Add the required imports, System.Net, System.Net .Mail, and
System. IO to the top of the code.

4. Create a new subroutine called bownload File that accepts a remote
file name and a local file name as strings.

5. In the new subroutine, dimension a new FileStream (called
localFileStream) and FTPWebRequest (called myRequest), as shown
in Listing 17-1.

The Filestream references a local file and accepts the local file that is
passed into the subroutine. The FtpwWebRequest is the same thing for
the remote file.

6. Set the Method parameter of the FtpWebRequest to
WebRequestMethods.Ftp.Downloadfile.

7. Set the Credentials property of the FtpWebRequest to a new
NetworkCredential with anonymous information, like I did in
Listing 17-1.

8. Create a new WebResponse object from the myRequest method. This
gets the statement back from the FTP server as to how your request
will be handled.

9. Get the stream from the response object.

10. Next, read the file into a 1024 byte buffer, one block at a time, using a
While loop as shown at the end of Listing 17-1.
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Listing 17-1: The DownloadFile Method

Protected Sub DownloadFile(ByVal remoteFile As String, _
ByVal localFile As String)

Dim localFileStream As New FileStream(localFile, FileMode.OpenOrCreate)
Dim myRequest As FtpWebRequest = WebRequest.Create(remoteFile)
myRequest.Method = WebRequestMethods.Ftp.DownloadFile
myRequest.Credentials = New NetworkCredential ("Anonymous", _
"bill@sempf.net")

Dim myResponse As WebResponse = myRequest.GetResponse
Dim myResponseStream As Stream = myResponse.GetResponseStream
Dim buffer(1024) As Byte
Dim bytesRead As Integer = myResponseStream.Read(buffer, 0, 1024)
While bytesRead > 0

localFileStream.Write(buffer, 0, bytesRead)

bytesRead = myResponseStream.Read (buffer, 0, 1024)
End While
localFileStream.Close()
myResponseStream.Close ()

End Sub

11. Call the DownloadFile method from the Buttonl_click event han-
dler, like I show in the following code:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
DownloadFile("ftp://ftp.vbfordummies.com/sampleFile.bmp", _
"c:\sampleFile.bmp")
End Sub

This is a very watered-down FTP example, but it gets the point across. The
WebRequest and WebResponse classes in the System.Net namespace are
fully utilized to create the more complete FtpWebRequest, for instance.
Properties like the Method of download and Credentials make it an easy
call.

In fact, the toughest part of this process is dealing with a FileStream object,
which is still the best way to move files and not specific to the System.

Net namespace. Streams are discussed in Chapter 16, which covers the
System. IO namespace, but they have significance to the network classes,
too. Streams represent a flow of data of some kind, and a flow of information
from the Internet qualifies.

That’s what you are doing when you get a Web page or a file from the
Internet — gathering a flow of data. If you take a second to think about it, it
makes sense that this is a flow, because the status bar in an application
shows a percentage of completion. Just like pouring water into a glass, the
flow of data is a stream, so the concept is named Stream.
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This concept holds true for getting a file from the World Wide Web, as well.
HTTP, the protocol of the Web, is just another protocol that defines how a
document is moved from a server on the Internet to your local machine. In
fact, the code even looks strikingly similar to the FTP example, as you can see
in the following code. The same stream is recovered, just the formatting is
different.

Protected Sub DownloadWebFile (ByVal remoteFile As String, _
ByVal localFile As String)
Dim localFileStream As New FileStream(localFile, FileMode.OpenOrCreate)
Dim myRequest As WebRequest = WebRequest.Create(remoteFile)
myRequest .Method = WebRequestMethods.Http.Get
Dim myResponse As WebResponse = myRequest.GetResponse
Dim myResponseStream As Stream = myResponse.GetResponseStream
Dim buffer(1024) As Byte
Dim bytesRead As Integer = myResponseStream.Read(buffer, 0, 1024)
While bytesRead > 0
localFileStream.Write (buffer, 0, bytesRead)
bytesRead = myResponseStream.Read (buffer, 0, 1024)
End While
localFileStream.Close ()
myResponseStream.Close ()
End Sub

You will need to pass in a Web address, so your subroutine call would look
like this:

DownloadWebFile ("http://www.vbfordummies.com/sampleFile.bmp",
"c:\sampleFile.bmp")

Note the changes, marked as bold. myRequest is now a WebRequest rather
than an FtpWebRequest. Also, the Method property of myRequest has been
changed to WebRequestMethods .Http.Get. Finally, the Credentials prop-
erty has been removed because the credentials aren’t required any longer.

E-mailing a status report

E-mail is a common requirement of networked systems. If you are working in
an enterprise environment, you are going to write a larger scale application
to handle all e-mail requirements, rather than make each individual applica-
tion e-mail-aware.

However, if you are writing a standalone product, it might require e-mail sup-
port. Because | happen to be writing a standalone application, that is exactly
what I'm going to do.
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E-mail is a server-based operation, so if you do not have an e-mail server that
you can use to send from, this might be hard. Many ISPs no longer allow
relaying, which is sending an outgoing message without first having an
account and logging in. Therefore, you might have trouble running this part
of the sample.

If you are in a corporate environment, however, you can usually talk to your
e-mail administrator and get permission to use the e-mail server. Because
outgoing requests are usually only harnessed inside the firewall, relaying is
often available. To build your e-mail function, try these steps:

1.

Add a text box to the default form in Design View, and then change to
Code View.

. At the top of the Code View, make sure that you have referenced the

System.Net .Mail namespace.

. Create a new subroutine called sendEmail. It should accept the from

e-mail address, the to e-mail address, the subject of the e-mail, and the
body of the e-mail.

. Dimension a new MailMessage and pass in the fromaddress,

toAddress, subject, and body parameters, as follows:

Dim message As New MailMessage (fromAddress, toAddress,
subject, body)

. Dimension a new smtpClient and pass in the address of your mail

server.

This can be an IP address, machine name, or URL.

. Finally, use the send method of the smtpclient object you created to

send the MailMessage, which is passed in as a parameter.

. When you’re finished, make sure that you set the values of the

MailMessage and SmtpClient to Nothing, because they do take up
resources.

Listing 17-2 shows the completed subroutine.

Listing 17-2: The SendEmail Subroutine

Sub SendEmail (ByVal fromAddress As String, ByVal toAddress As String, _

ByVal subject As String, ByVal body As String)
Dim message As New MailMessage (fromAddress, toAddress, _
subject, body)
Dim mailClient As New SmtpClient ("localhost")
mailClient.Send(message)
message = Nothing
mailClient = Nothing

End Sub
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|
Figure 17-1:
The finished
Network
Tools form.
|

Notice that [ used localhost as the e-mail server name. If you have an e-mail
server software installed locally, even just IIS 6.0 with SMTP, this will work.
Most of the time, you will have to put another e-mail server name in the
SmtpClient constructor. The e-mail server name can often be found in your
Outlook preferences.

After you have written your method, you need to call it after the file is down-
loaded in the Buttonl_cC1lick event handler. Change the code of that subrou-
tine to the following to call that method:

Private Sub Buttonl_Click(ByVal sender As System.Object, _
ByVal e As System.EventArgs) Handles Buttonl.Click
DownloadFile ("ftp://ftp.vbfordummies.com/sampleFile.bmp",
"c:\sampleFile.bmp")
SendEmail (TextBoxl.Text, TextBoxl.Text, "FTP Successful", _
"FTP Successfully downloaded")
End Sub

Notice that I sent in the value of the text box twice, once for the To address,
and once for the From address. This isn’t always necessary, because you may
have a situation where you want the e-mail to come only from a Webmaster
address or to go only to your address.

You should have enough code in place to run the application now. Press F5 to
launch the application in debug mode and give it a try. My form ended up
looking like this (see Figure 17-1) — your form may vary, of course.

3 Form1 E]@

Network Tools

Label2

Bution1

StatusBarl

When you click the button, the application should download the file to the
local drive and then e-mail you to inform you that the download is complete.
A whole host of things can go wrong with network applications though, and
you should be aware of them. Here are just a few:
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v For most network activity, the machine running the software must be
connected to a network. This isn’t a problem for you as the developer,
but you need to be conscious of the end users, who may need connectiv-
ity to have access to the features they want to use. Use of the network
status code can help inform users as to the availability of those features.

v Firewalls and other network appliances sometimes block network traffic
from legitimate applications. Some examples of this include:

¢ FTP is often blocked from corporate networks.

e Network analysis features of .NET are often blocked on corporate
servers. If the server is available to the public, these openings can
cause holes for hackers to crawl through.

¢ Speaking of hackers, make sure that if you do use incoming net-
work features in your application, you have adequately secured
your application. More on this can be found in the excellent book
Writing Secure Code, Second Edition, by Michael Howard and David
C. LeBlanc (published by Microsoft Press).

¢ E-mail is especially fragile. Often, Internet service providers will
block e-mail from an address that is not registered on a mail server.
This means that if you are using your localhost server (like in the
example in Listing 17-2), your ISP might block the e-mail.

v Network traffic is notoriously hard to debug. For instance, if the sample
application works, but you never receive an e-mail from the smtpsServer
you coded, what went wrong? You may just never know. XML Web serv-
ices (covered in Chapter 7) have a similar problem — it is spectacularly
tough to see the actual code in the SOAP envelope to tell what went
wrong.

Logging network activity

This brings you to the next topic, which is network logging. Because network
activity problems are so hard to debug and reproduce, Microsoft has built in
several tools for the management of tracing network activity.

What’s more, like the ASP.NET tracing available, the System.Net namespace
tracing is completely managed using the configuration files. This means that
in order to use the functions, you don’t need to change and recompile your
code. In fact, with a little management, you can even show debug information
to the user by managing the config files your application uses.
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Each kind of application has a different kind of configuration file. For Windows
Forms applications, which you are using here, the file is called app.config
and is stored in the development project directory. When you compile, the
name of the file is changed to the name of the application, and it is copied
into the bin directory for running.

If you open your app.config file now, you see that there is already some

diagnostic information in there, as shown in Listing 17-3. You are going to add
some information to that.

Listing 17-3: The Default app.config File

<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<system.diagnostics>
<sources>
<!-- This section defines the logging configuration for
My.Application.Log in Windows Forms projects.-->
<source name="Microsoft.VisualBasic.Logging.Log.WindowsFormsSource"
switchName="DefaultSwitch">
<listeners>
<add name="FileLog"/>
<!-- Uncomment the below section to write to the Application
Event Log -->
<!--<add name="EventLog"/>-->
</listeners>
</source>
</sources>
<switches>
<add name="DefaultSwitch" value="Information" />
</switches>
<sharedListeners>
<add name="FileLog"
type="Microsoft.VisualBasic.Logging.FileLogTraceListener,
Microsoft.VisualBasic, Version=8.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a, processorArchitecture=MSIL"
initializeData="FileLogWriter"/>
<!-- Uncomment the below section and replace APPLICATION_NAME with
the name of your application to write to the Application Event Log
-2
<!--<add name="EventLog"
type="System.Diagnostics.EventLogTraceListener"
initializeData="APPLICATION_NAME"/> -->
</sharedListeners>
</system.diagnostics>
</configuration>
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First, you need to add a new source for the System.Net namespace. You
see that there is already a source in place for the My object, and you add one
for the System.Net namespace as well.

Next, you add a switch to the switches section for the source you added.
Finally, you add a sharedListener to that section and set the file to flush
the tracing information automatically.

The finished app.config file, with the adds in bold, is shown in Listing 17-4.
It is also in the sample code on this book’s companion Web site.

Listing 17-4: The Finished app.config File

<?xml version="1.0" encoding="utf-8" ?>
<configuration>
<system.diagnostics>
<sources>
<source name="Microsoft.VisualBasic.Logging.Log.WindowsFormsSource"
switchName="DefaultSwitch">
<listeners>
<add name="FileLog"/>
</listeners>
</source>
<source name="System.Net">
<listeners>
<add name="System.Net"/>
</listeners>
</source>
</sources>
<switches>
<add name="DefaultSwitch" value="Information" />
<add name="System.Net" value="Verbose" />
</switches>
<sharedListeners>
<add name="FileLog"
type="Microsoft.VisualBasic.Logging.FileLogTraceListener,
Microsoft.VisualBasic, Version=8.0.0.0, Culture=neutral,
PublicKeyToken=b03f5f7f11d50a3a, processorArchitecture=MSIL"
initializeData="FileLogWriter"/>
<add name="System.Net"
type="System.Diagnostics.TextWriterTraceListener"
initializeData="my.log"/>
</sharedListeners>
<trace autoflush="true" />
</system.diagnostics>
</configuration>
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Run the application again and watch the Output window. Advanced logging
information is shown there because of your changes to the configuration file.
Additionally, a log file was written. In the development environment, this is in
the bin/debug folder of your project. You might have to click the Show All
Files button at the top of the Solution Explorer to see it.

In that folder, you should see a file called my . 1og. This is where the
SharedListener that you added to the app.config file directed the logging
information. My copy of that file is shown in Listing 17-5 — your mileage may
vary.

Listing 17-5: The Log Information

System.Net Information: 0
WebRequest: :Create (ftp://ftp.vbfordummies.net/sample.bmp)

System.Net Information: 0 : Exiting WebRequest::Create() ->
FtpWebRequest#37460558

System.Net Information: 0 : FtpWebRequest#37460558::GetResponse ()

System.Net Information: 0 : Exiting FtpWebRequest#37460558::GetResponse ()

System.Net Information: 0 : Associating Message#59487907 with
HeaderCollection#23085090

System.Net Information: 0 : HeaderCollection#23085090::Set (mime-version=1.0)

System.Net Information: 0 : Associating MailMessage#6964596 with
Message#59487907

System.Net Information: 0 : SmtpClient::.ctor (host=24.123.157.3)

System.Net Information: 0 : Associating SmtpClient#17113003 with
SmtpTransport#30544512

System.Net Information: 0 : Exiting SmtpClient::.ctor() ->
SmtpClient#17113003

System.Net Information: 0 : SmtpClient#17113003::Send(MailMessage#6964596)

System.Net Information: 0 : SmtpClient#17113003::Send(DeliveryMethod=Network)

System.Net Information: 0 : Associating SmtpClient#17113003 with
MailMessage#6964596

System.Net Information: 0 : Associating SmtpTransport#30544512 with
SmtpConnection#44365459

System.Net Information: 0 : Associating SmtpConnection#44365459 with
ServicePoint#7044526

System.Net Information: 0 : Associating SmtpConnection#44365459 with
SmtpPooledStream#20390146

System.Net Information: 0 : HeaderCollection#30689639::Set (content-transfer-
encoding=base64)

System.Net Information: 0 : HeaderCollection#30689639::Set (content-transfer-
encoding=quoted-printable)

System.Net Information: 0 : HeaderCollection#23085090::Remove (x-receiver)

System.Net Information: 0 : HeaderCollection#23085090::Set (from=bill@sempf.net)

System.Net Information: 0 : HeaderCollection#23085090::Set (to=bill@sempf.net)

System.Net Information: 0 : HeaderCollection#23085090::Set (date=1 Apr 2005
16:32:32 -0500)
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:Set (subject=FTP

:Get (mime-version)
:Get (from)

:Get (to)

:Get (date)

:Get (subject)

:Get (content-type)
:Get (content-transfer-

Exiting SmtpClient#17113003::Send()

Reading this file, you can see that the reference numbers that match the
requests on the server all appear, dramatically improving the ease of debug-
ging. Also, because everything is in order of action, finding out exactly where
the error occurred in the process is much easier.
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Chapter 18
Creating Images

In This Chapter

Understanding the System.Drawing namespace
Finding out how the drawing classes fit into the .NET Framework

Using System.Drawing to create a simple game application

No one is going to write the next edition of Half-Life using Visual Basic. It
just isn’t the kind of language that you use to write graphic-intensive
applications like shoot ’em up games.

That said, Visual Basic packs a fair amount of power into the System.Drawing
classes. While these classes are somewhat primitive in some areas, and using
them might cause you to have to write a few more lines of code than you
should, there isn’t much that these classes can’t do with sufficient work.

The drawing capability provided by the .NET Framework is divided into four
logical areas by the namespace design provided by Microsoft. All of the gen-
eral drawing capability is right in the System.Drawing namespace. Then
there are several specialized namespaces:

V¥ System.Drawing.2D has advanced vector drawing functionality:.

V¥ System.Drawing.Imaging is mostly about using bitmap graphic for-
mats, like .bmp and . jpg files.

V¥ System.Drawing.Text deals with advanced typography.
In this chapter, | focus on the base namespace and cover just the basics of

drawing in Visual Basic. (Discussing every aspect of drawing could easily fill
an entire book.)
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Getting to Know System.Drawing

Even at the highest level, graphics programming consists of drawing poly-
gons, filling them with color, and labeling them with text — all on a canvas of
some sort. Unsurprisingly, this leaves you with four objects that you find are
the core of the graphics code you write: graphics, pens, brushes, and text.

Graphics

Generally speaking, the Graphics class creates an object that is your palette.
It is the canvas. All of the methods and properties of the Graphics object are
designed to make the area you draw upon more appropriate for your needs.

Also, most of the graphics- and image-related methods of other classes in the
framework provide the Graphics object as output. For instance, you can call
the System.Web.Forms.Control.CreateGraphics method from a Windows
Forms application and get a Graphics object back that enables you to draw
in a form control in your project. You can also handle the pPaint event of a
form, and check out the Graphics property of the event.

Graphics objects use pens and brushes — discussed later in this chapter in
the “Pens” and “Brushes” sections — to draw and fill. Graphics objects have
methods such as

V¥ DrawRectangle

V¥ FillRectangle

V¥ DrawCircle

V¥ FillCircle

V¥ DrawBezier

V¥ DrawLine
These methods accept pens and brushes as parameters. You might think
“How is a circle going to help me?” but you must remember that even com-
plex graphic objects such as the Covenant in Halo 2 are just made up of cir-
cles and rectangles — just thousands and thousands of them. The trick to
useful art is using math to put together lots of circles and squares until you

have a complete image. The sample application described later in this chap-
ter is a very simple example of just that.
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Pens

You use pens to draw lines and curves. Complex graphics are made up of
polygons, and those polygons are made of lines, and those lines are gener-
ated by pens. Pens have properties such as

V¥ Color

V¥ DashStyle

¥ EndCap

¥ Width

You get the idea: You use pens to draw things. These properties are used by
the pens to determine how things are drawn.

Brushes

Brushes paint the insides of polygons. While you use the pens to draw the
shapes, you use brushes to fill in the shapes with color, patterns, or gradi-
ents. Usually, brushes are passed in a parameter to a Drawihatever method
of the pen objects. When the pen draws the shape it was asked to draw, it
uses the brush to fill in the shape — just like you did in Kindergarten with
crayons and coloring books (the brush object always stays inside the lines
though).

Don’t look for the Brush class, however. It is a holding area for the real
brushes, which have kind of strange names. Brushes are made to be cus-
tomized, but you can do a lot with the brushes that come with the framework
as is. Some of the brushes include

V¥ SolidBrush

V¥ TextureBrush

V¥ HatchBrush

V¥ PathGradientBrush

While the pens are used to pass into the Draw methods of the Graphics
object, brushes are used to pass into the #i11 methods that form polygons.
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Text

Text is painted with a combination of fonts and brushes. Just like pens, the
Font class uses brushes to fill in the lines of a text operation.

System.Drawing.Text has collections of all fonts installed in the system
running your program, or installed as part of your application. System.
Drawing.Font has all of the properties of the typography, such as the
following:

v Bold

v Size

v Style

v Underline

The Graphics object, again, provides the actual writing of the text on the
palette.

How the Drawing Classes
Fit into the Framework

The system.Drawing namespace breaks drawing into two steps:

v Create a System.Drawing.Graphics object.

v Use the tools in the System.Drawing namespace to draw on it.

Seems straightforward, and it is. The first step is to get a Graphics object.
Graphics objects come from two main places — existing images and
Windows Forms.

To get a Graphics object from an existing image, look at the Bitmap object.
The Bitmap object is a great tool that allows you to create an object using an
existing image file. This gives you a new palette that is based on a bitmap
image (a JPEG file, for example) that is already on your hard drive. It’s a very
convenient tool, especially for Web images.

Dim myBitmap As New Bitmap ("c:\images\myImage.jpg")
Dim myPalette As Graphics = Graphics.FromImage (myBitmap)
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Now the object myPalette is a Graphics object who’s height and width are
based on the image in myBi tmap. What’s more, the base of the mypPalette
image looks exactly like the image referenced in the myBi tmap object.

You can use the pens, brushes, and fonts in the Graphics class to draw right
on that image, as if it were a blank canvas. I use it to put text on images
before I show them on Web pages and to modify the format of images on the
fly, too.

The second way to get a Graphics object is to get it from Windows Forms.
The method that you are looking for is System.Windows.Forms.Control.
CreateGraphics. This method gives you a new palette that is based on the
drawing surface of the control being referenced. If it is a form, it inherits the
height and width of the form and has the form background color. You can use
pens and brushes to draw right on the form.

When you have a Graphics object, the options are pretty much endless.
Sophisticated drawing is not out of the question, though you would have to
do a ton work to create graphics like you see in Halo 2 using Visual Basic.
(There isn’t a Master Chief class that you can just generate automatically.)

Nonetheless, even the most complex 3D graphics are just colored polygons,
and you can make those with the System.Drawing class. In the following sec-
tions, I build a Cribbage board with a Graphics object, pens, brushes, and
fonts.

Using the System.Drawing Namespace

A\

Good applications come from strange places. Gabrielle (my wife) and [ enjoy
games, and one of our favorites is the card game Cribbage. We were on vaca-
tion in Disney World when she had the urge to play, but we didn’t have a
Cribbage board. We had cards, but not the board.

However, I did have my laptop, Visual Studio 2005, and the System.Drawing
namespace. After just an hour or two of work, I built an application that
serves as a working Cribbage board!

This is a fairly complete application, and I don’t have enough pages to walk
you through it step by step. Load the application from the Web site at

www . vbfordummies .net, and follow along with the rest of this chapter. This
isn’t a complex application, but it is long.
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Getting started

Cribbage is a card game where hands are counted up into points, and the first
player to score 121 points wins. It’s up to the players to count up the points,
and the score is kept on a board.

Cribbage boards are made up of two lines of holes for pegs, usually totaling
120, but sometimes 60 holes are used and you play through twice. Figure 18-1
shows a typical Cribbage board. Cribbage boards come in a bunch of differ-
ent styles — check out www.cribbage.org if you are really curious, it has a
great gallery of almost 100 boards, from basic to whimsical.

|
Figure 18-1:
A traditional
cribbage
board.
|

For this example, I just create the board image for an application that keeps
score of a Cribbage game — but it wouldn’t be beyond Visual Basic to write
the cards into the game too!

So the board for this application has 40 holes on each of three pairs of lines,
which is the standard board setup for two players playing to 120, as shown in
Figure 18-2. The first task is to draw the board, and then to draw the pegs as
the players’ scores — entered in text boxes — change.
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|
Figure 18-2:
The digital
cribbage
board.

|
Figure 18-3:
The basic
board.
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The premise is this: The players play a hand and enter the resulting scores in
the text box below his or her name (refer to Figure 18-2). When the score for
each hand is entered, the score next to the player’s name is updated, and the
peg is moved on the board. Then next time that same player scores a hand,
the peg is moved forward, and the back peg is moved into its place. Didn’t
mention the back peg? Oh, yes, the inventor of Cribbage was paranoid of
cheating — if you’re unfamiliar with Cribbage, you may want to check out the
rules at www.cribbage.org.

Setting up the project

To begin, create a playing surface. I actually set up the board shown in
Figure 18-2 without drawing the board itself — I paint that on later with
System.Drawing. My board looked a lot like Figure 18-3 when [ was ready to
start with the business rules.

& Sempf Cribbege

1] o Gabnsle o

Somebody wins!
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[ used a little subroutine to handle score changes by calling the subroutine

from the two text boxes’ onChange events. The code that calls the subroutine
follows:

Private Sub HandleScore (ByVal scoreBox As TextBox, ByVal points As Label,
ByVal otherPlayer As Label)
Try
If 0 > CInt(scoreBox.Text) Or CInt (scoreBox.Text) > 27 Then
ScoreCheck.SetError (scoreBox, "Score must be between 0 and 27")
scoreBox.Focus ()
Else
ScoreCheck. SetError (scoreBox, "")
'Add the score written to the points
points.Text = CInt(points.Text) + CInt (scoreBox.Text)
End If
Catch ext As System.InvalidCastException
'Something other than a number
If scoreBox.Text.Length > 0 Then
ScoreCheck. SetError (scoreBox, "Score must be a number")
End If
Catch ex As Exception
'Eek!
MessageBox.Show ("Something went wrong! " + ex.Message)
End Try
'Check the score
If CInt(points.Text) > 120 Then
If CInt(points.Text) / CInt(otherPlayer.Text) > 1.5 Then
WinMessage.Text = scoreBox.Name.Substring (0,
scoreBox.Name.Length - 6) & " Skunked 'em!!!"
Else
WinMessage.Text = scoreBox.Name.Substring (0,
scoreBox.Name.Length - 6) & " Won!!"
End If
WinMessage.Visible = True
End If
End Sub

All of this changing of screen values causes the paint event of the form to
fire — every time VB needs to change the look of a form for any reason, this
event fires — so [ just tossed a little code in that event handler that would
draw my board for me:

Private Sub CribbageBoard_Paint (ByVal sender As Object, ByVal e As
System.Windows.Forms.PaintEventArgs) Handles MyBase.Paint
PaintBoard(BillsPoints, GabriellesPoints)
End Sub

From that point on, my largest concern is drawing the board itself.
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Drawing the board

So I need to paint right on a form to create the image of the board for my

Cribbage application, so I use the CreateGraphics method of the form con-
trol. From there, I need to:

v Paint the board brown using a brush.

v Draw six rows of little circles using a pen.
v Fill in the hole if that is the right score.
v Clean up my supplies.

To that end, I came up with the PaintBoard method, which accepts the labels
that contain the standing scores for both players. It is shown in Listing 18-1.

Listing 18-1:  The PaintBoard Method

Private Sub PaintBoard(ByRef Bill As Label, ByRef Gabrielle As Label)
Dim palette As Graphics = Me.CreateGraphics
Dim brownBrush As New SolidBrush(Color.Brown)
palette.FillRectangle (brownBrush, New Rectangle(20, 20, 820, 180))
'0K, now I need to paint the little holes.
'There are 244 little holes in the board.
'Three rows of 40 times two, with the little starts and stops on either end.
'Let's start with the 240.
Dim rows As Integer
Dim columns As Integer
Dim scoreBeingDrawn As Integer
Dim blackPen As New Pen(System.Drawing.Color.Black, 1)
Dim blackBrush As New SolidBrush (Color.Black)
Dim redBrush As New SolidBrush(Color.Red)

'There are 6 rows, then, at 24 and 40, 80 and 100, then 140 and 160.
For rows = 40 To 160 Step 60
'There are 40 columns. They are every 20
For columns = 40 To 820 Step 20
'Calculate score being drawn
scoreBeingDrawn = ((columns - 20) / 20) + ((((rows + 20) / 60) - 1)
*40)
'Draw Bill
'If score being drawn = bill fill, otherwise draw
If scoreBeingDrawn = CInt(Bill.Text) Then
palette.FillEllipse (blackBrush, columns - 2, rows - 2, 6, 6)

(continued)



308 Part IV: Digging into the Framework

Listing 18-1 (continued)

ElseIf scoreBeingDrawn = BillsLastTotal Then
palette.FillEllipse (redBrush, columns - 2, rows - 2, 6, 6)
Else
palette.DrawEllipse (blackPen, columns - 2, rows - 2, 4, 4)
End If
'Draw Gabrielle
'If score being drawn = Gabrielle fill, otherwise draw
If scoreBeingDrawn = CInt(Gabrielle.Text) Then
palette.FillEllipse(blackBrush, columns - 2, rows + 16, 6, 6)
ElseIf scoreBeingDrawn = GabriellesLastTotal Then
palette.FillEllipse (redBrush, columns - 2, rows + 16, 6, 6)
Else
palette.DrawEllipse (blackPen, columns - 2, rows + 16, 4, 4)
End If
Next
Next
palette.Dispose()
brownBrush.Dispose ()
blackPen.Dispose ()
End Sub

Aside from the math, note the decision making. If the score being drawn is
the score in the label, fill in the hole with a red peg. If it is the last score
drawn, fill in the hole with a black peg. Otherwise, well, just draw a circle.

It is tough to fathom, but this is exactly how large-scale games are written.
Admittedly, big graphics engines make many more If-Then decisions, but the
premise is the same.

Also, large games use bitmap images sometimes, rather than drawing all of
the time. For the Cribbage scoring application, for example, you could use a
bitmap image of a peg instead of just filling an ellipse with a black or red
brush!
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“Ii’s a horse racing software program. Tt analyzes
my betting history and makes suggestions. Right
now it’s suggesting I try betting on £ootball.”



In this part . . .

Some things fit nowhere. In fact, so much of this book
fit nowhere that the publisher had to cut down the
number of chapters in this part! (You can still find them
on the Web site, though).

In this part, you find tips on everything from moving on
after reading this book to finding resources online. [ hope
you will find it to be a useful reference!




Chapter 19

Ten Tips for Using the
VB User Interface

In This Chapter

Finding multiple ways to generate event handler code
Copying text the way you really want it

Making good use of the toolbars

Extending VB with your own creations

Using the same cool tricks as the pros

USual Studio is a great tool for writing Visual Basic code, but so much
goes in to using this tool that you might not find the really neat features
until the next version is out! To help you find cool features for writing VB
code, | compiled this list of (almost) ten tips for working with the Visual
Studio interface. I hope that these tips make your coding more enjoyable!

Generating Event Handlers from
the Properties Window

When you’re working in the Design View for Web or Windows Forms and you
double-click a control, Visual Studio treats you to the code for the default
event handler. But what if you don’t want the default event handler? Any
given object often has several events that you might want to access, and
Visual Studio can just as easily (and automagically) generate code for any
one of those events.

Follow these few steps to give it a try:

1. Open a new Visual Basic 2005 Windows Application project. (It works
in Web Forms, too.)

2. Drag a control to the default form.



312

Part V: The Part of Tens

Figure 19-1:
The listing
of events for
a text box
control.
|

[ use a text box in this example.

3. Select your control and then press F4 to expand the Properties
window.

4. In the Properties window, click the Event button (which looks like a
little lightning bolt).

You see a list of associated events, something like the list shown in
Figure 19-1.

Properties %
TextBox1 System.Windows.Forms =
b E
= A
Click I
DoubleClid
MouseCapturel
MouseClick | w
MouseDoubleC
ResizeBegin
ResizeEnd

ChangeUICues
ControlAdded
ControlRemove
HelpRequestad
ImeModeChang
QueryAccessibi
StyleChanged
SystemColorsC

=

MouseClick
DOccurs after the vser dicks and then
releases the mouse.

53] Soluti... | % Prop... [EpData...

5. Double-click an event from the list to generate the event handler
code.

The events listed in Figure 19-1 are all the events exposed by the
TextBox object. I selected the MouseClick event. This means that any-
time the user clicks in the text box, my code will run.

When you double-click an event in the events window, the generated code
looks something like the following:

Private Sub TextBoxl_MouseClick(ByVal sender As System.Object, ByVal e As
System.Windows.Forms.MouseEventArgs) Handles TextBoxl.MouseClick

End Sub

Check the Hand1les statement at the end of the declaration; it should match
the event you selected.
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Generating Event Handlers
from the Code View

The preceding section shows you how to create event handlers from the
Design View — but the Design View isn’t the only part of the Visual Basic
interface with automatic features. The Code View has a few tricks, too.
Specifically, the events are handily listed along the top of the Code View, for
both navigation among events and creation of new ones. I show this place-
ment in Figure 19-2.

Forml.vb*| Forml.vb [Design]* T X
,#Euttonl || & Chick I w
I [ Public Class Form] ¥ Click »
. # ContextMeruChanged
Flgure 19-2: | Private Sub B # ContextMeruStripChanged
The event [ rivate Sub BY’ cradded
# ControlRemoved
selectorin End Sub # CursorChanged
. End Class ¥ Disposed
Code View. % Dockchanged
# DoubleClick
| f Deaaie

Figure 19-2 also shows the new default handler I created by double-clicking
a button and then clicking the drop-down list above and to the right of the
code window. You can see that Click is bold, which means that the click
method exists. All other events exposed by the Button object are shown as
well.

The drop-down list just to the left shows the objects instantiated in the form.
In this example, the list would show just the Button and the Form objects.
The following steps outline the process for creating a new event in this view:

1. Right-click on the form you want to edit, and choose View Code to go
to Code View.

2. Select the object you need to handle an event for from the leftmost
drop-down list.

3. Select the event you would like to handle from the rightmost drop-
down list.

At this point, Visual Studio creates the stub of the subroutine for you,
and you can add the code you need right to it.

Later, if the code in the form gets long, you can navigate back to the event
handler the same way and make changes.
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Pasting Text as HTML

When making Web pages in Web Forms, you may often find yourself pulling
content from other Web pages open in Internet Explorer or from Office docu-
ments. For example, when you’re creating static Web sites, the content may
come to you in the form of a Word document.

The problem with getting content this way comes from the interactivity
between Microsoft programs. Did you ever notice that, when you cut from
Excel and paste to Word, the table structure remains? Microsoft products try
to maintain formatting whenever possible. Take a look at this example:
1. Open any Word document that contains formatted text.
For this example, I just use this Word document for this chapter.
2. Open Visual Studio and start a new Web site.

3. In the default page, click the Design tab to change to Design View (if
you’re not already in Design View).

4. Highlight text from the Word document and choose Edit~> Copy.

5. Back in Visual Studio, position the cursor in the default Web page and
choose Edit=>Paste.

6. Click the Code tab to change to Code View and look at the text your
cut-and-paste job left behind.

My examples leaves the text shown in Listing 19-1.

Listing 19-1: Messy HTML from the Paste Command

<hl>

Paste as HTML</hl>

<p class="MsoNormal">

When making Web pages in Web Forms, you may often find yourself pulling content
from other

Web pages open in Internet Explorer or from Office documents

.<span style="mso-spacerun: yes">&nbsp; </span> For example, when you're
creating static Web

sites, the content may

<?xml namespace="" prefix="stl" ?>

<stl:state w:st="on"><stl:place w:st="on">come</stl:place></stl:state>

to you in the form of a Word Document.</p>

Most of the time, you don’t want to retain the formatting from other pro-
grams when dealing with a Web application. You want to copy content from
the other program (Word document, Excel spreadsheet, and so on) and paste
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just the text, so you can apply styles suitable for a Web page. If that’s your wish,
then choose the Edit=>Paste Alternate command instead of the Edit=>Paste
command in the preceding Step 5.

Customizing Your Toolbars
for Every File Type

While in the Web Forms builder of Visual Studio, you may notice something
else that is cool. When you switch between the Design View and Code View,
your toolbars — the buttons under the menus — change. In fact, your work-
ing area might even change size because toolbars are added or removed.

This changing-of-the-toolbars happens because Visual Studio supports a dif-
ferent toolbar setup for each file type and view. HTML and ASPX pages can
have totally different toolbars, and the Design View and Code View can have
different toolbars for each file type.

You can customize your workspace by specifying the toolbars you want to
see for any given file type or view. Simply open a file of the desired type and
right-click in the ribbon bar (the gray area under the menus). When you do,
you get a long list of the toolbars available and can just click on the ones you
want. [ list some toolbars and their contents in Table 19-1.

Table 19-1 Toolbars for Different File Types and Views

Toolbar Name What It's Good For

Build Has buttons that match the Build menu and enable you to
compile your project with various options

Class Designer Holds design tools that are appropriate for making DLL
files

Debug Has buttons that function similarly to the Debug menu and
enable you to enter debug mode or debug other running
programs

Device Contains tools to help you work with Smart Devices (such
as mobile phones) and give you access to the emulators
for Pocket PCs

Layout Holds tools, such as the Alignment feature mentioned in

Chapter 4, which are useful for structuring forms

(continued)
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Table 19-1 (continued)

Toolbar Name What It's Good For
Query Designer Has tools to help create SQL and XML data queries
Style Sheet Contains buttons for applying CSS styles to HTML

Adding Extender Providers

Extender providers could really use their own chapter, but because of every-
thing else about Visual Basic I need to tell you, I give you a brief look at them
here. An extender provider provides an extension — specifically new proper-
ties — to an existing object or group of objects. Try this:

1. Open Visual Studio and start a new VB Windows Application project.
2. Drag a Button object onto the form.

Suppose that you want to enhance your button with a ToolTip — the
little floating window that appears in some applications when you
mouse over an object on the screen. In a VB Windows Application pro-
ject, you can’t add a ToolTip directly to the Button object.

3. To add a ToolTip property to the button, add a ToolTip object to the
form.

You can find the ToolTip object in the Toolbox. The ToolTip will appear
in the Component Tray.

4. Return to the Properties window for the button.

Notice that, at the bottom of the window in the Misc category, there is
now a ToolTip!

Because the ToolTip is an extender provider, it is designed to give all objects
that populate an interface a new property, in this case, a ToolTip. Although
adding a property to an object might seem a little odd, it is actually a great
way to extend the functionality of a set of controls. And I think that
Microsoft’s doing so was quite brilliant.

You can actually create your own extender providers to do everything from
adding textual strings for reference, all the way to making new functional and
graphical elements. These properties give you a powerful way to extend the
user interface controls provided by Microsoft.
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Using Visual Components
That Are Not So Uisual

|
Figure 19-3:
The
Component
Tray
showing a
ToolTip.
|

[ would be remiss if [ didn’t tell you about the Component Tray and, espe-
cially, the visual components that are not so visual. Though Visual Basic is
set up as a rapid, point-and-click development tool, lots of objects (that
aren’t all that visible) still should be and are managed by the visual develop-
ment tools.

The Component Tray is a special section of the form designer that shows up
when you are using a non-visual component such as the timer or dataset.
Figure 19-3 shows the Component Tray, which displays only a few actual
features, because the majority of the point-and-click development involves
moving visual components around on the screen.

Other parts of the book refer to non-visual components a number of times.

In Part II, you find out about the Menu object. In Part III, [ show you the Timer
object. Part IV has information about Data objects. In this chapter’s previous
section, I show you the ToolTip object. Not all of these have usable parts that
you see on-screen, but they do show up in the Component Tray.

And although you can’t reposition these components on-screen, you can do
the following:

v Right-click on the component to get a context-sensitive menu, just like
you do for a button or other window component.

v Open the Properties window and click on the component in the tray to
select it for editing purposes. In the Properties window, you can change
the component name and other common properties.

317
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Here’s one caveat to keep in mind: Declaring the object in Code View doesn’t
immediately make it a Component Tray object. Generally speaking, if you
want to edit a component in Design View, you need to create it in Design
View. Most developers are primarily either Code View developers or Design
View developers. As you find your personal style, you'll get to know how
often you'll use the Component Tray.

Recording Macros

Figure 19-4:
The Macro
IDE.

a\\J

Macros are so cool that they get their own user interface, which [ show in
Figure 19-4. And macros are so powerful and flexible, they have the potential
to totally change your development patterns. Here I present a small part of
their power. (I leave the experimenting up to you.)
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File Edt WView Project Debug Tools Window Help
HCANEEAN" NN AN =
iS22 =2 |03 8 3N
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2 =L  [E(General) + | [ (Declarations) v
5 | MyMacros [mports EnvDIE =
%) 2 samples EnvDTES0 1
@ [l References rt2 System.Diagnostics
% 2] AddDirAsSInFalder
o) Dey!
3 —] .'_J-:' .svudcaedtor B Public Module AddDirAsSlnFolder
5 8] EnvironmentEvents
= Te] MakeAddin R - . - -
) Utitties (=] A __3._ of folder names, file names, and €
] vsDebugger so the = *
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extension = SYSUE]‘\'\-IC,F&:?{,GE:EXEET.SL(v
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One of the neatest things you can do is record a keystroke-saving macro for
later playback. If there is a task (such as formatting text) that you expect to
do more than once, record it as a macro.

One of my favorite ways to use a macro is to record HTML formatting. [ have
a whole host of macros [ recorded to format strings for paragraphs and lists.
Formatting with prerecorded macros makes site management with Visual
Studio a breeze.
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To get to the macros, you can do a few things:

v Press Alt+F8 to bring up the Macro Explorer in Visual Studio.
v Select Toolse>Macros>Macros IDE from the menu bar.
v Right-click in the ribbon bar and select Macros.

Fire up the Macro Explorer (press Alt+F8) and follow these steps to see how
it’s done:

1. Start with a new Web project in Visual Studio. Right-click on the HTML
Designer and select View Code to change the view to Code View.

2. Open the default Web page and paste a few lines of text into the Code
View.

For example, copy some text from Notepad, just as if you received it
from a client, and paste the text in the Code View.

3. Click to the left of the first line of text to leave the cursor at the begin-
ning of the first line that you want to format.

4. Select Tools>Macro=>Record Temporary Macro from the main menu.

The Record panel appears and starts capturing every significant com-
mand you give Visual Studio.

5. Type the following to record formatting for an HTML paragraph:

e Type the HTML paragraph tag, <p>, at the start of the text you
want to format. If Visual Studio adds the rest of the paragraph tag,
just delete it by pressing the Delete key.

¢ Press the End key on your keyboard to move the cursor to the end
of the line of text.

e Type the HTML close paragraph tag, </P>.

¢ Press the right-arrow key, which moves the cursor to the start of
the next line.

6. Click the Stop Recording button on the Record panel.
The macro is now recorded and, what’s more, it is actually code that resides

in the temporary macro spot in the Macro Explorer. Listing 19-2 shows this
code.

Listing 19-2: The Paragraph Macro

Imports EnvDTE
Imports EnvDTES80
Imports System.Diagnostics

(continued)
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Listing 19-2 (continued)

Public Module RecordingModule

Sub TemporaryMacro ()
DTE.ActiveDocument.Selection.Text = "<P>"
DTE.ActiveDocument.Selection.Delete (4)
DTE.ActiveDocument .Selection.EndOfLine ()

DTE.ActiveDocument.Selection.Text = "</P>"
DTE.ActiveDocument.Selection.CharRight ()
End Sub

End Module

If you right-click TemporaryMacro and select Edit, you can see the code in
the Macro IDE where you can

v Make changes to the macro.

1 Delete unnecessary code lines (such as the line created when I deleted
the automatically generated paragraph close tag in my example) to save
a cleaner macro.

v Make the macro permanent by copying the code into another module in
the macro recorder and saving it.

v Right-click and choose Save As to a different name in the Macro
Explorer.

v Run the macro from the Macro Explorer by double-clicking it, or use the
context menu in Code View, as shown in Figure 19-5.

3 Code Srippets Manager... CHI+E, CirlE
Choase Tookas: Thems...,
Add-n Manager..,
Macraz v|[E R TenporanMaca
Dntfiscator Community Edtion | Record TH aryMarre
External Toals. .. Save TemporaryMaoo
ImportfExport Satings... Carncel Recording
E— Customize.. B¢ MeooBpiorsr  Alt+FE
Oplions... 98 Maoes ICE ..
F|gure 19-5: Load Mamra Froject ...
Runnlng a ey Macro Project ...
macro.
|

Using the Task List

The Task list is a very cool personal Project Management feature of the Visual
Studio IDE. To show it, choose View=>Other Windowsr>Task List or press
Ctrl+Alt+K. To use it, you just click the Create New User Task button, and
then start typing. When you’ve completed the task in your Task list, you can
just check it off.



|
Figure 19-6:
The Task
list.
|
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You can do a lot more with this tool than just make to-do lists. It is fully inte-
grated with source control, too, so pending check-ins and such show up in
the list. Also, you can add tokens into the code that show up in the Task list.

To add a token, open up any project and add a comment that starts with
ToDO. You'll notice that after you add a ToDO comment, Comments shows up
with User Tasks in the Task List drop-down list, as shown in Figure 19-6. You
can use this to keep track of things you need to remember as you do them.

Task List - 1 task

|User Tasks |T|| =1

Comments
Liser Tasks
S 5 & NEW USEr .

The other tokens include HACK and UNDONE. These don’t usually get their own
Task List filter, but you can use them for marking questionable code that you

might need to revisit, or work that needs completed. You can add new tokens
in the Environment section of the Options panel.

Inserting Snippets in Your Code

Figure 19-7:
Using the
Insert
Snippet
feature.
|

A really cool new VB feature, like the CodeSwap feature, is the Insert Snippet

feature. This organizational tool has several easy-to-use but hard-to-remember
bits of code quickly available in various categories, including those shown in

Figure 19-7.

To use the Insert Snippet feature, just right-click on your VB code in the Code
View, and select Insert Snippet. The code is well-factored and includes a lot
of template-type things, too, such as array looping and complex algorithms.
If you have a tough problem to solve, do take a look at the Insert Snippet
feature.
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Chapter 20

Ten ldeas for Taking Your
Next Programming Step

In This Chapter

Making new kinds of projects

Participating in contests

Trying out other peoples’ ideas

Wthout a doubt, by the time you’'ve worked through the examples in
this book, you’ll be an expert. Experts shine by going out on their own
and trying new things. This chapter is all about the things that you can go
and try in the wide world after you’ve gotten down the basics of Visual Basic,
and you're ready to find some programming challenges.

Get Uisual Basic 2005 for Home Use

If you primarily use Visual Basic for work, you may want to get a copy of
Visual Basic 2005 Express Edition for home use so that you can have fun
with after-hours projects. While you can download the .NET SDK and use
the command line, [ recommend using the Express Edition.

The Express Edition is a copy of Visual Studio 2005 for hobbyists. It is missing
a few of the features of the Professional version that I discuss elsewhere in
this book, but nothing significant is left out. The Express Edition is perfect for
the odd open-source project.

To get a hold of Visual Basic 2005 Express Edition, convince your boss that

it will be worth the price of four classes and plunk down $99 for the box set.
You can find the Express Edition at stores that sell software, such as Amazon.
com, Best Buy, or CompUSA.
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Build Vour Own Tools

To become a Visual Basic 2005 expert, you need to know that the defining
trait of experts in a RAD language such as VB is that they make their own tools.
This isn’t a new idea — Brian W. Kernighan and P.J. Plaugher wrote a great
book in 1978 called Software Tools (Addison-Wesley) about third-generation
language and tool creation. They hit the nail on the head: Writing tools in the
language in which you are writing your projects is a great way to reduce
errors and enhance expertise.

[ do my darnedest to write tools in the language in which I am working. Code
generators are especially useful. Keep in mind that tools you create for your
own use don’t have to be perfect — just their resulits have to be perfect, if
they get used in a production system. Tools are a great place to try out ideas.

For instance, check out the code in Listing 20-1. It is a data object generator
that I wrote in VB.NET. It isn’t perfect, but it doesn’t have to be! This tool is a
great example of reading the details of a stored procedure from a SQL Server.
The sample code is that of a method that generates an update method from a
stored procedure. (For more on data access, see Part IV.)

Listing 20-1: A Bit from My Data Object Generator

Public Sub UpdateMethod ()
'Hey, here is the function:
Dim functionCode As String = ""
functionCode = "Public Function Update ("
'Select the sproc name
Dim lcSelectedLine As String
Dim ts As TextSelection = DTE.ActiveDocument.Selection
lcSelectedLine = ts.Text.Trim()
'Get a reference to the Sproc
Dim myConnection As SglConnection = New SglConnection (ConnectionString)
Dim mySglCommand As SglCommand = New SglCommand(lcSelectedLine,
myConnection)
mySqglCommand.CommandType = CommandType.StoredProcedure
myConnection.Open ()
SglCommandBuilder.DeriveParameters (mySqglCommand)
'Rip through those parameters
Dim myParameter As SglParameter
Dim counter As Integer = 0
For Each myParameter In mySglCommand.Parameters
counter = counter + 1
If myParameter.ParameterName.ToString() <> "@RETURN_VALUE" Then
functionCode = functionCode & "ByVal "
functionCode = functionCode &
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myParameter.ParameterName.ToString () .TrimStart ("@") & " As "
Select Case myParameter.SqlDbType

Case "2"
functionCode = functionCode & "Boolean"
Case "4"
functionCode = functionCode & "Date"
Case "8"
functionCode = functionCode & "Integer"
Case "22"
functionCode = functionCode & "String"
End Select
If counter <> mySglCommand.Parameters.Count Then
functionCode = functionCode & ", _" & vbCrLf
Else
functionCode = functionCode & ") As Integer" + vbCrLf
End If
End If
Next

functionCode = functionCode &

"SglHelper.ExecuteNonQuery (ConnectionString, _" & vbCrLf
functionCode = functionCode & """" & lcSelectedLine & """, _" & vbCrLf
counter = 0
For Each myParameter In mySglCommand.Parameters

counter = counter + 1
If myParameter.ParameterName.ToString() <> "@RETURN_VALUE" Then
functionCode = functionCode &
myParameter.ParameterName.ToString () .TrimStart ("@")
If counter <> mySglCommand.Parameters.Count Then

functionCode = functionCode & ", _" & vbCrLf
Else
functionCode = functionCode & ")" + vbCrLf
End If
End If
Next

functionCode = functionCode & "End Function"
'Drop that puppy in
ts.Insert (functionCode)
myConnection.Close()
myConnection = Nothing
End Sub

Join In an Online Competition
at TopCoder

Another great thing to do to stretch your coding legs is to participate in an
online competition. TopCoder (www . topcoder.com) is the best there is — a



320 PartV:The Part of Tens

free competition in which you can answer problems using VB and compete
for fame, fortune, and projects. For example, one of the easier problems to
solve involves taking data about students and figuring out a way to extract
the oldest student by using a specified class and method.

The problems you find on TopCoder sound a lot like quizzes in a program-
ming class, and that’s a fair comparison. The goal is to write the best code
you can that solves the problem and to have your code compared to that of
other programmers.

Participate in an Open Source Project

Open source software is software governed by one of a myriad of free licenses,
which state rules such as “This software is free for use, but any adjustments
made to it must also be provided for free to the community.” Open source’s
most famous output, Linux, might get all of the press, but a ton of open
source .NET projects are available, too.

Before you just jump in, though, take a look around. Two of the best places to

find projects are SourceForge.net (http://sourceforge.net) and GotDotNet
(www .gotdotnet.com). Log in and look at the projects. Find one that interests
you, get the code, and play around with it. See if you can make improvements.

Then log into the message board and talk to the designers. These should be
people you could go have a drink with, you know? Talk about the project.
See if it is something that you would want to donate a handful of hours a
month to.

You can garner a ton of benefits from working on open source projects. First,
it might be the only chance you get, depending on your situation, to work
with expert .NET programmers. Second, you get a genuine chance to practice
coding on a peer-reviewed project. Third, you may end up being able to point
to a public application that you participated in building. This is a great
resume builder.

Above all of that, though, open source projects are fun. As I write this, a quick
look at the applications available on a few project sites include:

v A Web portal project

v+ XML documentation tools

v An object relational framework
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v~ [IS Web managers
v Line counting utilities

v An HTTP proxy

This points out another benefit — some really cool software is available, free
for the downloading. All you are morally obligated to do to pay for it is help
out a little. It’s a fair price, that’s for sure!

Use Third-Party Tools in Your Projects

When you are looking to do more sophisticated things with VB, look at some
third-party tools to integrate into your projects. Great examples of third-party
tools are user controls for Web Forms projects and form controls for
Windows Forms applications.

Software created by third-party individuals makes for a great way to
inexpensively expand your horizons without spending hundreds of hours
programming and testing. Don’t be put out by “Not built here syndrome” —
third-party software has its benefits.

For starters, third-party software is often peer reviewed. Take a look at www.
windowsforms.net. The top ten user ranked controls are right there on the
home page. Search for a form that you night need. All of the controls have a
download and view rating, and many of them are reviewed by users.

For Web Forms, check out www.asp.net. As with the Windows Forms .NET
Web site, the code samples in the Control Gallery of the ASP.NET site are
rated and counted by other users.

Programmers use third-party software, and when you know your way around
the language, you should too. If you still aren’t sure, look for a Microsoft certi-
fied vendor — called an ISV (Independent Software Vendor). My company is
one — many others are too. It’s Microsoft’s mark for a company that knows
what it is building.

To look for certified vendors, check out the resource directory at http://
directory.microsoft.com/mprd. This page allows you to find a partner
by specialty (you would want an ISV) and location (which might not matter
for just finding control builders).

Also in the arena of third-party software for programmers are add-ins for
Visual Studio. The Visual Studio Integration Program (available at http: //
msdn.microsoft.com/vstudio/extend) provides vendors with a ton of
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great tools for integrating their products into Visual Studio, and it just helps
you to move right along.

Dotfuscator, which [ mention in Part I, is an example of an add-in. It is a
Windows Forms application that seamlessly integrates into Visual Studio to
assist you with programming chores — in this case, to protect your source
code. You can find out more about Dotfuscator in the Visual Studio help files.

Trying add-ins from vendors is a lot like trying a control — research, check
the reviews, and test, test, test. And have fun! Half of the reason to try out
new things is for the thrill.

Integrate a Public Web Service
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Chapter 7 describes how to build and integrate a Web service, but integrating
a public service is a special treat. Many people and companies with special
information have provided said information in public XML Web services for
you to try out. You have to pay to use some of these services, while others
are free. Even if it is just for a fun side project, you should certainly try to
integrate a public service once or twice.

The directory of directories for public services is http: //xmethods.com.
The XMethods Web site provides links to the mapping for Web service
methods — the WSDL files. These files are used by Visual Studio 2005 to
make proxies of the service for use in your own programs.

As you look at these, keep in mind that you are stepping out of the .NET world
in many instances. XML Web services are cross-platform, so there are as many
Perl and Java services out there as ASMX services. Some of them might return
something unexpected, and as such, mess up a perfectly good program. Be
prepared, and trap errors often.

You can search the XMethods library for demo services you can use in your
own projects. Usually, you find a page that describes the service and pro-
vides a link to the WSDL file. For example, | found a demo service in the
XMethods library called the TemperatureService.

To use a service you find on the XMethods site, first make sure you are con-
nected to the Internet, and then download and use the service by following
these steps:

1. Open Visual Studio and start a new Windows Application project.

2. In the form, add a label object and leave it with the default name.
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3. Right-click on the project and select Add Web Reference.
The Add Reference dialog box appears, as shown in Figure 20-1.

4. Enter the URL to the service in the URL text box and click the Go
button.

For example, the WSDL file for this service I use for this example is at
www . xmethods .net/sd/2001/TemperatureService.wsdl.

Add Web Reference =]
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Methods
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| Weh reference name:
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5. Enter a name for the service in the Web Reference Name text box and
click the Add Reference button.

For example, | entered the name TempService.
6. Double-click the form to get the Form1l_Load event handler.
7. Add the code to enable the service:

[ entered the following code to enable TemperatureService:

Private Sub Forml_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
Dim myTempService As New TempService.TemperatureService
Labell.Text = myTempService.getTemp ("43123")
End Sub

8. Run the code by pressing F5.

The service returns the current temperature, based on the ZIP Code
you supply in the myTempService.getTemp method, as shown in
Figure 20-2.
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And there you are — that’s all it takes to integrate a public Web service! Give
it a try in your next for-fun project.

Try Out CodeRush and
Other Code Generators

CodeRush is a code generator, which is a program that writes the code for
you, or at least makes it much easier to write the code. Largely, code genera-
tor programs are based around taking a database schema and writing the
access code for you — such as my example in the “Build Your Own Tools”
section, earlier in this chapter. Some code generators, though, do oh so
much more.

The goal is to write better code more quickly, and enjoy it. CodeRush — and
other code generator programs like it — are a great way to start. They are not
a substitute for knowing how to do it yourself, but they are a great tool once
you are in the production world. You can find out more about CodeRush at
www . coderush. com.
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To be fair, CodeRush is more than a simple code generator. For instance,
CodeRush has the following neat features:

v It allows you to see the code you have built in a visual tool, even if the
code is a class library!
v~ It intelligently selects code for you, rather than just selecting a line.

v~ It has a very sophisticated copy feature that makes sure you get the
entire block of code. For example, if you select a Try-Catch block, it
copies to the End Try statement.

v It, of course, generates code with a set of great code templates.
When you’re setting up a project, and you’re at the point where you really
know what you’re up against, you should look into using a productivity tool

such as CodeRush to help you code faster and more accurately. Using a code
generator can improve the whole experience of writing a program!

Write a Web Part

SharePoint is a portal server by Microsoft for the corporate set. By portal
server, | mean a predesigned intranet page that includes space to store
documents, schedules, and the like. Don’t cringe — it is actually a pretty
good product, unlike a lot of similar efforts.

Web Farts are the little holes in which the documents and schedules are
placed. Basically, instead of writing a custom page or user control every time
you need a new page or control on your intranet, you can invoke a standard
Web Part and configure it slightly to fit your needs.

SharePoint comes with 15 or so Web Parts, which include the following:

v Discussion board

v Fax control

v Document storage

v Link list

v Help Desk
You can find more downloadable Web Parts from Microsoft sponsored sites,
such as MSDN and MSNBC. Just go to MSDN and search for “SharePoint Web

Part” to get lists of Web Parts you can download. [ recommend the MSNBC
Weather control, shown in Figure 20-3.
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Figure 20-3:
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What should interest you, though, as a VB programmer, is the ability to write
a new Web Part. In total, the process for writing a Web Part from scratch is
actually very complicated. Microsoft makes it much easier by providing a
new project type for Web Parts — just like a Windows Application project or
a Web Service project.

The output of a Web Part is a DLL, just like a class library project (in fact, it is
a class library). The trick to getting rolling with a new Web Part, though, is to
download the SDK from the SharePoint site at http://msdn.microsoft.
com/sharepoint and install it. Then you will have access to a new project
type when you open Visual Studio and choose Filec>oNewr>Project.

Use the DTE

The DTE (Design Time Environment) is the automation object model — the
class library that you use to create new add-ins and wizards for Visual Studio
itself. Yes, that’s right; I am recommending that you further your understand-
ing of Visual Basic by creating an add-in for Visual Studio itself.

I could get into the philosophical implications of this, but I'll leave it straight-
forward: The more you work in depth with something, the better you get at it.

To use the DTE, you again need to start a new project type by choosing File=>
Newr>Project. In the New Project dialog box, look in the Project Types list on
the left and click the plus sign next to Other Project Types, and then select
Extensibility. In the Templates box on the right, select the Visual Studio Add-
in (shown in Figure 20-4), and then click OK.

What is great about this is that like the SharePoint Web Part, Microsoft has
done all of the plumbing for you. A lot of code is involved in making an add-in
work, but much of the code is automatically supplied by the project type.
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When you’ve loaded the Visual Studio Add-in project, you have access to
almost every part of a Visual Studio project. Need to loop through the files

in a project? No problem. Want to check out a

selected piece of code? Done.

Want to change a line of text into an HTML paragraph? Check this out:

Sub MakeParagraph ()
DTE.ActiveDocument.Selection
DTE.ActiveDocument.Selection
DTE.ActiveDocument.Selection

DTE.ActiveDocument .Selection
End Sub

.Text = "<P>"
.EndOfLine ()
.Text = "</pP>"

.CharRight ()

Like the data object generator described in the “Build Your Own Tools” sec-
tion, earlier in this chapter, the DTE can be a powerful ally. It’s worth giving it

a shot!

Write an Article about What
Vou Have Discovered

Say you've become pretty knowledgeable about Visual Basic, or perhaps
you've figured out a clever way to fix a problem you encountered while
creating a program. Especially when you figure out something on your own
by creating a unique block of code to solve a problem, you may want to
share your knowledge by writing an article.

333
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A bunch of great, popular sites accept short articles from new authors. Don’t
expect money, but you do get two important things if your article is accepted
and published: the acknowledgement of your peers, and the firm education
that comes with researching something solidly enough to write about it. To
get started, check out these sites:

www .dotnetjunkies.com/community.aspx
www.asptoday.com/Info.aspx?view=WriteForUs
www . dguysfromrolla.com/authors.shtml
www.asplO0l.com/resources/submit.asp
If you're interested in writing an article, write it! Don’t make up excuses like
you’re too shy or unknown to publish an article. In 2001, I wrote an article for
Intranet Journal that is still up (www.intranetjournal.com/articles/

200107/ia_07_25_0la.html), and I couldn’t believe the furor it started.
Now look where I am!



Chapter 21
Ten Resources on the Internet

In This Chapter

Researching with Web sites

Sharing ideas with online communities

Finding sample code

Wlat would we do without the Internet to turn to? In this chapter, |
show you my favorite online sites for getting information about
Visual Basic. You can find a lot of junk out there on the Internet, but you
can also find a lot of good stuff too. The trick lies in telling it apart.

MSDN Library

http://msdn.microsoft.com/library

The MSDN Library is without a question the number one resource for .NET
research. MSDN stands for Microsoft Developer Network, and the name MSDN
Library suits the site just fine; it is effectively a big online document storage
location.

The site’s search feature works great (type your sought-after term in the
Search For text box and click Go), but don’t overlook just browsing through
the site. The tree to the left has a very intelligently designed table of contents
built in, and you can find a ton of sample code and resources just by digging
through. Be careful, though, the content includes some older stuff, and you
want to focus on VB 2005 documents.
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UBForDummies.net

www . vbfordummies.net

VbForDummies.net is my site, a Wiki Web. My goal for using this type of site
is to post bits of the book, as well as other documents and code, and allow
it to be edited by the readers. Yes, that’s right, you can log on and change
things, add things, whatever. With an ever-changing resource like this, you
can share your thoughts, give examples of your own, or ask questions.

The most famous of the Wikis — the Wikipedia — has been going strong for a
few years now. Hopefully the VbForDummies site will follow in its footsteps.

GotDotNet.com

www . gotdotnet .com

The GotDotNet site started as the .NET team’s community pages, but has
grown into the first place for anyone to stop to research a general .NET
question. It is a community site, so the resources here are the forum and
the blogs. All of the .NET minds hang out here, and the ideas floating around
are great. For example, users can upload their own samples, and you can
research resources like server controls and components.

ASP.NET Web

www . asp.net

As with GotDotNet, the ASP.NET community was started by a Microsoft team —
but this time it was the ASP.NET team. ASP.NET Web is the place to go for any
download, control, or question about Web Forms development.

www.asp.net/Tutorials/quickstart.aspx

Also — don’t miss this — the ASP.NET site is the hosting location for the
QuickStart Tutorials. You may find that these tutorials are similar to this
book with to-the-point explanations and lots of examples. The QuickStart
Tutorials are solution driven, too, so they answer real rather than theoretical
questions. The code samples are based on the inline scripting model, which I
didn’t use in this book. This model offers another way to build ASP.NET Web
Forms projects. You can catch on to this model pretty quickly by looking at
the examples in the Quickstart.
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The Microsoft Public Newsgroups

http://msdn.microsoft.com/newsgroups/managed

[ used to be a huge fan of the Usenet, but with the proliferation of spammers,
it has really gone downhill. Microsoft has made a major effort though, to get
the Usenet started up again for Microsoft developers using the Managed
Newsgroup model. If you have an MSDN subscription and have signed up
with the Managed Newsgroup service, you get an answer to any posted ques-
tion within 48 hours (or two business days) from a Microsoft employee

or MVP. It’s a great plan, and it’s free with the MSDN subscription.

NET 247

www.dotnet247.com/247reference/default.aspx

I'll admit it — I am going to promote another author here. Matt Reynolds is a
fantastic writer and coder, and he has put up a fantastic resource in .NET 247.
This site looks through the Usenet for posts that actually have something inter-
esting in them, and then indexes these posts to make the information useful. I
highly recommend that you take advantage of the content on .NET 247.

Search IRC

http://searchirc.com/dir/Computers/Programming-and-
Development

Internet Relay Chat, like the Usenet, has gotten to be kinda bad (that is, not
too usable) with all of the script kiddies and spammers out there. It is still,
though, a good place to chat about VB 2005, if you know where to look. I
sometimes use the name Trillian when [ hang out on the Undernet, at the VB
channel. You can find more channels and their ratings here:

kbAlertz

www . kbalertz.com
What is kbAlertz.com? The kbAlertz site says it best:

“kbAlertz.com is an e-mail notification system that scans the entire
Microsoft Knowledge Base every night, and e-mails you when updates or
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additions are made to the technologies you subscribe to. Since we scan
the entire knowledge base, we also have a pretty good search system for
you to use on the left menu.”

Using kbAlerts isn’t about VB 2005 as much as it’s about having access to
information that’s handy for anyone in a Windows environment. I subscribe
to the alerts and get information on changes to the security best practices,
among other things.

CodeSwap

www . vscodeswap . net

In the same general vein as the control providers described in Chapter 23,
CodeSwap is a really neat tool for helping you find little bits of code that do
something you need. If you have a particular algorithm that you need the VB
2005 code for, or a bit of data-handling code for an Excel file, then CodeSwap
is the tool you need to find it.

The coolest part is that Code Swap is actually a Visual Studio add-in, so after
you install it, you don’t have to visit the site again! And in addition to finding
great code to use, you can post your own code to share, too. It’s a great idea.

<Microsoft> Google for Code Snarfing

A\

www .google.com/microsoft

With all of these specialty sites for finding and sharing code, don’t forget about
good old Google. The trick for using Google to find useful bits of code is to
refine your search technique. I search for the exact class I need code for and
add the term VB.NET, and I usually find what I need. For instance, | needed to
connect to an Excel spreadsheet as a data source recently. [ could have pieced
together the needed code from the MSDN documentation, but instead I turned
to Google. I searched with the phrase vb.net OleDbConnection Excel and got
four examples as the first four hits.

Now to do a proper search, you need to know a little about what you are
searching for. So don’t go off half-cocked, or your results will be too broad. To
narrow your search and get good results on Google, use one very specific
term (like OleDbConnection) with one or more broad terms (like vb.net and
FExcel).
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® Symbols

+ (addition) operator, 171

* (asterisk), 25, 100

/ (division) operator, 171

... (ellipsis), 28

% (modulus) operator, 171

* (multiplication) operator, 171
- (subtraction) operator, 171

o/ o

abstraction, reusable code, 200

AccessControl namespace, 251

AccessRule class, 251

Adapter classes, 257

Add a New Data Source button (Data
Sources window), 33

Add command (File menu), 119, 154

Add Connection dialog box, 260-261

Add method, 173

Add Reference dialog box, 216

Add Web Reference dialog box, 134-136

add-ins, 41-42

addition (+) operator, 171

ADO.NET services, 47

affected users, risk analysis, 242

Align command (Format menu), 73

Anchor tags, Web applications, 103-104

API (Application Programming
Interface), 64

AppActivate function, 219-220

app.config file, 294-296

append functions, StringBuilder
class, 168

application design

application load, 57
application state details,

Trace mode, 153

assumptions in, 57
BCL (Base Class Library), 45
consistency in, 59
data storage, 53-54
developer tools, 44-45
documentation research, 59
enterprise services, 47
ER (Entity Relationship), 54
[0 (Input Output) services, 47
logic, defining, 56-58
loosely coupled applications, 247
My .Application object, 46
.NET Framework, 44
n-tier design, 54
operating system basics, 45-47
overview, 43
planned processes, 58-59
project lifecycle process, 49-51
pseudocode, 57
requirements gathering, 52
scenarios, 57
scope, 51
screen design, 54-56
server integration, 47-48
services integration, 47-48
test plans, 58
use cases, 57
user interaction, 48
user stories, 57
user-identifiable field controls, 55
well-designed application layers, 45
Application Programming Interface
(APID), 64
applications. See Web Forms
applications; Windows Forms
applications
architecture-neutral Web service
characteristic, 127
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Array class, 229-230
Ask a Question button (Document
Explorer tool), 39
ASPNET 2 For Dummies (Hatfield), 93, 106
ASP.NET services
overview, 47
Web applications and, 84-85
Web site, 336
.aspx file, 90

assemblies, compiled blocks of code, 205

assessing data. See data assessment
assumptions, in application design, 57
asterisk (*), 25, 100
Attach to Process dialog box, 155
AuditRule class, 251
authentication
Authentication class, 285
defined, 239
Windows logins, 243-245
authorization
Authorization class, 285
Authorization namespace, 251
defined, 239

ol e

backward compatibility issues, Web
services, 131
BCL (Base Class Library), 45
best practices, secure applications, 250
BinaryReader class, 272
BinaryWriter class, 272
BindingNavigator application, 264
Bitmap object, 302-303
black box problems, data
assessment, 255
bold text, 302
branching, business logic in code, 181
breakpoints
Breakpoints window, 144
concept of, 142

creating, 143
properties, 144
stopping, 143
Brush class, 301
bugs. See debugging
Build toolbar, 315
business logic in code
branching, 181
class libraries, 111
decision making, 181-182
exceptions, 186-187
flowchart presentations, 178
multiple choice processes, 184-185
overview, 178
process definition, 180
single processes, 182-184
users, communicating with, 179
Web services, 128-129
Business Logic Layer, n-tier design, 54
Button control
Web Forms applications, 87
Windows Forms applications, 66
buttons
adding to toolbars, 40
Ask a Question (Document Explorer
tool), 39
Category (Properties window), 29
Contents (Document Explorer tool), 39
Events View (Properties window), 164
How Do I (Document Explorer tool), 39
Index (Document Explorer tool), 39
lightning bolt (Properties window), 28
New Connection (Data Source
Configuration Wizard), 260
Refresh button, Document Explorer
tool, 39
Refresh button, Solution Explorer
tool, 29
Reset Window (Options dialog box), 41
Search (Document Explorer tool), 39
Solution Explorer tool button
options, 29
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ByRef keyword, 206-207
Byte type, 161
ByVal keyword, 206-207

oo

Cache function, 286
Calendar control, Web Forms
applications, 87
CallByName function, 215
Catch statement, 186
Category button (Properties window), 29
CBool statement, 163
CDhate statement, 163
CDbl statement, 163
cell properties, Properties window, 28
CGI (Common Gateway Interface), 83, 98
Change Data Source dialog box, 261
Char type, 161
CInt statement, 163
CipherAlgorithmType class, 251
circles, image creation, 300
Class Designer toolbar, 315
class libraries. See also DLLs
business logic code, 111
class definition, 114
code-heavy devices, 114
coding, 114-115
creating, 115-118
debugging, 153-154
defined, 109
functional code, 114
functions, 112
namespaces, 112
objects, 112
operation declaration, 114
overloading, 123-124
private variables, 117
properties, 112, 114, 116-117
subroutines, 112, 114, 118, 122

classes

AccessRule, 251
Adapter, 257

Array, 229-230

AuditRule, 251
Authentication, 285
Authorization, 285
BinaryReader, 272
BinaryWriter, 272

Brush, 301
CipherAlgorithmType, 251
class files, reusable code, 203-205
CodeAccessPermission, 251
Cookie, 285
CryptoConfig, 251
DataReader, 256

DataRow, 255-256

DataSet, 254-256
DataTable, 255-256
DataView, 255-256
DbCommand, 255
DbConnection, 255

Debug, 147-148
defined, 49, 112
Directory, 272
DirectoryInfo, 272, 279-280
DNS, 285

Download, 285
DrivelInfo, 272
EndPoint, 285
Evidence, 251

File, 273

FilelInfo, 273
FileStream, 272
FileSystemWatcher, 273, 280-281
FileWeb, 285
FolderBrowserDialog, 273
Font, 302

FtpWeb, 285

Graphics, 302-303
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classes (continued)
HatchBrush, 301
Http, 285
HttpApplication, 89
HttpBrowserCapabilities, 89
HttpContext, 89
HttpCookie, 89
HttpRequest, 89, 105-106
HttpResponse, 89
HttpSession, 89
HttpUtility, 89
HttpWriter, 89
Inherits, 73
instances of, 49
instant, 273
IP, 285
IrDAa, 286
NetworkCredential, 286
OdbcAdapter, 255
OdbcCommand, 255
OleDbAdapter, 255
0leDbCommand, 255
OpenFileDialog, 273-275
OracleAdapter, 255
OracleCommand, 255
Path, 273
PathGradientBrush, 301
PrincipalPermission, 251
Process, 215-217
SaveFileDialog, 273, 277
SecureString, 251
SecurityPermission, 251
Service, 286
Site, 251
SmtpClient, 292
Socket, 286
SolidBrush, 301
SglCommand, 255
SglDataAdapter, 255
SglDataTime, 255
StreamReader, 277

StreamWriter, 277
StringBuilder, 166-169
TextReader, 272
TextureBrush, 301
TextWriter, 272
Upload, 286
Url, 251
Web, 286
WindowsIdentity, 105-106, 251
WindowsPrincipal, 251
ClickOnce deployment, 246
clients, well-designed application
layers, 45
clock controls, Toolbox feature, 27
closed categories, Toolbox feature, 27
CObl statement, 163
code
class libraries, 114-115
code generator programs, 330-331
for controls, writing, 65
snippets, 321
Code View
event handlers, 303
Insert Snippet tool, 321
opening, 37
CodeAccessPermission class, 251
CodeBehind file, 90
CodeRush Web site, 330-331
CodeSwap organizational tool
example of, 321
Web site, 338
collections
data assessment, 256
loops and, 193-195
Color property, 301
COM (Component Object Model),
214-215
command line programs, 218-219
commands
Add (File menu), 119, 154
Align (Format menu), 73



Attach to Process (Tools menu), 155
Customize (Tools menu), 40
Macros (Tools menu), 319
New (File menu), 15, 130, 162
New Project (File menu), 116
New Web Site (File menu), 91
Options (Tools menu), 40
Other Windows (View menu), 320
Paste Alternate (Edit menu), 315
Paste (Edit menu), 314
Project/Solution (File menu),
147, 150, 152
Properties (View menu), 28
Save All (File menu), 19
Shell, 218-219
Technical Support (Help menu), 39
Toolbox (View menu), 27
Commands tab (Customize dialog
box), 40
Common Gateway Interface (CGI), 83, 98
compiled blocks of code, assemblies, 205
complexity traps, reusable code, 205-208
Component method, 173
Component Object Model (COM),
214-215
Component Tray feature, 317-318
component-based software, Data
Sources window, 35
concatenation, 163
Condition column (Breakpoints
window), 144
config file, 293
Configuration function, 286
Connection Properties dialog box, 31-32
connectivity
data sources, 257
network connectivity checks, Internet
access, 287-288
ODBC (Open Database
Connectivity), 257
consistency, application design, 59

consuming Web services, 134-137
content placeholders, 212
Contents button (Document Explorer
tool), 39
context menus, Windows Forms
applications, 81-82
ContextMenuStrip control, 81-82
Control Panel services, Server Explorer
tool, 31
controls
control details, Trace mode, 153
positioning, 65
properties, changing, 65
Properties window, 28
Toolbox feature, 26-27
Web Forms applications, 86-88
Windows Forms applications, 65-66
writing code for, 65
Conversion method, 173
cookies
Cookie class, 285
details, Trace mode, 153
copying files, 29
CreateGraphics method, 307
CreateObject function, 214-215
cross-platform compatibility issues, Web
services, 131
CryptoConfig class, 251
Cryptography namespace, 251
Crystal Reports Services node, 31
Ccstr statement, 163
CType statement, 162-163
Customize dialog box, 40
customizing toolbars, 315-316

o) e

D format provider, 174

d format provider, 174

damage potential, risk analysis, 242
DashStyle property, 301

Index 343
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data assessment
Adapter classes, 257
BindingNavigator application, 264
black box problems, 255
collections, 256
data brokers, 269
data code, writing, 266-269
data source connections, 257-261
DataSet container, 254
disconnection, 255
hashtables, 256
importance of, 253
manually retrieving data, 256-257
ODBC (Open Database
Connectivity), 257
OLEDB (Object Linking and Embedding
Database), 257
RAD data tools, 263
smart tags, 264
System.Data namespace, 254-255, 257
System.Data.Common namespace, 255
System.Data.ODBC namespace, 255
System.Data.OleDb namespace, 255
System.Data.OracleClient
namespace, 255
System.Data.SglClient
namespace, 255
System.Data.SglTypes
namespace, 255
data brokers, data assessment, 269
data connection screen (Data Source
Configuration Wizard), 259-260
Data Connections node, 31-32
data controls, Web Forms
applications, 88
Data Encryption Standard (DES), 245
Data Layer, n-tier design, 54
Data Source Configuration Wizard
Add Connection dialog box, 260-261
Change Data Source dialog box, 261
data connection screen, 259-260

Data Sources panel, 262-263
New Connection button, 260
Object Source type, 258
Web service selection, 258
Data Sources window
Add a New Data Source Button, 33
component-based software, 35
Database option, 33
data-bound control creation, 34
Local Database File option, 33
Object option, 33
Products dataset, 34
Web Service option, 33
data storage, application design, 53-54
Database option (Data Sources
window), 33
data-bound control creation (Data
Sources window), 34
DataGridview control, 66
DataReader class, 256
DataRow class, 255-256
DataSet class, 254-256
DataTable class, 255-256
DataView class, 255-256
DateTime type, 161, 172-173
DbCommand class, 255
DbConnection class, 255
Debug toolbar, 315
debugging. See also errors
breakpoints, 142-144
class libraries, 153-154
common tools for, 142
Debug class, 147-148
Debug.Print method, 146
error handling, 148-149
Immediate window, 146-147
importance of, 141
remote, 151
Trace mode, 152-153
Watch window, 145-146
Web Forms applications, 96-97,
151-153
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Web services, 154-156
Windows Forms applications, 150-151
Debugging Not Enabled dialog box, 96
decision making, business logic in code,
181-182
declaring variables, 122
default namespaces, Web services, 132
deleting files, 29
denial of service, security threats, 242
deployment security, 246-247
DES (Data Encryption Standard), 245
Description property, 132
design
design issues, overloading, 229-230
project lifecycle process, 49-51
Web services, 128
Design Time Environment (DTE),
332-333
Design View
discussed, 16
overview, 90
screen management options, 25
tabs, 25
uses for, 24
developer tools, application design,
44-45
development tips, Web Forms
applications, 107
Device toolbar, 315
dialog boxes
Add Connection, 260-261
Add Reference, 216
Add Web Reference, 134-136
Attach to Process, 155
Change Data Source, 261
Connection Properties, 31-32
Customize, 40
Debugging Not Enabled, 96
File Management, 276
Items Collection Editor, 75-76
New Project, 15, 67

New Web Site, 91
Options, 40-41
Save Project, 19
dialog controls, 273
Dim statement, 128, 161
directories, listing, 279
Directory class, 272
DirectoryInfo class, 272, 279-280
DISCO (discovery) files, 138-139
disconnection, data assessment, 255
discoverability, risk analysis, 242
discussion boards, Web Parts, 331
Disk Operating System (DOS), 218
display page, Web services, 132
division (/) operator, 171
DLLs (Dynamic Link Libraries). See also
class libraries
defined, 110
encapsulation and, 111
files, running, 118-121
memory management, 111
procedure definitions, 121
DNS class, 285
Do loop, 195
dockable windows, 36
Document Explorer tool, 38-39
document storage, Web Parts, 331
documentation
application design research, 59
document requirements, 52
security, 240-241
DomainUpDown control, 66
DOS (Disk Operating System), 218
Dotfuscator add-in, 41-42
Double type, 161
Do-Until loop, 197-198
Do-While loop, 196-197
Download class, 285
downloading files from Internet, 288-290
DragDrop event, 225
dragging windows, 36

345
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DrawBezier object, 300
DrawCircle object, 300
DrawLine object, 300
DrawRectangle object, 300
DriveInfo class, 272
DTE (Design Time Environment),
332-333
Dynamic Link Libraries. See also class
libraries
defined, 110
encapsulation and, 111
files, running, 118-121
memory management, 111
procedure definitions, 121

oF o

Edit Items link (Properties window), 75

Edit menu commands
adding to Windows Forms
applications, 80
Paste, 314
Paste Alternate, 315
editable files, Web Forms
applications, 90
editions, Visual Studio 2005, 14
elevation of privileges, security
threats, 242
ellipsis (...), 28
Else statement, 183
ElseIf statement, 184
e-mail requirements, Internet access,
290-293
encapsulation
defined, 111

encapsulated versus reusable code, 200

encryption, 245-246

End Class statement, 131
End If statement, 183
EndCap property, 301
EndPoint class, 285

Enterprise Library Data Access
Application Block data broker, 269
enterprise servers, application
design, 47
ER (Entity Relationship), 53-54
ErrorProvider control, 66
errors. See also debugging
exceptions versus, 186
InvalidCastException, 163
in reusable code, 207-208
throwing and error, 208
escaping the mark, 161

Even Spacing Between Controls option,

alignment, 73
event handlers
Code View use, 303
DragDrop event, 225
Form_Load, 76
IntelliSense feature, 226-227
MouseEnter event, 225-226
OnChange event, 305
OnClick event, 224
PostBack communication, 85
Properties window use, 225-226,
312-313
Windows Forms applications, 70-72
Event Logs node, 31
Events View button (Properties
window), 164
Evidence class, 251
exceptions
business logic in code, 186-187
errors versus, 186
Exception object, 148-149
Exit While statement, 198
exploitability, risk analysis, 242
Express Edition, Visual Studio 2005,
14, 323
expressions, regular, 167, 169
extended providers, 316

Extensible Markup Language (XML), 138



Index

ofFe

fax control, Web Parts, 331
fields, private variables, 117
File class, 273
File Management dialog box, 276
File menu commands
Add, 119, 154
adding to Windows Forms
applications, 80
New, 15, 130, 162
New Project, 116
New Web Site, 91
Project/Solution, 147, 150, 152
Save All, 19
file systems. See also files
dialog controls, 273
file management classes, 272-273
FileUpload control, 274
System.IO namespace, 272-274
uses for, 271
FileInfo class, 273
files. See also file systems
app.config, 294-296
.aspx, 90
changes to, monitoring, 280-281
CodeBehind, 90
config, 293
copying, 29
deleting, 29
DISCO (discovery), 138-139
DLL, running, 118-121

downloading from Internet, 288-290

filenames, 277
information in, viewing, 279-280
listing, 279
opening, 29, 274-277
renaming, 29
saving, 277-278
shared, 272
FileStream class, 272

FileSystemWatcher class, 273, 280-281
FileUpload control, 88, 274
FileWeb class, 285
FillCircle object, 300
FillRectangle object, 300
Finalize function, 223
Finally statement, 187
floating windows, 36
flowchart presentations, business logic
in code, 178
FolderBrowserDialog class, 273
Font class, 302
font size maintenance, Document
Explorer tool, 39
For-Each loops, 193-195
form collection details, Trace mode, 153
Form object (Document Explorer
tool), 39
Format menu, Align command, 73
format providers, strings, 174
Form_Load event handler, 76
For-Next loops, 192-193
Friend keyword, 121
FTP sites, Web Forms applications, 91
FtpWeb class, 285
functional code, class libraries, 114
functions. See also methods
AppActivate, 219-220
Cache, 286
CallByName, 215
Configuration, 286
CreateObject, 214-215
defined, 112
Finalize, 223
function declaration, Web services, 132
Mail, 286
Mime, 286
NetworkInformation, 286, 288
Now, 173
returning values from, 113
reusable code, 201-203

347
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functions (continued)
Security, 286
shared, 122-123
SharedListener, 295
Sockets, 286
Sort, 229-230
ToString (), 112,174

oG o

G format provider, 174
g format provider, 174
Gantt Chart example, project lifecycle
process, 50
garbage collection feature, 223
General Environment variables (Options
dialog box), 40
generics
creating, 231-232
designing for, 233
Get property, 117
Google Web site, 338
GotDotNet Web site, 326, 336
Graphics class, 300, 302-303
gray dividers, Toolbox feature, 27
groups, tabs, 25

o o

hackers, Internet access, 293
Handles statement, 225
hashtables, 256
HatchBrush class, 301
Hatfield, Bill (ASPNET 2 For Dummies),
93, 106
header details, Trace mode, 153
Hello World application
new project setup, 15-16
Windows Forms application
example, 18

help options
Document Explorer tool, 39
Help Desk, Web Parts, 331
Help menu, Technical Support
command, 39
Hide parameter, 219
hierarchy, .NET Framework, 12-14
Hit Count column (Breakpoints
window), 144
How Do I button (Document Explorer
tool), 39
Howard, Michael (Writing Secure Code,
Second Edition), 293
HREF property, 103
HTML controls, Web Forms
applications, 88
Http class, 285
HttpApplication class, 89
HttpBrowserCapabilities class, 89
HttpContext class, 89
HttpCookie class, 89
HttpRequest class, 89, 105-106
HttpResponse class, 89
HttpSession class, 89
HttpUtility class, 89
HttpWriter class, 89

o]e

1D property, 100
IEnumerable interface, 194
If statement, 183
If-Then-Else statements, 104
IIS (Internet Information Services), 91,
137-138
image creation
Bitmap object, 302-303
Brush class, 301
CreateGraphics method, 307
Cribbage card game example, 303-307
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DrawBezier object, 300
DrawCircle object, 300
DrawLine object, 300
DrawRectangle object, 300
FillCircle object, 300
FillRectangle object, 300
Font class, 302
Graphics class, 300, 302-303
overview, 299
Paint object, 305
pen properties, 301
project setup, 305-306
System.Drawing namespace, 300-303
System.Drawing.Imaging
namespace, 299
System.Drawing.Text
namespace, 299
System.Drawing.2D namespace, 299
text operations, 302
image tags, Web Forms applications,
104-105
ImageMap control, 88
ImageURL property, 104
Immediate window, 146-147
Imports statement, 131
indefinite loops, 190-191, 195
Independent Software Vendor (ISV), 327
Index button (Document Explorer
tool), 39
information disclosure, security
threats, 242
inheritance statement, Web services, 131
Inherits class, 73
Input Output (I0) services, 47
insert functions, StringBuilder
class, 168
Insert Snippet organizational tool, 321
installing Visual Studio 2005, 15
instances, classes, 49
instant classes, 273

Integer type, 161
IntelliSense feature
event handling, 226-227
overloading, 123
overview, 37-38
interfaces, IEnumerable, 194
internal values, subroutines, 118
Internet access
e-mail requirements, 290-293
file downloads, 288-290
hackers, 293
network activity logs, 293-297
network connectivity checks, 287-288
network traffic, 293
overview, 283
RFC (Request For Comments), 284
status reports, 290-293
System.Net namespace, 284-286
Task List project management feature,
320-321
Internet Information Services (IIS),
91, 137-138
interoperable Web service
characteristic, 127
intrinsic types, 161
InvalidCastException error, 163
[0 (Input Output) services, 47
IP class, 285
IrDA class, 286
IsDbNull method, 167
ISV (Independent Software Vendor), 327
Items Collection Editor dialog box, 75-76

oo

kbAlertz Web site, 337-338
Kernighan, Brian W. (Software Tools), 324
keywords

ByRef, 206-207

ByVal, 206-207
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keywords (continued)
Friend, 121
of, 231
Private, 121, 205
Protected, 121
Protected Fried, 121
Public, 121, 205
Using, 224
With, 224

o/ o

labels
Label control, 66
Web Forms applications, 92
layers, n-tier design, 54
layout options
Toolbox feature, 27
windows, 41
Layout toolbar, 315
LeBlanc, David C. (Writing Secure Code,
Second Edition), 293
libraries
BCL (Base Class Library), 45
Enterprise Library Data Access
Application Block data broker, 269
MSDN Library Web site, 14
lightning bolt button, Properties
window, 28
linefeeds, 3
lines, image creation, 300
link lists, Web Parts, 331
listing directories and files, 279
literals, 170

local and remote resource access, Server

Explorer tool, 31

Local Database File option (Data Sources

window), 33
log files, network activity, Internet
access, 293-297
logic, application design, 56-58
LogonUserIdentity object, 106

loops
collections and, 193-195
defined, 189
Do, 195
Do-Until, 197-198
Do-While, 196-197
For-Each, 193-195
For-Next, 192-193
indefinite, 190-191, 195
specific, 190-191
when to use, 190-191
While-End, 198

loosely coupled applications, 247

ol o

macros, recording, 318-320
Mail function, 286
master pages, reusable code, 212-213
mathematical operators, 171
MaximizedFocus parameter, 219
MaxValue method, 172
memory
memory management, DLLs, 111
RAM (Random Access Memory), 160
menus, adding to Windows Forms
applications, 80-81
MenuStrip control, 66, 78-79
Message property, 149, 187
Message Queues node, 31
metacharacters, 170
methods. See also functions
Add, 173
calling, Web services, 136
Component, 173
Conversion, 173
CreateGraphics, 307
Debug.Print, 146
IsDbNull, 167
MaxValue, 172
method signature, 123
MinvValue, 172
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Parse, 174-175

Regex, 170

Save, 214

System.String.ToString (), 112

ToLower, 172

ToUpper, 166, 172

TryParse, 174-175

Write, 147
Mime function, 286
MinimizedFocus parameter, 219
MinimizedNoFocus parameter, 219
Minvalue method, 172
mobile computing devices, 21
modulus (%) operator, 171
monitoring files, 280-281
mouse, right-click activation, 81-82
MouseEnter event, 225-226
moving

between pages, Web applications,

103-104

windows, 35-36
MSDN Library Web site, 14, 335
multiple choice processes, business

logic in code, 184-185

multiplication (*) operator, 171
My Documents folder, 29
My .Application object, 46
My .Computer object, 46
My .User object, 46

o\ o

namespaces
AccessControl, 251
Authorization, 251
Cryptography, 251
defined, 112
namespace classes, Web Forms

applications, 89

Permissions, 251
Policy, 251
Principal, 251

Security, 251
System.Data, 254-255, 257
System.Data.Common, 255
System.Data.ODBC, 255
System.Data.0OleDb, 255
System.Data.OracleClient, 255
System.Data.SglClient, 255
System.Data.SglTypes, 255
System.Drawing, 300-303
System.Drawing. Imaging, 299
System.Drawing.Text, 299
System.Drawing. 2D, 299
System. IO, 272-274
System.Net, 284-286
System. Security, 251
Web services, 132
naming Web Forms applications, 92-93
navigation
navigation button (Document Explorer
tool), 39
navigation controls, Web Forms
applications, 88, 103-104
NavigationURL property, 104
.NET Framework
application design, 44
hierarchy, 12-14
Visual Basic version differences, 11
.NET 247 Web site, 337
network activity logs, Internet access,
293-297
NetworkCredential class, 286
NetworkInformation function, 286, 288
New command (File menu), 15, 130, 162
New Connection button (Data Source
Configuration Wizard), 260
New Project command (File menu), 116
New Project dialog box, 15, 67
New Web Site dialog box, 91
newsgroups, 337
non-volatile storage, 160
NormalFocus parameter, 219
NormalNoFocus parameter, 219
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Now function, 173
n-tier design, application design, 54
null values, strings, 166-167

o () o

Object Linking and Embedding Database
(OLEDB), 257
Object option (Data Sources window), 33
Object Source type (Data Source
Configuration Wizard), 258
Object type, 161
objects, defined, 49, 112
ODBC (Open Database Connec-
tivity), 257
OdbcAdapter class, 255
0OdbcCommand class, 255
of keyword, 231
OLEDB (Object Linking and Embedding
Database), 257
OleDbAdapter class, 255
0OleDbCommand class, 255
onChange event, 305
OnClick event, 224
Open Database Connectivity
(ODBC), 257
open source software, 326-327
OpenFileDialog class, 273-275
opening
Code View, 37
files, 29, 274-277
Server Explorer tool, 30
Toolbox feature, 27
Watch window, 145-146
operating systems, application design,
45-47
operation declaration, class
libraries, 114
operators, mathematical, 171
optional parameters, overloading,
230, 232
Options command (Tools menu), 40

Options dialog box (Visual Studio 2005),
40-41
Oracleadapter class, 255
OracleCommand class, 255
Other Windows command
(View menu), 320
overloading
built-in functions, changing, 228-229
class libraries, 123-124
design issues, 229-230
optional parameters, 230, 232
procedure names, reusing, 227-228

opPoe

Paint object, image creation, 305
Panel control, 88
Parse method, 174-175
Paste Alternate command
(Edit menu), 315
Paste command (Edit menu), 314
Path class, 273
PathGradientBrush class, 301
patterns, regular expressions and, 169
pen properties, image creation, 301
Performance Counters node, 31
Permissions namespace, 251
personalization controls, Web Forms
applications, 88
planned processes, application, 58-59
planning, project lifecycle process, 49-51
Plaugher, P. J. (Software Tools), 324
Pocket PC 2003, mobile computing
devices, 21
Policy namespace, 251
port numbers, 135
portal servers, 331-332
positioning controls, 65
PostBack communication, Web Forms
applications, 85
Presentation Layer, n-tier design, 54
Principal namespace, 251



PrincipalPermission class, 251
PrintDialog control, 66
pPrivate keyword, 121, 205
private variables, fields, 117
procedure definitions, DLLs, 121
procedure names, reusing, 227-228
Process class, 215-217
process definition, business logic in
code, 180
producing Web services, 130-131
Products dataset (Data Sources
window), 34
Professional Edition, Visual
Studio 2005, 14
project lifecycle process
design, 49-51
Gantt Chart example, 50
planning, 49-51
requirements considerations, 51
scope considerations, 51
project management, Task List feature,
320-321
project sensitivity, Toolbox feature, 26
project types and platforms, Web
services, 126
Projects directory, My Documents
folder, 29
Project/Solution command (File menu),
147, 150, 152
properties
adding, 116-117
breakpoints, 144
Color, 301
DashsStyle, 301
defined, 112
Description, 132
EndCap, 301
Get, 117
HREF, 103
ID, 100
ImageURL, 104
Message, 149, 187

NavigationURL, 104

renaming, 116-117

Selectedvalue, 99

Set, 117

StackTrace, 149

Text, 99

values, 114

Width, 301
Properties button (Solution Explorer

tool), 29

Properties window

Category button, 29

cell properties, 28

controls, 28

Edit Items link, 75

ellipsis (...), 28

event handling, 28, 225-226, 312-313

Events View button, 164

lightning bolt button, 28

opening, 28

overview, 27

property description information, 29
Protected Friend keyword, 121
Protected keyword, 121
proxy class, Web service, 137
pseudocode, 57
Public keyword, 121, 205
public services, Web services, 137-138,

328-330

OQ.

Query Designer toolbar, 316

o R o

RAD (Rapid Application Development),
23, 263

RadioButtonList control, 88

RAM (Random Access Memory), 160

recording macros, 318-320

rectangles, image creation, 300

Index 353
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referencing Web services, 136
Refresh button
Document Explorer tool, 39
Solution Explorer tool, 29
Regex method, 170
regular expressions
defined, 167
patterns and, 169
uses for, 169
remote and local resource access, Server
Explorer tool, 31
remote debugging, 151
remove functions, StringBuilder
class, 168
renaming
files, 29
properties, 116-117
replace functions, StringBuilder
class, 168
reproducibility, risk analysis, 242
repudiation of action, security
threats, 242
request details, Trace mode, 152
Request For Comments (RFC), 284
RequiredFieldvalidator control, 100
requirements
project lifecycle process, 51
requirements document, 52
requirements gathering, application
design, 52
Reset Toolbox option, Toolbox
feature, 27
Reset Window Layout button (Options
dialog box), 41
resources, debugging, 155
reusable code
abstraction, 200
AppActivate function, 219-220
class files, 203-205
COM (Component Object Model)
references, 214-215

command line programs, 218-219
complexity traps, 205-208
custom control creation, 209-211
DOS (Disk Operating System), 218
encapsulated code versus, 200
errors in, 207-208
functions, 201-203
Interop function, 219
master pages, 212-213
overview, 199
Process class, 215-217
user controls, creating, 211
RFC (Request For Comments), 284
RichTextBox control, 66
right-click activation, 81-82
risk analysis, security, 242
Ruby Forms engine, Visual Basic 6.0,
63-64

oS e

s format provider, 174

SAO (Software Architecture
Overview), 241

Save All command (File menu), 19

Save method, 214

Save Project dialog box, 19

SaveFileDialog class, 273, 277

saving files, 277-278

scenarios, application design, 57

scope

application design considerations, 51
project lifecycle process, 51

screen design, application design, 54-56

screen management options, Design
View, 25

script exploits, 248-250

Search button (Document Explorer
tool), 39

Search IRC Web site, 337

SecureString class, 251
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security
AccessControl namespace, 251
authentication, 239, 243-245
authorization, 239
base classes for, 251
best practices, 250
Cryptography namespace, 251
denial of service, 242
deployment, 246-247
documentation, 240-241
elevation of privileges, 242
encryption, 245-246
new features, 21
Permissions namespace, 251
Policy namespace, 251
Principal namespace, 251
program component documentation,
240-241
risk analysis, 242
script exploits, 248-250
Security namespace, 251
spoofing, 242
SQL Injection attacks, 247-248
System.Security namespace, 251
threats, 241-242
Web Forms applications, 247-251
what to secure, 240
Windows Forms applications, 243-247
Security function, 286
Security namespace, 251
SecurityPermission class, 251
SelectedvValue property, 99
Server Explorer tool
Control Panel node, 31
Crystal Reports Services node, 31
Data Connections node, 31-32
Event Logs node, 31
Message Queues node, 31
opening, 30
Performance Counters node, 31
remote and local resource access, 31

Servers node, 31
tree view, 31
Server View, 90
servers
portal, 331-332
server integration, application design,
47-48
variables, Trace mode, 153
variables, Web Forms applications, 86
well-designed application layers, 45
Servers node (Server Explorer tool), 31
Service class, 286
Service-Oriented Architecture (SOA), 128
services integration, application design,
47-48
Session object, 101-103
session state details, Trace mode, 153
Set property, 117
Setup Project tool, 19
shared files, 272
shared functions, 122
SharedListener function, 295
SharePoint portal server, 331
Shell command, 218-219
short article publications, 333-334
Show All Files button (Solution Explorer
tool), 29
Simple Object Access Protocol
(SOAP), 138
simplicity characteristic, Web
services, 127
single processes, business logic in code,
182-184
Site class, 251
sites. See Web sites
smart tags, 264
SmartPhone platform, mobile computing
devices, 21
SmtpClient class, 292
snippets, inserting in code, 321
SOA (Service-Oriented Architecture), 128



356

Visual Basic 2005 For Dummies

SOAP (Simple Object Access
Protocol), 138
Socket class, 286
Sockets function, 286
software
ISV (Independent Software Vendor), 327
open source, 326-327
Software Architecture Overview
(SA0), 241
Software Tools (Kernighan and
Plaugher), 324
SolidBrush class, 301
Solution Explorer tool, 29
Sort function, 229-230
Source View, 90, 93-94
SourceForge Web site, 326
specific loops, 190-191
spoofing, security threats, 242
SQL Injection attacks, 247-248
SglCommand class, 255
SglDataAdapter class, 255
SglDataTime class, 255
src attribute, 104
StackTrace property, 149
Standard Edition, Visual Studio 2005, 14
state management
Session object, 101-103
ViewState object, 101-103
Web Forms applications,
85-86, 101-103
statements
Catch, 186
CBool, 163
CDhate, 163
CDbl, 163
CInt, 163
Cobl, 163
Cstr, 163
CType, 162-163
Dim, 128, 161
Else, 183

ElseIf, 184

End Class, 131

End If, 183

Exit While, 198
Finally, 187
Handles, 225

If, 183
If-Then-Else, 104
Imports, 131

Step, 193

Try, 186

Try-Catch block, 148
WebMethod, 131
WebServiceBinding, 131-132

status bar controls, Windows Forms

applications, 74-76
StatusStrip control, 75
Step statement, 193
stopping breakpoints, 143
storage

application data, 53-54
documents, Web Parts, 331
non-volatile, 160
volatile, 160
StreamReader class, 277
StreamWriter class, 277
String type, 161, 165
StringBuilder class, 166-169
strings
concatenation, 163
defined, 161
format providers, 174
literals, 170
metacharacters, 170
null values, 166-167
title, 165-166
Style Sheet toolbar, 316
styles, text, 302
subroutines
class libraries and, 114
defined, 112
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internal values, 118
shared functions versus, 122

subtraction (-) operator, 171
System.Data namespace, 254-255, 257
System.Data.Common namespace, 255
System.Data.OleDb namespace, 255
System.Data.OracleClient

namespace, 255
System.Data.SglClient

namespace, 255
System.Data.SglTypes

namespace, 255
System.Drawing namespace, 300-303
System.Drawing.Imaging

namespace, 299
System.Drawing.Text namespace, 299
System.Drawing.2D namespace, 299
System.IO namespace, 272-274
System.Net namespace, 284-286
System.Security namespace, 251
System.String.ToString ()

method, 112

oJ o

tabbed windows, 36
TabControl control, 66
tabs
Commands (Customize dialog box), 40
Design View, 25
groups, 25
order of, changing, 25
tactics, Web services, 129
tags
Anchor, 103-104
image, 104-105
tampering with files, security
threats, 242
Task List project management feature,
320-321

Technical Support command (Help
menu), 39
Templates pane (New Project dialog
box), 15
templates, Web services, 130
testing
application design, 58
Web services, 133

text
bold, 302
styles, 302

text input, Windows Forms
applications, 72-74
underlined, 302
in Web pages, 314-315
text box controls, Web Forms
applications, 98
Text property, 99
TextBox control, 66, 72
TextReader class, 272
TextureBrush class, 301
TextWriter class, 272
third-party tools
add-ins, 41-42
software created by, 327-328
threading
implementation, 234-236
overview, 233
uses for, 234
threats, security, 241-242
throwing an error, 208
timing details, Trace mode, 152
title strings, 165-166
TODO comments, Task List project
management feature, 321
tokens, Task List project management
feature, 321
ToLower method, 172
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toolbars

Build, 315

buttons, adding, 40

Class Designer, 315

customizing, 315-316

Debug, 315

Device, 315

Layout, 315

Query Designer, 316

Style Sheet, 316
Toolbox feature

clock controls, 27

closed categories, opening, 27

controls, 26-27

gray dividers, 27

layout options, 27

opening, 27

project sensitivity, 26

Reset Toolbox option, 27
Tools menu commands

Attach to Process, 155

Customize, 40

Macros, 319

Options, 40
ToolStrip control, 66
ToolTips, 76-77, 316
TopCoder Web site, 325-326
ToString () function, 112, 174
ToUpper method, 166, 172
Trace mode, debugging, 152-153
tree view, Server Explorer tool, 31
Try statement, 186
Try-Catch block, 148
TryParse method, 174-175
types

Byte, 161

Char, 161

DateTime, 161, 172-173

discussed, 159

Double, 161

Integer, 161

intrinsic, 161

mathematical operators, 171
Object, 161

String, 161, 165

validation control, 164-165

olf o

ubiquitous Web service character-
istic, 127
UDDI (Universal Discovery and
Description Language), 138-139
underlined text, 302
Upload class, 286
Url class, 251
URL option (Add Web Reference dialog
box), 135
urlString variable, 216-217
use cases, application design, 57
user stories, application design, 57
user-identifiable field controls,
application design, 55
users
communicating with, business
logic, 179
input forms, Windows Forms
applications, 67-69
input validation, Web Forms
applications, 98-101
LogonUserIdentity object, 106
My .User object, 46
user controls, reusable code, 211
user information retrieval, Web Forms
applications, 105-106
user interaction, application design, 48
Using keyword, 224

o[/ e

validation

controlling types with, 164-165
RequiredFieldvalidator
control, 100
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user input, Web Forms applications,
98-101
ValidationSummary control, 100
values, properties, 114
variables
declaring, 122
private, 117
urlString, 216-217
Watch window, 146
VbForDummies Web site, 336
View Code button (Solution Explorer
tool), 29
View Designer button (Solution Explorer
tool), 29
View Diagram button (Solution Explorer
tool), 29
View menu commands
Other Windows, 320
Properties, 28
Toolbox, 27
viewing Web services, 132-134
views
Code, 37, 303, 321
Design, 16, 24-25, 90
Server, 90
Source, 90, 93-94
ViewState object, 101-103
Visual Basic 6.0
Ruby Forms engine, 63-64
Visual Basic 2005 versus, 13
Visual Basic 2005
new features, 21
overview, 13
Visual Basic 6 versus, 13
Visual Studio 2005
add-ins, 41-42
Code View, 37
Customize dialog box, 40
Data Sources window, 33-35
Design View, 16, 24-25

Document Explorer tool, 38-39
Express Edition, 14, 323
installing, 15
IntelliSense feature, 37-38
New Project dialog box, 15, 67
Options dialog box, 40-41
overview, 12-13
Professional Edition, 14
Properties window, 27-29
Server Explorer tool, 30-32
Solution Explorer tool, 29
Standard Edition, 14
Toolbox feature, 26-27

Visual Studio Integration Program Web

site, 327
volatile storage, 160
VWD (Visual Web Developer), 96-98

o/ o

Watch window
opening, 145
variables, 146
watch lists, 145

Web class, 286

Web Forms applications
Anchor tags, 103-104
ASP.NET service and, 84-85
. aspx file, 90
Button control, 87
Calendar control, 87
CodeBehind file, 90
controls, 86-88
data server, 88
debugging, 96-97, 151-153
Design View, 90
development tips, 107
editable files, 90
FileUpload control, 88
FTP sites, 91
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Web Forms applications (continued)
HTML controls, 88
HttpApplication class, 89
HttpBrowserCapabilities class, 89
HttpContext class, 89
HttpCookie class, 89
HttpRequest class, 89, 105-106
HttpResponse class, 89
HttpSession class, 89
HttpUtility class, 89
HttpWriter class, 89
If-Then-Else statements, 104
IIS sites, 91
image tags, 104-105
ImageMap control, 88
label controls, 92
LogonUserIdentity object, 106
moving between pages, 103-104
namespace classes, 89
naming, 92-93
navigation controls, 88, 103-104
New Web Site dialog box, 91
overview, 13, 20, 83
Panel control, 88
personalization controls, 88
PostBack communication, 85
RadioButtonList control, 88
RequiredFieldvalidator

control, 100
running, 96-98
security, 247-251
server variables, 86
Server View, 90
Source View, 90, 93-96
state management, 85-86, 101-103
text box controls, 98
user information retrieval, 105-106
user input validation, 98-101
validation controls, 88

ValidationSummary control, 100
VWD (Visual Web Developer), 96-98
Web Forms controls, 88
Web-ready images, 104-105
WindowsIdentity object, 105-106
Web pages, text in, 314-315
Web Parts, 331-332
Web servers, saving files to, 274
Web services
Add Web Reference dialog box, 134-136
advantages of, 127
backward compatibility issues, 131
business logic code, 128-129
characteristics of, 127
consuming, 134-137
cross-platform compatibility issues, 131
debugging, 154-156
default namespaces, 132
Description property, 132
design strategies, 128
display page, 132
End Class statement, 131
function declaration, 132
goals of, 134
inheritance statement, 131
methods, calling, 136
overview, 13, 125
producing, 130-131
project types and platforms, 126
proxy class, 137
public services, 137-138, 328-330
referencing, 136
SOA (Service-Oriented Architec-
ture), 128
tactics, 129
templates, 130
testing, 133-134
viewing, 132-134
WebMethod statement, 131
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WebServiceBinding statement,
131-132
Windows concepts, 126
Web Services Description Language
(WSDL), 138
Web sites
ASP.NET, 336
CodeRush, 330-331
CodeSwap, 338
Google, 338
GotDotNet, 326, 336
kbAlertz, 337-338
MSDN Library, 14, 335
.NET 247, 337
Search IRC, 337
SourceForge, 326
TopCoder, 325-326
VbForDummies, 336
Visual Studio Integration, 327
Windows Forms .NET, 327
XMethods, 328
WebBrowser control, 66
Web-ready images, Web Forms
applications, 104-105
well-designed application layers, 45
What-You-See-Is-What-You-Get
(WYSIWYG), 24, 90
While-End loop, 198
width property, 301
windows
dockable, 36
dragging, 36
floating, 36
layout options, 41
moving, 35-36
tabbed, 36
Windows CE platform, mobile computing
devices, 21

Windows Forms applications
Button control, 66
context menus, 81-82
ContextMenuStrip control, 81-82
controls, 65-66
DataGridview control, 66
DateTimePicker control, 66
debugging, 150-151
DomainUpDown control, 66
Edit menu commands, adding, 80
ErrorProvider control, 66
event handlers, 70-72
File menu commands, adding, 80
Form_Load event handler, 76
Hello World application, 18
Label control, 66
menus, adding, 80-81
MenuStrip control, 66, 78-79
overview, 13, 63-64
PrintDialog control, 66
RichTextBox control, 66
right-click activation, 81-82
security, 243-247
status bar controls, 74-76
StatusStrip control, 75
TabControl control, 66
text input, 72-74
TextBox control, 66, 72
ToolStrip control, 66
ToolTip control, 76-77
user input forms, 67-69
WebBrowser control, 66
Windows Forms .NET Web site, 327
WindowsIdentity class, 105-106, 251
WindowsPrincipal class, 251
with keyword, 224
wizards, Data Source Configuration,
258-263
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Write method, 147

Writing Secure Code, Second Edition
(Howard and LeBlanc), 293

WSDL (Web Services Description
Language), 138

WYSIWYG (What-You-See-Is-What-You-
Get), 24, 90

° X’ °
XMethods Web site, 328
XML (Extensible Markup Language), 138

oyo

Y format provider, 174
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